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MiCONTACT CENTER BUSINESS
Mitel MiContact Center Business integrates with MiVoice Business platform to provide contact
centers with the tools they need to efficiently and effectively measure andmanage contact center
operations. Interactions are routed intelligently across all media types (voice, email, chat, SMS, and
openmedia), increasing customer satisfaction and streamlining agent calls. Contact center
efficiency and agent performance can bemonitored both historically and in real time and can be
measured using a wide variety of reports. Flexible licensing packages provide access to specific
features and applications and enable you to build a contact center package that best suits your
business needs.

CONTACT CENTER ANDWORKGROUP
There are two licensing bundles available for MiContact Center Business: Contact Center and
Workgroup.

Contact Center is the licensing level of choice for businesses with more than 100 concurrent agents,
who want resiliency, and require more than 10 IVR ports.

Workgroup is geared toward contact centers with fewer than 100 concurrent agents, requiring a
maximum of 10 IVR ports, with no need for resiliency. Workgroup supports single-node ACD
environments only.

Both licensing bundles offer general business and contact center reporting and real-timemonitoring,
client desktops, and IVR Routing capabilities, and support voice, email, chat, SMS, and openmedia
communication. They include feature-rich, web-based applications for streamlining contact center
management and enabling agent productivity. There are several options available to further
customize your contact center solution.

For detailed licensing information, see theMiContact Center Business andMiVoice Analytics
System Engineering Guide.

MiContact Center Business includes the following applications, depending on your licensing bundle:

l CCMWeb
l Contact Center Client
l Interactive Contact Center
l Interactive Visual Queue
l Contact Center PhoneSet Manager
l Contact Center Softphone
l Multimedia Contact Center
l Contact Center Screen Pop
l Flexible Reporting
l IVR Routing
l Workforce Scheduling
l Employee Portal
l Schedule Adherence
l Traffic Analysis
l Ignite



Licensing

3

l MiCollab Client
l MiVoice Border Gateway
l CTI Developer Toolkit

LICENSING
An employee is a physical person you track in your contact center. In the YourSite database, you
must create an employee ID for each employee whoworks in your contact center. Employees can
havemultiple agent IDs, but only one employee ID. You can run reports on licensed employees only.
The number of employees you license in YourSite Configurationmust be consistent with your
software license.

To view details on your software license

l Hover overHelp and select About your Mitel applications.

ABOUT THIS USERGUIDE
This guide provides information on how tomanage your contact center and instructions for
employees and supervisors regarding daily use of MiContact Center Business desktop applications,
including CCMWeb, Contact Center Client, Forecasting, Interactive Contact Center, Interactive
Visual Queue, theMiCollab and Ignite integration, Contact Center Softphone, Contact Center
PhoneSet Manager, Flexible Reporting, Workforce Scheduling, Schedule Adherence, and Employee
Portal.

To report an issue with this document please email techpubs@mitel.com.

MiContact Center Business

This chapter describes

l The layout of the user guide
l Document conventions
l Where to find information and troubleshooting assistance

Contact Center Concepts

This chapter describes

l The basics of ACD
l The basics of ring group call distribution
l The inbound contact center environment
l How resources interact to process interactions

mailto:techpubs@mitel.com
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Contact Center Planning and Management

This chapter provides information on how to plan andmanage your contact center, including how to

l Establish a corporate Service Level objective
l Collect data
l Forecast the Call Load
l Calculate the resources required
l Schedule agents
l Determine contact center costs

Getting Started

This chapter describes how to

l Specify user preferences in CCMWeb
l Configure email contacts in CCMWeb

Real-time monitors

This chapter describes how to

l View real-time agent and queue statistics on real-timemonitors
l View andmanage callbacks
l View ports
l View web pages
l View historical real-time events
l Configure alarms for agent and queue performance
l Customizemonitor display characteristics
l Build marqueemonitors and broadcast statistics andmessages
l Chat online with co-workers and supervisors

Forecasting

This chapter describes how to

l Create forecasts
l Export forecasts to Excel andWorkforce Scheduling

Interactive Contact Center

This chapter describes how to

l Control the availability of agents, queues, and extensions

Interactive Visual Queue

This chapter describes how to

l View calls within queues andmove calls from busy queues to less active queues
l Call back abandoned callers
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Contact Center PhoneSet Manager and Contact Center Softphone

This chapter describes how to

l Handle calls using Contact Center PhoneSet Manager, Contact Center Softphone, and
Contact Center Client

MiCollab Client and Ignite integration

This chapter describes how to

l UseMiCollab Client with Ignite for voice handling

Flexible Reporting

This chapter describes how to

l Design your own report templates and customize existing reports

Workforce Scheduling

This chapter describes how to

l Schedule agents
l Measure employee adherence to schedules
l View and trade shifts online and request changes to schedules

SEARCHING FORKEYWORDSANDTOPICS
You can search for content in this PDF by using the search function built into Adobe Acrobat or
Reader. Consult your Adobe documentation for other search options.

To search for a key word or topic

1. In the open PDF, press Ctrl+F.
Alternatively, right-click in the document and select Find.

2. Type the key word or topic for which you want to search.
3. Press Enter.
4. Navigate the results by clicking theNext orPrevious buttons.

DOCUMENTCONVENTIONS
This document uses the following conventions.

UI syntax

The following terms apply to actions you perform on the user interface:

l Click precedes items you select with themouse, such as buttons, menus, and items in list
boxes.

l Press precedes items you use select on the keyboard.
l Select or clear precedes items you turn on or turn off, such as check boxes.
l Select precedes items you select in combo boxes (text boxes with attached list boxes).
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For example

1. Click OK.
2. Press Enter.
3. Select theShow Start page check box.

Bold

Bold typeface designates paths you select in your root directory and items you click, press, type, or
select.

For example

1. Click OK.
2. Delete 50 and type 60.
3. Select theCheck database integrity check box.

UI Menu items

UI menu items you select are separated by an arrow [=>]. For example, File=>Open tells you to
select theOpen submenu on the Filemenu.

Note

The wordNOTE: designates essential user information.
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LOCATING THE LATEST VERSIONOF OURGUIDES
TheMiContact Center Business documentation library includes the following guides. The latest
version of each guide is available from http://edocs.mitel.com.

l MiContact Center Business User Guide: provides information on the basics of contact center
management, and descriptions for use of all agent and supervisor applications within the
MiContact Center Business suite. This guide focuses on voicemedia.

l MiContact Center Business Installation and Administration Guide: provides instructions for:
l Downloading, installing, registering, and configuringMiContact Center Business on the
Enterprise Server and client computers

l Upgrading from previous versions of MiContact Center Business
l Installing and configuringMiContact Center Business at remote sites
l Installing and deployingMiContact Center Business .ova files
l All IVR Routing configuration

l Multimedia Contact Center Installation and Deployment Guide: is the primary source of
information for contact centers using email, chat, SMS, or openmedia to communicate with
customers. This guide describes how to:

l Install, configure, andmaintain amultimedia contact center
l Use the tools required tomanage amultimedia contact center
l Handle customer interactions via voice, email, chat, SMS, and openmedia using Ignite

l MiContact Center Business andMiVoice Analytics System Engineering Guide discusses the
following topics:

l Deployment models based on licensing, contact volume, network requirements, and
availability

l Recommendations for collocating server applications
l System requirements, including server and client hardware and software requirements,
virtual application requirements, andmulti-tenanting requirements

l Server and client virtualization details and best practices
l Performance and scalability details, including verified capacity results for all media
types (alone and blended) and IVR Routing scalability and port sizing recommendations

l Bandwidth and storage requirements
l Licensing information
l Support details for third-party integrations and internal products, such as Multimedia
Contact Center and IVR Routing

l MiContact Center Business—Reports Guide: describes all of the report types available and
explains how to generate, view, and share reports for the Contact Center licensing package.

l MiContact Center Business -Workgroup Reports Guide: describes all of the report types
available and explains how to generate, view, and share reports for theWorkgroup licensing
package.

l MiContact Center Business Deployment Guide: discusses the following topics:
l Contact center basics, with a focus on ACD routing functionality
l Topologies for scaling

http://edocs.mitel.com/
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l ACD resiliency
l IVR Routing resiliency and redundancy
l Virtual contact centers

l Contact Center Blueprint: discusses the following topics:
l MiContact Center Business topologies
l MiContact Center Business deployment details
l Cloud and hosted considerations

l MiContact Center Business Site-Based Security (Multi-tenant) Administration
Guide: describes how to install and configureMiContact Center Business in amulti-tenant
deployment.

TROUBLESHOOTING ASSISTANCE
For the latest frequently asked questions and troubleshooting information, see theMitel Knowledge
Base at KnowledgeManagement System available onMiAccess.mitel.com.
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CONTACT CENTER CONCEPTS
Contact centers process a high volume of contacts to meet marketing, sales, customer service,
technical support, and other business objectives. A fine-tuned contact center distributes contacts
efficiently and optimizes the use of agents and other resources. This section describes the inbound
contact center environment and how resources interact to process voice contacts.

AUTOMATIC CALL DISTRIBUTION (ACD)
Automatic Call Distribution (ACD) is a specializedmechanism for distributing incoming calls. The
primary goal of ACD is to ration calls to agents in a cost-effectivemanner that provides acceptable
service to callers.

To optimize the use of agents, you cross-train them so they can handle a variety of inquiries. Rather
than distributing calls to a number of small, specialized agent or extension groups, ACD distributes
them efficiently among the entire pool of available agents. When you consolidate resources (use the
Pooling Principle), the same number of contact center agents handlemore calls while maintaining
Service Levels.

Typically, you program ACD to ensure the first call to arrive reaches the first available agent or the
agent who has been idle the longest. However, you can vary the order of calls and agents to provide
superior service to preferred customers, and skills-based routing.

UNDERSTANDING ACDCALL FLOW
The path of an incoming call is as follows. A caller telephones your contact center via the Public
Switched Telephone Network (PSTN). (The PSTN is a global collection of Central Offices (COs)
interconnected by long-distance telephone switching systems.) The local CO directs the call to one
of your trunk groups. An available trunk picks up the call. Typically, calls from the PSTN arrive to the
contact center over incoming trunks and calls from the contact center to the PSTN travel over
outgoing trunks. If no trunks are available, the call does not get through to the system (it is blocked)
and the caller receives a busy signal.

When a trunk picks up a call, it forwards it through to a group of agents handling calls, or to some
other answering point. The call arrives at the ACD queue of an agent group. The queue delays the
call rather than blocking the call from entering the system. The length of time the caller waits in
queue is the queue time. While waiting in queue, the caller listens to product features,
announcements, or other messages provided by a Recorded Announcement Device (RAD). The
caller can wait patiently in queue for an available agent, leave a voicemail message, or hang up
(abandon) the call. (See Figure 1.)

An agent handles the call. The time the caller spends talking to the agent is the ACD Handling Time
(including the hold time). If the agent calls the supervisor in search of more information (while the
caller is on hold) and/or transfers or conferences the call, these times are added to the ACD Handling
Time value.

For example, an agent speaks to a caller for twominutes and then puts the caller on hold for three
minutes and tries to solve the problem. This may include a call to the supervisor. The agent then
initiates a conference call with the caller and a third party and they speak for threeminutes and
resolve the issue. Therefore, the ACD Handling Time for the agent is 2 + 3 + 3 = 8minutes.
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When the call is completed, the agent might need to perform additional work associated with the call.
The time taken to perform this work is theWrap Up Time.

Figure 1: Call flow

Monitoring the call flow process
Second-by-second (real-time) statistics presented on wall signs and desktopmonitors enable you to
monitor the service provided to callers. You canmonitor the number of incoming calls, the time it
takes to process them, the queue load, and the availability of agents using aManagement
Information System (MIS). TheMIS refers processes data produced by the telephone system. The
MIS uses telephone system records to provide forecasting, real-timemonitoring, and reporting
functions.

Ensuring traffic-carrying efficiency
To optimize traffic-carrying efficiency ensure

l Sufficient trunks are available to carry incoming calls.
l Callers experience a delay in queue.
l There is a random distribution of calls among available agents.

Scheduling to optimize call flow
You schedule agents so the number of incoming calls at any given time typically exceeds the
number of agents currently available. The intent is that callers experience a slight delay before
agents answer their calls. The expected number of incoming calls forecasted for the time of day, and
day of the week influence scheduling decisions.



MiContact Center Business—MiVoice Business User Guide

12

Routing calls
Call routing options you program in the telephone system provide a set of instructions that automate
themovement of calls to their intended answering points. You can define options—for example, if
the caller dials 1, the system forwards the caller to customer service. You can specify re-routing for
calls not answered after a set period of time and parse incoming Automatic Number Identification
(ANI) and Dialed Number Identification Service (DNIS) data to direct call routing. (See Figure 2.)

Figure 2: Call routing

Dialing an agent’s extension
In the simplest call scenario, a single trunk picks up an incoming call to your contact center. The
telephone system presents the caller with options to dial various answering points. The caller dials
an individual agent at an extension through a queue number. A queue number is an address
mechanism for a queue or other answering point. The programming associated with the queue
number defines the routing and timing features of the call. The telephone system collects data on the
agent and trunk involved in the call. The ACD management reporting application produces reports on
agent and trunk activity.

Dialing a queue
In the next call scenario a trunk group picks up an incoming call to your contact center. The system
presents the caller with options to dial various answering points. The caller dials queue number 1 to
reach queue 1 (Customer Service). The system forwards the call to the first available agent in the
agent or extension group associated with queue 1. The call is an ACD call because one dialable
number represents all of the agents in the group. The telephone system collects data records for the
call. The ACD management software produces Queue Reports on queue 1.
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Overflowing calls
An ACD call that is not answered immediately is placed in a queue. If an agent does not pick up the
call after a set amount of time (the overflow time) the system places the call in the queue of another
agent group, in addition to keeping it in the first queue. The first available agent in either group
handles the call. The overflow feature limits the delay faced by callers by queuing calls against two
or more agent groups. (See Figure 3.)

Figure 3: Multiple queue routing

Interflowing calls
You can program the ACD routing system to direct a queue delayed call to voicemail or to another
answering point. The interflow timer runs independently of the overflow timer. If the interflow timer
expires, the system removes the call from the queue and re-directs it to another answering point,
such as a trunk or voicemail.

RING GROUPS
MiContact Center Business andMiVoice Analytics support Ring Groups. Ring Groups are a call
distributionmechanism that offers an alternative to ACD for distributing calls in your business. While
ACD is focused on rationing calls to pools of available agents, Ring Groups are configured to
distribute calls to a pool of specific extensions. Users can configure RingGroups within YourSite
Explorer, monitor them in Contact Center Client, and report on them.

When an incoming call rings the RingGroup, themember extensions configured in the RingGroup
are rung until one extension answers. Ring Groups can be programmed to offer calls to extensions
using five different algorithms:

l Ring All: Rings all available extensions in the RingGroup simultaneously.
l Terminal: Starting from the first extension in themember list, rings the first available
extension.

l Terminal Cascade: Starting from the first extension in themember list, rings the first
available extension for the duration of the Cascade Ring Timer before calling the next
available extension in themember list.
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l Circular: Starting from the last member to handle a call, rings the next available extension in
themembers list

l Circular Cascade: Starting from the last member to handle a call, rings the next available
extension in themember list for the duration of the Cascade Ring Time before calling the next
available extension in themember list.

Ring Groups enable a business to ensure that in settings where employees may not have a set
physical location or mobile device, such as a warehouse or back office, calls can be effectively
distributed to an answering extension. Calls to Ring Groups can be ACD or Non ACD inMiContact
Center Business real-time and reporting.

Incoming calls are handled differently than ACD path queues as well. If a call comes in, it will be
queued if any one of the RingGroup’s extensions are available. Available extensions are those that
are:

l Idle
l Busy (ACD, Non ACD, or Out)

If the RingGroup’s extensions are not available, the call is overflowed immediately (if an overflow
point has been configured) or receives no answer. Extensions in the following states are not
available:

l DoNot Disturb
l Out of Service
l Not Present
l Reseize Timer

For more information about extension states, see "Extension states" on page 55.

THE INBOUNDCALL ENVIRONMENT
The inbound contact center environment has unique characteristics that must be considered in
effective planning andmanagement.

Predicting call arrivals

Calls arrive randomly to contact centers. You cannot predict theminute-to-minute arrival of calls.
This results in unanticipated increases in workload, and impacts staffing calculations and the load
carried by system and network resources.

You can predict the pattern of call arrivals for 15-minute or longer intervals. For example, you can
predict that next Monday between 1:00 P.M. and 1:30 P.M. you will receive 60 phone calls.
However, you cannot predict how many calls will arrive in the first fiveminutes, the second five
minutes, and so on.
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Understanding caller tolerance

Several factors influence a caller’s tolerance to queue delays:

l The immediacy of the caller’s requirement
l The availability of similar products or services
l The caller’s expectations for service
l The time available to make the call
l Whether or not the caller is paying for the call



Chapter 3
CONTACT CENTER PLANNING AND
MANAGEMENT

Establish a corporate service objective
Collect data
Forecast the Call Load
Calculate the resources required
Schedule agents
Determine contact center costs
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CONTACT CENTER PLANNING AND
MANAGEMENT

Effective contact center management involves having the right resources in place at the right times
to handle an accurately forecasted workload at the desired level of service. Commitment to a
systematic planning andmanagement strategy is essential. The strategy is based on corporate
objectives that you continually assess and refine.

Whether you aremanaging a start-up contact center or refining the performance of an existing
operation, the process illustrated in Figure 4 applies. It is the basic framework for achieving and
maintaining your service objectives.
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Figure 4: Planning cycle

The objective of contact center management is to find the right balance between the agents
scheduled and the service provided to customers. This involves assessing and re-assessing trade-
offs between the Service Level, agents scheduled, and average call duration for a knownCall Load
for each 15-minute or half-hour interval of the day. Collecting, properly interpreting, and applying
ACD and other information allows you to accurately forecast the workload and schedule sufficient
agents to meet your service objectives.
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STEP #1 ESTABLISH A CORPORATE SERVICE
OBJECTIVE

The Service Level % is a performancemetric contact center managers use to determine what
proportion of customers, who contact you by voice/email/chat, receive 'good' service. Using the
Service Level %, you can gauge the level of service customer's experience, from a historical and a
real-time perspective.

Defining and adequately funding a service objective should be closely tied to your corporatemission.
The service objective identifies the average length of time a caller who has obtained a trunk waits for
an available agent. It is the basis for planning and budgeting and links the resources you require to
your service objectives. Choosing a service objective is the first step in a comprehensive planning
andmanagement solution. Once you set a service objective, you should routinely access it to see
how consistently you aremeeting it, on a 15-minute or half-hour basis.

Contact centers in different industries use different criteria for measuring service. Your service
objective should reflect the type of service being provided and the expectations of callers seeking
the service. For example, a company that sells magazine subscriptions has less to lose in the
outcome of any one call than a car dealership does. A caller to a credit card 'lost or stolen' linemight
expect different service than a caller to a customer service department at a bank. Contact center
metrics across industries are designed to reflect this.

Performance targets must suit the primary function of a contact center. In revenue-based contact
centers where agents sell products or services, the net revenue per call is considered when defining
a service objective. Revenue-based contact centers strive to provide a high level of service with
minimal blocking and delays.

UNDERSTANDING THESERVICE LEVEL
The Service Level applies to all of themedia types (voice, email, chat, SMS, and openmedia).

TheService Level is expressed as X percent of calls handled in Y seconds or less, such as 80
percent of calls handled in less than 20 seconds. Why is Service Level the standardmeasurement of
service? Service Level provides themost accurate representation of the callers’ experience. It is
ultimately the caller who decides what constitutes good service, and whether or not to end a call. It
applies to inbound transactions that must be addressed as they arrive.

When a caller enters a queue, the call is processed in one of three ways:

l An agent answers the interaction (handled interaction).
l The client disconnects before an agent answers (abandoned interaction) (for calls and chats
only).

l The interaction is removed from the queue, and sent to another handling point (for example, to
voicemail, an automated attendant, or another queue), (Interflowed interaction).

For detailed information on Calls Offered, Calls Handled, Calls Abandoned, Calls Interflowed, and
other Service Level parameters see "Choosing a Service Level goal" on page 21.
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UNDERSTANDINGWHYTHESERVICE LEVEL IS THEMOST
MEANINGFUL STATISTIC
The Service Level is one of many ACD statistics used tomeasure performance. Each statistic has
its purpose. For example, theGrade of Service (GOS) statistic relates the number of trunks to the
level of traffic and indicates the likelihood an attempted call will receive a busy signal. It is expressed
as a decimal fraction. For example, a GOS of P.02means a caller will have a two percent chance of
receiving a busy signal. Since trunk costs are insignificant compared to agent costs contact centers
are well advised to schedule sufficient trunks, abandons should beminimal.

A delayed call is a call placed in the ACD queue because it cannot be answered immediately by an
agent. The probability of delay statistic relates the number of agents or extensions to the level of
traffic carried by the trunks and indicates the likelihood and amount of delay experienced. TheGOS,
probability of delay, andQuality of Service rendered by agents provide vital information about the
callers’ experience. (See Figure 5.)

Figure 5: Service criteria

TheGOS and probability of delay contribute to our understanding of what happens to the calls not
answered in Y seconds, and givemeaning to Service Level. Service Level is the primary statistic
used in planning and budgeting because it is themost stable measurement of queue activity.

The following statistics are alsomeaningful contact center indicators:

ASA

TheAverage Speed of Answer (ASA) is an ACD statistic that measures how long the average caller
waits on hold before the call is picked up by an agent. ASA is a valuablemeasure of service quality,
but is oftenmisinterpreted. The average does not represent what is typically experienced by
individual callers. Most calls are answered by agents more quickly than the average, but a small
percentage of callers wait several minutes in queue. ASA is a useful parameter, but Service Level is
amore reliable indicator of what callers experience.
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Abandonment

ACDs collect statistics on how long callers wait before abandoning calls, and what percentage of
calls are abandoned. Unfortunately, abandonment is difficult to forecast because it is impossible to
predict caller behavior with any reliability. Sometimes when the Service Level is highmore callers
abandon than expected. There are no industry standards for abandonment. It is a somewhat
unreliable measure of contact center performance. However, abandonment statistics assist in
planning Service Levels, and provide valuable information used to create in-queue andmessage-on-
hold announcements.

CHOOSING ASERVICE LEVELGOAL
Contrary to popular belief, there is no industry standard Service Level. Some contact centers base
their Service Level goal on the targets of same-industry companies. In doing so, they assume these
companies are actually meeting their intended targets. Companies are setting increasingly rigorous
Service Level targets in sectors where outstanding customer service is the norm.

Setting an appropriate Service Level goal for your contact center is not easy. Themotivation and
expectations of your customers, the availability of similar goods or services, the Service Level
targets of same-industry companies, and the value of calls are things to consider. It may be useful to
run some calculations to determine the trade-offs in Service Level associated with adding or
removing an agent, and implement customer satisfaction surveys. When defining your corporate
Service Level, consider several factors and rate their relative importance.

An appropriate Service Level is one that

l Satisfies callers’ expectations for service
l Keeps abandonment in check (at less than five percent)
l Minimizes expenses andmaximizes revenue
l Meets with the approval and support of agents, supervisors, and senior management

Consider this modest objective. For a Service Level of 80 percent of calls answered in less than 20
seconds, callers receive the following service:

l Approximately 30 percent of callers experience a delay in queue.
l The longest wait time is approximately threeminutes.
l The average speed of answer is approximately 12 seconds.

Is this acceptable service for you and for your callers?

UNDERSTANDING QUALITYOFSERVICE
Agent statistics reflect the time agents spend in various states and are used to assess agent
performance. The average time an agent spends handling interactions, and in theMake Busy, Do
Not Disturb, Unavailable, andWrap Up states directly affects the agent’s availability and the
Service Level provided to callers.
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Service Level alone does not ensure customer satisfaction. The quality of the interaction between
the caller and agent leaves a lasting impression. Quality of Service reflects an agent’s ability to
provide excellent service to each customer. The knowledge of the agent, the accuracy and
completeness of the information provided, and the courtesy extended to the caller contribute to the
caller’s experience.

MONITORING CALLHANDLING TECHNIQUES
Silent monitoring systems complement ACD statistics by providing a snapshot of quality and
productivity in your contact center. You can track call handling techniques and determine where
improvements can bemade in individual performance. Advanced systems capture the voice
interactions between agents and callers and record agent data tables for a complete picture of call
handling. They provide online evaluation forms so you can annotate recordings with feedback.

Silent monitoring takes the bias out of performance evaluation. Silent monitoring provides a
systematic process for monitoring and grading agent calls. You can schedule sessions across
different times of the day, days of the week, and evaluators promoting fairness and consistency.
Showing agents where improvement is needed is more effective than just telling them. Silent
monitoring can contribute to a reduction in call time, a reduction in monitoring time and personnel,
and increased training efficiency.

You can use pre-recorded interactions between agents and customers to train agents and for
ongoing evaluation.

You can use the information to

l Provide recorded examples of exceptional service and unacceptable service to agents in
training.

l Record, review, annotate with feedback, and forward call records to agents who then review
your comments within the context of the actual call.

l Calibrate and routinely access the scoring consistency of call monitors.
l Assess the effectiveness of current training programs.
l Assess the efficiency of themonitoring and assessment process.

Defining scoring parameters

The parameters used to evaluate how well agents handle calls are based on the purpose of the calls.
Goals vary across calls for inbound and outbound services. For example, in an outbound sales
environment quality may be based on whether or not the agent made the sale, took advantage of
cross-sell opportunities, and adhered to a pre-defined script. In an inbound environment quality may
be based on the completeness and accuracy of the information and whether or not the caller’s
questions were answered satisfactorily. Agents are also evaluated on 'soft skills', such as voice
quality, pausing at regular intervals, rate of speech, use of positive language, and other listening and
communication skills.
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Setting performance standards and goals

Once you determine appropriate scoring parameters, you define standards for exceptional and
acceptable levels of performance. Assessment standards are based on consensus andmust be
clearly defined and communicated tomonitors and agents. Collaborate with agents in setting
performance goals and clearly define exceptional service and interim performance steps. Determine
a baseline of current performance and set performance steps for an agent group. Provide agents in
the group whomeet or exceed the interim target with rewards and recognition commensurate with
their performance. When systematically used in training and coaching recorded sessions positively
impact productivity. Fair assessment is good for moral andmotivation, and contributes to an
environment in which agents can learn and grow.

Monitoring frequency

The frequency of monitoring sessions is determined by individual companies and ranges from once a
month to 15 or 20 sessions amonth. Implementing five to 10monitoring sessions per month is
common practice. Trainees and agents with consistently low scores aremonitoredmore frequently
than other agents. Resource limitations typically influence the frequency of monitoring.

MONITORING SYSTEMSANDTOOLS
The followingmonitoring systems and tools help you evaluate the performance andmanage the
quality of service of your contact center.

Silent monitoring systems

Silent monitoring systems range from tape recorders to client/server based recording systems.
Advanced systems schedule, record, and store voice files in a compressed digital format using a
real-time link to your telephone system. They capture any data tables accessed by the agent in
addition to voice data. Silences are eliminated to optimizemonitoring efficiency. Recording sessions
can be played back from any telephone, anywhere, at any time. You can customize agent evaluation
forms and define parameters for quality with advanced systems. They provide activity, status, and
management reports for evaluating agents and observation practices.

IT support systems

Information Technology (IT) support systems are commonplace in contact centers. Contact center
agents divide their time between listening to customer requests, entering and updating customer
information and other entries, searching for required information, and providing feedback to
customers. In order to provide prompt and complete information, agents must have immediate online
access to information including customer records and case histories, products and services, and
company policies and procedures.

The push to increase agent efficiency and customer service has placed new demands on computer
information systems and information technology. Information products that enhance agent
productivity are continually being developed. Contact center systems are designed to incorporate
some, or all of the following specialized support functions.
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CTI

Computer telephony integration (CTI) is themerging of computers and telephone systems. Today’s
computer-based telephone systems deliver synchronized voice and data, voice and data
conferencing, automatic information retrieval for calls, caller-basedmessaging and routing, and
desktop productivity tools. You can use customer databases in call handling to enhance customer
service and agent productivity. When databases are shared between contact center departments
each agent can access a caller’s contact information, purchasing records, call history, and
preferences by a caller ID number.

ANI

Automatic Number Identification (ANI) identifies the telephone numbers of callers to your contact
center, so agents can receive screen pops with calls. You can connect a database to your telephone
system to simultaneously send calls and caller information. The telephone system forwards the
caller’s telephone number to a software application that relays database records on the caller to the
agent. Alternately, the caller enters an ID number that the database associates with a set of records
for the caller and the agent is sent the information.

ANI saves agents time since they do not have to ask for and enter a name for a caller, and wait for
the database to respond. This time savings significantly impacts staffing requirements and
telephone service charges. ANI also identifies telephone numbers of callers who abandon calls so
they can be contacted later for potential business.

Reports can identify the volume of usage and costs of internal line numbers, and help you track the
long distance distribution per line number andmaximize long distance efficiency.

DNIS

Dialed Number Identification Service (DNIS) is a feature of toll-free lines that identifies the telephone
number the caller dials. This assists agents who handle calls for more than one business or product
line. Each business or product line has its own toll-free number. When a caller dials a toll-free
number, the telephone system forwards information to the agent so the agent can identify who the
caller dialed. For example, a caller dials a toll-free number for a cruise line. The telephone system
sends a script to the agent along with the call. The agent then knows to answer 'Goodmorning.
Thank you for calling Southern Cruises', instead of the name of another cruise line serviced by the
center.

AUTOMATING HELPDESKWORKFLOW
Agents at IT help desks require quick access to customer information and call history, and the ability
to rapidly log all of the support calls and incidents. Advanced help desk packages offer automated
desk help workflow systems. They assist agents in logging service requests (tickets), dispatching
them to prioritized queues or agents, tracking them, and documenting activities.

External applications, help desk operators, or end users (in web-based applications) generate
tickets. The system generates themmanually, or in some cases automatically, in response to
system events. It can correlate multiple incidents with single tickets, andmultiple problems with a
single call.

Automated help desk workflow systems track each step taken in answering a call, with automatic
time stamping of all of the referrals, escalations, reminders, alerts, and email notifications. Calls are
prioritized and referred to other departments without reassignment, reassigned (escalated) to other
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technicians or specialized staff, and placed in an alert condition when they are not resolved
promptly. Activities are date and time stamped automatically. Most help desks offer outgoing email
notification and paging. Some help desks offer automated logging of incoming emails, and
automated call acknowledgment emails to clients.

STEP #2 COLLECT DATA
Telephone systems generate an enormous amount of real-time and historical data used in planning
andmanagement of your contact center. You use real-time data tomonitor the current Call Load and
agent availability sominute-to-minute adjustments can bemade. You use historical information in
forecasting, staffing, and scheduling. Other critical management information comes from customer
surveys, market studies, employees, external departments, telephone networks, workforce
management systems, competitors, and themedia. Data collection is a continuous process you
implement as soon as your telephone system is up and running. 

Telephone systems provide detailed report data on every aspect of call transactions. You can
program computer-based telephone systems connected to a Local Area Network (LAN). Users on
the LAN can view or print real-time and historical reports. Using web-enabled telephone systems,
you can view and generate reports in aWeb browser. You canmonitor contact center activities
remotely, and distribute reports to people on different networks.

COLLECTING DATAONCALLHANDLING
Contact center reporting software displays real-time telephone system data on desktopmonitors and
wall signs. Using real-time data, you canmanage current conditions and ensure agents respond to
changing contact center events. The telephone system provides information on call activity, agent
activity, and queue activity.

You can use historical data in forecasting and in assessing the performance of your resources.
Historical reports provide vital information on load activity, resource activity, and queue activity. For
example, resource activity reports on trunks can tell you the highest number of trunks used during
peak traffic periods, and the total duration of calls handled by each trunk for the reporting period. You
can determine how busy your trunks are, and whether or not you have the right number of trunks
scheduled.

CTI provides in-depth information on call transactions. Detailed information on keystroke
sequences, databases searched on, and on-screen assistance provides a clear picture of agent
activities. Using ANI data, you can identify callers by area code and collate information on
demographic trends in caller behavior.

Workforcemanagement systems use telephone system data to forecast and schedule agents.
Some packages monitor the real-time adherence of agents to scheduled activities, so you know the
number of agents currently logged on and available to handle calls. Workforcemanagement systems
collect and store real-time adherence data. This data provides a historical account of adherence
used in agent assessment.

Customer surveys provide valuable supporting information on callers’ tolerance to delay, and
expectations for service. They address some of the following questions: Was the agent accessible?
Was the caller put on hold for too long?Was the agent courteous and responsive tomy request?
Was the agent well informed? Did the agent provide the correct information and keep commitments?
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Contact centers use this information to estimate the repercussions of poor service: escalated costs,
duplication of work, lost customers.

As the economy moves towards individual, personalized services, new ways of handing calls
continue to emerge. These new features add to the complexity of collecting andmeasuring
information. It is vital you establish an integrated, reliable system for measuring the key indicators of
performance: the efficiency of call handling, the service callers experience, and their perceptions of
that service.

STEP #3 FORECAST THE CALL LOAD
Finding the right balance between resources and traffic volumes is a critical step in effective contact
center management. Estimating resource requirements is particularly challenging as the number of
calls and the total duration of calls expected for a given time interval is difficult to predict.

Forecasting impacts contact center operations and performance in the following ways:

l The number of blocked and abandoned calls
l The level of service provided to callers and callers’ perception of service
l Agent workload, call behavior, and retention
l The accuracy and usefulness of schedules
l The success of periodic sales campaigns

FORECASTING ACCURATELY
Forecasting is an imprecise science. The accuracy of your forecast increases markedly with the
size of your data sample. You take a year (or preferably two or three years) of ACD queue traffic
data, examine trends in Call Load patterns, break down the information, and determine the ACD
Handling Times of the calls. You thenmodify the forecast based on current contact center activities
and other considerations, such as absenteeism, agent breaks, holidays, and training.

The range of forecast dates you specify depends on the purpose of the forecast. Using long-term
forecasts, you can estimate future budgets and expansion opportunities, and establish corporate
objectives. Using short-term forecasts (of one to threemonths) you can determine seasonal staffing
requirements, plan for short-term sales campaigns, and assess upcoming hiring needs. You can use
weekly, daily, hourly and half-hour forecasts to tweak agent schedules and adjust for absenteeism.

CONDUCTING FORECASTS
Conducting a forecast involves accurately estimating the three components of Call Load: the ACD
Handling Time, Wrap Up Time, and Calls Offered. After you run a forecast, it is useful to examine
the data andmake adjustments based on present contact center conditions. You tweak the forecast
by adding or reducing calls based on your intuition and on information gathered by yourself and
others.



MiContact Center Business—MiVoice Business User Guide

27

To forecast the agent requirement, you

1. Examine trends in Call Load patterns.
2. Break the information down in tomonthly, weekly, daily, half-hour, and 15-minute intervals

that reflect Call Load patterns.
3. Determine the handling times of calls.
4. Modify the forecast based on current contact center activities and other considerations, such

as absenteeism, agent breaks, holidays, and training.

Youmay need to consider the following issues: hardware or software system changes, expected
callers, advertising andmedia, changes to your products, services, or pricing, new products, product
performance, competitors' actions, and international, national, and corporate events. It is vital to
have a systematic forecasting process in place that all of the departments support. For detailed
information on Call Load, ACD Handling time, Wrap Up Time parameters, see "Forecasting terms"
on page 134.

STEP #4 CALCULATE THE RESOURCES REQUIRED
You calculate the agent requirement in conjunction with the trunking requirement. The number of
available agents affects the likelihood and length of delay experienced by callers. The delay affects
the load trunks must carry. Because the number of available agents impacts the number of trunks
required, you calculate the agent requirement first.

The Erlang C formula uses your historical Call Load and Average Talk Time data to predict the agent
requirement for the time interval and date range in the forecast. The resultant spreadsheet displays
the Call Load and agents required across time intervals.

PREDICTING AGENTREQUIREMENTS
Agent costs account for over 60 percent of all of the contact center costs. Accurately predicting the
agent requirement, making themost effective use of agents, and standardizing andmonitoring agent
activities are paramount to achieving your service objectives. Agents are your most valuable
resource: make team building and teammanagement a high priority.

You can predict the agent requirement for your Service Level Percentage and Service Level Time
targets by applying the Erlang C equation to the estimated Call Load and Average Talk Time.

UNDERSTANDING ERLANG C
Staffingmodels consider important factors unique to the inbound contact center environment:

l Call arrival is random.
l Consolidating resources allows the same number of contact center agents to handlemore
calls while maintaining Service Levels.

l Maintaining high Service Level targets requires staffing a large number of agents that will be
idle a significant portion of the day.

The industry standard Erlang C equation operates on these principals. Most contact center reporting
packages use Erlang C. An Erlangmeasures telephone traffic, or the flow of calls and call attempts
to your contact center during a given period. One Erlang equals one hour or 60 x 60 = 3,600 seconds
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of telephone interaction. This could be one call lasting one hour, six calls lasting 10minutes, or any
combination of calls and call durations that equal 60minutes. The Erlang formulas provide a
mathematical basis for making predictions about randomly arriving workloads.

Agent and delay calculations use the Erlang C equation. It predicts the resources required to keep
delay times within your Service Level objective. Three variables influence the delay time: the number
of agents, the number of waiting callers, and the average time it takes to handle each call.

Limitations of Erlang C

Erlang C has fundamental principles that do not reflect real-world circumstances. It assumes all of
the calls reach the contact center and all of the callers wait indefinitely to reach agents. Because
Erlang C assumes no blocking or abandons, it may overestimate the agents you need. Erlang C
requires accurate information on call flow where voicemessaging and call overflow are employed,
assumes your Call Load prediction is extremely accurate, and assumes you have the same number
of agents handling calls the entire half hour.

Although Erlang C has its limitations, it is the preferred planning tool as it provides reasonable traffic
estimates for contact centers that maintain good service-and few abandons.

Considerations when predicting resource requirements
Erlang C provides theoretical numbers for staffing that you need to assess in light of the following
contact center realities:

l The contact center blocks a certain proportion of calls and some callers abandon their calls.
l Talk time is unpredictable, and althoughmost calls may last two to threeminutes, a few calls
can last upwards of an hour.

l Agents in trainingmay require more time to process calls.
l Agents may use wrap up (after-call paperwork) time inconsistently during busy periods.
l Not all of the agents within an agent group are available at all times to handle calls offered to
the agent group.

Erlang C predicts staffing needs fairly accurately. However, contact centers that use skills-based
routing, overflow, interflow, and advanced routing options need to use intuition and experience in
adjusting the final numbers.

The Erlang C formula uses your historical Call Load and Average Talk Time data to predict the agent
requirement for the time interval and date range in the forecast. The resultant spreadsheet displays
the Call Load and agents required across time intervals.

PERFORMING 'WHAT-IF' SCENARIOS
After you run a forecast, you can perform 'what-if' scenarios on the resultant data by changing the
value of forecast parameters and recalculating the results. You can enter values for the ACD Calls
Offered, average ACD Handling Time, Wrap Up Time, and Service Level Percent and Time and
recalculate the number of agents required. For example, you can reduce the average handling time
and recalculate the agents required and the calls handled across 15-minute time intervals for the
shift.
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UNDERSTANDING THERELATIONSHIPBETWEENAGENTS
ANDTRUNKS
You are already familiar with the terms GOS (probability of blockage) and Service Level (average
wait time).

The following definitions are essential to understanding the relationship between agents and trunks.

Delay

Trunk calculations assume no queuing. For trunk calculations, the delay includes the time from when
a trunk picks up a call until an agent answers it.

Agent Load

TheAgent Load includes the ACD Handling Time andWrap Up Time.

Trunk Load

The Trunk Load includes the time from when a trunk picks up a call until the agent finishes speaking
to the caller and disconnects. The Trunk Load does not includeWrap Up Time.

Callers expect to have a 95 percent or better chance of obtaining a free trunk in to your contact
center, and expect to connect to an agent within a reasonable amount of time. Theremust be
sufficient trunks available to pick up calls, and sufficient agents available to handle the level of traffic
carried by the trunks. Themore agents handling a given Call Load, the less delay callers’ experience.
Callers experience a delay if there are insufficient agents available. If the delay is considerable, calls
back up and some calls do not reach the contact center.

Traffic engineering involves estimating the number of trunks and amount of communications
equipment needed to service an anticipated number of callers. It revolves around basic questions
concerning the relationships between service parameters and trunk and agent resources. How much
traffic can a particular number of trunks handle for a particular GOS?What is the GOS for a particular
number of trunks and traffic level? How many trunks are required to handle a particular traffic level
andGOS?What is the probability of delay and length of delay experienced for a particular traffic level
and number of agents? How many agents are required to handle a particular traffic level for a given
set of delay characteristics?

UNDERSTANDING ERLANG B
Contact centers use the Erlang B equation to estimate the number of trunks required. Erlang B
assumes calls are not queued and that callers who receive a busy signal do not attempt to call again.
It can underestimate the trunks required. One Erlang equals one hour or 60 x 60 = 3,600 seconds of
telephone interaction.

Predicting your trunk requirement involves

l Determining your Busy Hour Traffic (BHT)
l Deciding how many blocked calls you can tolerate, or Grade of Service (GOS)
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BHT

TheBusy Hour Traffic (BHT) statistic, measured in Erlangs, is the number of hours of call traffic (or
trunk traffic) you experience during the busiest hour of operation. It is important that your busy hour
figure represent the busiest Call Load your trunks will ever receive, and not just today’s peak traffic.
BHT is the (average call duration + average delay) x calls per hour ÷ 3600. This value represents the
highest Trunk Load (occupancy) in hours.

The call center traffic is the average number of trunks busy during the hour in question. One Erlang
equals one hour, or 60 x 60 = 3,600 seconds of telephone interaction. If a contact center experiences
6.12 erlangs (or 6.12 hours of telephone interaction) during an hour, an average of six trunks were
busy.

GOS

TheGrade of Service (GOS) value is a decimal fraction. A GOS of P.02means a caller has a two
percent chance of receiving a busy signal. Contact centers useGOS in calculating the number of
trunks required. It is important to specify a GOS that is right for you in order for the trunk calculation
to be realistic.

PREDICTING TRUNKREQUIREMENTS
The number of trunks you require reflects the level of traffic expected during your busiest hour of
operation. The busy hour is the hour during the workday in which a trunk group carries themost
traffic. You calculate the Trunk Load after you forecast the Call Load for the busiest hour and
determine the number of agents required to handle the Call Load for your Service Level objective.

Traffic calculators used to predict contact center resource requirements are available on theWeb
from companies such as erlang.com. You can obtain basic calculators at no cost. Calculators that
display and print results or calculations made during the previous week are available at amodest
cost.

To calculate the trunks required you simply input two of the figures and calculate the third. For
example, if you know that your Busy Hour Traffic is 10 erlangs and you want to determine how many
trunks are required when two calls are blocked in every 100 call attempts, you input the busy hour
time (10) and your target rate of blocking (0.02). The calculator displays a value for the trunks
required (17).

Figure 6 illustrates the trunks required across a spectrum of GOS values. Whether you chose aGOS
of 0.01, 0.05, or somewhere in between these values reflects how may calls per 100 call attempts
you can afford to lose. In revenue-based contact centers minimal blocking and delay is a priority.
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Figure 6: Estimating the trunk requirement

Although some contact centers base the trunk requirement on a staff-to-trunk ratio, such as 1.5
trunks per agent, many use the Erlang B equation. Whatever ratio results will be the right one for you.

It is better to slightly overestimate than slightly underestimate the number of trunks required: trunks
are inexpensive, compared to agent costs. You can always cancel a trunk if periodic Trunk Load
calculations show low occupancy on the trunk.

No staffing approach is absolute. You need to acknowledge the assumptions implicit in your
calculations and use common sense when estimating your resource requirements. When you
schedule resources, they must be closely monitored to ensure you aremaking full use of them.

STEP #5 SCHEDULE AGENTS
Scheduling involves accurately forecasting the workload and determining which agents should work
which shifts. This has traditionally been a labor-intensivemanual process for contact center
supervisors. You can schedule agents for breaks, split shifts, ACD and Non ACD work periods,
repeating work patterns, holidays, and on call work. You can categorize agents by pay level,
overtime eligibility, skill level, employment status (part time or full time), and scheduling preferences.
Matching these shift and agent variables to the anticipated workload, and re-allocating agents in
response to employee absenteeism can be a daunting task.

Scheduling is becoming increasingly challenging, as contact centers support a wider range of
products and services, and agents require more frequent and specialized training. Advances in
technology have automatedmany agent tasks and have resulted in more varied and challenging
calls and responsibilities.

Accurately forecasting and building schedules that reflect the workload as it changes across
intervals for days of the week, weeks of themonth, and seasons of the year is essential in meeting
your service objectives. You need a schedule that accurately matches agents to the anticipated
workload and agents who aspire to adhere to the activities scheduled.
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You can track the availability and activities of agents throughout the day and verify agents are
performing the duties for which they are scheduled. Not adhering to the schedule, such as forgetting
to log out for a break, or performing Non ACD work when scheduled to perform ACD work adversely
affects your Service Level and themoral of other agents whomust compensate for the unavailable
agent.

UNDERSTANDING THESHRINKAGEFACTOR
Accurately forecasting the workload and scheduling agents to satisfy your Service Level objective is
a good start, but does not account for the activities that prevent agents from sitting at their desks and
handling telephones.

Agents scheduled for ACD work can be involved in some of the following activities:

l On a bathroom break
l Making or receiving personal calls
l Conferring with the supervisor or another agent
l On the phone with other departments
l Sending emails
l Involved in a lengthy, difficult call
l Prolonged in after-call work
l Absent due to illness or compassionate leave

To account for short-term or daily unscheduled absences, you can calculate the rostered staff factor
(Shrinkage Factor). TheShrinkage Factor is a numerical value that defines the percentage of time
agents are scheduled to work but are unavailable to handle calls. It tells you the number of agents
youmust schedule in addition to the base number of agents required tomeet your Service Level.

CALCULATING THESHRINKAGEFACTOR
You calculate the Shrinkage Factor for one or more agent groups as follows:

1. Determine the base staff forecasted by hour or half hour for the day.
2. Make a list of activities that prevent ACD agents from handling calls.
3. Add the base staff to the number of agents who are unavailable to handle calls because they

are absent, on break, at an unanticipatedmeeting, etcetera.
4. Calculate the Shrinkage Factor for each time interval by dividing the scheduled staff by the

base staff required to handle telephones.
The result is a set of Shrinkage Factors that represent the expected shrinkage by half hour.
See Figure 7.
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Figure 7: Calculating the Shrinkage Factor

Youmultiply shrinkage values against the base staff required on telephones when setting future
schedules. If your agent requirements vary considerably on certain days of the week, you can
calculate a separate set of Shrinkage Factors for these days. Youmust use your good judgment in
identifying absences that are relevant to include in your Shrinkage Factor calculations. Anticipating
higher absenteeism on Fridays andMondays is a safe bet while factoring in daily compassionate
leave is not. As with all of the steps in contact center planning, routinely assess the accuracy of your
shrinkage predictions and adjust them as required.

OPTIMIZING SCHEDULES
Now that you have adjusted your agent requirement to account for unanticipated absences, the next
step is to design a schedule that makes themost of your resources.

The following examples illustrate ways to adequately staff a contact center without having agents sit
idle during slower periods.

Scheduling split shifts

Although not everyone likes to take a long break in themiddle of a shift, for some agents split shifts
fit well with priorities outside of work. For contact centers that experience heavy call traffic in the
morning and evening, split shifts prevent overstaffing during these periods.

Staggering shifts

Staggering shifts allows you tomaintain staffing levels over busy periods or periods when agents are
on breaks. For example, one set of agents could start at 8:00 A.M., a second group at 9:00 A.M., and
a third group at 10:00 A.M. so the contact center is fully staffed when it starts getting busy mid-
morning. Alternately, you could schedulemorning and afternoon shifts that overlap from noon until
1:00 P.M. to enable themorning shift to break for lunch while the afternoon shift handles calls.
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Staggering breaks

Making slight adjustments to the timing of morning, lunch, and afternoon breaks has a tremendous
effect on call handling. The Erlang C equation predicts 28 agents can handle 300 calls, each lasting
280 seconds and delayed 20 seconds. (See Figure 8.)

Figure 8 illustrates that changing the availability by one agent decreases the average delay time by
five seconds, and allows the contact center to handle 16 additional calls.

Figure 8: Staggering breaks to optimize call handling

Forecasting Non ACD work

Not all of the Non ACD work must be performed immediately. For example, call-backs to clients,
emails, and discussions with staff and supervisors can sometimes wait until less busy periods.
Forecast and schedule Non ACD work for slow times to ensure sufficient agents are available during
peak periods. Set availability priorities and regularly communicate them to agents.

Scheduling part-time agents and agents on call

When practical, scheduling part-time agents and agents on call can be an effective strategy for
topping up your pool of available agents. Scheduling agents on call is particularly useful for days of
the week and seasons when absenteeism is noticeably higher.

ROUTING CALLSTO OPTIMIZECOVERAGE
To optimize service, you can use the following routing strategies that involve resources outside of
the target agent group.

Overflowing calls to less busy agent groups

You can overflow calls from busy agent groups to less busy agent groups during peak periods. You
can route calls to agents who primarily perform Non ACD work but act as reinforcements during
busy periods, and to supervisors.
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Employing call-back messaging

You can program the ACD to forward calls to voicemail so callers can leavemessages instead of
waiting for live agents. Call-back messaging helps to balance agent workloads between peak call
periods and slow periods.

Contracting calls to customer care bureaus

Contracting calls is a growing industry. During peak periods, you can route simple, routine calls
externally to customer care bureaus. Service bureaus collaborate with contact centers to set up
scheduling andmonitoring practices, and train agents to handle calls that vary in complexity.

Employing ACD enterprise call routing

Contact centers that provide extended, or around-the-clock service, can interflow calls to other sites.
For example, you can interflow mid-day calls received by a busy center in San Francisco to agents
working the late-afternoon shift at a center in Philadelphia. This optimizes call handling without
scheduling additional agents.

SCHEDULING CONSIDERATIONS
Scheduling should be a collaborative effort. Agents have schedule preferences, and want to know
when they are working well in advance. Agents aremore likely to adhere to schedules if they are
involved in defining the conditions of schedule adherence and non-adherence, and in other areas of
the planning process.

Producing long-term schedules is less efficient than producingmonthly schedules, as contact center
conditions and agent availability are continually changing. Short-term scheduling is more accurate,
but less popular with agents. It is important to find a good balance.

Measuring scheduling accuracy

You canmeasure the effectiveness of your scheduling process. Create a line graph of the Service
Level for each half-hour interval for each day over the past week. Draw a horizontal line across the
graph to indicate your service objective. Look for inconsistencies in the service provided for different
time intervals across days, and how far you stray from your service objective.

If the Service Level is erratic, youmay have enough resources in place, but they may not be
consistently available to handle calls. If the Service Level is inconsistent at certain time intervals
across the week, or you are not meeting your Service Level objective, investigate to see if you are
adequately staffed at these times and aremaking the best use of resources. Try to assess how
consistently the agents are responding to real-time information displays. Determine if they are
restricting Non ACD activities to slow periods and adhering to the schedule.

Scheduling agents with workforce management tools

Workforcemanagement tools assist you in scheduling agents for work and holiday periods. Many
packages offer an integrated forecasting component that uses historical data to partially automate
the scheduling process for established agents. Scheduling is not entirely automated: youmust
tweak agent schedules and enter shift and agent variables for agents manually.
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STEP #6 DETERMINE CONTACT CENTERCOSTS
An effective budget conveys what is currently happening in the contact center, projections for the
upcoming year, and business objectives. It is important to highlight the trade-offs between the
service provided to callers and costs to the organization by developing at least two budgets that
reflect different scenarios.

You need to provide a clear indication of how themoney is being spent, what you are doing to reduce
or curb spending, and what equipment is required tomeet service objectives and expected growth
over the next year. Budgeting is on-going process that needs continuous refinement.

BREAKING DOWNEXPENSES
The costs associated with contact center operations include

l Loaded labor costs
Loaded labor costs include wages, fringe benefits, and facilities, and account for over 60
percent of contact center costs. This is a significant cost and underlines the importance of
accurate forecasting and scheduling.

l Equipment and automation costs
Equipment and automation costs include the cost of the telephone system, computer
systems, and furniture, and account for about five percent of total expenses.

l Transmission costs
Transmission costs include costs incurred for voice (telephone lines) and data transmission,
and account for 25 to 30 percent of contact center costs. Transmission costs have decreased
considerably in the past few years and are continuing to drop. In revenue-based contact
centers, toll-free lines cost approximately 15 cents per minute, or nine dollars per hour, per
line.

The following statistics help you breakdown and analyze your contact center costs:

l Cost of Delay
When insufficient agents are available to handle a given Call Load, the delay increases as
does the Trunk Load. Calls are queued. For toll-free services each call delayed in queue is a
cost to the organization. You are charged for the toll-free service from the time a trunk picks up
a call until an agent completes the call and hangs up. The expense of queuing callers is known
as theCost of Delay. Staffing affects toll-free service costs: if insufficient agents are
available and the Service Level is continually low, network costs will be high. You need to
consider the Cost of Delay when estimating the agent requirement, and closely monitor it.

l Cost per Call
You use a cost-per-call analysis to measure contact center profitability and performance. The
cost per callmeasures labor, communication, and equipment costs against the revenue
generated. You calculate it by dividing the total cost by the total calls for a particular period of
time.

l Average Call Value
You use theAverage Call Value in revenue-based contact centers. You calculate it by dividing
the total revenue by the number of calls received for a given period. Sales and reservations
environments use the Average Call Value. The value of each call is balanced against the
service provided to customers.
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ANTICIPATING GROWTH
Predicting company growth is a challenging and essential aspect of contact center costing. Growth
predictions impact budgeting considerations andmust be clearly communicated to senior
management. It is useful to map out your projected costs and time frames for the upcoming year and
substantiate them with statistics and graphs. Determine when and how many resources you require,
and lead-time issues.



Chapter 4
GETTING STARTED

Setting up user preferences
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GETTING STARTED
After MiContact Center Business has been installed on the Enterprise Server and clients, you can
launch CCMWeb and configure user preferences and email contacts. All other client configuration is
done at the administrative level and described in theMiContact Center Business Installation and
Administration Guide.

SETTING UP USERPREFERENCES
You can change your preferences at any time. They are found in CCMWeb under My options. From
this menu, you can:

l Specify your language preference
l Change your password
l View your security role properties
l Configure email contacts

SPECIFYING YOURLANGUAGEPREFERENCE
NOTE:MiContact Center Business applications, such as YourSite Explorer and Contact Center
Client, all leverage the language settings of the operating system in addition to the language
preference set for MiContact Center Business. Ensure that if you adjust the language settings of
MiContact Center Business, you also adjust the language settings of your operating system to
match.

To specify your language preference

1. Hover overMy options and selectMy preferences.
2. AfterDisplay this language, select a language.
3. Click Save.

CHANGING YOURPASSWORD
To change the password for your login

1. Hover overMy options and selectMy password.
2. AfterOld password, type your old password.
3. AfterNew password, type your new password.
4. AfterConfirm new password, type your new password.
5. Click Save.

VIEWING SECURITYROLEPROPERTIES
You can view your security role properties. They describe the application areas which you can
access. Only employees with access to YourSite Explorer and whose security role permits
managing security can change the security role properties of employees.

To view the security role properties associated with your login ID
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l Hover overMy options and selectMy security role.

CONFIGURING EMAIL CONTACTS
You can create a list of email contacts and email contact groups to whom you email reports. Contact
groups can contain both user-configured contacts fromMiVoice Analytics as well as all existing
employees from YourSite Explorer.

To create a contact group

1. Add email contacts
2. Add contact groups
3. Add email contacts to the groups

Adding email contacts
To add an email contact

1. Hover overMy options and select Contacts=>My email contacts.
2. Click Add.
3. After First name, type the first name of your contact.
4. After Last name, type the last name of your contact.
5. AfterEmail address, type the email address of your contact.
6. To save this contact, click Save.
7. To save this contact and add another contact, click Save & Add.

Adding contact groups
To add a contact group

1. Hover overMy options and select Contacts=>My email contacts group.
2. Click Add.
3. AfterName, type the name of the contact group.
4. AfterDescription, type the description of the contact group.
5. To share this contact group with other CCMWeb users, select Shared Contact Group.

A shared contact group can be viewed, used, and edited by other users.
6. To save this contact group, click Save.
7. To save this contact group and add another contact group, click Save & Add.
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Adding email contacts to contact groups
To add an email contact to a contact group

1. Hover overMy options and select Contacts=>My email contacts group.
2. Click Members for the contact group with which you want to associate agents.
3. If you want to addmembers from your contacts configured in CCMWeb, click Contacts.

If you want to addmembers from the employees configured in YourSite Explorer, click
Employees.
Both contacts and employees can be added to the same contact group.

4. UnderAvailable contacts, select the check boxes of themembers you want to add to the
group and click Add >>.



Chapter 5
REAL-TIME MONITORS

Contact Center Client
Accessing real-time information with Ignite
(WEB)
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REAL-TIME MONITORS
The Enterprise Server continuously updates the real-time applications with gateway data and
simultaneously updates connected clients through Transmission Control Protocol-Internet Protocol
(TCP/IP). Real-timemonitors are automatically updated to reflect device and device group changes
made in YourSite Explorer. Supervisors and agents are provided with point-and-click access to real-
time performance statistics for their contact center, enabling them to identify issues in contact
center performance and see who is available to answer or assist with calls.

The real-time applications include Contact Center Client, Ignite (WEB), andWallBoarder. In Contact
Center Client and Ignite (WEB), supervisors and agents can view real-time voice statistics and the
phone availability of contact center agents and employees. In contact centers that have the
Multimedia Contact Center optional application, supervisors and agents can view real-time voice,
email, chat, SMS, and openmedia statistics. WallBoarder displays text messages and contact
center statistics on one or more Spectrum Light Emitting Diode (LED) reader boards (wall signs).
WallBoarder administration details are included in theMiContact Center Business Installation and
Administration Guide.

Call recordings are initiated in Contact Center Client and are appended to specific Lifecycle reports.

In addition to real-timemonitors, Contact Center Client includes the following application areas:

l Interactive Contact Center
Using Interactive Contact Center, you can control the availability of agents and ACD queues.
Agents can log themselves on or off, and place themselves in or remove themselves from
Make Busy or Do Not Disturb.
See "Interactive Contact Center" on page 145.

l Auditor
Using Auditor, supervisors can view the historical real-time events that occurred on a
particular date, in the sequence they occurred, at your own pace.
See "Viewing historical real-time events with Auditor" on page 98.

l Management Console
UsingManagement Console, System Administrators can restart services, administer the
database, and perform maintenance functions.
System administration is described in theMiContact Center Business Installation and
Administration Guide.

l Data-mining
The ACD Inspector searches for agent and ACD queue event records. The SMDR Inspector
searches through SMDR data to find specific contact center events.
Datamining is described in theMiContact Center Business Installation and Administration
Guide.

l Contact Center Chat
Contact Center Client provides instant messaging capabilities for employees. Contact Center
Chat provides the online chat presence of employees, including Online, Offline, and Away.
Employees can view the availability and presence of other employees before they transfer
calls or send online chat messages. With Microsoft Skype for Business Server, Contact
Center Chat integrates with Skype for Business to provide enhanced presence.
See "Using Contact Center Chat" on page 120.
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The following applications and features reside in Contact Center Client:

l Interactive Visual Queue
Interactive Visual Queue is an optional application that enables agents to monitor calls within
queues, move calls from busy queues to less active queues, and call back abandoned callers.
See "Interactive Visual Queue" on page 164.

l Contact Center PhoneSet Manager and Contact Center Softphone
Contact Center PhoneSet Manager and Contact Center Softphone are optional applications
that enable employees to use their desktop computers as IP-based phones.
See "Contact Center PhoneSet Manager and Contact Center Softphone" on page 177.

l Contact Center Screen Pop
Contact Center Screen Pop is an optional application that launches applications or webpages.
In addition, it enables agents to automatically receive caller and account information via pop-
ups on their computer monitors every time they receive calls.
Contact Center Screen Pop configuration and details are included in theMiContact Center
Business Installation and Administration Guide.

l Contact Center Chat with Skype for Business
With the addition of Microsoft Skype for Business Server, employees and supervisors use
Skype for Business as their default instant messaging client. The presence of all company
employees is natively delivered in Contact Center Client. Contact center employees can view
the presence of both internal and external contacts to determine if they are available to
communicate. In addition to Available, Offline, and Away, employees see In aMeeting, Busy,
In a call, Do Not Disturb, Be Right Back, and other presence indicators.
See "Using Contact Center Chat with Skype for Business" on page 122.

CONTACT CENTERCLIENT
NOTE:

l Your ability to view real-timemonitors and devices in Contact Center Client is dependent on
administrative security settings.

l An employeemust be amember of an employee group in order for you to view the employee
on the employee groupmonitors in Contact Center Client. A queuemust be amember of a
queue group in order for you to view the queue on the queue groupmonitors in Contact Center
Client.

l The number of employees logged on at any timemust be consistent with your software
license.

Contact Center Client uses ribbons for device andmonitor control. (See Figure 9.)

Figure 9: Contact Center Client ribbon
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Some tabs that display in the ribbon are dependent upon whichmonitor is active. These are referred
to as context sensitive tabs. When you enable context sensitivity for monitors, the associated
context sensitive tab for the activemonitor automatically becomes the active tab. See Table 1 for a
list of the associated context sensitive tabs for eachmonitor. See Figure 10 for an example of
context sensitivity enabled for the Agent State by Positionmonitor. Note that the Agent andMonitor
Control tabs display in the ribbon.

NOTE: The options that display in the Contact Center Client ribbon are dependent upon your
individual security settings. Options which you are not given access to will not display.
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MONITOR ASSOCIATED CONTEXT SENSITIVE TABS

Agent State
by Position Agent andMonitor Control tabs

Employee
State by
Position

Employee andMonitor Control tabs

Extension
State by
Position

Extension andMonitor Control tabs

NOTE: When an agent is logged into an
extension, the context sensitivity tab displays
'Agent Control'. When no agent is logged into the
extension, the context sensitivity tab displays
'Extension Control'.

Extension
Now Monitor Options tab

Agent State
by Time Agent andMonitor Control tabs

Agent State
by Time for
Queue

Agent andMonitor Control tabs

Employee
State by
Time

Employee andMonitor Control tabs

Agent Shift Agent andMonitor Control tabs

Queue by
Period Monitor Options tab

Queue Now Monitor Options tab

Queue
Group Now Monitor Options tab

Queue
Performance Chart Options tab

Queue
Group

Performance
Chart Options tab

Queue Chart Options tab

Table 1: Context sensitivity options display per monitor
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MONITOR ASSOCIATED CONTEXT SENSITIVE TABS

Queue
Group Chart Options tab

Interactive
Visual
Queue

n/a

NOTE: Context sensitivity is not supported for
the Interactive Visual Queuemonitor

Table 1: Context sensitivity options display per monitor
(continued)

Figure 10: Context sensitivity example - Agent Control tab

STARTING CONTACTCENTERCLIENT
You start Contact Center Client to access real-time functionality. Supervisors and agents can view
real-time voice statistics. In contact centers that have the optional Multimedia Contact Center
application, supervisors and agents can view real-time voice, email, chat, SMS, and openmedia
statistics. After starting Contact Center Client, you can choose tominimize it to either the system
tray or the taskbar, depending on your operating system.

NOTE: Launching client-side desktop applications from the task bar causes them to bypass the
MiContact Center Updater Service process. To ensure successful updates from the Enterprise
Server, after an upgrade close all client-side applications for 15minutes or reopen them from the
Start menu/Start screen.
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To start Contact Center Client

1. OpenContact Center Client.
2. If prompted, type yourUsername andPassword and verify theEnterprise Server IP

address.
3. If you use Secure Socket Layer, select SSL.
4. Optionally, select Remember my credentials.
5. Click Login.

To display Contact Center Client in the taskbar

1. In Contact Center Client, click the File tab.
2. Click Options.
3. Clear theHide when minimized check box and click OK.

Contact Center Client, whenminimized, will display in the taskbar.
4. To save the profile, click File=>Save as.
5. Type aName for the profile and click OK.

The profile is saved and will automatically be applied each time you open Contact Center
Client.
When your System Administrator changes device settings (such as changes to naming or
associations between devices), they will be automatically reflected in your Contact Center
Client user profile.

CONFIGURING CONTACTCENTERCLIENTOPTIONS
You can customize the Contact Center Client user interface and real-timemonitor device control and
display options by accessing the Options menu.

To configure Contact Center Client options

1. In the ribbon, click the File tab.
2. Click Options.

TheOptions window displays.
See Figure 11.

3. UnderUser interface display, select a Toolbar style, Real-time icon type, Background
color, Page size, and whether you want to hide Contact Center Client when the window is
minimized.

4. Select Context Sensitivity forMonitors if you want the context sensitive tab to
automatically become the active tab when you select amonitor.
NOTE:Monitor context sensitivity is enabled by default.

5. Select Context Sensitivity forSoft phone if you want the soft phone tab to automatically
become the active tab when a call is received.
If the Soft phone toolbar is floating, context sensitivity does not apply. Soft phone context
sensitivity is disabled by default.

6. Select theDisplay monitor device control option check box if you want to be able to see
the option for monitor control when you right-click cells in a real-timemonitor.
NOTE:Monitor control enables you to simultaneously control all of the agents on amonitor
and is only available if you have appropriate permissions.
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7. Configure Time format options.
The options you select will display in the real-timemonitor cells.

8. Under Full name format, select how you want agent and employee first and last names to
display in real-timemonitors.

9. Click OK.

Figure 11: Contact Center Client options
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ADJUSTING THECONTACTCENTERCLIENTVIEW
You can adjust the way you view Contact Center Client features on your desktop.

To adjust the view

1. Click View in the Contact Center Client ribbon.
The View options ribbon opens.
See Figure 12.

Figure 12: View options ribbon

2. To change the way monitors display inside Contact Center Client, select from the options in
theWindow Docking column.

3. To adjust the position of the Contact Center Client window on your desktop, select from the
options in theScreen Docking column.

4. If you want Contact Center Client to always display on top of other applications on your
desktop, click Always on top.

5. Enable theStatus Bar if you want the status bar to be visible at the bottom of the Contact
Center Client window.
See Figure 13.

Figure 13: Status bar

6. To open Voice, Email, Chat, or SMS legends, select from the options in the Legends column.

EMPLOYEEANDAGENTSTATES
NOTE:

l If Contact Center Client becomes disconnected from the server, upon re-connection the
following states will automatically be synchronized with the server.

Table 2 lists the employee states and their corresponding icons.

Table 3 lists the agent states and their corresponding icons.
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TERM ICON MEANING

Ringing An ACD interaction ringing on the employee, waiting to be
handled

ACD An employee handling an ACD interaction

ACD Hold An employee who has placed an ACD interaction on hold

Idle An employee logged on and waiting to receive an interaction

Non ACD An employee involved in an incoming Non ACD interaction or
employee-originated voice interaction

Non ACD
Hold

An employee who has placed a Non ACD voice interaction on
hold

Outbound An employee on an outgoing voice interaction

Outbound
Hold

An employee who has placed an outgoing voice interaction on
hold

DoNot
Disturb

An employee who has activated DoNot Disturb and is not
available to receive any ACD or Non ACD interactions

Table 2: Employee states
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TERM ICON MEANING

Make Busy

An employee who is not available to receive ACD interactions
but can receive transferred interactions and voice interactions
dialed directly to the employee

This icon also displays when an agent is in the Reseize Timer
state. When voice agents fail to answer a voice interaction,
agents are placed inMake Busy (Reseize Timer)

This icon also displays when an external hot desk agent is in the
Reseize Timer state

System
Make Busy

An employee that the system has put into a state where they
cannot receive ACD contacts. For example, if an employee is
offered a communication and does not answer, they will be put
into SystemMake Busy for a predetermined length of time.

Work Timer
An employee who is completing post-contact work, such as
paperwork, and is unavailable to receive interactions of that
media type

LoggedOff An employee not currently logged in to any queue

Logged In
Not

Present

An employee logged in but not present in any of their agent
groups, and employees not present in amedia type across all
groups.

Unavailable An employee who has not generated any activity since
MiContact Center Business was started

Table 2: Employee states (continued)

TERM VOICE EMAIL CHAT SMS MEANING

Ringing
An ACD interaction
ringing on an agent,
waiting to be handled

Table 3: Agent states
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TERM VOICE EMAIL CHAT SMS MEANING

ACD An agent handling an
ACD interaction

ACD Hold
An agent who has
placed an ACD
interaction on hold

Idle
An agent logged on and
waiting to receive an
interaction

Non ACD - - -

An agent involved in an
incoming Non ACD
interaction or agent-
originated voice
interaction

Non
ACD Hold - - -

An agent who has
placed a Non ACD voice
interaction on hold

Outbound - - - An agent on an outgoing
voice interaction

Outbound
Hold - - -

An agent who has
placed an outgoing voice
interaction on hold

DoNot
Disturb

An agent who has
activated DoNot
Disturb and is not
available to receive any
ACD or Non ACD voice
interactions

Table 3: Agent states (continued)
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TERM VOICE EMAIL CHAT SMS MEANING

Make
Busy

An agent who is not
available to receive
ACD interactions but
can receive transferred
interactions and voice
interactions dialed
directly to the agent

This icon also displays
when an external hot
desk agent is in the
Reseize Timer state

System
Make
Busy

An employee that the
system has put into a
state where they cannot
receive ACD contacts.
For example, if an
employee is offered a
communication and
does not answer, they
will be put into System
Make Busy for a
predetermined length of
time.

Work
Timer

An agent who is
completing post-contact
work, such as
paperwork, and is
unavailable to receive
interactions of that
media type

Unknown

An agent who has not
generated any activity
sinceMiContact Center
Business was started

Logged Off An agent not currently
logged in to any queue

Table 3: Agent states (continued)
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TERM VOICE EMAIL CHAT SMS MEANING

Logged In
Not

Present

An agent logged in but
not present to any of
their agent groups, and
agents not present to a
media type across all
groups

Table 3: Agent states (continued)

EXTENSIONSTATES
NOTE:

l If your Contact Center Client becomes disconnected from the server, upon re-connection the
extension states will automatically by synchronized with the server.

l If an agent is logged into the extension, agent state icons will display. See "Employee and
Agent states" on page 50.

Table 4 lists the extension states and their corresponding icons.

TERM ICON MEANING

Ringing Call is ringing on the extension and waiting to be handled

ACD Extension is involved in an ACD call

ACD Hold Extension has placed an ACD call on hold

Idle Extension is waiting to receive a call

Non ACD Extension is involved in an incoming call or an internal extension-
originated call

Non ACD
Hold

Extension has placed an incoming call or an internal extension-
originated call on hold

Table 4: Extension states
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TERM ICON MEANING

Outbound
Call Extension is on an outgoing call

Outbound
Hold Extension has placed an outgoing call on hold

Forwarded
to

Extension has set all incoming calls to be forwarded to an
alternate answer point

Camp on Extension is on a call and an incoming call is camped on (waiting
to be answered)

Off Hook Extension's phone is off the hook, so cannot receive calls

Do Not
Disturb

Extension has activated DoNot Disturb and is not available to
receive calls

LoggedOff Extension is not currently logged on and is unavailable to take
calls

Logged In Not
Present Extension is removed from its Ring Groups

Unknown Extension has not generated any activity sinceMiContact Center
Business was started

Table 4: Extension states (continued)

UNDERSTANDING CONTACTCENTERCLIENT FEATURES
Contact Center Client has agent, queue, queue chart, and call notemonitors. For information on
adding and viewing call notes, see "Adding call notes to a call" on page 195.

You can perform the following tasks on themonitors by either right-clicking within themonitor or
selecting options via the Contact Center Client ribbon:

l Call recording
l Openmonitors
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l Dock monitors
l Add and remove device IDs
l Sort monitor devices
l Rearrange cells
l Set monitor dimensions
l Freeze and unfreeze columns
l Hide and show columns
l Filter device variables
l Set alarms
l Clear alarms
l Definemonitor styles
l Group data
l Print monitors
l Arrange windows
l Modify the view
l Build marqueemonitors to broadcast statistics andmessages
l Chat online with other employees

Contact Center Client options
The following options apply to real-timemonitors.

Call recording

On the Agent State by Time, Agent State by Position, Agent State by Queue by Time, and Extension
by Positionmonitors, the Call recording option enables you to start, stop, and restart call recording at
any time during a call. See "Recording calls" on page 208.

Clear alarms

The Clear alarms command clears any current performance variable threshold alarms.

Set alarms

The Set alarms command specifies performance thresholds for queues, extensions, and agents.

Add/Remove devices

The Add/Remove devices command adds or removes devices or device groups from themonitor. If
you add agents, they are added to the bottom of themonitor.

Set table dimensions

On the Agent State by Position, Extension State by Position, and Employee State by Position
monitors, the Set table dimensions command adds or deletes columns or rows. If you delete
devices, they are deleted them from the lower-right side of themonitor.

Size table to frame

On all monitors, the Size table to frame command adjusts the table to fit within the frame
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Sort monitor

On the Agent State by Position, Extension State by Position, and Employee State by Position
monitors, the Sort monitor by Agent ID, name, state, or extension command sorts agents by Agent
ID, name, state and time in state, or extension.

Note that you cannot drag and drop devices betweenmonitors.

Filter device variables

On the Extension Now, Agent Shift, Queue by Period, andQueue Now monitors the Filter device
variables command filters the data based on conditions you specify and displays a subset of data on
themonitor.

General

On all monitors, under Properties, the General option specifies themonitor name and enables the
horizontal and vertical scroll bars.

On the queuemonitors, you can also enable grouping.

On the extension, agent, and employeemonitors you can also display tool tips, display a pattern
upon failover, and display instant messaging online presence indicators.

On the Agent and Employee State by Timemonitors, you can also sort logged off agents by the
longest logged off first.

Print monitor

The Print monitor command prints the current monitor.

Enable grouping

Under Properties, the Enable grouping option displays a grouping panel to which users can drag
columns. The grouping order determines the order in which the rows display. The Enable grouping
option affects all monitors that contain columns.

Row settings

Under Properties=>Layout, the Row settings option specifies the background color and font color of
rows, and the font type and text alignment.

Row alternate settings

Under Properties=>Layout, the Row alternate settings option specifies the background color and
font color of alternate rows, and the font type and text alignment.

Column settings

Under Properties=>Layout, the Column settings option specifies the background color and font color
of columns, and the font type and text alignment.

Column dimensions

Under Properties=>Layout, the Column dimensions option specifies the column height and width.
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Column order

Under Properties=>Layout, the Column order option hides or displays individual columns, and
specifies the order of columns across themonitor.

Monitor style

Under Properties=>Layout, theMonitor style option specifies styles and skins (sets of styles) for the
monitor, and the Card design option specifies how information is displayed in the cells of extension,
agent, and employeemonitors.

Cascade

When you right-click amonitor tab, underWindows, the Cascade command distributes active
monitors down and across the Contact Center Client window.

Tile vertically

When you right-click amonitor tab, underWindows, the Tile vertically command distributes active
monitors across the Contact Center Client window.

Tile horizontally

When you right-click amonitor tab, underWindows, the Tile horizontally command distributes active
monitors down the Contact Center Client window.

Dock Contact Center Client

When you right-click amonitor tab, underWindows, the Dock Contact Center Client command
docks Contact Center Client at the top, bottom, left, or right of your desktop.

Always on top

When you right-click amonitor tab, underWindows, and select the Always on top command,
Contact Center Client always displays on your desktop on top of all other open applications.

View

The View command hides or displays themainmenu, status bar, real-timemonitors, voice, email,
chat, SMS, and openmedia legends.
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DIAGNOSTICSMONITOR
The log and error monitors are accessed via Contact Center Client.

To access log and error monitors

1. Click Tools in the Contact Center Client ribbon.
2. Click either Log Monitor orError Monitor, depending on what kind of log information you

want to review.
See Figure 14.

Figure 14: Diagnostics monitors

VIEWING AGENTAVAILABILITY
Contact Center Client provides instant messaging capabilities for both supervisors and agents and
is typically used by contact center employees. Contact Center Chat provides the online chat
presence of contact center employees, including Online, Offline, and Away. On the agent,
employee, and extensionmonitors, agents can view the availability and presence of other contact
center employees before they transfer calls or send online chat messages. (See Figure 15.) If an
agent cell in amonitor is grayed out, the phone is not connected to the network and considered out of
service. The out of service state applies to phones that are not connected to the network, remote
agents and employees that have lost their Internet connection, phones that are physically
disconnected or malfunctioning, or employees that are not logged into their soft phone.

Figure 15: Agent State by Position - viewing agent availability and online presence

With the addition of Microsoft Skype for Business Server, agents and supervisors use Skype for
Business Client as their default instant messaging client. The presence of all company employees is
natively delivered in Contact Center Client. Contact center employees can view the presence of
both internal and external contacts to determine if they are available to communicate. In addition to
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Available, Offline, and Away, employees see In aMeeting, Busy, In a call, Do Not Disturb, Be Right
Back, and other presence indicators. (See Figure 16.)

Figure 16: Employee State by Position - viewing employee availability and enhanced presence

The followingmonitors display agent activities:

l Agent State by Position
l Employee State by Position
l Extension State by Position
l Agent State by Time
l Employee State by Time
l Agent Shift

Extension, Agent, and Employee State by Position
The Extension, Agent, and Employee State by Positionmonitors provide real-time information in
cells that you can arrange tomirror your floor plan: you can view extensions, agents, or employees
by their physical position in your contact center. In addition, thesemonitors enable you to view the
current status of general business extensions. Card designs enable you to customize the
information displayed in the cells. See "Customizing the information displayed on position and time
monitors" on page 114.

Agents can join multiple agent groups and therefore answer for multiple queues. However, each
agent has only one ID and displays in a single cell of each applicable monitor. The agent activity that
displays in themonitor cell reflects their current overriding action

When you first open amonitor, you can select a card design:

l The Classic card displays the agent state, time in the state, presence, agent/employee name,
agent login ID/employee ID, and extension number (or queue name for voice agents on ACD
or on ACD Hold).

l The Caller ID card displays the caller name and number (ANI), the number the
caller/employee dials for incoming/outgoing calls, the state, time in the state, presence,
agent/employee name, agent login ID/employee ID, and extension number (or queue name for
voice agents on ACD or on ACD Hold).

l Custom cards you create and share display customized extension/agent/employee and/or
caller information.

Caller ID information is displayed when

l Extensions, Agents, and employees are in the following real-time states: ACD, ACD Hold,
Ringing, Non ACD, Non ACD Hold, Out, andOut Hold Time

l Extensions are in the following real-time states: Inbound andOutbound
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You can set alarms for all real-time statistics and for caller ID information, such as the caller name
and number.

NOTE:Before you can select the Caller ID card on the Add devices window of monitors, youmust
make the card available. To do so, right-click an openmonitor, select the Caller ID card under
Properties, Layout=>Card design and click Apply.

In a fault tolerant setup, if a network outage occurs the cells in the agent, employee, and extension
monitors display a crisscrossed pattern to identify agents who have homed to their secondary
controllers.

If an agent cell in amonitor is grayed out, the phone is not connected to the network and considered
out of service. The out of service state applies to phones that are not connected to the network,
remote agents and employees that have lost their Internet connection, phones that are physically
disconnected or malfunctioning, or employees that are not logged into their soft phone.

Viewing the activities of agents who can log on to multiple voice queues
In Figure 17, the Agent State by Positionmonitor shows three cells for Andre Bourque, each with a
different agent ID. The first two cells show Andre logged off of the telephone system. The third cell
shows Andre’s current state. Andre is logged on to Queue 151 using Agent ID 2013. He has been on
an ACD call for 12minutes and 50 seconds.

Figure 17: Agent State by Position - viewing multiple agent IDs

Agents can log on to the telephone system using only one agent ID at a time. If your agents have
multiple voice IDs (and thereforemultiple cells) the Agent State by Positionmonitor becomes
cluttered.

If you have agents who are cross trained to answer calls for different departments (and log in and out
of various voice queues) the telephone system requires you assign the agents multiple IDs. You can
use the Agent State by Positionmonitor to view the activities of each department. You create an
Agent State by Positionmonitor for each department. When you arrange the cells for the agents in
the same order for each department, you can easily compare the activities of one department with
another.

Viewing the current logged on states of agents who log on to multiple
queues
If you have voice agents who are cross trained to answer calls for different departments (and log in
and out of several queues) the telephone system requires you assign the agents multiple IDs. If a
voice agent has multiple agent IDs and you want to view the agent’s current logged on state only,
you use the Employee State by Positionmonitor.
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To view themonitor, you open the Employee State by Positionmonitor and select employees to add
to themonitor. Themonitor shows one cell for Andrew, listing his current state and agent ID. (See
Figure 18.)

Figure 18: Employee State by Position - viewing the ID to which the agent is logged on

Andrew is currently logged on to Extension 1564 using Agent ID 1559. Sometime later you notice
Andrew is logged on to Extension 1059 using Agent ID 1788. (See Figure 19.)

Figure 19: Employee State by Position

Agent State and Employee State by Time
The Agent State by Time and Employee State by Timemonitors provide real-time agent information
under ACD, Idle, Non ACD, Unavailable, and LoggedOff column headings. They display the same
real-time information as that of the Extension State by Position, Agent State by Position, and
Employee State by Positionmonitors. See "Extension, Agent, and Employee State by Position" on
page 61.

If an agent is in an email, chat, or SMS agent state, themonitors display the queue number to which
the agent is logged on. Each column lists agents in order of time in state. You can specify which
columns of agent statistics are displayed, and the order in which they are displayed. You can sort
logged off agents by the longest logged off first. (See Figure 20.)

If you have agents who are cross trained to answer calls for different departments (and log in and out
of various voice queues) the ACD routing system requires you assign the agents multiple IDs. You
use the Employee State by Timemonitor to view the activities of voice agents with multiple agent
IDs. See "Viewing the current logged on states of agents who log on tomultiple queues" on page 62.
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Figure 20: Agent State by Time

Table 5 lists the Agent State by Time and Employee State by Time column headings and their
associated agent states.

CATEGORY ASSOCIATED AGENT STATES

ACD includes agents in ACD and agents in ACD Hold

Idle includes agents in the Idle state

Non ACD includes agents in Non ACD, in Non ACD Hold, Outbound agents, andOutbound
Hold agents

Unavailable includes agents in Do Not Disturb, Make Busy, Work Timer, Reseize Timer, and
Unknown

Logged in not
present

includes agents logged in but not present to any of their agent groups, and agents
not present to amedia type across all groups

LogOff includes agents in the LoggedOff andOffline (Ignite, WEB) states

Table 5: Agent State by Time and Employee State by Time column headings

Agent State by Time for Queue
The Agent State by Time for Queuemonitor is a Contact Center Client real-timemonitor designed
specifically for contact centers using Agent Group Presence functionality. However, the Agent State
by Time for Queuemonitor is available for all media server types.

The Agent State by Time for Queuemonitor is accessed from the Real Time tab in Contact Center
Client and displays all agents configured in a specific queue and agents who are on ACD calls, idle,
on Non ACD calls, unavailable, logged on to the system (but not present in the queue being
monitored), and logged off. (See Figure 21).
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NOTE:

l Virtual queue groups are shown under the Virtual queue groups section of the Agent State by
Time for Queuemonitor. Any Agent State by Time for Queuemonitors that aremonitoring
virtual queues aremarked in the title as (virtual).

l The Agent State by Time for Queuemonitor does not support viewing RingGroups.

Figure 21: Agent State by Time for Queue

Table 6 lists the Agent State by Time and Employee State by Time column headings and their
associated agent states.

CATEGORY ASSOCIATED AGENT STATES

ACD includes agents in ACD and agents in ACD Hold

Idle includes agents in the Idle state

Non ACD includes agents in Non ACD, in Non ACD Hold, Outbound agents, andOutbound
Hold agents

Unavailable includes agents in Do Not Disturb, Make Busy, Work Timer, and Reseize Timer

Logged in not
present

includes agents logged in but not present to any of their agent groups, and agents
not present to amedia type across all groups

LogOff includes agents in the LoggedOff, Unknown, andOffline (Ignite, WEB) states

Table 6: Agent State by Time for Queue column headings
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To view the Agent State by Time for Queuemonitor

1. In the Contact Center Client ribbon, click theReal Time tab.
2. In theState by Time column on the ribbon, click Agent by Queue.
3. Select the queues tomonitor. You can optionally sort members in either ascending or

descending order.
4. Click OK.

Agent Shift
The Agent Shift monitor provides running totals of statistics on individual agents for the day. You can
specify which columns of statistics are displayed, rearrange columns, and sort individual columns in
ascending or descending order. (See Figure 22.)

Figure 22: Agent Shift

Agent Shift column heading definitions
Table 7 describes the Agent Shift column headings.

TERM ABBREVIATED
NAME MEANING

Agent State The agent's media type and current state

Media Server Media Server Themedia server to which the agent is associated

Agent Shift Name Name The name of the agent beingmonitored

Agent login ID Agent login ID The login ID of the agent beingmonitored

Extension Number Extn # The extension where the agent logged in (voice
only)

LoggedOn Log In Themost recent time the agent logged in

Table 7: Agent Shift column headings
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TERM ABBREVIATED
NAME MEANING

Last Event
Received Last Event Recd Themost recent time an agent event occurred

Shift Time Shift Time
The total elapsed time logged for the agent,
calculated based on the difference between log in
and last event received

ACD Time ACD Time The duration of ACD interactions handled, from
agent pickup to completion (not including hold time)

ACD Hold Time ACD Hold Time The duration of time ACD interactions spent on hold

Non ACD Time Non ACD Time
The duration of Non ACD interactions handled, from
agent pickup to completion (not including hold time)
(voice only)

Non ACD Hold
Time Non ACD Hold Time The duration of time Non ACD interactions spent on

hold

Outbound Time Out Time The duration of time agents spent handling outbound
calls (voice only)

Outbound Hold
Time Out Hold Time The duration of time outbound calls spent on hold,

for agents (voice only)

Do Not Disturb
Time DND Time The duration of time the agent entered the DoNot

Disturb State

Make Busy Time MKB Time The number of times the agent entered theMake
Busy state

Wrap Up Time Wrap Up Time

The duration of time whereWrap Up Timewas the
overriding state for the agent. Wrap up time does not
include any time spent making or taking interactions
during the wrap up timer.

Do Not Disturb
Count DND Cnt The number of times the agent entered the DoNot

Disturb state

Make Busy Count MKB Cnt The number of times the agent entered theMake
Busy state

ACD Count ACD Cnt The number of ACD interactions handled by the
agent

Table 7: Agent Shift column headings (continued)
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TERM ABBREVIATED
NAME MEANING

Short ACD Count Shrt ACD Cnt
The number of ACD interactions handled by the
agent where the handle time was less than the Short
Handle parameter

Non ACD Count Non ACD Cnt The number of Non ACD interactions handled by the
agent (voice only)

Hold ACD Count Hold ACD Cnt The number of times ACD interactions were placed
on hold (voice only)

Non ACD Hold
Count Non ACD Hold Cnt The number of times Non ACD interactions were

placed on hold

Outbound Count Out Cnt The number of outbound calls made by the agent
(voice only)

Outbound Hold
Count Out Hold Cnt The number of times outbound calls were placed on

hold (voice only)

Contacts Per Hour Contacts Per Hour
The total ACD interaction count minus the ACD
short handle count, divided by the shift time for the
agent

On Failover On failover
Indicates whether the primary media server is offline
and has failed over to the secondary media server
(voice only)

Agent Unavailable
Percent Agt Unavail % The percentage of shift time for which the agent was

unavailable to receive interactions

Logged In Not
Present Time

Logged In Not
Present Time

The duration of time the agent was logged into but
not present to any of their agent groups, and the
duration of time the agent was not present in a
media type across all groups

Average Handle Avg Hndl
The average amount of time the agent spent
handling ACD interactions (ACD Time divided by
ACD Count, excluding ACD Hold Time)

Occupancy Occp The duration of time the agent spent processing
interactions, including ringing time

Table 7: Agent Shift column headings (continued)

Viewing Agent and Extension Availability and Resiliency
Contact Center Client’s Agent, Employee, and Extension real-timemonitors provide a visual
indication if agents fail over to a resilient media server. In an Agent monitor (Agent State by Position,
Agent State by Time, and Agent State by Queue by Time), if an agent fails over to the secondary
voicemedia server, a cross-hatch pattern displays in the agent’s cell in themonitor. (See Figure 23.)
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Figure 23: Agent monitor with failed over agents

In an Employeemonitor (Employee State by Position and Employee State by Time), if an
employee’s agent fails over to the secondary voicemedia server, a cross-hatch pattern displays in
the employee’s cell in themonitor. (See Figure 24.)

Figure 24: Employee monitor with failed over agents

In an Extensionmonitor, if a logged in agent who is associated to an extension fails over to the
secondary voicemedia server, then a cross-hatch pattern is applied to the agent’s associated
extension in the extensionmonitor. (See Figure 25.)

NOTE:Extensions that fail over to the secondary voicemedia server do not have a cross-hatch
pattern applied to their cell.

Figure 25: Extension monitor with failed over agents

Modifying visual indicator settings for agents failing over
By default, monitors are configured to display a pattern if agents fail over to a secondary media
server. This setting is optional, however, and can be disabled on amonitor-by-monitor basis.

The following procedures explain how to

l Disable visual indicators for agents failing over
l Enable visual indicators for agents failing over
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To disable visual indicators for agents failing over

1. Right-click in an openmonitor and select Properties.
2. In theGeneral tab, clearDisplay pattern when on failover.
3. Click OK.

To enable visual indicators for agents failing over

1. Right-click in an openmonitor and select Properties.
2. In theGeneral tab, select Display pattern when on failover.
3. Click OK.

VIEWING EXTENSIONS
In your business, youmay bemonitoring

l Traditional or hot desking ACD agents who sit at different desks each day and who log on
using their agent ID

l General business, traditional extensions (non-contact center employees) who sit at the same
desks each day, are assigned their own desk phone extensions, and do not log on to their
phones (their phones are programmedwith their personal settings and are always active)

l General business, hot desking extensions (non-contact center employees) who log on to any
phone in the enterprise with a virtual extension configured with their personal settings. When
the employee logs on the extension becomes active. When the employee logs off of the
extension it goes out of service.

The followingmonitors are available for viewing extensions:

l Extension State by Position
l Extension Now

You can set up your real-timemonitor profile to include two or more Extension by Positionmonitors:
one with cells that are arranged to show the whereabouts of agents in your contact center, and
another that shows the status of general business extensions: active/inactive, inbound/outbound.

Extension Inbound

Extension Inbound refers to a general business extension on an inbound call.

Extension Outbound

Extension Outbound refers to a general business extension on an outbound call

General business active extension

General business active extension refers to aMitel desk phone/Contact Center PhoneSet
Manager/Contact Center Softphone that is live with no ACD agents logged on (active extension), or
an extension to which a general business hot desking user is logged on. The user is an active
extension not logged on to any ACD queue.
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General business inactive extension

General business inactive extension refers to aMitel desk phone that has been unplugged or is
damaged, or a soft phone that is not running because the computer is turned off or Contact Center
Client is not running, or a hot desking extension to which nobody is logged on.

Traditional or hot desking ACD agents who sit at different desks each day

If you have traditional or hot desking ACD agents who sit at different desks each day, you use the
Extension State by Positionmonitor to view where they are sitting in the contact center. After you
add Registration Directory Numbers (RDNs)/desk phone extensions to themonitor, you can arrange
the cells to match the layout of your contact center.

When nobody is logged on to a particular extension, themonitor cell displays the General business
active icon and the phone set RDN ID. When an agent logs on to the desk phone, themonitor cell
displays the ACD agent status, (which can include information such as the time in state, queue
reporting number, andMake Busy status), the agent ID, the agent name, and the RDN (at the bottom
of the cell). Depending on the agent’s current state youmay see additional information, such as the
time in state, queue reporting number, or Make Busy status. If the Caller ID card design is selected,
you will also see the caller name and phone number. (See Figure 26.)

If you would prefer that Extension State by Positionmonitor cells be blank when there are no agents
logged on to the telephone system, you can right-click themonitor, select Properties, and clear the
Enable the general business view check box.

If an agent cell in amonitor is grayed out, the phone is not connected to the network and considered
out of service. The out of service state applies to phones that are not connected to the network,
remote agents or employees that have lost their Internet connection, phones that are physically
disconnected or malfunctioning, or employees that are not logged into their soft phone.

Figure 26: Extension State by Position
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General business, traditional extensions who sit at the same desks each day

If you have general business, traditional extensions who sit at the same desks each day, you use
the Extension State by Positionmonitor to view where they are sitting in the contact center. After
you add their extensions to themonitor, you can arrange the cells to match the layout of your
business, or arrange them alphabetically or by department.

When a general business employee is in Idle, the cell for the employee’s phone extension in the
Extension State by Positionmonitor displays the employee’s name and extension number, and the
General business active icon. When the employee is on an incoming/outgoing call, the cell displays
the Extension Inbound/Extension Outbound icon, the employee’s name and extension number, and
the time in state. If the Caller ID card design is selected, you will also see the caller name and phone
number. Either card enables you to readily determine the online and phone availability of general
business subject matter experts.

General business hot desking employees who sit at different desks each day

General business, hot desking extensions can log on to any phone in the enterprise and access their
personal settings. When adding extensions to the Extension State by Positionmonitor, you can
arrange them alphabetically or by department.

When an employee is logged on, themonitor cell displays the General business active icon, the
employee’s name and extension. When the employee is on an incoming/outgoing call, the cell
displays the Extension Inbound/Extension Outbound icon and the time in state. If the Caller ID card
design is selected, you will also see the caller name and phone number. When the employee logs
off, themonitor cell is grayed out (inactive). (See Figure 27.)

Figure 27: Extension State by Position

Extension Now
The Extension Now monitor enables supervisors to view extension statistics in real time. The
Extension Now monitor provides visibility to extensions. If an agent logs out of an extension
displayed in this monitor, the extension will go out of service and will not be updated in real time. In
the Extension Now monitor, you can specify which columns of statistics are displayed, rearrange
columns, and sort individual columns in ascending or descending order. (See Figure 28.)

NOTE: Extensions must be licensed to display statistics.
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Figure 28: Extension Now monitor

Extension Now column heading definitions
Table 8 indicates the current status of the extension and describes the real-time and over-the-
business-day Extension Now extension statistics.

TERM MEANING

Media Server The extension’s media server

Name The extension name

Reporting
The extension’s reporting number

NOTE: The extension reporting number is also its dialable number.

Last Event Recd Themost recent time an extension event occurred

ACD Time The duration of ACD (RingGroup) interactions handled, from extension
pickup to completion (not including hold time)

ACD Hold Time The duration of time ACD (RingGroup) interactions spent on hold

Non ACD Time The duration of Non ACD interactions handled, from extension pickup to
completion (not including hold time)

Non ACD Hold Time The total time for Non ACD calls put on hold

Out Time The number of outbound calls made by the extension

Out Hold Time The duration of time outbound calls spent on hold for extensions

DND Time The duration of time where DoNot Disturb was the overriding state for the
extension

DND Cnt The number of times the extension entered the DoNot Disturb state

ACD Cnt The total number of ACD (RingGroup) calls answered by the extension

Shrt ACD Cnt The total number of ACD (RingGroup) calls answered by the extension
that lasted less than the Short Handle parameter

Table 8: Extension Now extension statistic column headings
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TERM MEANING

ACD Hold Cnt The number of times the extension put ACD (RingGroup) calls on hold

Non ACD Cnt The total number of Non ACD calls answered by the extension

Non ACD Hold Cnt The number of times Non ACD calls were put on hold

Out Cnt The total number of outgoing calls the extensionmade

Out Hold Cnt The total number of times the extension put outgoing calls on hold

Calls Per Hour The average number of incoming ACD calls answered by the extension per
hour since the extension was logged in

On Failover Indicates whether or not the extension has failed over to the secondary
media server

Not Present Time The duration of time the extension was in service but not present in a Ring
Group

Avg Handl The average amount of time the extension spent handling ACD interactions
(ACD Time divided by ACD Count, excluding ACD Hold Time)

Occp The total time the extension spent in an occupied state (occupied state
excludes idle time)

Table 8: Extension Now extension statistic column headings (continued)

VIEWING QUEUESTATISTICS
NOTE: If an agent fails to answer an ACD call after X seconds or X rings or refuses a voice
interaction, the agent is placed in Reseize Timer state instead of SystemMake Busy state. This
default behavior can be reset to place agents into SystemMake Busy state rather than the Reseize
Timer state. The system then re-queues the call, in the same queue, and offers it to the next
available agent..

The followingmonitors display queue statistics:

l Queue by Period
l Queue Now
l QueueGroup Now

Queue by Period
TheQueue by Periodmonitor collates queue statistics by 15-minute intervals over a 24-hour period.
Themonitor refreshes each time there is a change in a statistic and each 15-minute interval. The
Queue by Periodmonitor always displays the current 15minute interval at the top of themonitor. You
can specify which columns of statistics are displayed, rearrange columns, and sort individual
columns in ascending or descending order. (See Figure 29.)
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Figure 29: Queue by Period

Queue by Period column heading definitions
Table 9 describes the Queue by Period column headings.

NOTE:Statistics that do not support Ring Groups display as '0'.

TERM ABBREVIATED
NAME MEANING

Interval time Interval The 15minute interval of time

Offered Offr The total number of calls offered to the
queue during the 15-minute interval

Handled Hndl The total number of calls answered by
members during the 15-minute interval

Short Abandoned Shrt Abn

During the 15-minute interval, the total
number of calls abandoned before the short
abandon time configured against the queue
in YourSite Explorer

Abandoned Abn
The total number of calls abandoned during
the 15-minute interval before being
answered by members

Interflowed Intrfl The total number of calls interflowed during
the 15-minute interval

Requeued ReQ

The total number of calls re-queued during
the 15- minute interval

NOTE: This statistic displays information
for ACD paths only. Statistics for Ring
Groups display as '0'.

Table 9: Queue by Period column headings
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TERM ABBREVIATED
NAME MEANING

%Handled by 1-4 % Hndl by 1-4

A count of all of the calls answered by the
first, second, third, and fourth answer
points during the 15-minute interval

NOTE: This statistic displays information
for ACD paths only. Statistics for Ring
Groups display as '0'.

#Handled by 1-4 # Hndl by 1-4

The number of calls answered by the first,
second, third, and fourth answer points
during the 15-minute interval

NOTE: This statistic displays information
for ACD paths only. Statistics for Ring
Groups display as '0'.

Total Conversation Time Ttl Conv Time The total timemembers spent talking to
callers during the 15-minute interval

Average Conversation Time Avg Conv time The average timemembers spent talking to
callers during the 15-minute interval

Average Time to Handle Avg TimeHndl
The average amount of time callers waited
in queue beforemembers answered their
calls during the 15-minute interval

Average Time to Abandon Avg Time Abn
The average amount of time callers waited
in queue during the 15-minute interval
before they abandoned their calls

Average Time to Interflow Avg Time Intrfl
The average amount of time callers waiting
in queue during the 15-minute interval
before being interflowed

Service Level % Today Scv Lvl % Tday
During the 15-minute interval, the
percentage of calls answered within the
Service Level Time specified for the queue

% Handled % Hndl

During the 15-minute interval, the
percentage of calls answered compared to
the total number of calls offered to the ACD
queue for the day

Table 9: Queue by Period column headings (continued)
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TERM ABBREVIATED
NAME MEANING

WrapUp Wrap Up

The total time the agent spent in theWork
Timer state during the 15-minute interval

NOTE: This statistic displays information
for ACD paths only. Statistics for Ring
Groups display as '0'.

Make Busy Make Busy

The total time the agent spent in theMake
Busy state during the 15-minute interval

NOTE: This statistic displays information
for ACD paths only. Statistics for Ring
Groups display as '0'.

Occupancy Occp
The total time the queuemembers spent in
an occupied state during the 15-minute
interval (occupied state excludes idle time)

Table 9: Queue by Period column headings (continued)

QueueNow andQueueGroup Now
TheQueue Now monitor enables supervisors to view queue statistics in real time, as well as expand
individual queues in themonitor to view statistics on each queue’s associatedmember agents or
extensions. When you expand theQueue Now monitor to display the Name column, themonitor also
displays member presence in the queue. Presence is indicated by a colored star in the Present
column. A green star indicates themember is present in the queue. A gray star indicates themember
is not present in the queue. A gray row indicates that themember is not logged in (for agents and hot
desk users) or out of service (for extensions).

TheQueueGroup Now monitor enables supervisors to view aggregated statistics for Reporting,
Virtual, and Unified queue groups in real-time, as well as expand individual queue groups in the
monitor to view statistics for the queue group’s associated queues.

On theQueue Now monitor, you can specify which columns of statistics are displayed, rearrange
columns, and sort individual columns in ascending or descending order. You can expand a queue
and view statistics on themembers associated with the queue. (See Figure 30.)

NOTE: Prior to Version 7.1, Queue Now monitors displayed the agent groups belonging to the
queues with agent group statistics. As of Version 7.1, this functionality has been removed. Instead,
queuemembers are grouped by agent group.
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Figure 30: Queue Now

NOTE:

l Contact Center Client updates Longest Waiting statistics every fifteen seconds, or more
frequently as records are received from the ACD routing system.

l If the ACD routing system has not updatedMiContact Center Business with real-time
statistics for Contacts Waiting and Agents Available within the last 90 seconds, question
marks display in place of these statistics.

l Agents present in the queue and idle whose extensions are ringing are included in 'Available'
statistics. Agents whose extensions are ringing are not included in Unavailable statistics.

l The Average Handling Time is the Average interaction Time plus the Average Hold Time. If
the call is put on hold, transferred, or conferenced, these times are added to the Average
Handling time value.
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l If an agent fails to answer an ACD call after X seconds or X rings or refuses a voice
interaction, the agent is placed in Reseize Timer state instead of SystemMake Busy state.
This default behavior can be reset to place agents into SystemMake Busy state rather than
the Reseize Timer state. The system then re-queues the call, in the same queue, and offers it
to the next available agent..

l The abandonedmedia column in the Interactive Visual Queuemonitor displays all abandoned
calls. The abandoned column in the Queue Now monitor does not include short abandons as
abandoned calls. Because of this difference, youmay notice discrepancies between the
abandoned call information in these twomonitors.

l Statistics that do not support Ring Groups display as '0'.

Queue Now and Queue Group Now column heading definitions
Table 10 describes the real-time and over-the-business-day Queue Now andQueueGroup Now
queue and queue group statistics.

NOTE:Statistics that do not support Ring Groups display as '0'.
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TERM ABBREVIATED
NAME MEANING

Queue Status Queue Status

The current status of the queue—either Open, Do Not
Disturb (DND) or Closed.

Open indicates that the queue is available to queue
calls.

Closed indicates that the queue is not available to
queue calls. This is because it is outside of Business
Hours or because of a Queue Control Plan condition.

Do Not Disturb indicates that the queue has been
closedmanually using the Set DND command. If the
queue alsomeets the criteria above for a Closed
queue, the status will show Closed instead of Do Not
Disturb.

If licensed for IVR Routing, an additional queue status,
Offline, is available. Offline indicates that IVR Routing
failed to receive a real-time status from the queue after
a set period of time.

Queue Number Queue # The queue's reporting number

QueueGroup
Number QueueGroup # The queue group reporting number (QueueGroup Now

only)

Media Server Media Server The queue’s media server

Queue Name Name The queue or queue group name

Contacts Waiting Contacts Wtg
The current number of interactions in queue waiting for
amember to become available, including those
listening to silence, music, or recorded announcements

Longest Waiting LongWtg The current duration, in minutes and seconds, of the
interaction waiting the longest in queue or queue group

Available (Queue
Now)

Agents Available
(QueueGroup

Now)

Avail

Agts Avail

The total number of members logged in and not in Do
Not Disturb, Make Busy, Work Timer, Ringing,
Reseize Timer, Unknown, andOffline (Ignite, WEB)

NOTE: This statistic updates only whenmembers are
present to the queue

Table 10: Queue Now and Queue Group Now queue statistic column headings
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TERM ABBREVIATED
NAME MEANING

ACD ACD

The current number of members handling ACD
interactions

NOTE: This statistic updates only whenmembers are
present to the queue

Idle Idle

The current number of members logged on and ready to
receive interactions

NOTE: This statistic updates only whenmembers are
present to the queue

Non ACD Non ACD

The current number of members handling Non ACD
calls (voice only)

NOTE: This statistic updates only whenmembers are
present to the queue

Outbound Out

The current number of members on outgoing calls
(voice only)

NOTE: This statistic updates only whenmembers are
present to the queue

Unavailable Unavail The current number of members in Do Not Disturb,
Make Busy, Work Timer, or Unknown

Offered Off The total number of interactions offered to the queue /
queue group

Handled Hndl The total number of ACD interactions handled by
members

Abandoned Abn

The total number of interactions abandoned before
being answered by members

NOTE:Abandoned does not peg short abandons as
abandoned interactions in the Queue Now monitor. The
Abandoned column in the Interactive Visual Queue
monitor displays all abandoned interactions. Because
of this difference, youmay notice discrepancies
between the abandoned call information in these two
monitors.

Table 10: Queue Now and Queue Group Now queue statistic column headings (continued)
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TERM ABBREVIATED
NAME MEANING

Interflowed Intrfl

The total number of ACD interactions interflowed.
Interflow is amechanism that directs an interaction
waiting in queue to another answer point.

NOTE: If an interaction waiting in queue is redirected
before the queue’s short abandon time has elapsed, the
queue is pegged with a Queue Unavailable count rather
than an Interflowed count. In order for the Interflowed
peg to occur, the redirectionmust occur after the short
abandon time has elapsed.

Requeued ReQ
The total number of ACD interactions requeued

NOTE: This statistic displays information for ACD
paths only. Statistics for Ring Groups display as '0'.

Average Time to
Handle Avg TimeHndl The average time it takes for the interaction to be taken

out of queue by amember

Average Time to
Abandon Avg Time Abn The current average amount of time customers wait in

queue before abandoning interactions

Average
Conversation

Time
Avg Conv Time The current average timemembers spent

communicating with interactions

Service Level % Svc Lvl %

For a queue, this is the percentage of interactions
handled within the queue’s Service Level Time value
over the day

For a queue group, this is the lowest percentage of
interactions handled within the queue’s Service Level
Time value over the day across all queues

% Handled % Hndl

For a queue, this is the percentage of interactions
handled compared to the total number of interactions
offered to the queue for the day

For a queue group, this is the lowest percentage of
interactions handled compared to the total number of
interactions offered to the queue for the day across all
queues

Table 10: Queue Now and Queue Group Now queue statistic column headings (continued)
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TERM ABBREVIATED
NAME MEANING

%Handled by 1-4 % Hndl by 1-4

For a queue, this is the percentage of all of the
interactions answered by the first, second, third, and
fourth agent groups

For a queue group, this is the highest percentage of all
of the interactions answered by the first, second, third,
and fourth agent groups

NOTE: This statistic displays information for ACD
paths only. Statistics for Ring Groups display as '0'.

Total
Conversation

Time
Ttl Conv Time The current total timemembers spend talking to callers

Total Queue
Unavailable Ttl Q Unavail

The total number of times during the day that
interactions are rerouted because the queue is in Do
Not Disturb or has nomembers logged in

Current Queue
Unavailable Curr Q Unavail

The current number of interactions are rerouted
because nomembers are logged in or the queue is in
Do Not Disturb. Once the queue becomes available,
this value resets to 0

Offered Last Hour Offr Last Hour The total number of interactions offered to the queue
during the last hour of business

Time to Handle
Last Hour TimeHndl Last Hour The time interactions waited in queue during the last

hour of business before being handled by amember

% Handled Last
Hour % Hndl Last Hour

For a queue, this is the percentage of interactions
handled in the last hour of business, compared to the
total number of interactions offered to the ACD queue
for the day

For a queue group, this is the lowest percentage of
interactions handled in the last hour of business,
compared to the total number of interactions offered to
the ACD queue for the day

Service Level %
Last Hour Svc Lvl % Last Hour

For a queue, this is the percentage of interactions
answered or picked within your Service Level Time
value in the last hour

For a queue group, this is the lowest percentage of
interactions answered or picked within your Service
Level Time value in the last hour

Table 10: Queue Now and Queue Group Now queue statistic column headings (continued)
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TERM ABBREVIATED
NAME MEANING

Handled Last
Hour Hndl Last Hour The total number of interactions handled by members

during the last hour of business

Abandoned Last
Hour Abn Last Hour The total number of interactions abandoned during the

last hour of business

Interflowed Last
Hour Intrfl Last Hour

The total number of interactions interflowed during the
last hour of business. Interflow is amechanism that
directs an interaction waiting in queue to another
answer point

Unavailable Last
Hour Unavail Last Hour

The total number of times, in the last hour of business,
interactions were rerouted because the queue they tried
to access was in DoNot Disturb or had nomembers
logged in

See Current Queue Unavailable

Average Handling
Time Last Hour Avg Hndl Last Hour

The average duration of interactions frommember pick
up to client hang up (including hold time) during the last
hour of business

Offered Last 15
Minutes Offr Last 15Min The total number of interactions offered to the queue in

the last 15minutes of business

Time to Handle
Last 15Minutes

TimeHndl Last 15
Min

The time interactions waited in queue during the last 15
minutes of business before being handled by amember

% Handled Last
15Minutes % Hndl Last 15Min

For a queue, the percentage of interactions answered in
the last 15minutes of business, compared to the total
number of interactions offered to the ACD queue for the
day

For a queue group, the lowest percentage of
interactions answered in the last 15minutes of
business, compared to the total number of interactions
offered to the ACD queue for the day

Service Level %
Last 15Minutes

Svc Lvl % Last 15
Min

For a queue, this is the percentage of interactions
answered or picked within your Service Level Time
value in the last 15minutes of business

For a queue group, this is the lowest percentage of
interactions answered or picked within your Service
Level Time value in the last 15minutes of business

Handled Last 15
Minutes Hndl Last 15Min The total number of interactions handled by members

during the last 15minutes of business

Table 10: Queue Now and Queue Group Now queue statistic column headings (continued)
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TERM ABBREVIATED
NAME MEANING

Abandoned Last
15Minutes Abn Last 15Min The total number of interactions abandoned during the

last 15minutes of business

Interflowed Last
15Minutes Intrfl Last 15Min

The total number of interactions interflowed during the
last 15minutes of business. Interflow is amechanism
that directs an interaction waiting in queue to another
answer point.

Unavailable Last
15Minutes Unavail Last 15Min

The total number of times, in the last 15minutes of
business, interactions were rerouted because the
queue they tried to access was in DoNot Disturb or
had no agents logged in

See Current Queue Unavailable

Average Handling
Time Last 15
Minutes

Avg Hndl Last 15
Min

The average handling duration of interactions from
interaction pickup to interaction completion, including
hold time, during the last 15minutes of business

% Abandoned % Abn

For a queue, this is the percentage of interactions that
were abandoned (% Abandoned = Interactions
Abandoned ÷ Interactions Offered)

For a queue group, this is the highest percentage of
interactions that were abandoned (% Abandoned =
Interactions Abandoned ÷ Interactions Offered)

% Abandoned
Last Hour % Abn Last Hour

For a queue, this is the percentage of interactions that
were abandoned in the last hour of business

For a queue group, this is the highest percentage of
interactions that were abandoned in the last hour of
business

% Abandoned
Last 15Minutes % Abn Last 15Min

For a queue, this is the percentage of interactions that
were abandoned in the last 15minutes of business

For a queue group, this is the highest percentage of
interactions that were abandoned in the last 15minutes
of business

Wrap Up Wrap Up

The total time that agents spent in theWork Timer
state

NOTE: This statistic displays information for ACD
paths only. Statistics for Ring Groups display as '0'.

Table 10: Queue Now and Queue Group Now queue statistic column headings (continued)
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TERM ABBREVIATED
NAME MEANING

Make Busy Make Busy
The total time that agents spent in theMake Busy state

NOTE: This statistic displays information for ACD
paths only. Statistics for Ring Groups display as '0'.

Occupancy Occp The total time that members spent in an occupied state
(occupied state excludes idle time)

# Handled by 1-4 # Hndl by 1-4

The number of interactions answered by the first,
second, third, and fourth agent groups

NOTE: This statistic displays information for ACD
paths only. Statistics for Ring Groups display as '0'.

LoggedOut Logged out

The number of members associated with the queue but
not logged in to the system

NOTE: For Ring Groups, this statistic displays either
the number of extensions out of service or hot desk
users logged out.

Members Not
Present Not Present

The number of members that are logged into the
ACD routing system, but not present in the queue being
monitored

Table 10: Queue Now and Queue Group Now queue statistic column headings (continued)

Table 11 describes the real-time and over-the-business-day Queue Now andQueueGroup Now
member statistics.

NOTE: Some statistics in the Queue Now monitor display in the QueueGroup Now monitor as
member statistics.

TERM MEANING

State
The queuemember's agent or extension state (Queue Now only)

For a list of agent and extension states, see "Employee and Agent states" on
page 50 and "Extension states" on page 55.

Name The name of themember beingmonitored. The icon beside the name
indicates themedia type themember handles

Present

Indicates whether themember is present in the queue

Presence is indicated by a colored star. A green star indicates the agent or
extension is present in the queue. A gray star indicates the agent is not
present in the queue

Table 11: Queue Now and Queue Group Now member statistic column headings
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TERM MEANING

Media Server Themedia server to which themember is associated

Reporting The reporting number of themember beingmonitored.

Extn # The base extension where themember logged in (voice agent or hot desk
user only)

Log In
The first login of themember’s shift.

NOTE: This statistic displays information for ACD pathmembers only and is
not calculated for Ring Groupmembers.

Last Event Recd Themost recent time amember event occurred

Shift Time

The total elapsed time logged for themember, calculated based on the
difference between log in and last event received

NOTE: This statistic displays information for ACD pathmembers only and is
not calculated for Ring Groupmembers.

DND Time The duration of time where DoNot Disturb was the overriding state for the
member

MKB Time

The duration of time whereMake Busy was the overriding state for the
member

NOTE: This statistic displays information for ACD paths only. Statistics for
Ring Groups display as '0'.

Wrap Up Time

The duration of time whereWrap Up Timewas the overriding state for the
member. Wrap up time does not include any time spent making or taking
interactions during the wrap up timer.

NOTE: This statistic displays information for ACD paths only. Statistics for
Ring Groups display as '0'.

ACD Time The duration of ACD interactions handled, frommember pickup to
completion (not including hold time)

Hold ACD Time The duration of time ACD interactions spent on hold

Non ACD Time The duration of Non ACD interactions handled, frommember pickup to
completion (not including hold time) (voice only)

Hold Non ACD
Time The duration of time Non ACD interactions spent on hold

Out Time The duration of timemembers spent handling outbound calls (voice only)

Out Hold Time The duration of time outbound calls spent on hold, for members (voice only)

Table 11: Queue Now and Queue Group Now member statistic column headings
(continued)
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TERM MEANING

DND Cnt The number of times themember entered the DoNot Disturb state

MKB Cnt
The number of times themember entered theMake Busy state

NOTE: This statistic displays information for ACD paths only. Statistics for
Ring Groups display as '0'.

ACD Cnt The number of ACD interactions handled by themember

Shrt ACD Cnt The number of ACD interactions handled by themember where the handle
time was less than the Short Handle parameter

Hold ACD Cnt The number of times ACD interactions were placed on hold (voice only)

Non ACD Cnt The number of Non ACD interactions handled by themember (voice only)

Hold Non ACD Cnt The number of times Non ACD interactions were placed on hold

Out Cnt The number of outbound calls made by themember (voice only)

Out Hold Cnt The number of times outbound calls were placed on hold (voice only)

Avg Handl The average amount of time queuemembers spent handling ACD
interactions (ACD Time divided by ACD Count, excluding ACD Hold Time)

Agt Grp
The agent group to which the agent belongs

NOTE: This statistic displays information for ACD paths only. Statistics for
Ring Groups display as '0'.

Occupancy The duration of time themember spent processing interactions

Contacts per Hour The total ACD interaction count minus the ACD short handle count, divided
by the shift time for themember

On failover Indicates whether the primary media server is offline and has failed over to
the secondary media server (voice only)

Unavail% The percentage of time for the shift that themember was in DoNot Disturb,
Make Busy, andWork Timer states

Not Present Time The duration of time themember was logged into but not present in an agent
group or Ring Group

External handle
time The duration of time themember spent handling external calls (voice only)

External inbound
cnt The number of incoming external calls (voice only)

Table 11: Queue Now and Queue Group Now member statistic column headings
(continued)
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TERM MEANING

External outbound
cnt The number of outgoing external calls (voice only)

Table 11: Queue Now and Queue Group Now member statistic column headings
(continued)

VIEWING QUEUECHARTSTATISTICS
The following charts display queue statistics:

l Queue Now
l QueueGroup Now
l Queue Performance by Period
l QueueGroup Performance by Period

QueueNow andQueueGroup Now
TheQueue Now andQueueGroup Now charts offer visual representations of Queue Now and
QueueGroup Now real-time statistics, grouped by the type of statistics displayed. Three different
series of statistics are available to view in charts:

l Integer—displays numerically-based real-time statistics
l Percentage—displays percentage-based statistics
l Time—displays time-based statistics

Users can specify which statistics display in their charts. Figure 31 shows an example of a Queue
Now chart displaying the Integer series with the default statistics selected.
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Figure 31: Queue Now (Integer) chart

The Integer chart shows:

l Handled (Default)
l Abandoned (Default)
l Interflowed (Default)
l Calls Waiting
l Agents Available
l ACD
l Idle
l Non ACD
l Outbound
l Unavailable
l Offered
l Requeue
l Total Hour
l Interflowed Last Hour
l Unavailable Last Hour
l Offered Last 15Minutes
l Handled Last 15Minutes
l Abandoned Last 15Minutes
l Interflowed Last 15Minutes
l Unavailable Last 15Minutes
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l Logged out
l Logged in not present
l # Handled by 1-4

The Percentage chart shows, by default:

l Service Level %
l Handled%
l %Handled by 1-4
l %Handled Last Hour
l Service Level % last Hour
l %Handled Last 15Minutes
l Service Level % Last 15Minutes
l %Abandoned
l %Abandoned Last Hour
l %Abandoned Last 15Minutes.

Time charts show, by default:

l Longest Waiting
l Average Time to Handle
l Average Time to AbandonMinutes
l Average Talk Time
l Ttl Talk Time
l Time to Handle Last Hour
l Average Time to Handle Last Hour
l Hdnl Last 15Min
l Average Handling Time Last 15Minutes
l Total work timer minutes
l Total make busy minutes
l Total occupancy minutes

For descriptions of the statistics, see "Queue Now andQueueGroup Now column heading
definitions" on page 79.

NOTE: The following statistics are for ACD path voice queues only and will not display information
for Ring Groups:

l Requeue
l # Handled by 1, 2, 3, 4
l %Handled by 1, 2, 3, 4
l Total work timer minutes
l Total make busy minutes
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Queue Performance by Period andQueueGroup Performance by
Period
TheQueue Performance by Period andQueueGroup Performance by Period charts offer visual
representations of Queue andQueueGroup Performance by Period statistics, grouped by the type of
statistic displayed. Three different series of statistics are available to view in charts:

l Integer—displays numerically-based real-time statistics
l Percentage—displays percentage-based statistics
l Time—displays time-based statistics

Figure 32 displays aQueue Performance by Period chart displaying the default statistics of the
Integer series.

Figure 32: Queue Performance by Period chart

The Integer series shows the following statistics across 15minute intervals for queues or queue
groups:

l Handled (Default)
l Interflowed (Default)
l Offered
l Short Abandoned
l Abandoned
l Requeue
l # Handled by 1-4
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The Percentage series shows the following statistics across 15minute intervals for queues or queue
groups, by default:

l %Handled by 1-4
l Service Level % Today
l %Handled

The Time series show the following statistics across 15minute intervals for queues or queue groups,
by default:

l Average Time to Handle
l Average Time to Abandon
l Average Time to Interflow
l Ttl Talk Time
l Average Talk Time
l Total work timer minutes
l Total make busy minutes
l Total occupancy minutes

For more information for the definitions of these statistics, see "Queue by Period column heading
definitions" on page 75.

NOTE: The following statistics are for ACD path voice queues only and will not display information
for Ring Groups:

l Requeue
l # Handled by 1, 2, 3, 4
l %Handled by 1, 2, 3, 4
l Total work timer minutes
l Total make busy minutes

Navigating charts
You can zoom in and out of charts to change how the data is displayed in the chart, expanding or
compressing the displayed data. If the range of data displayed exceeds the boundary of the chart
window in Contact Center Client, you can use the horizontal scroll bar to move back and forth across
the displayed data.

To zoom in on a chart

1. Hold your mouse over the edge of the horizontal scroll bar until the cursor turns into a double-
arrow (<->) icon.

2. Click and drag the edge of the horizontal scroll bar towards the opposite side of the scroll bar.
The chart zooms in and the horizontal scroll bar shrinks in size.
NOTE: To undo the zoom function, click Zoom Out.

To zoom out of a chart

1. Hold your mouse over the edge of the horizontal scroll bar until the cursor turns into a double-
arrow (<->) icon.

2. Click and drag the edge of the horizontal scroll bar and drag to zoom out.
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To show the entire chart in the window

l If you are zoomed in, in the chart window click Show All.

To scroll across the chart

l Click and drag the horizontal scroll bar in the direction you wish to scroll the chart.

VIEWING CALLBACKLISTSWITHTHEGLOBALCALLBACK
MONITOR
When licensed for IVR, the Global callback monitor enables you tomonitor callback states in real
time and displays the callbacks currently available. Using the Global callback monitor, you can
requeue and delete callbacks. (See Figure 33.)

Figure 33: Global callback monitor

To access the global callback monitor

1. Click theReal Time tab in the Contact Center Client ribbon.
2. Click theCallbacks icon.

TheMonitor Callback List displays.

Table 12 describes the Global callback monitor column headings.
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COLUMN
HEADING DEFINITION

Caller number the phone number provided by the caller

Caller name the name of the caller

Status the state of the callback — new request, in progress, requeued, completed,
unknown

Priority

the importance level of the callback.

Callback priority levels are:

l Voice—Normal
l Web—Normal
l Caller abandoned— Low

Type the type of callback — voice, web, or caller abandoned

Reason lists why the callback is in a particular status

Attempted
Calls to Agent the number of times the callback was offered to an agent in queue

Last Time
Agent

Attempted
the last time the agent attempted the callback

Request Time the specific time at which the callback is scheduled to be processed; this
field is populated when the callback is requeued

Time
Received the specific time the caller submitted the callback request

Web IP
Address the IP address of the caller who submitted the callback request

Last
Attempted
Call to Client

the specific time the last callback attempt to the caller was made

Attempted
Calls to Client the number of times the callback was attempted

Client
Available
From

the earliest time the caller is available to receive the callback

Client
Available To the latest time the caller is available to receive the callback

Table 12: Global callback column headings
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COLUMN
HEADING DEFINITION

ANI the phone number of the caller

DNIS  the phone number the caller dialed

Dialable the dialable number of the device that will handle the callback

Device Name the name of the device that will handle the callback

Device Type the type of device that will handle the callback — agent, queue, or
extension

Recorded
Message contains a hyperlink to the voice callback .wav file left by the caller

Area the province/state or other area the call originated from

Country the country the call originated from

Endpoint the endpoint attempting to perform the callback

Region the region the call originated from

Table 12: Global callback column headings (continued)

Managing callbacks in the Global Callbackmonitor
TheGlobal callback monitor enables users to requeue, reject, and delete callbacks within the
monitor. Requeued callbacks are re-entered into their queue. Rejected callback are removed from
the queue are will not be offered to employees. Deleted callbacks are removed from themonitor, but
are not removed from the system.

Users can also adjust a callback’s priority. Callback priority determines the order of which callbacks
will be offered to agents. Callbacks are offered to agents in order of their priority and then by the
longest waiting callback of that priority. For example, High priority callbacks are offered before
Normal priority callbacks, even if the Normal priority callbacks have been in queue longer.

The following procedures explain how to:

l Requeue a callback
l Reject a callback
l Delete a callback
l Change a callback’s priority

To requeue a callback

1. Right-click a callback and select Requeue.
2. Select Yes.

To reject a callback

1. Right-click a callback and select Reject.
2. Select Yes.
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To delete a callback

1. Right-click a callback and select Delete.
2. Select Yes.

To change a callback’s priority

l Right-click a callback and select Change priority=>[priority level].

VIEWING PORTS
NOTE:

l You canmonitor port states in real time and view currently executing workflows.
l You can select the ports you want to monitor individually or by hunt group.
l You can remove ports from DoNot Disturb.

The Port Status monitor displays port information.

Port statusmonitor
The Port Status monitor enables you tomonitor port states in real time and displays the workflows
that are currently executing on ports. Using the Port Status monitor, you can take ports out of Do Not
Disturb and playback historical port events in Auditor mode. (See Figure 34.)

To access the port status monitor

1. Click theReal Time tab in the Contact Center Client ribbon.
2. Click thePorts icon.

The Port status monitor displays.

Figure 34: Port status monitor
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Table 13 describes the Port Status monitor column headings.

COLUMN
HEADING DEFINITION

Name the name of the port

Dialable the port's dialable number

Extension Type the type the extension—RAD, messaging, callback, or UPiQ

Media Server themedia server to which the port is associated

Hunt Group
Name

the name of the hunt group the port is associated with. A port can be associated
with more than one hunt group

Hunt Group
Dialable the dialable number of the hunt group

Phone state the state of the phone— idle, dialing, talking, ringing, or unknown

Workflow name the name of the executing workflow

Phone Display displays theMiAUDIO state (that is displayed on the phone)

ANI the phone number of the caller

DNIS the phone number dialed by the caller

Redirect the number of the device the call was directed from

Table 13: Port Status column headings

VIEWINGWEBPAGES
While using Contact Center Client, you can view webpages using theWeb browser monitor.

To view awebpage within Contact Center Client

1. Click theReal Time tab in the Contact Center Client ribbon.
2. Click theWeb icon.

TheWeb Browser Properties window opens.
3. AfterMonitor title, type a name for themonitor.
4. AfterStart URL, type the address of the website to view.

NOTE: The website address must begin with http:// or you will not be able to view themonitor.
5. Optionally, select a value for theWeb BrowserRefresh Rate.
6. Click OK.

VIEWING HISTORICALREAL-TIMEEVENTSWITHAUDITOR
Using Auditor you can view historical, multimedia real-time events, at your own pace. Auditor makes
it easy for you to analyze when and why past service problems occurred. By understanding the
series of events you can prevent such issues from recurring.
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For example, you notice that on July 15 you have 12 interactions abandon between 10:00 AM and
10:15 AM. You can review the interactions and the agents’ actions on that date for that time period
with Auditor. Did all of the interactions arrive at the same time? Did all of the agents go on break at
the same time? If all of the interactions arrived at once, you need to schedulemore people. If all of
the agents went on break at the same time, you need to adjust their break schedule.

Using Auditor you can also track when employees log on and log off the system. It is easy to
determine if any of the employees consistently start late or finish early.

With Auditor, you can use existing profiles, including alarm thresholds, when viewing past days run
in real time.

Your access to Auditor is determined by administrator-set security roles.

The first toolbar consists of real-timemonitors that provide information on agent availability, queue
statistics, and graphic displays on queues. (See Figure 35.)

Figure 35: Auditor toolbar

Auditor icons
Using Auditor’s second toolbar you select the date of the historical real-time events that you want to
view and the speed at which to play the events. The icons are described in Table 14.
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ICON TERM MEANING

Calendar You can select the date of the historical real-time events that
you want to view by clicking the calendar.

Speed of audit

The Speed of audit is expressed as a ratio of real-time to play
speed. You can select the speed from a list of ratios that opens
when you click the clock: 1:1, 1:2, 1:5, 1:10, 1:30, 1:60, and
1:120. If you select the ratio1:1, it will take you one second to
view one second of the past day. If you select 1:60, it will take
you one second to view oneminute of the past day.

Rewind If you click Rewind when the play is stopped, you jump back to
the beginning of the day.

Stop You can stop the real-time historical events from playing, and
jump back to the beginning of the day, by clicking Stop.

Pause You can pause the real-time historical events by clicking
Pause.

Play You can play the real-time historical events by clicking Play.

Step forward

You can select the increment (in seconds) you will advance
from a list that opens when you click the down arrow to the
right of Step forward: 1 sec, 2 sec, 5 sec, 10 sec, 15 sec, 30
sec, and 45 sec. If you select 30 seconds, then when the play
is stopped, you can step forward in 30 second increments each
time you click Step forward. When you reach the end of data
for that day, you will automatically jump to the end of the day.

Jump forward

You can select the increment (in minutes) you will advance
from a list that opens when you click the down arrow to the
right of Jump forward: 1min, 2min, 5min, 10min, 15min, 30
min, and 60min. If you select 10minutes, then when the play
is stopped, you can jump forward in 10minute increments each
time you click Jump forward. When you reach the end of data
for that day, you will automatically jump to the end of the day.

Slider

As you view the events of the day, the slider indicates the time
at which the events occurred. The length of the slider
represents the length of the day for which you are viewing
historical real-time events.

Table 14: Auditor Icons
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Starting and using Auditor
You start Contact Center Client to gain access to Auditor functionality.

To view historical real-time events, youmust

1. Start Contact Center Client.
2. Open the grids in which you want to view historical events.
3. Start Auditor.

NOTE: If you are using the Contact Center Client marquee, Contact Center PhoneSet Manager,
Contact Center Softphone, or Interactive Visual Queue applications (which function in real time
only), open Auditor in another instance of Contact Center Client.

To start and use Auditor

1. In the Contact Center Client ribbon, click Auditor Controls.
2. Click Auditor Mode in the toolbar ribbon.

The Auditor toolbar displays.
3. Click the calendar icon and select a date.

The date displays on the left of the slider.
4. Click the speed icon and select the speed of the audit.

The speed of the audit, expressed as a ratio of real time to play speed, displays on the right of
the speed icon.

5. Move the slider to select the time of day at which you want to start monitoring.
6. Click the play button to play the real-time events of the selected date.

The historical real-time events play at the speed you selected.

VIEWING ANDCUSTOMIZING REAL-TIMEMONITORS
NOTE:

l Contact Center Client has a tabbed interface for managing and arranging windows. You can
dock themonitors, displaying them on overlapping tabbed panels to maximize real estate.
This enables you to readily navigate betweenmonitors.

l You can save threshold settings and display characteristics you define for monitors. When
you click File=>Save, Contact Center Client saves all openmonitors under one profile name.
You can click File=>Open to open another profile, or File=>New to create a new profile.

Openingmonitors
To open amonitor in Contact Center Client

1. In the Contact Center Client ribbon, click Real time to view the Contact Center Client monitor
icons.

2. In theState by Position column on the ribbon, click Agent.
This selects the Agent State by Positionmonitor and the Add/Remove device IDs window
opens.
See Figure 36.

3. UnderAgent groups, select agent groups tomonitor and/or under Agents, select agents to
monitor.
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4. UnderCard designs, select a card design.
Card designs specify the information displayed on extension, agent, and employeemonitors.

5. Click OK.

Figure 36: Add/Remove devices

Dockingmonitors
You can dock monitors and readily navigate between them. You can dock amonitor to the top,
bottom, left, or right of another monitor. Alternatively, you can dock amonitor on the top, bottom, left,
or right side of the Contact Center Client window. You can dock monitors on top of one another,
displaying them on overlapping tabbed panels to maximize real estate.

To dock amonitor on top of another monitor

1. Right-click the title bar of an openmonitor and select Dock.
2. Repeat step 1 for all openmonitors.
3. Click the title bar of amonitor and drag themonitor on top of a secondmonitor placing your

cursor in the center of the four-headed arrow that displays.
See Figure 37.
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Figure 37: Docking monitors

4. Release themouse button.
Your monitors are displayed on overlapping tabbed panels.
See Figure 38.

Figure 38: Docked monitor
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Adding and removing devices
You can add and remove devices from all of the Contact Center Client monitors except for the chart
monitors.

To add devices to the bottom of amonitor

1. Right-click an openmonitor and click Add/Remove devices.
2. UnderAgent/Employee/Queue groups, select additional agent, employee, or queue groups

to add to themonitor, or underAgents/Employees/Queues, select additional agents,
employees, or queues to add to themonitor.

3. Click OK.
On the State by Positionmonitors a blank row of cells separates the original agents from
those you just added. To remove the blank row youmust sort themonitor.
See "Sortingmonitor devices" on page 104.

To remove devices from amonitor

1. Right-click an openmonitor and click Add/Remove devices.
2. UnderAgents/Employees/Queues, clear the check boxes of the agents, employees, or

queues to be removed.
3. Click OK.

NOTE:You can alternatively add and remove devices via theMonitor Options tab in the Contact
Center Client ribbon for the Queue by Period, Queue Now, andQueueGroup Now monitors.

Sortingmonitor devices
When you select devices to display on amonitor, you can specify the devices be sorted by media
server (on agent monitors only), ID, or name (alphabetically) in ascending or descending order. When
themonitor opens, the devices display in the order you selected.

To sort the devices displayed on amonitor

l In the left pane of theAdd/Remove deviceswindow, click Media server to sort themembers
by media server, click Name to sort themembers alphabetically, or click Reporting to sort
themembers by ID, in either ascending or descending order.

You can sort information by state, name, agent ID, or extension on the State by Positionmonitors.

To sort agents or employees by state

l Right-click amonitor and click Sort monitor=>By state.

If you sort agents by state, Contact Center Client displays the agents by state and time in state
across themonitor in the following order:

l Ringing
l ACD
l ACD Hold
l Idle
l Non ACD
l Non ACD Hold
l Outbound
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l Outbound Hold
l DoNot Disturb
l Make Busy
l SystemMake Busy
l Work Timer
l Unknown
l LoggedOff

To sort agents or employees by name

l Right-click amonitor and click Sort monitor=>By name.

To sort agents or employees by agent ID

l Right-click amonitor and click Sort monitor=>By agent ID.

To sort agents or employees by extension

l Right-click amonitor and click Sort monitor=>By extension.

Rearranging cells
You can rearrange cells on the State by Position monitors.

To rearrange cells

l On an openmonitor, drag a cell to a different position on themonitor.

You can rearrange columns on the Agent Shift, Queue by Period, Queue Now, andQueueGroup
Now monitors.

To rearrange columns

1. Right-click an openmonitor and click Properties.
2. Click the Layout folder.
3. Click Column order.
4. Click a column header and click the up or down arrow key to change the position of the column

relative to other columns on themonitor.

NOTE:You can alternatively rearrange cells via theMonitor Options tab in the Contact Center Client
ribbon for the Queue by Period, Queue Now, andQueueGroup Now monitors.

Settingmonitor dimensions
You can specify the numbers of rows and columns of cells to display on the State by Position
monitors.
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To set table dimensions

1. Right-click amonitor and click Set table dimensions.
2. AfterColumns, type a number.
3. AfterRows, type a number.
4. Click OK.

Columns or rows are added or deleted from themonitor. You can redistribute the cells using a
drag-and-drop operation.

To size the table to fit the frame

l Right-click in any real-timemonitor and select Size table to frame.

Hidingmonitor columns
On the Agent Shift, Queue by Period, Queue Now, andQueueGroup Now monitors, you can hide
specific columns of statistics.

To hide columns

1. Right-click an openmonitor and click Properties.
2. Click the Layout folder.
3. Click Column order.
4. In theVisible column, clear the check boxes of the columns you want to hide from view.

NOTE:You can alternatively hidemonitor columns via theMonitor Options tab in the Contact Center
Client ribbon for the Queue by Period, Queue Now, andQueueGroup Now monitors.

Filtering device variables
On theQueue Now, Agent Shift, Queue by Period, andQueueGroup Now monitors, you can filter
specific device variables. For example, on the Queue by Periodmonitor, you could filter the Calls
Offered variable and display statistics for the intervals during which the queue was offered five or
more calls.

To filter variables

1. Right-click amonitor and click Filter device variables.
2. Click Filter data to show, select a variable, select an operand, and type a number.
3. Click OK.

A subset of the data is displayed based on the conditions defined in the filter.
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Configuring chart characteristics
Individual charts have a range of configurable characteristics and options that enable users to
customize their chart display.

You can right-click charts to access the following options or select them via the Chart Options tab:

l Change the chart types
l Configure the legend
l Configure the color scheme
l Define queue chart properties
l Enable points labels
l Modify Properties

Changing chart type
Contact Center Client enables you to configure the type of chart, either column or line, used for your
Queue andQueueGroup Performance by Period charts.

Queue andQueueGroup Now charts display as bar charts.

1. Right-click on an open By Period chart and click Chart Type.
2. Select the type of chart you want your chart to display.

NOTE:Alternatively, you can change the chart type by selecting an open By Period chart, and
choosingColumn or Line from the drop-down list beside Type in the Chart Options tab.

Configuring the legend
You can choose if your chart has a legend, as well as configure where the legend displays.

To configure the legend

1. Right-click on an open queue chart and click Legend box.
2. Select or deselect Enabled to either display or remove the legend.
3. Right-click on an open queue chart and click Legend box.
4. Click Left, Top, Right, orBottom to determine where you want the legend box to display.

NOTE:Alternatively, you can configure the legend by selecting an open queuemonitor and
accessing options from the Legend section of theChart Options ribbon.

Configuring the color scheme
You can select the color scheme for the chart.

To configure the color scheme for a chart

1. Right-click on an open queue chart and click Color.
2. Select the color scheme you want to apply to the chart from the list.

NOTE:Alternatively, you can configure the color scheme by selecting an open queue chart and
selecting color options from the drop-down list besideColor in theChart Options ribbon.
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Defining queue chart properties
Under Chart properties, you can select general chart characteristics, such as colors and stacked
effects. You can define series characteristics, such as the type of chart, the fill properties, and the
shape of the bars. In addition, you can define y axis characteristics.

To define queue chart properties

1. Right-click an open queuemonitor and click Chart properties.
2. On theGeneral tab, specify general chart characteristics (colors, effects, and 3D).
3. Click theSeries tab.
4. Specify series characteristics (chart style, fill style, bar type, and border style).
5. Click theY Axis tab.
6. Specify axis scale characteristics, label characteristics, and the width and color of the axis

line.
7. Click OK.

NOTE:Alternatively, you can configure queue chart properties by selecting an open queuemonitor
and clickingProperties located in theChart Options ribbon.

Enabling point labels
You can enable labels for each point in your chart.

To enable point labels

l Right-click on an open queue chart and click Points labels.

NOTE:Alternatively, you can enable point labels by selecting an open queue chart and clicking
Enabled in thePoints Label section of theChart Options ribbon.

Modifying Properties
Properties controls the way chart data displays. Under Properties, you can

l Specify the queue chart title
l Highlight statistics
l Configure 2D and 3D displays
l Animate charts
l Select call statistics to display
l Create andmodify Constant lines

NOTE:You can either right-click an open queue chart to modify properties or select an open queue
chart and choose options via the Properties section of the Chart Options tab.
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Specifying the queue chart title

Under Properties, you can specify the title of the queue chart.

To specify the queue chart title

1. Right-click on an open queue chart and click Properties.
2. AfterMonitor title, select and delete the old chart title and type a new name for the queue

chart.
3. Click OK.

Highlighting statistics

Under Properties, you can enable the highlight feature. When the highlight feature is enabled, and
when youmove your cursor over a bar representing a specific call statistic, that bar is highlighted
and the other bars, representing other call statistics, are dimmed.

To highlight statistics

1. Right-click on an open queue chart and click Properties.
2. Expand theChart properties tree and click General.
3. Select theHighlight check box.
4. Click OK.

Configuring 2D or 3D chart displays

Under Properties, you can configure whether your chart displays bars in 2D or 3D. By default, your
charts display in 3D.

1. Right-click on an open queue chart and click Properties.
2. Expand theChart properties tree and click General.
3. Select the 3D check box to enable or disable 3D charts.
4. Click OK.

Animating charts

Under Properties, you can enable the animated feature. When the animated feature is enabled,
changes to chart values actively display. The animated feature is disabled by default.

CAUTION:Enabling the animated feature will result in additional CPU load on the affected
workstation.

To animate charts

1. Right-click on an open queue chart and click Properties.
2. Expand theChart properties tree and click General.
3. Select theAnimated check box.
4. Click OK.
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Selecting call statistics to display

Under Properties, you can select call statistics to display. For example, you can add Calls Waiting,
Agents Available, Idle, and Requeued statistics to the QueueGroup Now (Integer) chart.

To select call statistics to display

1. Right-click on an open queue chart and click Properties.
2. Expand theChart properties tree and click Series data.
3. Select theSeries data type radio button to define the types of data visible in the chart.

l Integer
l Percentage
l Time

4. If you are selecting call statistics for a Queue or QueueGroup Performance by Period chart,
click Time Interval. Select the radio button for the interval you want to use and set the time.

5. UnderVisible, select the check box of the data you want to add to the chart.
6. Alternatively, underVisible, clear the check box of the data you want to remove from the

chart.
7. Click OK.

Creating and modifying Constant lines

Under Properties, you can configure Constant lines. Constant lines are horizontal lines you configure
to display across your chart at set values on the Y-axis, enabling you to clearly see how the data
being displayed in the chart meets with desired values.

To create Constant lines

1. Right-click on an open queue chart and click Properties.
2. Click Chart properties.
3. Click Constant lines.
4. Click Add.
5. Click in theColor box to choose a color.

NOTE: The default constant line color is red.
6. After Text, type the name you want to display beside the constant line in the chart.
7. AfterValue, type the value you want the constant line tomark.
8. AfterWidth, select the thickness of the line.
9. Click OK.

The Constant line will be added to the list of active Constant lines.

Tomodify a Constant line

1. Select the Constant line you want to modify and click Edit.
2. After Text, type the name you want to display beside the Constant line in the chart.
3. AfterValue, type the value you want the Constant line tomark.
4. AfterWidth, select the thickness of the line.
5. Click OK.
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To delete a Constant line

l Select the Constant line you want to delete and click Delete.

SETTING ALARMS
You can define alarms to alert you to significant changes in contact center activity. Using the
alarms, you specify performance thresholds for contact center elements, such as queues and
agents, and customize the visual, auditory, or email delivery of alarms. If any availability or
performance issues arise, your alarms deliver a notification enabling you to instantly change agent
and queue availability to adjust to unplanned call volumes.

Client alarms are specific to each computer. To notify you that performance thresholds are not being
met, you can configure alarms so that

l Monitor cells and statistics change color.
l A pop-up notification opens on your desktop.
l A sound prompt, such as a beep or .wav file, plays.
l You are notified by email.
l Contact Center Client opens on top of all open applications.

To configure alarms for real-timemonitors

1. Add performance thresholds.
2. Specify threshold colors.
3. Specify threshold notification.

Adding performance thresholds
To add performance thresholds so you canmonitor alarms

1. Right-click amonitor and click Set alarms.
Alternatively, select an openmonitor and click Set alarms in the Alarms column, found in the
Monitor or Chart Options tab in the Contact Center Client ribbon.
The Set alarms window opens.
NOTE:You can select theApply the alarm thresholds to all devices displayed on the
monitor check box to apply the threshold settings for performance variables across all
queues or agents. Alternatively, you can select Apply the alarm thresholds to a specific
list of devices to apply the threshold settings for a performance variable to a list of queues or
agents.

2. UnderDevices, select one or more queues or agents or select theSelect all check box to
select all queues or agents.

3. In thePerformance variables list, select a variable.
4. UnderAlarm Thresholds, click Add threshold and type a value for the upper boundary of

the threshold.
The lower boundary cannot bemodified. The lower boundary of the next threshold is always
slightly greater than the upper boundary of the previous threshold.

5. Click OK.
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Specifying performance threshold colors
To configure performance threshold colors

1. For the alarm threshold for which you want to specify colors, underBackground, click the
arrow.
A color palate opens.

2. Select a color.
3. Under Font color, click the arrow.

A color palate opens.
4. Select the font color for the alarm threshold.
5. Click OK.

Specifying threshold notification
To configure performance threshold sound notification

1. For the alarm threshold for which you want to be notified by a sound, underSound, select the
check box.
The Sound window opens.

2. Specify the alarm triggering properties.
3. Specify the sound you want played when the alarm is triggered.
4. Click Save.

To configure performance threshold pop-up window notification

1. For the alarm threshold for which you want to be notified by a pop-up window, underPop-up,
select the check box.
The Pop-up window opens.

2. AfterDuration, type the number of seconds you want the pop-up alarm to be displayed when
threshold conditions are satisfied.

3. If you want to display the pop-up alarm on top of all of the other applications, select theKeep
this message visible on mouse over check box.

4. Optionally, click the Format font button to specify font attributes for the pop-up alarm
message.

5. In the text box, type themessage for the performance threshold and click theAdd variable
button to insert performance variables. (for example, type CW P001 = <calls waiting
variable>).

6. Click Save.

To specify that Contact Center Client opens on top of all other applications when a performance
threshold is satisfied

l For the alarm threshold for which you want to be notified, underBring to front, select the
check box.
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To configure performance threshold email notification

1. For the alarm threshold for which you want to be notified, or notify others by email, under
Email, select the check box.
The Email window opens.

2. AfterDistribution, specify which contacts are to be notified by email when threshold
conditions are satisfied.

3. AfterSubject, type the subject of the email to be sent (for example, type Calls Wtg in Sales
Queue 1 >10!).

4. In themessage box, type the body of the email.
5. Click Save.

Consider the threshold programming in Figure 39. When the number of agents available in the
technical support queue is between 0 and 2, the cell housing the Agents Available statistic is red.
When the number of agents available is between 3 and 4, the cell turns orange. When the number of
agents available is 5 or greater, the cell turns white. In addition, audible alarms and pop-up alarms
display.

To clear any current client alarms in Contact Center Client

l Right-click themonitor and click Clear alarms.
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Figure 39: Set alarms window

CUSTOMIZING THE INFORMATIONDISPLAYEDON
POSITIONANDTIMEMONITORS
On the agent, employee, and extension by position and by timemonitors, real-time information is
displayed in cells (cards). You can select from available card designs, or customize cards to display
specific information.

When you first open an agent, employee, and extensionmonitor, you can select a card design on the
Add/Remove device IDs window:

l The Classic card displays the agent state, time in the state, presence, agent/employee name,
agent login ID/employee ID, and extension number (or queue name for voice agents on ACD
or on ACD Hold).

l The Caller ID card displays the caller name and number (ANI), the number the
caller/employee dials for incoming/outgoing calls, the state, time in the state, presence,
agent/employee name, agent login ID/employee ID, and extension number (or queue name for
voice agents on ACD or on ACD Hold.

l Custom cards you create and share
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The Caller ID card is the default card design. You can use this card design, or select the Classic
card or a customized card. You can create new card designs or copy existing card designs and
modify them. For example, you can add or remove text and variables from cards and rearrange the
information displayed. You can share card designs with other employees. When you select a card
design for an agent, employee, or extensionmonitor, it is applied to all monitors of that type.

Selecting and customizing card designs
To select a card design

1. Right-click an open position or timemonitor and click Properties.
2. Click Layout=>Card design.
3. Under Design name, select a card design.
4. Click OK.

To customize cards for position and timemonitors

1. UnderCard design,
l If you want to create a card design, click New.
l If you want to edit an existing card design, select a card design and click Edit.
l If you want to create a card design based on the Caller ID card or the Classic card,
select either card and click Copy.

2. On theNew card designwindow, type the name of the new card design.
3. If you want to share the design with other agents, select Share design.
4. Click OK.
5. Select the card and click Edit.

See Figure 40.
6. AfterState, select a state for the card design.

You can use the same card design for all states or you can customize cards for specific
states, such as ACD, Idle, Make Busy, and Unknown.

7. Under Fields, select a field type and drag and drop it to the card design.
8. If you want to resize the field, click the field and use your pointer to move or resize the field.
9. If you want to change the properties for a field, click the field and change the properties in the

right pane of Card Designer.
10. If you want to change the size of the card design preview, after Zoom, select a different

magnification value from the list.
11. Add additional fields to the card.
12. Select Copy to if you want to copy the current design to the card of a different state.
13. Click OK.

The new card design displays on the Card design list.
14. Click OK.
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Figure 40: Card Designer window

Definingmonitor styles
You can customize the appearance of individual monitor elements. For example, you can configure
the font size and color of column headings or apply a skin of predefined colors and font attributes to
the entire monitor.

To customize the appearance of monitor elements

1. Right-click an openmonitor and click Properties.
2. Click General=>General settings.
3. If you want to change the title of themonitor, after Title, type a name.
4. If you want to scroll horizontally on themonitor, select theEnable horizontal scroll bars

check box.
5. If you want to scroll vertically on themonitor, select theEnable vertical scroll bars check

box.
6. If you want to groupmonitor headings, select theEnable grouping check box.
7. If you want to apply a skin to themonitor, click Layout=>Monitor style.
8. Click Load style and select a skin.
9. Otherwise, underProperties, manually configure the column settings, column font, row

settings, and row-alternate settings.
10. Click OK.
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Adding text to card designs
You can use a text box to add custom text to a card.

To edit text that you have added to a card

1. Select the text box.
Properties displays on the right.

2. UnderProperties, in the box to the right of Text, type the text to be added to the card.
3. Click OK.
4. Click OK.

Grouping data
You can group rows of data in the Queue Now monitor, and other monitors that contain columns. For
example, you can group the data by the ACD count statistic and readily see which agents handled
themost calls, and which agents handled the least calls, as illustrated in Figure 41.

Figure 41: Enable grouping

The Enable grouping option displays a grouping panel to which users drag columns. The grouping
order determines the order in which the rows display.

To enable grouping

1. Right-click an openmonitor and click Properties.
2. Select theEnable grouping check box.
3. Click OK.

Themonitor displays a grouping panel.
4. Drag a column heading to the panel to group by the column heading.
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BUILDINGMARQUEEMONITORS
You can build marqueemonitors to broadcast real-time statistics andmessages and alarm on real-
time contact center performance statistics. With marqueemonitors and wall-mountedmarquee
displays, such as LCD monitors or LED reader boards, you can offer your supervisors and agents
access to important contact center performancemetrics.

To build amarqueemonitor, youmust

l Specify styles for themarqueemonitor.
l Configuremarquee text and variables.

Configuringmarqueemonitor styles
To specify attributes for themarquee background

1. Click theMarquee icon.
The Configuremarquee window opens.

2. Click Add a message. 
The Add amessage window opens.

3. Type a name for themessage.
4. Under Position, select Top, Right, Left, Center, orBottom to specify how themessage is to

be displayed on themarquee.
5. Click Format marquee.

The Format marquee window opens.
6. AfterBackground color, select a color for the background.
7. AfterCell color, select a color for themarquee cells.
8. AfterCell size, specify a value for the size of themarquee cells.
9. AfterCell spacing, select a value for the space betweenmarquee cells.
10. To specify themarquee text font type and color, click Format font.

The Font window opens.
11. Select font attributes.
12. Click OK.
13. If you want themessage and the background of themessage to be displayed using pixels,

select theMatrix style check box.
14. Click OK.
15. Click OK.

Themarquee displays.
NOTE: Youmust configuremarquee text and variables. See "Configuringmarquee text and
variables" on page 119.
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Configuringmarquee text and variables
To configure text and variables for themarquee

1. Right-click themarquee and click Configure marquee.
The Configuremarquee window opens.

2. In theMessage editor text box, type amessage to display on themarquee (for example, type
Calls Wtg =).

3. UnderMessage editor, click theAdd variable button.
The Add/Edit variable window displays.

4. Click Add.
The Configure variable window opens.

5. UnderVariable types, click themonitor type to which the variable applies.
6. UnderVariables, click a variable.

NOTE: The following queue variables will not supply information for Ring Groups:
l %Handled by 1, 2, 3, 4
l Dial Out of queue
l Requeued

NOTE: The Extension variable is available in the list, when you add this variable, this will be
displayed blank in themarquee as extensions are not reported on a SIP platform.

7. UnderDevices, select the check box of a device.
8. Under Thresholds, click Add threshold and specify a value for the upper boundary of the

first threshold.
9. Click OK.
10. For the threshold, underVariable, select a color to be displayed in themarqueemessage

string.
11. For the threshold, underMessage, select a color for the text that will precede the variable in

themarquee text string.
12. After Type a name for the variable, type a name.
13. Click OK.
14. On theConfigure marqueewindow, in theMessage editor text box, position your pointer

where you want to add the variable.
15. You can add variables at the beginning, middle, or end of message strings.
16. On theAdd/Edit variablewindow, double-click the variable to add it to themessage string.

Click theAdd variable button.
The Add/Edit variable window opens.

17. Click theConfigure transition effects button and select the check boxes for the transition
effects to be included.

18. Click OK.
Themarquee displays, showing the text you typed and a real-time value for the performance
variable. You can define additional thresholds for the performance variable, and add additional
variables to themarquee.
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USING CONTACTCENTERCHAT
Contact Center Client provides instant messaging capabilities for both supervisors and agents and
is typically used by contact center employees only. Contact Center Chat provides the online chat
presence of contact center employees, including Online, Offline, and Away. Agents can view the
availability and presence of other contact center employees before they transfer calls or send online
chat messages.

Using Contact Center Chat, you can communicate essential information to one or more agents,
agent groups, or supervisors quickly and securely. You can coach agents and send timely
messages, such as asking an agent to delay going on break when it is busy.

NOTE:

l Youmust have a security role that does not restrict you from gaining access to Contact
Center Chat.

l Youmust log on to Contact Center Client in order to send and receive onlinemessages.
l When you receive amessage it is displayed immediately on top of all open windows.

Sending a Contact Center Chat message
On an extension, agent, or employeemonitor you can right-click an agent’s cell and click Send
instant message to send an onlinemessage to the agent.
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To send a chat message

1. Double-click your presence indicator in Contact Center Client’s Status Bar.
Contact Center Chat opens. (See Figure 42.)

Figure 42: Contact Center Chat

2. Right-click a contact and select Send an instant message.
Alternatively, double-click the contact.
The Conversation window opens.

3. Type amessage.
4. Click Send.

To send a chat message while viewing an extension, agent, or employeemonitor

1. Right-click a cell in an openmonitor and click Send instant message. Alternatively, double-
click the presence indicator in the extension, agent, or employee's cell in themonitor.
The Conversation window displays.

2. Type amessage.
3. Click Send.



Contact Center Client

122

Adding someone to an interaction
To add someone to an interaction

1. On theConversation window, click theAdd Participants button to join this conversation
icon.

2. Double-click a contact to add the contact to the interaction.
3. Click Send.

Responding to a Contact Center Chat message
Agents and supervisors can receive Contact Center Chat messages only if they are logged on to
Contact Center Client. When someone sends a Contact Center Chat message to you, the
Conversation window opens and a desktop notification appears in the bottom-right of your monitor.
The desktop notification shows the name and presence of the employee contacting you and their
message. Figure 43 illustrates a chat notification.

Figure 43: Desktop Chat notification

To respond to a chat message

1. Type amessage.
2. Click Send.

Contact Center Chat sends your response to all chat session participants.

USING CONTACTCENTERCHATWITHSKYPEFOR
BUSINESS
With the addition of Microsoft Skype for Business Server agents and supervisors use Skype for
Business as their default instant messaging client. The presence of all company employees is
natively delivered in Contact Center Client. Contact center employees can view the presence of
both internal and external contacts to determine if they are available to communicate. In addition to
Available, Offline, and Away, employees see In aMeeting, Busy, In a call, Do Not Disturb, Be Right
Back, and other Skype for Business presence indicators.

NOTE: In order to use Contact Center Chat with Skype for Business, youmust enable Contact
Center Chat and have Skype for Business open and running.

If an agent views an employee on a real-timemonitor and notes the employee is online, the agent
can right-click the employee and send an instant message.
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Table 15 provides details on the presence indicators that are available when Contact Center Client is
used in conjunction with Skype for Business Client and Contact Center Chat with Skype for
Business.

2013
PRESENCE

ICON
(LARGE)

2013
PRESENCE

ICON
(SMALL)

STATUS
TEXT DESCRIPTION

Available

The contact is online and can participate in
interactions. Users canmanually set this status, but
the next automatic state change will override this
setting.

Busy

The contact is available, but is engaged by another
activity. Busy contacts will not be routed ACD calls,
but may receive Non ACD calls. Possible activities
include the following:

In a Call—the contact is in a phone, voice, or
video interaction.

In a Meeting—theOutlook calendar shows that
the contact has a scheduledmeeting.

Users canmanually set this status.

Do Not
Disturb

The contact is engaged by another activity and is
unavailable. Contacts in Do Not Disturb will neither
receive ACD or Non ACD calls. Users canmanually
set this status.

Table 15: Skype for Business presence indicator icons
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2013
PRESENCE

ICON
(LARGE)

2013
PRESENCE

ICON
(SMALL)

STATUS
TEXT DESCRIPTION

Away /
Inactive

Be Right
Back

Off Work

The contact is likely unavailable. Possible reasons
include the following:

The contact’s computer has been idle for more
than the away time period setting (5minutes by
default).

NOTE:By default, the transition from Available
to Inactive occurs after 5minutes. Then, after
fivemoreminutes, the status changes to Away if
there is still no activity on the computer.

The contact’s Outlook calendar or Out of Office
Assistant indicates that they are out of the office.

The contact is temporarily unavailable

NOTE:As soon as activity is detected on the
contact’s computer, Ignite automatically resets
the presence status to the appropriate state.

The contact has locked their computer.

The contact has manually set their presence to
Away or Be Right Back.

Users canmanually set this status.

NOTE:When a user manually sets themselves as
Away, they are still available to receive calls, such as
from a transfer.

Offline

The contact is not available. Possible reasons for this
include the following:

The contact has manually set their presence
status to Appear Offline.

The contact has not signed into Skype for
Business.

The contact has blocked you from seeing their
presence status.

Skype for Business is not running on the
contact’s computer.

Table 15: Skype for Business presence indicator icons (continued)
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2013
PRESENCE

ICON
(LARGE)

2013
PRESENCE

ICON
(SMALL)

STATUS
TEXT DESCRIPTION

Presence
unknown

Skype for Business cannot determine the status of
the contact. This status is typically displayed
because the contact’s presence status is unavailable
to Skype for Business, such as for a contact who is
part of an organization that is not a federated partner.

Table 15: Skype for Business presence indicator icons (continued)

Sending an instant message
On an agent or employeemonitor, you can right-click an agent or employee’s cell and click Send
instant message to send an onlinemessage to the agent or employee. You can also send instant
messages usingMicrosoft Skype for Business. Using Skype for Business, you can send instant
messages to individuals or multiple contacts. After initiating an interaction, you can invite additional
contacts to the interaction. For instruction in using Skype for Business, consult your Microsoft
Skype for Business documentation.

NOTE:Supervisors send instant messages to contacts or groups of contacts using Contact Center
Client.

To send an instant message while viewing agents on an extension, agent, or employeemonitor

l Right-click a cell in an openmonitor and click Send instant message.
A Skype for Business Conversation window opens.

HOTDESKING PROFILESETTINGS
When an agent is configured as aMitel hot desking agent, the agent can sit at any extension on the
network and log on to the extension. After the agent is logged on, the agent takes control of the
extension. The agent's Contact Center Client and soft phone real-time profile settings are available.
Any previous associations with the extension are taken out of service. When an agent logs off, the
agent disconnects from the extension and the default settings for the extension are restored
automatically.

WARNING: If an external hot desk agent is using a personal phone to handle calls, incoming calls
that are not answered could reach their personal voicemail.
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POSTING FEEDBACKANDVIEWING OURFORUMS
Mitel has partnered with UserVoice, a third-party service, to host customer suggestions on
https://micontactcenter.uservoice.com. When you post an idea to our feedback forum, others will be
able to subscribe to it andmake comments.

Our forums enable you to send feedback directly to the people building the product. While we cannot
comment on every suggestion, feedback is analyzed and considered for future releases.

NOTE: Please do not use the forums to submit product defects. To submit product defects, please
contact your administrator or dealer.

Feedback can also be submitted directly to Mitel without posting the suggestion on the forums. For
more general feedback, you can also provide a rating of your experience with MiContact Center
Business.

NOTE:Please do not use feedback for requesting customer assistance. For assistance with
MiContact Center Business, please contact your dealer or Mitel Customer Support.

To post feedback and view our forums

1. In YourSite Explorer, click File=>Feedback.
2. Click Got an idea? Tell us.

OR
Access the following URL: https://micontactcenter.uservoice.com.

To submit feedback directly

1. In YourSite Explorer, click File=>Feedback.
2. Click Contact Us.

To rate your Mitel experience

1. In YourSite Explorer, click File=>Feedback.
2. Click Rate us.

ACCESSING REAL-TIME INFORMATIONWITH IGNITE
(WEB)

Ignite (WEB) enables real-timemonitoring of employees, agents, queues, and callback requests.
The Ignite (WEB) real-timemonitors do not duplicate those available in Contact Center Client but,
instead, offer a succinct set of themost essential statistics in the highly accessible online format of
Ignite (WEB).

The following real-timemonitors are available in Ignite (WEB):

l Employee State
l Agent State
l Queue Now
l Callback Requests

https://micontactcenter.uservoice.com/
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To access the real-timemonitors in Ignite (WEB)

1. In Ignite (WEB), click Dashboards.
2. Click the down arrow and select the dashboard from the list that contains themonitor you

want to display.

NOTE:

l Alarms are not supported for real-timemonitors in Ignite (WEB).
l Access to real-timemonitors is determined by administrator-set security roles.

To learn how to add and configure settings for real-timemonitors in Ignite (WEB), see "Configuring
Ignite (WEB) dashboards" on page 244.

MONITORING EMPLOYEESTATE IN IGNITE (WEB)
The Employee Statemonitor available in Ignite (WEB) enables you to view activity and, if enabled
for Interactive Contact Center, adjust presence for individual employees in your contact center.

You can view the following real-time employee information:

l Employee name, reporting number, and avatar
l ACD availability and state (with colored state icon)
l Busy duration for the day
l DoNot Disturb duration for the day
l Number of interactions handled for the day (voice, email, chat, SMS, openmedia as
applicable)

l Date/Time of first login
l Total shift duration

NOTE:Only one employee at a time can display in the Employee Statemonitor but you can
optionally add several employeemonitors to a dashboard to access information for multiple
employees.

The Employee Statemonitor in Ignite (WEB) is accessible from your Ignite (WEB) Dashboard. To
learn how to add and configure settings for the Employee Statemonitor in Ignite (WEB), see
"Configuring Ignite (WEB) dashboards" on page 244.

MONITORING AGENTSTATE IN IGNITE (WEB)
The Agent Statemonitor available in Ignite (WEB) enables you to view the real-time state of agents
in your contact center and, if enabled for Interactive Contact Center, adjust agent presence.

Each column lists agents in order of time in state, with the longest in state at the top. For example,
the agent at the top of the Idle column is the next longest idle agent and should receive the next
inbound interaction.

The following table lists and describes real-time agent state information that displays in the Agent
Statemonitor in Ignite (WEB).
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STATISTIC DESCRIPTION

ACD includes agents in ACD and ACD Hold

Idle includes agents who are available for ACD but currently not handling any
interactions

Non ACD includes agents in Non ACD, Non ACD Hold, Outbound, andOutbound Hold

Unavailable includes agents in Do Not Disturb, Busy, Work Timer, and Reseize Timer

Not Present includes agents who are logged in as an agent but not present in any agent groups

Offline includes agents who are logged in as an ACD agent

Table 16: Agent State monitor statistics - Ignite (WEB)

The Agent Statemonitor in Ignite (WEB) is accessible from your Ignite (WEB) Dashboard. To learn
how to add and configure settings for the Agent Statemonitor in Ignite (WEB), see "Configuring
Ignite (WEB) dashboards" on page 244.

MONITORING QUEUES IN IGNITE (WEB)
TheQueue Now monitor available in Ignite (WEB) enables supervisors to view queue or queue group
statistics and a summary of current agent states for each queue or queue group in real time.

Queue statistics includeOffered, Service Level %, Interactions Waiting, Requeued, and Longest
Waiting. Handled, Interflowed, and Abandoned counts can also be accessed by hovering over
‘Offered’ for each queue or queue group.

The following table lists and describes queue statistics that display in the Queue Now monitor in
Ignite (WEB).
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STATISTIC DESCRIPTION

Offered the total number of interactions offered to the queue or queue
group

Service Level %

for a queue, this is the percentage of interactions handled within
the queue’s Service Level Time value over the day

for a queue group, this is the lowest percentage of interactions
handled within the queue’s Service Level Time value over the day
across all queues

Contacts Waiting
the current number of interactions in queue waiting for amember
to become available, including those listening to silence, music,
or recorded announcements

Requeued
the total number of ACD interactions requeued

NOTE: This statistic displays information for ACD paths only.
Statistics for Ring Groups display as '0'

Longest Waiting the current duration, in minutes and seconds, of the interaction
waiting the longest in queue or queue group

Handled the total number of ACD interactions handled by members

Interflowed

the total number of ACD interactions interflowed

interflow is amechanism that directs an interaction waiting in
queue to another answer point

NOTE: If an interaction waiting in queue is redirected before the
queue's short abandoned time has elapsed, the queue is pegged
with a Queue Unavailable count rather than an interflowed count.
In order for the Interflowed peg to occur, the redirectionmust
occur after the short abandoned time has elapsed

Abandoned

the total number of interactions abandoned before being
answered by members

NOTE:Abandoned does not peg short abandons as abandoned
interactions in the Queue Now monitor. The Abandoned column
in the Interactive Visual Queuemonitor displays all abandoned
interactions. Because of this difference, youmay notice
discrepancies between the abandoned call information in these
twomonitors

Table 17: Queue Now monitor statistics - Ignite (WEB)
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The current number of agents, by state, also displays for each queue or queue group for the following
agent states:

l Idle: includes agents who are available for ACD but not currently handling any interactions
l ACD: includes agents in ACD and ACD Hold
l Non-ACD: includes agents in Non ACD, Non ACD Hold, Outbound, andOutbound Hold
l Unavailable: includes agents in Do Not Disturb, Busy, andWork Timer

TheQueue Now monitor in Ignite (WEB) is accessible from your Ignite (WEB) Dashboard. To learn
how to add and configure settings for the Queue Now monitor in Ignite (WEB), see "Configuring
Ignite (WEB) dashboards" on page 244.

VIEWING ANDMANAGING CALLBACKS IN IGNITE (WEB)
When licensed for IVR, the Callback Requests monitor, available in Ignite (WEB), enables you to
interact with callbacks andmonitor their state in real time.

The Callback Requests monitor enables users to requeue, reject, and delete callbacks from within
themonitor. Requeued callbacks are re-entered into their queue. Rejected callbacks are removed
from the queue and will not be offered to employees. Deleted callbacks are removed from the
monitor, but are not removed from the system.

To requeue, reject, or delete a callback

l In the row of the call you want to interact with, in theActions column, left-click either
Requeue, Reject, orDelete.

The following table lists and describes the statistics available in the Callback Requests monitor.

STATISTIC DESCRIPTION

Name the name of the caller

Number the phone number provided by the caller

Status the status of the callback

Offer At the specific time the callback will be executed

Received the specific time the caller submitted the callback request

Preferred
Time

the time the caller is available to receive the callback (if the caller does not enter a
preferred time, this columnwill be blank)

Destination the queue, agent, and extension for which the callback is intended

# of
Attempts the number of times the callback has been attempted

Last
Attempted the specific time the last callback attempt to the caller was made

Actions within this column, you can choose to requeue, reject, or delete a callback

Table 18: Callback Requests monitor statistics - Ignite (WEB)
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The Callback Requests monitor in Ignite (WEB) is accessible from your Ignite (WEB) Dashboard. To
learn how to add and configure settings for the Callback Requests monitor in Ignite (WEB), see
"Configuring Ignite (WEB) dashboards" on page 244.



Chapter 6
FORECASTING

Forecasting terms
Forecasting tool
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FORECASTING
Forecasting is the basis of estimating required resources to handle a contact center’s workload.
Using historical data generated by the ACD routing system for both voice and other media types,
forecasting allows you to adjust key modifiers to predict the number of agents required, by interval,
to handle the predicted workload.

The Forecasting tool available in Contact Center Client andWorkforce Scheduling enables users to
quickly choose historical data from both voice andmultimedia queues or queue groups to use in the
forecast, providing average transaction traffic by day of week, by media, as well as by historic
manned agents and handling statistics for user-selected intervals of time. Supervisors can create
forecasts based on historic contact center volumes andmanually adjust various modifiers to
generate hypothetical or future anticipated traffic scenarios, optimizing the balance between the
agents required to handle the anticipated traffic with the expected handling time, wrap up time and
Service Level objectives. The Forecasting tool lets you adjust key statistics together with intra-day
contact volumes rather than only daily statistics which provides amuchmore accurate output of
agents required per interval. For example, youmay have a situation where calls coming into your call
center aremore complex earlier in the day and/or earlier in the week creating a higher demand for
agents to be available at these times. It is possible that handling time drops throughout the day and
the demand for agents reduces, allowing for alternate options for agents such as off line work, team
meetings or performance reviews.

Your ability to forecast is limited only by the available ACD routing data collected and available in
your SQL database. For example youmay choose to take the last few weeks to help predict the next
few weeks or you could take the last year to help predict the average traffic per week, or youmight
want to only take the period of time in the past where you ran a particular campaign/season to
anticipate the amount of traffic to expect for a similar upcoming campaign/season, etc. After you run
a forecast, you could examine the data andmake adjustments based on current or anticipated
contact center conditions. You could then tweak the forecast as required.

NOTE:RingGroups are not supported with Forecasting, either as queues or as amember of a
reporting queue groups.
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FORECASTING TERMS
Conducting a forecast involves accurately estimating Time to Handle, Wrap Up Time, and Contacts
Offered values. The following terms are used in forecasting resource requirements:

l Service Level percent
Service Level Percent = Service Level Count ÷ ACD offered
For calls and chats, the Service Level Percent is the number of interactions that are handled,
abandoned, and interflowed before a defined threshold time (Service Level time), compared to
the total number of Multimedia Contact Centers handled, abandoned, and interflowed. The
Service Level Percent = (Handled + Abandoned (long) + Interflowed (long)) within the Service
Level time ÷ Total (Handled + Abandoned (long) + Interflowed (long)).
For email and SMS, the Service Level Percent is the number of interactions that are handled
and interflowed before a defined threshold time (Service Level time), compared to the total
number of interactions handled and interflowed. The Service Level Percent = (Handled +
Interflowed (long)) within the Service Level time ÷ Total (Handled + Interflowed (long)).

l Service Level time
Service Level Time is the time used in calculating the Queue Service Objective. For example,
your Queue Service Objectivemay require queuemembers to handle 80% of interactions
within 120 seconds. 120 seconds is the Service Level Time. Queue Service Objectives,
which includes Service Level Time, are specified for individual queues.

l Wrap Up time
WrapUp Time is a real-time and reporting statistic detailing the total time an agent spends in
theWork Timer state. TheWrap Up Time is a standardized period. If an agent requires
additional time to complete paperwork or online transactions, the agent can leave the ACD
queue temporarily for this purpose.

l Agent Efficiency percent
Agent Efficiency percent is the percentage of time agents spend on ACD interactions relative
to the time agents are scheduled to work. Agent efficiency is calculated using a straight linear
relationship. For example, 50% agent efficiency means that twomore agents are required to
handle the forecasted workload. An Agent efficiency percentage of 100 is unrealistic. Agents
routinely take breaks, perform other Non ACD duties, make outgoing calls, and place
themselves in Make Busy.

l Contacts Offered
You can predict the queuemember requirement for your Service Level percent and Service
Level time targets by applying the Erlang C equation to the estimated Call Load and average
ACD Handling Time.

l Manned Agents
Manned Agents is the average number of agents who were logged on for the interval of time
being forecasted.
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l Average Handle Time
Average Handle Time is the average time queuemembers spend handling interactions, and is
determined by comparing the interaction duration to the number of interactions offered.
NOTE:

l The Average Handle Time in the Forecasting tool is calculated differently than the
Average Handling Time in CCMWeb reports, which is determined by comparing
interaction duration to the number of interactions answered.

l The Daily Average Handle Time in the Forecasting tool is calculated from the interval
rows in the forecast andmay differ from the Average Handling Time for that day in
contained in a report.

l Time to Handle
Time to Handle is the average time calls wait in queue before being handled.

l ACD Handling Time
ACD Handling time is the talk time plus the hold time. If a queuemember calls a supervisor in
search of more information (while the caller is on hold) and/or transfers or conferences the call,
the system adds these times to the ACD Handling Time value.

l Call Load
The term Call Load is to the combined effect of the number of interactions received by the
ACD queue and their duration, or the calls offered x (average ACD Handling Time + average
Wrap Up Time).

FORECASTING TOOL
The Forecasting tool is accessed via Contact Center Client. If you are licensed forWorkforce
Scheduling, you can also access it in that application under the Tools tab. In order to access the
Forecasting tool, your security role must have the 'May manage Forecasting' option enabled.

You use the Forecasting tool to create forecasts based on historical contact center traffic volumes.
After loading historical data into the tool, you can perform 'what-if' scenarios and optimize the
balance between the agents scheduled and your Service Level objectives.

The Forecasting tool offers a tabbed interface for viewing and setting historical data for each day of
the week. If more than onemedia type has been included in the historical data, each day’s tab will
have a section for eachmedia type included in the historic data. The forecast grid is divided into rows
based on the interval time selected when loading historical data, enabling users to adjust statistics
by 15, 30, or 60minute intervals. The statistics have Historic and Current values, which display the
original values from the loaded historical data and the current values after user modification
respectively.

After a forecast has been performed, each day lists the agents required for each interval. Figure 44
shows the Forecasting tool.
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Figure 44: Forecasting window

To forecast resource requirements you

1. Load historical data.
See "Loading historical data" on page 136.

2. Modify historical data if required.
See "Modifying historical data" on page 137.

3. Perform a forecast.
See "Performing forecasts" on page 142.

4. Export the forecast.
See "Exporting forecasts" on page 143.

To access the Forecasting tool

1. Click Tools in the Contact Center Client ribbon.
2. In theData Mining section, click Forecasting.

LOADING HISTORICALDATA
When you load historical data, you include data from a queue or queue group over a historical period
that best represents the contact center activity for the time period for which you are trying to
forecast. You can select one or more specific dates and/or date ranges when loading historical data.
You can select sequential or non-sequential dates (for example, Monday, Wednesday, and Friday) to
use in the forecast. You can also exclude specific dates from within your date range.
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NOTE:

l Users should identify and exclude any outliers or extreme values from the time period from
which they are loading historical data, as thesemay give artificial values.

l Historical data for agents can be validated by comparing it to the queue and queue group by
period reports for the same periods.

l RingGroups are not supported with Forecasting, either as queues or as amember of a
reporting queue groups.

The following procedure takes place in an open Forecasting tool window.

To load historical data

1. Click Load historical data.
The Forecasting window opens.

2. UnderQueues orQueue groups, click on the queue or queue groups you want to use as the
source of historical data.
NOTE: You can load historical data for a queue or queue group. If you are using the forecast to
build a schedule, select historical data from the same queue group with which the schedule is
associated. This data will best represent the agents required for your schedule.

3. If you want to include or exclude data from a specific date, underHistorical date(s) for the
forecast, select Specific day and then select a date.

4. If you want to include or exclude data from a date range, click Date range and specify a range
of dates.

5. If you are including the data from the specified date(s), click Include dates.
6. If you are excluding the data from the specified date(s), click Exclude dates.
7. Repeat steps 3-6 until you have specified the date(s) or date range(s) from which you will

derive your historical data.
8. AfterStart hour and End hour, select the time frame for historical data.
9. After Interval, select the schedule interval: 15, 30, or 60minutes.

The Interval value, in minutes, is the time increment by which the forecast will be displayed. It
is recommended that you select an interval that matches the increments in which you
schedule your employees. For example, if you schedule your employee shifts in 30minute
increments, select 30minutes as the Interval value.

10. Click Submit.

MODIFYING HISTORICALDATA
After loading your historical data, you canmodify the values of Contacts Offered and Average
Handle Time to generate different forecast results based on themodified values. You can also
modify values after performing forecasts to obtain different forecasts of required agents. The
historical values for data are always displayed, regardless of modifications, for comparison.
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Modifying Average Handle Time
You canmodify the Average Handle Time value for an interval, a day, or several days
simultaneously. When you select amodification to apply to a value, either the Historic or Current
value, it is applied as the new Current value. You cannot change the Daily Average Handle Time, but
you can use it to modify the Average Handle Time of other intervals.

The following procedures outline how to

l Modify the Average Handle Time parameter on the forecast grid
l Modify an interval’s Average Handle Time parameter
l Modify the Average Handle Time parameter using the Historic Daily Average Handle Time
parameter

The following procedures take place in an active Forecasting tool window.

Tomodify the Average Handle Time parameter on the forecast grid

1. Click Modify...=>Average Handle Time.
Alternatively, select an interval row, click the cell for Current Average Handle Time, and click
the… button.
See Figure 45.

2. UnderSpecify the Average Handle Time value(s), specify how you want to modify
Average Handle Time:

l Increase or decrease Average Handle Time by a specific number of seconds
l Increase or decrease Average Handle Time by a specific percentage
l Set the Average Handle Time to a specific number of seconds

3. UnderApply the changes to the following data source, specify if you want to have the
modification applied to the original value or the current grid value.

4. UnderApply to days, select the days for which you want to modify Average Handle Time.
5. UnderApply to media type, select themedia types for which you want to modify Average

Handle Time.
6. Click Apply.

Tomodify an interval’s Average Handle Time parameter

1. Select an interval row, click the cell forCurrent Average Handle Time.
2. Set the Average Handle Time parameter for the interval.

Tomodify the Average Handle Time parameter using the Historic Daily Average Handle Time
parameter

1. Click the… button after Historic Daily Average Handle Time.
2. UnderSpecify the Average Handle Time value(s), specify how you want to modify the

Historic Daily Average Handle Time:
l Increase or decrease Average Handle Time by a specific number of seconds
l Increase or decrease Average Handle Time by a specific percentage
l Set the Average Handle Time to a specific number of seconds
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3. UnderApply to days, select the interval(s) for which you want to apply themodified Historic
Daily Average Handle Time.

4. Click Apply.

Figure 45: Average Handle Time window

Modifying Contacts Offered
You canmodify the Contacts Offered value for one or several time intervals simultaneously. When
you select to modify a value, either Historic or Current, it is applied as the new Current value.

This section explains how to:

l Modify the Contacts Offered parameter on the forecast grid
l Modify an interval’s Contact Offered parameter

The following procedures take place in an active Forecasting tool window.
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Tomodify the Contacts Offered parameter on the forecast grid

1. Click Modify...=>Contacts Offered.
See Figure 46.

2. UnderSpecify how you want to change the Contacts Offered value(s), specify how you
want to modify Contacts Offered:

l Increase or decrease Contacts Offered by a specific number of calls
l Increase or decrease Contacts Offered by a specific percentage
l Set the Contacts Offered to a specific number of call

3. UnderApply the changes to the following data source, specify if you want to modify the
original value or the current grid value.

4. UnderApply to times, select the days and time interval for which you want to modify
Contacts Offered.

5. UnderApply to media type, select themedia types for which you want to modify Contacts
Offered.

6. Click Apply.

Tomodify an interval’s Contacts Offered parameter

1. Select an interval row, click the cell forCurrent Contacts Offered.
2. Set the Current Contacts parameter for the interval.

Figure 46: Contacts Offered window
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Modifying the weekly total for Contacts Offered
You canmodify the Contacts Offered values for an entire week simultaneously. Modifying these
values changes the number of Contacts Offered while maintaining the same proportion of calls
across all time intervals. For example, if you increase the weekly total by 10 percent, an interval with
10 calls will change to 11. However, an interval with zero calls will remain zero.

The following procedure takes place in an active Forecasting tool window.

Tomodify the Contacts Offered parameter on the forecast grid

1. Click Modify...=>Weekly total.
See Figure 47.

2. UnderSpecify how you want to change the weekly total, specify how you want to modify
Contacts Offered over the week:

l Increase or decrease the weekly total of Contacts Offered by a specific number of
contacts

l Set the weekly total of Contacts Offered to a specific number of contacts
3. UnderApply to totals, specify if you want to modify the original values or the current grid

values.
4. Click Apply.
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Figure 47: Weekly total for Contacts Offered window

PERFORMING FORECASTS
When you perform a forecast, you receive the required agents based on both the historical and
current values. If you adjust any of the values in your historical data, youmust perform the forecast
again.

NOTE: It is recommended that you save your forecast as an Excel file to preserve your settings to
use or compare with the next forecast youmake.
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To run a forecast

1. Specify the Service Level %, Service Level Time, Wrap Up Time, and Agent Efficiency % you
expect for the queue or queue group.

2. Click Perform forecast.
You can perform what-if scenarios on the historical data using different Service objectives
statistics until you are satisfied with the forecast.

EXPORTING FORECASTS
After performing a forecast, you can export it as aMicrosoft Excel spreadsheet or export the forecast
toWorkforce Scheduling.

Saving forecasts as Excel files
After you generate forecast data you can export it to aMicrosoft Excel .xlsx worksheet. If your
forecast has different media types, eachmedia type will have its ownworksheet in the .xlsx file.

To export a forecast as an Excel file

1. Click Export Forecast.
2. Click Microsoft Excel.
3. Click Export.

The forecast opens in aMicrosoft Excel spreadsheet you canmodify and save.

Exporting forecasts toWorkforce Scheduling
If you are licensed forWorkforce Scheduling, after you generate forecast data, you can export it into
aWorkforce Scheduling schedule.

When scheduling for agents who handle a particular media type, it is recommended that you export
forecasts that use solely data from that media type. For example, if you are forecasting based on
historical data from an email queue, the forecast should be exported into aWorkforce Scheduling
schedule that only handles email ACD interactions.

To export a forecast into aWorkforce Scheduling schedule

1. Click Export Forecast.
2. SelectWorkforce.
3. For eachmedia type, select the schedule for which to apply the forecast.

NOTE:Eachmedia typemust be exported to a different schedule.
4. Click Export.



Chapter 7
INTERACTIVE CONTACT CENTER

Supervisors and Interactive Contact
Center
Agents and Interactive Contact Center
Employee and agent control
Extension control
Queue control
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INTERACTIVE CONTACT CENTER
Interactive Contact Center is a feature that enables supervisors to control the availability of agents,
extensions, and queues, and enables agents to control their own availability.

Access to Interactive Contact Center abilities is determined by security role settings. Employees
must be associated with the 'May control my real-time status in Interactive Contact Center' security
role setting in order to change their state using applicable MiContact Center Business client
applications.

SUPERVISORS AND INTERACTIVE CONTACT CENTER
Using Interactive Contact Center, supervisors can

l Control the availability of agents and ACD queues
l Log agents on and off of the system
l Have agents leave their agent groups and join other agent groups. Agent groups are assigned
to queues so, in this way, agents can bemoved from one queue to another as needed

l Have extensions leave their Ring Groups and join other Ring Groups
l Place agents in Make Busy
l Place agents in Do Not Disturb
l Place extensions into DoNot Disturb
l Place queues in DoNot Disturb
l Cancel Work Timer
l Cancel Reseize Timer

An employee's agent can be assigned tomultiple agent groups, which can be associated tomultiple
queues. In order to move the agent from one queue to another queue, the supervisor has the agent
leave one agent group and join another agent group.

AGENTS AND INTERACTIVE CONTACT CENTER
Using Interactive Contact Center, agents can

l Log themselves on and off of the system
l Remove themselves from agent groups and place themselves into other agent groups. Agent
groups are assigned to queues so, in this way, agents canmove themselves from one queue
to another as needed

l Place themselves in Make Busy
l Place themselves in Do Not Disturb

Every time agents leave their desks they must set themselves into either Make Busy or Do Not
Disturb and apply the applicable reason code. This enables supervisors to track agents' Do Not
Disturb and Make Busy activity in reports.
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EMPLOYEE ANDAGENT CONTROL
Using Interactive Contact Center and Contact Center Client, you can control agents on the following
monitors:

l Agent State by Position and Employee State by Position
l Agent State by Time and Employee State by Time
l Agent Shift

Agent control gives you control over individual agents. Monitor control gives you control over all of
the agents on amonitor. All of the agents on themonitor are affected simultaneously by the action
you take.

If you have Context Sensitivity enabled for monitors, the Agent Control andMonitor Control tabs
display in the Contact Center Client ribbon when you have any of the abovemonitors open. You can
perform actions using either a right-click and select method within themonitor or by selecting an
agent or an empty cell (monitor control) and accessing the actionmenu in the Agent or Monitor
Control tab views. (See Figure 48.)

Using Interactive Contact Center and Ignite (WEB), you can control agents and employees in the
followingmonitors:

l Employee State
l Agent State

NOTE:Context sensitivity andmonitor control are not supported with Ignite (WEB). You can only
alter the state for one employee or agent at a time.
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Figure 48: Agent Shift - Agent Control tab options

AGENTSANDAGENTGROUPPRESENCE
Agents can be assigned tomultiple agent groups, which are associated with different queues. When
agent groups are created, an employee’s agents are assigned a default group presence, either
Present or Absent. To handle interactions the employee canmake themselves present in their agent
groups using either Contact Center Client or Ignite.

It is important to note that agents may join or leave agent groups but not queues. Agents become
absent from a queue indirectly if they leave all agent groups associated with that queue. An agent
who is present in an agent group which is associated to all queues would be disassociated from all
queues simultaneously if they became absent in their agent group
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HIDING THEMONITORCONTROLOPTION
Interactive Contact Center enables you tomanage the presence of all devices in amonitor using
Monitor Device Control. If you do not want to usemonitor control, you can hide this option so it is not
accessible.

To hide theMonitor control option

1. In Contact Center Client, click File=>Options.
2. UnderDevice control, clear theDisplay monitor device control option check box.
3. Click OK.

LOGGING ONANAGENT - CONTACTCENTERCLIENT
NOTE:

l An ACD Hot Desking Agent must enter an extension number each time the agents logs on to
the ACD routing system using Interactive Contact Center. The agent cannot rely on the
extension number last used when logging on. This is because the ACD data stream unifies
the agent ID and the extension. After a Hot Desking Agent logs on or off of the ACD routing
system using Interactive Contact Center, sometimes the Interactive Contact Center agent
controls are not available to the agent for two to fiveminutes.

l Youwill be unable to log on an agent to the system if there are no available user licenses.
l If your contact center participates in the use of PINs, supervisors with the correct Class of
Service do not require an agent’s PIN to interactively log in a Hot Desking Agent.

l Depending on security roles and telephone switch settings, employees who are licensed as
Advanced Supervisor or System Administrator may not be prompted to enter a PIN when
logging into Interactive Contact Center, Softphone, or PhoneSet Manager.

l If a Hot Desking Agent logs into an extension that serves as the overflow point for a Ring
Group, calls to that Ring Group will not be offered to the extension and will remain queued or
ringing until abandoned or answered.

l Hot desking users logging into a RingGroup extensionmust also be amember of the Ring
Group to ensure accurate reporting.

You log employee voice agents in and out in either an open Employee or Agent Monitor in Contact
Center Client. Multimedia agents are not logged in with voice agents.

To log in an agent in an open Employeemonitor

l Right-click the cell of an employee and click Employee control=>Log in=>voice agent.
Alternatively, select the employee cell in an openmonitor, click Log in from theEmployee
Control tab on the Contact Center Client ribbon, and select the voice agent.
NOTE:When you log in an employee’s voice agent, youmust enter the extension for the
agent. See the procedure below.

To log in an agent by extension in an open Employeemonitor

1. Right-click the cell of an employee and click Employee control=>Log in=>By extension.
2. If the employee has multiple voice agents, select the agent to log in from the drop-down list.
3. Type theAgent’s extension.
4. Click OK.
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To log in an agent in an open Agent monitor

l Right-click the cell of a voice agent who is not logged into and click Agent Control=>Log
in=>voice agent. Alternatively, select the agent cell in an openmonitor and click Log in from
the Contact Center Client ribbon.
NOTE:When you log in a voice agent, youmust enter the extension for the agent. See the
procedure below.

To log in an agent by extension in an open Agent monitor

1. Right-click the cell of a voice agent and click Agent control=>Log in=>By extension.
2. If the employee has multiple voice agents, select the agent to log in from the drop-down list.
3. Type theAgent’s extension.
4. Click OK.

LOGGING OFFANAGENT - CONTACTCENTERCLIENT
You can log off an employee from all media in an Employeemonitor or Agent monitor. Logging off an
agent logs off all of the employee’s voice agents and sets the employee’s multimedia agents to
Absent in all their agent groups. If the employee is logged into their soft phone in Contact Center
Client, they will also be logged out of the soft phone.

The following procedures take place in either an open Employeemonitor or an open Agent monitor in
Contact Center Client.

To log off all of an employee's agents in an open Employeemonitor

l Right-click the cell of an employee and click Employee control=>Log off. Alternatively,
select the employee cell in an openmonitor and click Log Off from theEmployee Control
tab on the Contact Center Client ribbon.

To log off an agent in an open Agent monitor

NOTE: Logging off an employee's agent logs off all of the employee's agents simultaneously.

l Right-click the cell of an agent and click Agent control=>Log off. Alternatively, select the
agent cell in an openmonitor and click Log Off from theAgent Control tab on the Contact
Center Client ribbon.

To log off all employees' agents in an open Employeemonitor

1. Right-click themonitor and click Monitor control=>Log off.
Alternatively, click theMonitor Control tab in the Contact Center Client ribbon and select
Log Off.

2. Click Yes.

To log off all agents in an open Agent monitor

1. Right-click themonitor and click Monitor control=>Log off.
Alternatively, click theMonitor Control tab in the Contact Center Client ribbon and select
Log Off.

2. Click Yes
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LOGGING ONANAGENT - IGNITE (WEB)
When you log on an agent in Ignite (WEB), youmake them available to receive voice interactions.

The following procedure takes place in either an Agent State or Employee Statemonitor in Ignite
(WEB).

To log on a voice agent

1. In themonitor, select the agent you want to log on.
2. Click State=>Available.
3. Enter the agent’s extension and PIN (if enabled) and click Login.

NOTE: This step is not required if the agent is set to automatically log in when the ‘Available’
state is selected.

LOGGING OFFANAGENT - IGNITE (WEB)
When you log off an agent in Ignite (WEB), youmake them unavailable to receive all media
interactions, including voice, email, chat, SMS, and openmedia.

The following procedure takes place in either an Agent State or Employee Statemonitor in Ignite
(WEB).

To log off an agent

1. In themonitor, select the agent you want to log off.
2. Click State=>Offline.

JOINING ANDLEAVING AGENTGROUPS - CONTACT
CENTERCLIENT
After logging into Contact Center Client, agents can use Interactive Contact Center to control their
presence status in agent groups. Optionally, supervisors can use Interactive Contact Center to
control the presence status of agents in specific agent groups.

NOTE:

l An agent's ACD hot desk line remains in service while they are logged in as an ACD hot desk
user even if they are not present in any ACD groups and not receiving ACD calls.

To join an agent to or have an agent leave an agent group in an open Employeemonitor

1. Right-click the cell of an employee and click Employee control=>Join/Leave Agent
Group=>[Agent].
Alternatively, select the cell of an employee and in theEmployee Control tab of the Contact
Center Client ribbon, click Join/Leave agent group=>[Agent].

2. Select the agent group(s) to which you want the employee’s agent(s) to join or deselect the
agent group(s) to have the employee’s agent(s) leave the agent groups.

3. Click OK.
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To join an agent to or have an agent leave an agent group in an open Agent monitor

1. Right-click the cell of an agent who is logged on and click Agent control=>Join/Leave
Agent Group.
Alternatively, select the cell of an agent and click Join/Leave Agent Group from the Agent
Control tab in the Contact Center Client ribbon.

2. Select the agent group(s) to which you want the agent(s) to join or deselect the agent group(s)
to which you want the agent(s) to leave.

3. Click OK.

JOINING ANDLEAVING AGENTGROUPS - IGNITE (WEB)
After signing into Ignite (WEB) and logging into their phone, agents can use interactive Contact
Center to control their presence in agent groups. Optionally, supervisors can use Interactive Contact
Center to control the presence status of agents in specific agent groups from within the Agent and
Employee Statemonitors in Ignite (WEB).

The following procedures take place in either an Agent State or Employee Statemonitor in Ignite
(WEB).

To join an agent to an agent group

1. In themonitor, select the agent for which you want to modify agent group presence.
2. Click Agent Groups.
3. Hover over the agent group's avatar and select Join All.
4. Click Update.

To remove an agent from an agent group

1. In themonitor, select the agent for which you want to modify agent group presence.
2. Click Agent Groups.
3. Hover over the agent group’s avatar and select Leave All.
4. Click Update.

To join an agent to or remove an agent from all agent groups

1. In themonitor, select the agent for which you want to modify agent group presence.
2. Click Agent Groups.
3. To join an agent to all agent groups, click Join All=>Update.
4. To remove an agent from all agent groups, click Leave All=>Update.

Tomake an agent available or unavailable to answer interactions of a specific media type

1. In themonitor, select the agent for which you want to modify agent group presence.
2. Click Agent Groups.
3. To become available to answer interactions of a specific media type, click themedia icon in

the agent group so the icon displays in blue.
4. To become unavailable to answer interactions of a specific media type, click themedia icon in

the agent group so the icon displays in grey.
5. Click Update.
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PLACING EMPLOYEES INMAKEBUSY - CONTACTCENTER
CLIENT
NOTE: Employees inWork Timer can apply Busy/Make Busy or DND, but will remain in aWork
Timer state until theWork Timer expires or is cancelled. If Classification Codes are required for the
queue and theWork Timer expires without a Classification Code being entered, aNon-Compliant
Classification Code will be applied to the call..

Placing employees into Make Busy places both employees and all of their agents into Make Busy.

The following procedures take place in either an open Employeemonitor or an open Agent monitor in
Contact Center Client.

To place an employee in an open Employeemonitor in Make Busy

l Right-click the cell of an employee and click Employee control=>Set Make Busy=>reason
code. Alternatively, select an empty cell in an openmonitor and click Set Employee Make
Busy=>reason code from theEmployee Control tab in the Contact Center Client ribbon.

To place all employees in an open Employeemonitor in Make Busy

1. Right-click themonitor and click Monitor control=>Set Make Busy=>reason code.
Alternatively, select an empty cell in an openmonitor and click Set Make Busy=>reason
code from theMonitor Control tab in the Contact Center Client ribbon.

2. Click Yes.

To place an employee in an open Agent monitor in Make Busy

l Right-click the cell of an agent and click Agent control=>Set Employee Make
Busy=>reason code. Alternatively, select the agent cell in an openmonitor and click Set
Employee Make Busy=>reason code from the Agent Control tab in the Contact Center
Client ribbon.

To place all employees in an open Agent monitor in Make Busy

1. Right-click themonitor and click Monitor control=>Set Employee Make Busy=>reason
code. Alternatively, select an empty cell in an openmonitor and click Set Make
Busy=>reason code from theMonitor Control tab in the Contact Center Client ribbon.

2. Click Yes.
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REMOVING EMPLOYEESFROMMAKEBUSY - CONTACT
CENTERCLIENT
Removing employees fromMake Busy removes both employees and all of their agents fromMake
Busy.

The following procedures take place in either an open Employeemonitor or an open Agent monitor in
Contact Center Client.

To remove an employee in an open Employeemonitor fromMake Busy

l Right-click the cell of an employee whose agents are in Make Busy and click Employee
control=>Remove Make Busy. Alternatively, select an empty cell in an openmonitor and
click Remove Make Busy from theEmployee Control tab in the Contact Center Client
ribbon.

To remove all employees in an open Employeemonitor fromMake Busy

1. Right-click the cell of an employee who is in Make Busy and click Monitor
control=>Remove Make Busy. Alternatively, select an empty cell in an openmonitor and
click Remove Make Busy from theMonitor Control tab in the Contact Center Client ribbon.

2. Click Yes.

To remove an employee in an open Agent monitor fromMake Busy

l Right-click the cell of an agent in Make Busy and click Agent control=>Remove Make
Busy. Alternatively, select the agent cell in an openmonitor and click Remove Make Busy
from theAgent Control tab in the Contact Center Client ribbon.

To remove all employees in an open Agent Monitor fromMake Busy

1. Right-click the cell of an employee and click Monitor control=>Remove Make Busy.
Alternatively, select an empty cell in an openmonitor and click Remove Make Busy from the
Monitor Control tab in the Contact Center Client ribbon.

2. Click Yes.

PLACING EMPLOYEES INBUSY - IGNITE (WEB)
NOTE: Employees inWork Timer can apply Busy/Make Busy or DND, but will remain in aWork
Timer state until theWork Timer expires or is cancelled. If Classification Codes are required for the
queue and theWork Timer expires without a Classification Code being entered, aNon-Compliant
Classification Code will be applied to the call..

Placing an employee into Busy places them in Busy across all media types for which they answer
interactions. While in Busy, they can receive transferredmultimedia interactions, however, inbound
multimedia interactions will not be routed to them. They can also receive Non ACD voice
interactions and pick interactions waiting in queue.

The following procedure takes place in either an Agent State or Employee Statemonitor in Ignite
(WEB).
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To place an employee in Busy

1. In themonitor, select the employee you want to place in Busy.
2. Click State=>Busy….
3. Choose a Busy code.

REMOVING EMPLOYEESFROMBUSY - IGNITE (WEB)
Removing employees from Busy re-enables them to answer inboundmultimedia interactions and
ACD calls.

The following procedure takes place in either an Agent State or Employee Statemonitor in Ignite
(WEB).

To remove an employee from Busy

1. In themonitor, select the employee you want to remove from Busy.
2. UnderState, select an alternate state, or, click X button next toBusy... to remove the busy

code.
NOTE:Select Available if you want to make them available to receive interactions.

PLACING EMPLOYEES INDO NOTDISTURB - CONTACT
CENTERCLIENT
NOTE:

l If an agent on an ACD calls puts themselves into MKB or DND, Work Timer events are not
received for that call.

l Employees inWork Timer can apply Busy/Make Busy or DND, but will remain in aWork
Timer state until theWork Timer expires or is cancelled. If Classification Codes are required
for the queue and theWork Timer expires without a Classification Code being entered, aNon-
CompliantClassification Code will be applied to the call..

Placing employees into DoNot Disturb places employees and all of their agents into Do Not Disturb.

The following procedures take place in either an open Employeemonitor or an open Agent monitor in
Contact Center Client.

To place an employee in an open Employeemonitor in Do Not Disturb

l Right-click the cell of an employee and click Employee Control=>Set Do Not
Disturb=>reason code. Alternatively, select the employee cell in an openmonitor and click
Set Employee Do Not Disturb=>reason code.

To place all employees in an open EmployeeMonitor in Do Not Disturb

1. Right-click themonitor and click Monitor control=>Set Do Not Disturb=>reason code.
Alternatively, select an empty cell in an openmonitor and click Set Do Not Disturb from the
Monitor Control tab in the Contact Center Client ribbon.

2. Click Yes.
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To place an employee in an open Agent monitor in Do Not Disturb

l Right-click the cell of an agent who is logged on and click Agent control=>Set Employee
Do Not Disturb=>reason code. Alternatively, select the agent cell in an openmonitor and
click Set Do Not Disturb=>reason code from the Agent Control tab in the Contact Center
Client ribbon.

To place all employees in an open Agent monitor in Do Not Disturb

1. Right-click themonitor and click Monitor control=>Set Do Not Disturb=>reason code.
Alternatively, select an empty cell in an openmonitor and click Set Do Not Disturb from the
Monitor Control tab in the Contact Center Client ribbon.

2. Click Yes.

REMOVING EMPLOYEESFROMDO NOTDISTURB -
CONTACTCENTERCLIENT
Removing employees from DoNot Disturb removes employees and all of their agents from DoNot
Disturb.

The following procedures take place in either an open Employeemonitor or an open Agent monitor in
Contact Center Client.

To remove an employee in an open Employeemonitor from DoNot Disturb

l Right-click the cell of an employee who is in Do Not Disturb and click Employee
control=>Remove Do Not Disturb. Alternatively, select the employee cell in and click
Remove Do Not Disturb from theEmployee Control tab in the Contact Center Client
ribbon.

To remove all of a monitor’s employees in an open Employeemonitor from DoNot Disturb

l Right-click themonitor and click Monitor control=>Remove Do Not Disturb. Alternatively,
select an empty cell in an openmonitor and click Remove Do Not Disturb from theMonitor
Control tab in the Contact Center Client ribbon.

To remove an employee in an open Agent monitor from DoNot Disturb

l Right-click the cell of an agent who is in Do Not Disturb and click Agent control=>Remove
Do Not Disturb. Alternatively, select the agent cell in an openmonitor and click Remove Do
Not Disturb from theAgent Control tab in the Contact Center Client ribbon.

To remove all of a monitor’s employees in an open Agent monitor from DoNot Disturb

l Right-click themonitor and click Monitor control=>Remove Do Not Disturb. Alternatively,
select an empty cell in an openmonitor and click Remove Do Not Disturb from theMonitor
Control tab in the Contact Center Client ribbon.

PLACING EMPLOYEES INDO NOTDISTURB - IGNITE (WEB)
NOTE: Employees inWork Timer can apply Busy/Make Busy or DND, but will remain in aWork
Timer state until theWork Timer expires or is cancelled. If Classification Codes are required for the
queue and theWork Timer expires without a Classification Code being entered, aNon-Compliant
Classification Code will be applied to the call..
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Placing an employee into DoNot Disturb places them in DoNot Disturb across all media types for
which they answer interactions. While in Do Not Disturb, they are unable to receive inbound
multimedia interactions and internal voice interactions, including transfers.

The following procedure takes place in either an Agent State or Employee Statemonitor in Ignite
(WEB).

To place an employee in DoNot Disturb

1. In themonitor, select the employee you want to place in DoNot Disturb.
2. UnderState, click Do Not Disturb….
3. Choose a DND code.

REMOVING EMPLOYEESFROMDO NOTDISTURB - IGNITE
(WEB)
Removing employees from DoNot Disturb re-enables them to receive interactions for all applicable
media types.

The following procedure takes place in either an Agent State or Employee Statemonitor in Ignite
(WEB).

To remove an employee from DoNot Disturb

1. In themonitor, select the employee you want to remove from DoNot Disturb.
2. UnderState, select an alternate state, or, click X button next toDo Not Disturb... to remove

the DND Reason code.
NOTE:Select Available if you want to make them available to receive interactions.

CANCELINGWORK TIMERFOREMPLOYEES - CONTACT
CENTERCLIENT
NOTE:Employees inWork Timer can apply Busy/Make Busy or DND, but will remain in aWork
Timer state until theWork Timer expires or is cancelled. If Classification Codes are required for the
queue and theWork Timer expires without a Classification Code being entered, aNon-Compliant
Classification Code will be applied to the call..

In an Employeemonitor or Agent monitor, you can cancel Work Timer for one or more employees.
The following procedures take place in either an open Employeemonitor or an open Agent monitor in
Contact Center Client.

To cancel Work Timer in an open Employeemonitor

l Right-click the cell of an employee who is inWork Timer and click Employee
control=>Cancel Work Timer. Alternatively, select the employee cell in an openmonitor
and click Cancel Work Timer in the appropriate media section of theEmployee Control tab
in the Contact Center Client ribbon.

To cancel Work Timer for all employees in an open Employeemonitor

l Right-click themonitor and click Monitor control=>Cancel Work Timer. Alternatively,
select an empty cell in an openmonitor and click Cancel Work Timer in themedia type’s
section of theMonitor Control tab in the Contact Center Client ribbon.
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To cancel Work Timer for an employee in an open Agent monitor

l Right-click the cell of an agent who is inWork Timer and click Agent control=>Cancel Work
Timer. Alternatively, select the agent cell in an openmonitor and click Cancel Work Timer
from theAgent Control tab in the Contact Center Client ribbon.

To cancel Work Timer for all employees in an open Agent monitor

l Right-click themonitor and click Monitor control=>Cancel Work Timer. Alternatively,
select an empty cell in an openmonitor and click Cancel Work Timer from theMonitor
Control tab in the Contact Center Client ribbon.

CANCELINGWORK TIMERFOREMPLOYEES - IGNITE (WEB)
NOTE:Employees inWork Timer can apply Busy/Make Busy or DND, but will remain in aWork
Timer state until theWork Timer expires or is cancelled. If Classification Codes are required for the
queue and theWork Timer expires without a Classification Code being entered, aNon-Compliant
Classification Code will be applied to the call..

The following procedure takes place in either an Agent State or Employee Statemonitor in Ignite
(WEB).

To remove an employee fromWork Timer

1. In themonitor, select the employee you want to remove fromWork Timer.
2. Click State and select an alternate state.

NOTE:Select Available if you want to make them available to receive interactions.

CANCELING THERESEIZE TIMERFOREXTERNALHOTDESK
AGENTS
If an external hot desk user is unavailable and the ACD path attempts to deliver a call to them the
ACD routing system will initiate the Reseize Timer, preventing further ACD call delivery attempts
until the timer expires or is canceled by the agent or supervisor. Value settings for reseize timers are
aminimum of four seconds, a default of 180 seconds, and amaximum of 60minutes. These values
are configured on the ACD routing system. When an agent is in the Reseize Timer state, the
applicable real-timemonitors in Contact Center Client display theMake Busy icon as well as text
denoting the agent’s current state as 'Reseize Timer'.

The following procedures take place in either an open Employeemonitor or an open Agent monitor in
Contact Center Client.

To cancel Reseize Timer for an employee’s voice agent in an open Employeemonitor

l Right-click the cell of an employee who is in Reseize Timer and click Employee
control=>Cancel Reseize Timer. Alternatively, select the employee cell in an openmonitor
and click Cancel Reseize Timer in the appropriate media section of theEmployee Control
tab in the Contact Center Client ribbon.

To cancel Reseize Timer for all employee voice agents in amonitor in an open Employeemonitor

l Right-click themonitor and click Monitor control=>Cancel Reseize Timer. Alternatively,
select an empty cell in an openmonitor and click Cancel Reseize Timer from theMonitor
Control tab in the Contact Center Client ribbon.
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To cancel Reseize Timer for an employee’s voice agent in an open Agent monitor

l Right-click an agent who is in Reseize Timer and click Agent control=>Cancel Reseize
Timer. Alternatively, select the agent cell in an openmonitor and click Cancel Reseize
Timer in the appropriate media section of theAgent Control tab in the Contact Center Client
ribbon.

To cancel all of the voice agents on amonitor in the Reseize Timer state in an open Agent monitor

l Right-click themonitor and click Monitor control=>Cancel Reseize Timer. Alternatively,
select an empty cell in an openmonitor and click Cancel Reseize Timer from theMonitor
Control tab in the Contact Center Client ribbon.

EXTENSIONCONTROL
Using Interactive Contact Center and Contact Center Client, you can control extensions on the
followingmonitors:

l Extension State by Position
l Extension Now

Extension Control gives you control over individual extensions. Monitor Control gives you control
over all the extensions on amonitor. All of the extensions on themonitor are affected by the action
you take. You can perform actions using either a right-click and select method within themonitor or
by selecting an extension or an empty cell (monitor control) and accessing the actionmenu in the
Extension or Monitor Control tabs in the ribbon. (See Figure 49.)

Figure 49: Extension State by Position – Extension Control tab
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RING GROUPPRESENCE
If you are licensed for Ring Groups, extensions can join and leave RingGroups via Interactive
Contact Center.

Extensions can be assigned tomultiple Ring Groups. Within a RingGroup, an extension can be set
to Present, enabling it to receive calls, or Absent, ensuring that calls are not offered to the extension.
By default, extensions are set to Present. Supervisors canmanually change the extension presence
in Contact Center Client.

JOINING ANDLEAVING RING GROUPS
Interactive Contact Center can be used to control the presence of extensions in Ring Groups.

The following procedures take place in an open Extensionmonitor in Contact Center Client.

To join an extension to or remove an extension from aRingGroup

1. Right-click the cell of an extension and click Extension control=>Join/Leave.
Alternatively, select the cell of an extension and in theExtension Control tab of theContact
Center Client ribbon, click Join/Leave.

2. Select the RingGroup(s) to which you want the extension to join or deselect the RingGroup(s)
to have the extension leave the RingGroup(s).

3. Click OK.

PLACING ANEXTENSION INDO NOTDISTURB
The following procedures take place in an open Extensionmonitor in Contact Center Client.

To place an extension in Do Not Disturb

l Right-click the cell of an extension and click Extension control=>Set Do Not
Disturb=>reason code. Alternatively, select the Extension Control tab and select Set Do
Not Disturb=>reason code.

To place all extensions into DoNot Disturb in an openmonitor

1. Right-click the cell of an extension and click Monitor control=>Set Do Not
Disturb=>reason code.
Alternatively, select theMonitor Control tab and select Set Do Not Disturb=>reason
code.

2. Click Yes.

REMOVING ANEXTENSIONFROMDO NOTDISTURB
The following procedures take place in an open Extensionmonitor in Contact Center Client.

To remove an extension from DoNot Disturb

l Right-click the cell of an extension in Do Not Disturb and click Extension control=>Remove
Do Not Disturb.
Alternatively, select theExtension Control tab and select Remove Do Not Disturb.
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To remove all extension from DoNot Disturb in an openmonitor

l Right-click the cell of an extension and click Monitor control=>Remove Do Not Disturb.
Alternatively, select theExtension Control tab and select Remove Do Not Disturb.

QUEUE CONTROL
You canmanually place queues in or out of Do Not Disturb using the Queue Now monitor in Contact
Center Client.

Queues can be automatically set to open and close or go in and out of Do Not Disturb using queue
schedules and queue control plans. These are administrative settings. For more information see the
MiContact Center Business Installation and Administration Guide

MANUALLYCONTROLLING QUEUES
Queue control enables you to control individual queues. Monitor control enables you to control all of
the queues on amonitor.

TheMonitor Options tab displays in the ribbon for the Queue Now monitor. You can perform actions
using either a right-click and select method in the openmonitor or by accessing the actionmenu in
theMonitor Options ribbon. (See Figure 50.)

NOTE:Manual queue control overrides administrative settings for queue schedules and queue
control plans.
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Figure 50: Queue Now monitor - Monitor Options tab

Placing queues in DoNot Disturb
Usingmanual queue control, you can place queues in and remove queues from DoNot Disturb on
the Queue Now monitor. A contact will not enter a queue that is in Do Not Disturb. Instead the
contact is sent to an unavailable answer point if one is configured for the queue.

NOTE: Putting a RingGroup into DoNot Disturb removes the presence of all of its members.

To place a queue in DoNot Disturb

l Right-click the cell of an active queue and click Queue control=>Set Do Not Disturb.
Alternatively, select the queue in an openQueue Now monitor and click Set Do Not Disturb
from theMonitor Option tab in the Contact Center Client ribbon.
See Figure 51.
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Figure 51: Placing a queue in Do Not Disturb

To place all of the queues on amonitor in Do Not Disturb

l Right-click themonitor and click Monitor control=>Set Do Not Disturb. Alternatively,
select an openQueue Now monitor and click Set Do Not Disturb from theMonitor Option tab
in the Contact Center Client ribbon.

Removing queues from DoNot Disturb
To remove a queue from DoNot Disturb

l Right-click the cell of a queue that is in Do Not Disturb and click Queue control=>Remove
Do Not Disturb. Alternatively, select the queue in an openQueue Now monitor and click
Remove Do Not Disturb from theMonitor Option tab in the Contact Center Client ribbon.

To remove all of the queues on amonitor from DoNot Disturb

l Right-click themonitor and click Monitor control=>Remove Do Not Disturb. Alternatively,
select an openQueue Now monitor and click Remove Do Not Disturb from theMonitor
Option tab in the Contact Center Client ribbon.



Chapter 8
INTERACTIVE VISUAL QUEUE

Accessing Interactive Visual Queue
Interactive Visual Queuemonitor grids
Redirecting calls
Calling back abandoned callers
Configuring alarms
Understanding call priority
Viewing callback information in Interactive
Visual Queue
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INTERACTIVE VISUAL QUEUE
Interactive Visual Queue is a Contact Center Client real-timemonitor that enables supervisors to
bothmonitor and control the content in contact center queues. With Interactive Visual Queue
monitors open, supervisors canmonitor the contents of queues and queue groups, easily move
interactions between queues, assign interactions to agents, and proactively remove unwanted
interactions from the queues.

Interactive Visual Queue includes aQueuedmedia grid and an Abandonedmedia grid. In the Queued
media grid, supervisors and agents can view calls within queues and then use a drag-and-drop
operation tomove calls from busy queues to less active queues. In the Abandonedmedia grid,
supervisors can view abandoned call information, including the caller name, phone number, and time
of the abandoned call. Agents can use the Abandonedmedia grid to call back abandoned callers.

Ring Groups are not supported with Interactive Visual Queue and any queue groups displayed in
Interactive Visual Queue will not display calls in the RingGroup queues.

The following sections explain how to use Interactive Visual Queue tomonitor call activity, redirect
calls, manage abandoned calls, configure alarms, and view callback information. For information on
using Interactive Visual Queue tomanagemultimedia interactions, see theMultimedia Contact
Center Installation and Deployment Guide.

ACCESSING INTERACTIVE VISUAL QUEUE
You access Interactive Visual Queue by logging on to Contact Center Client and then opening the
Real-time toolbar.

To open an Interactive Visual Queuemonitor

1. Log on to Contact Center Client.
2. In the Contact Center Client ribbon, click Real time.
3. Click Interactive Visual Queue.

The Add/Remove device IDs window opens.
4. Select a queue from theQueues list and click OK.

See Figure 52.
NOTE:Virtual queue groups are shown in the Queue groups list.
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Figure 52: Interactive Visual Queue monitor

INTERACTIVE VISUAL QUEUEMONITORGRIDS
The Interactive Visual Queuemonitor includes the Queuedmedia grid and the Abandonedmedia
grid. TheQueuedmedia grid lists the calls that are currently in the selected queues or queue groups.
The Abandonedmedia grid lists abandoned calls. The calls are listed in order of priority and the
columns can be sorted. You can configure the column headings and specify which columns are
displayed. Depending on licensing, Interactive Visual Queue includes the Callback to be processed
grid, which lists callbacks.
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NOTE: The abandoned calls column in the Interactive Visual Queuemonitor displays all abandoned
calls except those abandoned while ringing an agent or extension. The abandoned column in the
Queue Now monitor does not peg short abandons as abandoned calls, but does peg calls that are
abandoned while ringing an agent or extension if they do not peg as a short abandon. Because of
these differences, youmay notice discrepancies between the abandoned call information in these
twomonitors.

The following list provides descriptions of the column headings available in the Queuedmedia grid:

l Position (#) displays the answer position relative to other interactions in the queue
l Media icon displays themedia type
l Queue Name is the name of the queue
l Queue Dialable displays:

l Voice—the dialable number of the queue
l Chat—Queue Auto Response User Name
l Email—Email address of the queue
l SMS--the dialable number of the queue

l Priority is the priority of the interaction in the queue (the lower the number, the higher the
priority)

l Time in Queue is the interaction's total time in the current queue
l TimeOffered to System is the time the interaction first entered the system
l Time in System is the interaction's total time in the system
l Queue Hops is the number of times an interaction has changed queues
l ANI (Contact ID) displays:

l Voice—caller # / ANI
l Chat—Chat email address from pre-chat form
l Email—From email address
l SMS—caller # / ANI

l Subject displays
l Voice—blank
l Chat—Chat subject from pre-chat form
l Email—Email subject
l SMS—blank

l Is Callback indicates if the queuedmedia is a callback request (voice only)
l Service level countdown provides a countdown in seconds when the contact will exceed the
target time tomeet the service level

l Contact Name is the name associated with the contact (if available)
l Voice—caller ID
l Chat—Chat name from pre-chat form
l Email—Email “From” name, if available
l SMS—caller #

l TimeOffered to Queue is the time the contact entered the current queue
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l DNIS (To Address) displays
l Voice—DNIS Number
l Chat—blank
l Email—receiver's email address
l SMS—blank

l ToName displays
l Voice—DNIS Name, if configured in YourSite Explorer for the associated DNIS
number

l Chat—blank
l Email—Email “To” name, if available
l SMS—blank

l Collected Information displays the single or series of collected results provided by IVR
Routing. Collected information requires IVR Routing and, optionally, Remote Database
Verification or CTI Developer Toolkit

l Queue Reporting is the queue’s reporting number

The following list provides descriptions of the column headings available in the Abandonedmedia
grid:

l ANI (Contact ID) displays caller # / ANI
l Contact Name is the caller ID associated with the contact (if available)
l Queue Name is the name of the queue
l Queue Dialable displays the dialable number of the queue
l Time Abandoned is the time at which the contact abandoned the queue
l Time Since Abandoned is the elapsed time since the contact abandoned the queue
l Last Callback Employee is the employee name and employee ID associated with themost
recent callback attempt

l Last Callback Time is the time at which themost recent callback was attempted
l Time Since Last Callback is the elapsed time since themost recent callback attempt
l TimeOffered to Queue is the time the contact entered the current queue
l Time in Queue is the contact's total time in the current queue
l TimeOffered to System is the time the contact first entered the system
l Time in System is the contact's total time in the system
l Queue Hops is the number of times a contact has changed queues
l Is Callback indicates if the queuedmedia is a callback request (voice only)
l Service level countdown provides a countdown in seconds when the interaction will exceed
the target time tomeet the service level

l DNIS (To Address) displays the DNIS number
l ToName displays the DNIS name, if configured in YourSite Explorer for the associated DNIS
number

l Subject displays DNIS
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l Collected Information displays the single or series of collected results provided by IVR
Routing. Collected information requires IVR Routing, Verified Collected Digits and, optionally,
Remote Database Verification or CTI Developer Toolkit

l Queue Reporting is the queue’s reporting number
l Media icon displays themedia type

The following list provides descriptions of the column headings available in the Callback to be
processed grid:

l Caller # displays the phone number provided by the contact
l Caller Name displays the contact’s name
l Status displays the state of the callback

l New request
l In progress
l Requeued
l Completed
l Unknown

l Priority the importance level of the callback
l Voice—Normal
l Web—Normal
l Abandoned—Low

l Type displays the type of callback
l Voice
l Web
l Abandoned

l Reason displays the callback’s reason for its current status
l Attempted Calls to Agent displays the number of times the agent attempted the callback
l Last Time Agent Attempted displays the last time the agent attempted the callback
l Request Time the specific time at which the callback is scheduled to be processed; this field
is populated when the callback is requeued

l TimeReceived displays the specific time the caller submitted the callback request
l Web IP Address displays the IP address of the contact who submitted the callback request
l Last Attempted Call To Client displays the specific time the last callback attempt to the caller
was made

l Attempted Calls To Client displays the number of times the callback was attempted
l Client Available From displays the earliest time the contact is available to receive the callback
l Client Available To displays the latest time the caller is available to receive the callback
l ANI displays the phone number of the caller
l DNIS displays the phone number the caller dialed
l Dialable displays the number of the device that will handle the callback
l Device Name displays the name of the device that will handle the callback
l Device Type displays the type of device that will handle the callback – extension, agent, or
queue
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l RecordedMessage displays a hyperlink to the voice callback request .wav file left by the
caller

l Area displays the state, province, or other area the call originated from
l Country displays the country the call originated from
l Endpoint displays the endpoint attempting to perform the callback
l Region displays the region the call originated from

SORTING CONTACTSBYCOLUMNS
Monitor columns can be used to sort contacts in Interactive Visual Queue. You can only sort by one
column in a grid at a time. By default, the Queuedmedia grid is sorted by Position number. Sort
preferences are preserved in your Contact Center Client profile.

To sort contacts by columns in the Interactive Visual Queuemonitor

l Click on the column heading by which you want to sort.
To reverse the sort order, click on the column again.

REDIRECTING CALLS
A call canmove between queues automatically (interflow) or manually (redirection).

Interflow

You can configure queue settings on the telephone system to automatically move a call from one
queue to another after a specific duration. For example, you can configure your system tomove a
call from Queue 1 to Queue 2 if the call has not been answered within 30 seconds. Interflow occurs
without any user interaction.

Redirection

Using Interactive Visual Queue, you canmanually redirect a call from a queue to another queue or a
dialable number.

There are two ways a call can be removed from the system. If a call is movedmore than 10 times,
either by redirection or by interflow, the call is dropped from the system. You can see the current
number of times a call has moved between queues in the Queue Hops column. A call will also be
automatically removed from the system if its total time in the system exceeds 24 hours. The Total
Time column lists the call’s duration in the system.

You canmanually redirect a call in the Queuedmedia grid using the followingmethods:

l Drag and drop a call between queues
l Use the right-click menu tomove a call between queues
l Use the right-click menu to send a call to a specific dialable number

Youmay notice that the first twomethods perform the same action. However, the secondmethod is
convenient when queuemonitor is maximized and you want to move a call without having to resize
one or moremonitors.

NOTE: If you right-click and redirect a call to a device other than a queue, the call will no longer be
considered an ACD call for reporting purposes. If you redirect a call using either of the other two
methods, the call remains an ACD call.
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When youmanually redirect (drag and drop) a call in Interactive Visual Queue, MiContact Center
Business changes the way the call is pegged on theQueue Performance reports. If you redirect a
call before the short abandon time set for the queue, the call is pegged as Unavailable. If you redirect
a call after the short abandon time set for the queue, the call is pegged as Interflowed. An internal
ACD call is pegged as Abandoned if the call is redirected at any time.

REDIRECTING CALLSBETWEENQUEUES
To redirect a call from one queue to another queue using a drag-and-drop operation

1. In the Queuedmedia grid, click anywhere in the row of the call you want to move.
2. Use a drag-and-drop operation tomove the call from its original queuemonitor to a new queue

monitor.

To redirect a call from one queue to another queue using themenu

1. In the Queuedmedia grid, right-click the row of the call you want to redirect and click Send to.
A list of available queues appears.
NOTE: You can select multiple rows tomovemultiple calls to a new queue.

2. Click the name of the queue to which you want to move the call.

REDIRECTING VOICE INTERACTIONSTO SPECIFICAGENTS
You can transfer voice interactions in queue directly to agents who are available or in Make
Busy/Overloaded states. Agents in Do Not Disturb cannot receive transferred interactions and will
not appear in the list of available agents.

To redirect voice interactions to agents

1. In the Queuedmedia grid, right-click the row of the interaction you want to redirect and click
Send to=>Agent.
A list of available agents who can handle the voice interaction displays.
NOTE:You can use the search button to locate a specific agent, either by name or reporting
number.

2. Click the name of the agent to which you want to send the interaction.
3. Click OK.

REDIRECTING CALLSTO SPECIFICNUMBERS
Using the Send tomenu option, you can redirect calls in Interactive Visual Queue to any dialable
number, including your own phone.

To redirect a call to a dialable number

1. In the Queuedmedia grid, right-click the row of the call you want to redirect and click Send
to=>[Extension].
When you click [Extension], it changes to a text box.

2. Type a number in the text box and press Enter.
See Figure 53.
NOTE: You cannot use the Extension option if you havemultiple calls selected. Only one call
can be sent to a dialable number at a time.
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Figure 53: Redirecting a call to an extension

To redirect a call to your phone

1. In the Queuedmedia grid, right-click the row of the call you want to redirect.
2. Click Send to=>Me

NOTE: This option is only available when you have Contact Center Softphone installed and
configured on your computer.

REMOVING CALLS
To remove a call from Interactive Visual Queue

1. Right-click the row of the call you want to remove.
2. Click Delete.

The call is removed from Interactive Visual Queue.

NOTE:Deleting a call from an Interactive Visual Queuemonitor will not remove it from the actual
queue. This will just cause Interactive Visual Queue to stop tracking the call.
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CALLING BACK ABANDONEDCALLERS
The Abandonedmedia grid displays abandoned call information and enables agents to call back
abandoned callers.

NOTE:

l Abandoned call information is automatically deleted from the Abandonedmedia grid after 24
hours.

l Abandoned calls cannot be transferred to agents.

To call back an abandoned caller

1. Right-click the row of the abandoned call you want to call back, and select Call to
automatically dial the abandoned caller.
NOTE:Each time an agent attempts to call back an abandoned caller, their name and ID are
attached to the call record and display in the Last callback employee column of the
Abandonedmedia grid.

2. After you have contacted the abandoned caller, right-click the row associated with that call,
and select Delete to remove the abandoned call record from the Abandonedmedia grid.

CONFIGURING ALARMS
You set alarms on Interactive Visual Queuemonitors similar to the way you set alarms on Contact
Center Client monitors. Themain difference is that some of the variables you canmonitor, Caller
Number, Caller Name, DNIS Number, DNIS Name, Collected Digits, and Collected Information,
use a string for their value as opposed to a threshold boundary. For example, you can set an alarm
that is triggered when a specific name appears in the Caller Name column.

The value you type for Caller Number or Caller Name alarms is a wildcard, whichmeans the alarm
will trigger if that value appears in any form. For example, if you configure a Caller Name alarm for
the value John, the alarm will trigger for the values John Smith, Johnathan, longjohn, and so on.

To configure alarms:

1. Right-click an Interactive Visual Queuemonitor and click Set alarms.
The Set Alarms window appears.

2. UnderPerformance variables, select the variable you want to monitor.
NOTE: You cannot set Alarm Thresholds for "Callback to be Processed" within the Interactive
Visual Queue, but you can set them for "QueuedMedia" and "AbandonedMedia".

3. UnderAlarm thresholds, click Add value and select a boundary (or value) for the variable
you selected as well as the alarm type(s) that will indicate when the variable exceeds those
boundaries.

4. If you want to add further alarms for the variable, repeat step 3.
5. Click OK to save the alarms.

For more information on configuringmonitor alarms, see "Setting alarms" on page 111.
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UNDERSTANDING CALL PRIORITY
Each queue has a default priority level. When a call enters the system for the first time, the call
adopts the default priority of whichever queue it enters. If all calls in a queue have the same priority,
the position of the calls are based on each call’s total time in the current queue. If a queue contains
calls that havemultiple priority levels, higher priority calls will have a higher position in the queue
than lower priority calls.

As long as a call remains in a queue, it maintains its priority. However, if a call moves from one
queue to another queue, the call’s priority may change, based on themethod used tomove the call.

When you redirect a call manually, the call always adopts the default priority level of the destination
queue. For example, supposeQueue 1 has a priority of 1 andQueue 2 has a priority of 15. When a
call first enters Queue 1, it has a priority of 1. However, if youmanually move that call to Queue 2,
using either a drag-and-drop operation or the right-click menu, the call priority lowers to 15. The rules
work the same in reverse. If youmanually move a priority 15 call from Queue 2 to Queue 1, the call
priority increases to 1 when it enters Queue 1.

Calls interflowed automatically retain the original call priority, or adopt the priority of the new queue
based on telephone system settings.

VIEWING CALLBACK INFORMATION IN INTERACTIVE
VISUAL QUEUE

When licensed for IVR, Interactive Visual Queue also provides the Callback to be processed grid,
which displays all callbacks in the displayed queues in the Interactive Visual Queuemonitor. Users
can access the Callback to be processed grid to manage callbacks in queue. For more information,
see "Managing callbacks in Interactive Visual Queue callback monitors" on page 174.

The following list provides descriptions of the column headings available in the Callback to be
processed grid:

l Caller # displays the phone number provided by the contact
l Caller Name displays the contact’s name
l Status displays the state of the callback

l New request
l In progress
l Requeued
l Completed
l Unknown

l Priority the importance level of the callback.
l Voice—Normal
l Web—Normal
l Abandoned—Low
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l Type displays the type of callback
l Voice
l Web
l Abandoned

l Reason displays the callback’s reason for its current status
l Attempted Calls to Agent displays the number of times the agent attempted the callback
l Last Time Agent Attempted displays the last time the agent attempted the callback
l Request time displays the specific time at which the callback is scheduled to be processed;
this field is populated when the callback is requeued

l TimeReceived displays the specific time the caller submitted the callback request
l Web IP Address displays the IP address of the contact who submitted the callback request.
l Last Attempted Call To Client displays the specific time the last callback attempt to the caller
was made

l Attempted Calls To Client displays the number of times the callback was attempted
l Client Available From displays the earliest time the contact is available to receive the callback
l Client Available To displays the latest time the caller is available to receive the callback
l ANI displays the phone number of the caller
l DNIS displays the phone number the caller dialed
l Dialable displays the number of the device that will handle the callback
l Device Name displays the name of the device that will handle the callback
l Device Type displays the type of device that will handle the callback – extension, agent, or
queue

l RecordedMessage displays a hyperlink to the voice callback request .wav file left by the
caller

l Area displays the state, province, or other area the call originated from
l Country displays the country the call originated from
l Endpoint displays the endpoint attempting to perform the callback
l Region displays the region the call originated from

MANAGING CALLBACKS IN INTERACTIVEVISUALQUEUE
CALLBACKMONITORS
Using Interactive Visual Queue’s Callback to be processed grid, users can requeue, reject, and
delete callbacks frommonitors. Requeued callbacks are re-entered into their queue. Rejected
callbacks are removed from the queue and will not be offered to employees. Deleted callbacks are
removed from the current monitor, but are not removed from the system.

Users can also adjust a callback’s priority. Callback priority determines the order of which callbacks
will be offered to agents. Callbacks are offered to agents in order of their priority and then by the
longest waiting callback of that priority. For example, High priority callbacks are offered before
Normal priority callbacks, even if the Normal priority callbacks have been in queue longer.
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The following procedures explain how to:

l Requeue a callback
l Reject a callback
l Delete a callback
l Change a callback’s priority

To requeue a callback

1. Right-click a callback and select Requeue.
2. Select Yes.

To reject a callback

1. Right-click a callback and select Reject.
2. Select Yes.

To delete a callback

1. Right-click a callback and select Delete.
2. Select Yes.

To change a callback’s priority

l Right-click a callback and select Change priority=>[priority level].



Chapter 9
CONTACT CENTER PHONESET
MANAGER ANDCONTACT CENTER
SOFTPHONE

Using Contact Center PhoneSet Manager
and Contact Center Softphone
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CONTACT CENTER PHONESETMANAGER AND
CONTACT CENTER SOFTPHONE

The Contact Center PhoneSet Manager and Contact Center Softphone applications are designed for
the 3300 ICP telephone system. They provide ACD agent functions and enable agents to use their
desktop computers as IP-based phones.

USING CONTACT CENTER PHONESET MANAGERAND
CONTACT CENTER SOFTPHONE

Contact Center PhoneSet Manager and Contact Center Softphone enable agents to use their
desktop computers as IP-based phones. Contact Center PhoneSet Manager automates Mitel IP
phone sets from the computer desktop. An agent who uses Contact Center PhoneSet Manager has
a headset connected to a desk phone. Contact Center Softphone provides complete phone set
functionality from the computer desktop. A computer and wired or wireless USB headset deliver
calls to the agent.

STARTING CONTACTCENTERCLIENT
Contact Center Softphone and Contact Center PhoneSet Manager reside in Contact Center Client.

NOTE: Launching client-side desktop applications from the task bar causes them to bypass the
MiContact Center Updater Service process. To ensure successful updates from the Enterprise
Server, after an upgrade close all client-side applications for 15minutes or reopen them from the
Start menu/Start screen.

To start Contact Center Client

1. OpenContact Center Client.
2. If prompted, type yourUsername andPassword and verify theEnterprise Server IP

address.
3. If you use Secure Socket Layer, select SSL.
4. Optionally, select Remember my credentials.
5. Click Login.

SETTING UPTHESOFTPHONE
The functionality of Contact Center PhoneSet Manager and Contact Center Softphone is similar. For
simplicity, we will use soft phonewhen referring to features and functionality common to both
applications.

NOTE:Before you set up the soft phone on your client computer, ensure your network administrator
has configured your soft phone as a 5020 IP phone on the telephone system.
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To set up a client computer to use the soft phone

1. Consult your network administrator to confirm your soft phone extension number.
2. Ensure your headset is connected.
3. Configure sound and audio device properties.

See "Configuring sound and audio device properties" on page 178.

NOTE:Contact Center Client's PhoneSet Manager function is not supported for use in
conjunction with MiCollab SIP Softphone.

CONFIGURING SOUNDANDAUDIO DEVICEPROPERTIES
To configure sound and audio device properties forWindows operating systems, youmust set the
PC speakers as the default audio device and adjust the volume of the PC speakers, headset
speakers, and headset microphone.

OPENING THESOFTPHONE
To open the soft phone

1. In theContact Center Client ribbon, click Soft Phone
2. Click theSoft Phone icon in the toolbar ribbon.

The Soft phone configuration window opens.
See Figure 54.
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Figure 54: Soft phone configuration window

3. Click Add Extensions to search and select from all internal standard extensions, hot desk
extensions, and external hot desk user extensions.

4. Click Add External Agents to search and select from all external hot desk agent extensions.
5. Select your phone extension from the list of extensions.
6. If you have Contact Center PhoneSet Manager, click Desk phone. If you have Contact

Center Softphone, click Soft phone.
7. If you want to log on automatically to the soft phone with your phone extension the next time

you open the current profile, select theRemember my extension check box.
Youmust save the current profile before you quit the soft phone for this option to work.
If you are a hot desk user who participates in the use of PINs, the PIN login dialog box opens.
If you are a hot desk user who does not participate in the use of PINs, go to step 10.
NOTE:When logging in as an External Hot Desking Agent or a hot desking user who is not
set up to use a PIN login, if the PIN entry window displays, do not enter a PIN; just click
Login.
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8. Type your Login PIN.
If you want Contact Center Client to remember your Login PIN, select the Remember your
credentials check box. This option is not available if your Contact Center Client profile is
shared. Depending on their security role settings, employees may not be prompted to enter a
PIN.

9. Click Login.
NOTE: If the Login PIN you entered is invalid the login will fail and you will be asked to enter a
valid Login PIN. If you exceed the configured number of failed login attempts, your PIN will
lock and you will need to contact your System Administrator to reset your PIN.

10. If you want Contact Center Client to be the top-most window on ringing, select theBring to
front on ringing check box.

11. If you do not want the screen pop windows to display in Contact Center Client when calls are
ringing on the desktop, select theDisable toaster on ringing check box.

12. If you selected Soft phone in step 6, underSoft phone settings, configure soft phone
options.
NOTE: For the relevant configuration information, contact your supervisor or system
administrator.

13. AfterAddress book source for contacts, select YourSite contacts.
Contact Center PhoneSet Manager and Contact Center Softphone users can access
YourSite database phone extensions or Global Address List phone numbers when they handle
calls.

14. To automatically log off the agent from the telephone system when closing the soft phone,
select theAutomatically log off this ACD agent when closing the soft phone check box.

15. To automatically launch Ignite (DESKTOP) when logging into Contact Center Softphone or
PhoneSet Manager, select theAutomatically launch the Ignite Client on ACD login
check box.
NOTE: This option only applies to voice agents who use Ignite (DESKTOP) to handle
multimedia interactions.

16. To synchronize online presence indicators with ACD agent states in real-timemonitors, select
theSynchronize my Lync presence with my ACD state check box.
When this option is selected an agent's state changes in sync with Skype for Business
presence.

17. To display call notes in the soft phone and on the Call Notes monitor, select theDisplay call
notes check box.

18. Click OK.
The Contact Center Client window displays the Soft Phone, Phone and Functions toolbars.
See Figure 55.

Figure 55: Soft phone toolbars
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19. If you want to be able to position the soft phone toolbar elsewhere on your desktop, enable the
Float check box.

20. Tomove the soft phone toolbar, hover themouse over the perforated line on the left-side of the
toolbar until the four-headed arrow displays. Then click, drag, and drop it to the desired
position on your desktop. To re-anchor the toolbar to the ribbon, drag and drop it into position
under the ribbon.

21. If you want to modify the soft phone configuration, click theConfiguration icon in the toolbar
to reopen the Soft phone configuration window.

Changing soft phone IP addresses
If you are required to change the IP address for your soft phone, consult the following procedure:

1. In theContact Center Client ribbon, click Soft Phone.
2. Click theSoft Phone icon in the toolbar ribbon.
3. In theSoft phone configuration window, click Soft phone settings.
4. AfterUse IP address: select the new IP address from the drop-down list and click OK.

NOTE: For information on what address to select, contact your supervisor or system
administrator.

5. In theSoft Phone configuration window, under ‘This extension is a’, click Desk phone
and then click Soft phone.
NOTE:Clicking ‘Desk phone’ is required to unbind your soft phone from the previous IP
address.

6. Click OK.
7. On the ribbon, click Save.

THUMBNAIL SOFTPHONETOOLBAR
The thumbnail soft phone toolbar enables agents to quickly perform soft phone actions when other
applications are open on the desktop. The thumbnail toolbar gives agents access to Answer, Hang
up, Cancel, and Dial functions and is particularly helpful when the Contact Center Client application
is minimized and you want to perform a quick soft phone action. To see the toolbar options, hover
over it with your mouse. (Figure 56.)

Figure 56: Thumbnail soft phone toolbar
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NOTE:

l To enable the thumbnail soft phone toolbar, yourWindows operating systemmust support
Windows AERO functionality.

l Because of Windows limitations, this toolbar may not always display when Contact Center
Client has focus on the desktop.

LOGGING ONTO THEACD
Agents can log on to the ACD in a number of ways, such as selecting the Superkey button in
Contact Center Softphone, or using the agent control function in Interactive Contact Center.

We recommend that soft phone users who are hot desking agents log on to the ACD using the soft
phone Actions menu. This enables the soft phone to identify agents.

NOTE: If you are an External Hot Desking Agent or a hot desking user who logged in internally,
logged out, and then chose to log back in externally, you will not be able to log on with the soft phone
Actions menu. In order to access this functionality, youmust first close and reopen the soft phone
toolbar.

To log a standard agent onto ACD

l On the soft phone Functions toolbar, click Actions=>Log on=>Agents and select an agent
ID.

To log an external hot desking user onto ACD

l On the soft phone Functions toolbar, click Actions=>Log on=>Hot Desking Users.

To log an External Hot Desking Agent on to ACD

l On the soft phone Functions toolbar, click Actions=>Log on=>Agent ID.

NOTE:When a hot desk agent logs in to the ACD a user license is taken from the available licensing
pool and when the agent logs out the license is released back to the licensing pool. Agents are
notified upon login attempt if the number of concurrent logins exceeds the number of available user
licenses. If there are no available user licenses the login attempt will fail.

PHONEANDFUNCTIONSTOOLBARS
The Phone toolbar displays your

l Extensions (gray oval buttons)
l Hold button (red oval button)
l Superkey button (blue oval button, for Contact Center Softphone only)
l Current phone state (Idle, Dialing, Talking) box with a down arrow that displays a call details
window

l Dial box (field for dialing extensions or phone numbers)
l Dial button (Contact Center PhoneSet Manager only)
l Redial button (Contact Center Softphone only)
l Cancel button (Contact Center Softphone only)
l Message button (for retrieving voicemail messages, Contact Center Softphone only)



MiContact Center Business—MiVoice Business User Guide

183

The Functions toolbar displays

l Your current ACD state (LoggedOn/Off, in Make Busy, in Do Not Disturb)
l The ACD actions currently available
l Telephony buttons

PHONEFUNCTIONS
You can readily answer calls or forward them to extensions or phone numbers using the soft phone.
You can select people from contact and speed dial lists, and perform the following actions: Redial
(Contact Center Soft phone only), Transfer, Conference, Mute, Forward, Request help, Hold,
Retrieve, Split, Swap, Camp on, Leave amessage, Retrieve amessage, Call me back, Hang up,
and Cancel.

NOTE:External hot desk agents access the 'Answer' and 'Hang up' functions using their external
device and not the soft phone toolbar.

Table 19 lists the soft phone telephony options and their correspondingmeanings.
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ICON MEANING

Account Code tags a call with an Account Code

Answer answers a ringing call

Auto answer if enabled, answers a ringing call without you having to click
Answer

Call me back notifies you as soon as the extension number you are trying
to call is available

Camp on notifies an employee you are attempting to call with a series
of audible beeps

Cancel terminates your connection to a caller

Conference connects three or more people together for an interaction

Dial pad enables you to dial a number using a keypad

Forward forwards a call to a phone number or extension

Hang up terminates a call

Hold places the current call on hold

Table 19: Agent actions
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ICON MEANING

Leave amessage leaves amessage waiting notification on an employee’s
extension

Mute
if you have Contact Center Softphone, disables your
microphone so you can consult privately with another
employee while on a call

Request help calls an employee who can click Answer and listen to an in-
progress call without the caller knowing

Retrieve picks up a call that is held or camped on to your extension

Speed dial enables you tomake a call to a specified number with one
mouse click

Split disconnects one person from a conference call

Swap swaps between the current and the held party

Transfer forwards an in-progress call to another answer point

Transfer/Conference places a caller on hold andmakes a consultation call

Volume if you have Contact Center Softphone, adjusts the volume
of your speakers and/or microphone

Call Notes
enables you to view the notes associated with the current
call and add notes. Call notes are supported for inbound
calls only.

Table 19: Agent actions (continued)
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CUSTOMIZING THESOFTPHONE
The following section describes how you can further customize your soft phone.

Selecting audio devices
To select audio devices

1. Click Configure next to the phone icon in the Soft Phone ribbon.
2. After Input audio device, select an audio device for your microphone.
3. AfterOutput audio device, select an audio device for your speakers or headset.

NOTE: You can configure the soft phone to use the “Default Communication Device” by
selecting the option. When idle or during a call or while on hold, you can switch the audio
device and the configured “Default Communication Device” temporarily changes to an
available device, which is usually the “Default Audio Device”. After you switch back to the
your audio device, it switches the “Default Communication Device” back to the configured
device.

4. Click OK.

Specifying the address book source for contacts
To specify the address book the soft phone uses for contacts (the YourSite database)

1. Right-click the Phone toolbar and click Configure.
2. AfterAddress book source for contacts, select YourSite contacts.
3. Click OK.

Resizing toolbar buttons
To resize toolbar buttons

1. Right-click the Phone toolbar and click Configure.
2. Click the Toolbars tab.
3. After Functions toolbar, select a size for displaying the Functions toolbar buttons.
4. AfterPhone toolbar, select a size for displaying the Phone toolbar buttons.
5. Click OK.

Displaying, hiding, and retiring toolbar buttons
You can display telephony buttons, hide them so they appear on the Functions toolbar only when
required, and retire them for actions you rarely perform, such as Camp on and Request help.

To display telephony buttons

1. Right-click the Phone toolbar and click Configure.
2. Click the Toolbars tab.
3. UnderSelected buttons, select the check boxes of the telephony buttons you want to

display.
4. Click OK.
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To hide telephony buttons

1. Right-click the Phone toolbar and click Configure.
2. Click the Toolbars tab.
3. UnderSelected buttons, clear the check boxes of the telephony buttons you want to hide

from view.
4. Click OK.

To retire telephony buttons

1. Right-click the Phone toolbar and click Configure.
2. Click the Toolbars tab.
3. UnderSelected buttons, select the telephony buttons you want to retire and click the left

arrow to add these buttons to the Available buttons list.
4. Click OK.

To restore telephony buttons

1. Right-click the Phone toolbar and click Configure.
2. Click the Toolbars tab.
3. UnderAvailable buttons, select the telephony buttons you want to restore and click the right

arrow to add these buttons to the Selected buttons list.
4. Click OK.

Repositioning toolbar buttons
To specify the order in which telephony buttons appear

1. Right-click the Phone toolbar and click Configure.
2. Click the Toolbars tab.
3. UnderSelected buttons, select a telephony button.
4. Click the up or down arrow to change the position of the button relative to other buttons on the

Functions toolbar.
5. Click OK.

Configuring sounds and notifications
You can configure sounds for individual phone events for incoming calls, secondary incoming calls,
and/or the digits dialed on your primary extension, or on all extensions. A primary incoming call is a
call you receive while you are in the idle state and are available to take the call. A secondary
incoming call is a call you receive while you are on a call on another extension and are not available
to take the call.

Every time you receive a call a pop-up window notifies you the call has arrived. You can disable the
pop-up notification.

To configure a sound for a phone event

1. Right-click the Phone toolbar and click Configure.
2. Click theSounds tab.
3. Select the Incoming calls, Secondary incoming calls, and/orPlay sounds when dialing

digits check boxes.
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4. AfterPhone events, select a phone event.
5. AfterSound file name, click Browse and select a sound file.
6. If you want to play the sound file when the phone event occurs on any of your extensions,

click Apply to all lines.
7. Click OK.

To disable the call arrival pop-up notification

1. Right-click the Phone toolbar and click Configure.
2. Click theSounds tab.
3. UnderPhone events, click a phone line.
4. Clear theDisplay pop-up notification for incoming calls check box.
5. Click OK.

Enabling and disabling Contact Center Screen Pop
Depending on administrative settings, Contact Center Screen Pop can launch applications or
webpages when calls are received and enable agents to automatically receive caller and account
information via pop-ups on their desktops for incoming calls.

When you enable or disable Contact Center Screen Pop, the settings you select determine Contact
Center Screen Pop accessibility on a per-agent profile basis.

To enable or disable Contact Center Screen Pop

1. Click Soft Phone=>Configure.
The Soft phone configuration window opens.

2. Click theScreen pop tab.
3. To enable Contact Center Screen Pop, select theDisplay Contact Center Screen Pop

check box.
4. To disable Contact Center Screen Pop, clear theDisplay Contact Center Screen Pop

check box.
5. Click OK.

Making calls ring through your computer speakers
You canmake calls ring through your computer speakers instead of your headset.

Tomake calls ring through your computer speakers

1. Right-click the Phone toolbar and click Configure.
2. Click theSounds tab.
3. AfterPlay the rings sounds on select the sound output device for your computer speakers.

Adjusting the volume of your speakers andmicrophone
If you have Contact Center Softphone, you can adjust the volume of your speakers andmicrophone.
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To adjust the volume of your speakers

1. Right-click the Phone toolbar and click Configure.
2. Click theSounds tab.
3. Adjust the volume by moving the speaker slider.

To adjust the volume of your microphone

1. Right-click the Phone toolbar and click Configure.
2. Click theSounds tab.
3. Adjust the volume by moving themicrophone slider.

Configuring call forward destinations
You can forward calls manually to pre-configured call forward destinations. In addition, you can
configure and enable call forwarding so the telephone system forwards calls to other answer points
when you are temporarily unavailable or away from the office. For example, you could specify all
External call busy calls (external calls to your extension when you are unavailable) you receive be
forwarded to a co-worker’s extension. Rather than directing these calls to voicemail, the telephone
system would forward these calls to your co-worker.

NOTE:MiContact Center Business andMiVoice Analytics Version 9.0 do not support Call Forward
Always from RingGroups. Call Forward Always toRingGroups is supported.

To configure call forward destinations for calls you will forwardmanually

1. Right-click the Phone toolbar and click Configure.
2. Click theCall forward tab.
3. UnderName, type the name of the person to whom you will forward calls.
4. UnderNumber, type an extension or phone number (preceded by a number you dial to access

an outside line).
5. Click OK.

To configure and enable call forward destinations for calls the telephone system will forward

NOTE: MiContact Center Business andMiVoice Analytics Version 9.0 do not support Call Forward
Always from RingGroups. Call Forward Always toRingGroups is supported.

1. Right-click the Phone toolbar and click Configure.
2. Click theCall forward tab.
3. Specify the source for call forwarding.
4. Specify destinations for the following call types:

l All calls (all calls you receive)
l External call busy (external calls to your extension when you are unavailable)
l External call no answer (external calls to your extension that you do not answer)
l Internal call busy (internal calls to your extension when you are unavailable)
l Internal call no answer (internal calls to your extension that you do not answer)

5. To activate the call forwarding rules immediately, select theEnabled check boxes of the call
forwarding types to be activated.

6. Click OK.
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Configuring speed dial numbers
When you pre-configure speed dial numbers in Contact Center Softphone, these contacts are
available in drop-down lists adjacent to the Speed dial, Trans/Conf, and Request help buttons on the
Functions toolbar.

You can display a button for each speed dial number or display one button with a down arrow that
lists all of the speed dial numbers you have configured. You can speed dial calls manually to pre-
configured extensions and phone numbers.

To configure a speed dial number

1. Right-click the Phone toolbar and click Configure.
2. Click theSpeed dial tab.
3. UnderName, type the name of the person to whom you will speed dial calls.
4. UnderNumber, type an extension or phone number (preceded by a number you dial to access

an outside line).
5. Click OK.

Configuring shortcut keys
You can assign a shortcut key to a telephony function to perform it with a simple keystroke. This
enables you to perform telephony functions while the soft phone is minimized or another application
is currently selected.

To configure a shortcut key for a telephony function

1. Right-click the Phone toolbar and click Configure.
2. Click theShortcut keys tab.
3. UnderShortcut key, select a telephony function.
4. Click the down arrow, select Ctrl, Alt, Shift, orWin, and select a keyboard number, letter, or

function from the list.
5. Click OK.

Configuring pre-announcement messages
Agents who have Contact Center PhoneSet Manager or Contact Center Softphone can record
introductions that are played to callers (for example, 'Hi. This is Paul Jones in Customer Support.
Could you please tell me your customer site key?') The introduction that is played is based on the
queue the call arrives on and the time of day it is received. The recorded introduction provides
customers with a consistent greeting and gives the agent extra time to retrieve customer
information. You can stop pre-announcement messages at any time.

You can configuremore than one pre-announcement rule. For each rule, you specify the conditions in
which the soft phone will play a particular pre-announcement message. If one or more conditions is
satisfied for a particular rule, the soft phone will play the associated pre-announcement message.
You can order the rules on the Pre-announcement rules table to establish their priority. Pre-
announcement rules are evaluated in the order shown in the table. If one pre-announcement rule is
satisfied, the associated sound file is played and no other rules are evaluated.
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To use pre-announcement messages with Contact Center PhoneSet Manager, youmust have a
Mitel ACD desk phone (for example, 5212) and a PCTI adaptor. The PCTI adaptor enables the audio
being played from the agent PC and the audio from the agent desk phone to bemixed.

To connect a PCTI adapter to your computer for use with Contact Center PhoneSet Manager

1. Set the PCTI switch toBoth.
2. Set the PCTI switch toHeadSet.
3. Plug theMic/Audio cable of the headset into the appropriate Mic/Audio inputs on the

PCTI adapter.
4. Unplug the handset from the deskphone and plug it into the handset plug on the PCTI adapter.
5. Plug the telephone input cable of the PCTI adapter into the telephone base.
6. Plug the computer input of the PCTI adapter into the appropriate Mic/Speaker inputs on the

PC.
NOTE: Ensure the headset is turned on, on the deskphone base.

To configure a pre-announcement rule for Contact Center PhoneSet Manager

1. Right-click the Phone toolbar and click Configure.
2. Under This extension is a, select Desk phone.
3. To use audio devices for pre-announcements, select Use audio devices for pre-

announcements and specify the input and output audio device.
4. Click thePre-announcement tab.
5. Click Add rule.

The Add / Edit pre-announcement rule window opens.
6. Select the conditions that determine when the pre-announcement message will play.
7. Specify parameters for each condition.
8. Select or record a wave file to play when the above conditions aremet.
9. Type a name for the pre-announcement rule.
10. If you want to hear ringing on your desk phone, select Enable ringing sound in desk

phone.
11. Click OK.

To configure a pre-announcement rule for Contact Center Softphone

1. Right-click the Phone toolbar and click Configure.
2. Under This extension is a, select Soft phone.
3. Click thePre-announcement tab.
4. Click Add rule.

The Add / Edit pre-announcement rule window opens.
5. Select the conditions that determine when the pre-announcement message will play.
6. Specify parameters for each condition.
7. Select or record a wave file to play when the above conditions aremet.
8. Type a name for the pre-announcement rule.
9. Click OK.
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To re-order pre-announcement rules

1. Select a rule.
2. Click the up or down arrow to change the priority of the rule.
3. Click OK.

NOTE:You can alternately configure whisper announcements using agent workflows in IVR. See
theMiContact Center Business Installation and Administration Guide for more information.

MAKING ANDTERMINATING CALLSUSING CONTACT
CENTERPHONESETMANAGER
When youmake calls, on the Functions toolbar you can readily select contacts you pre-configure in
CCMWeb, or speed dial numbers you configure in Contact Center PhoneSet Manager. See
"Configuring speed dial numbers" on page 190 and "Displaying, hiding, and retiring toolbar buttons"
on page 186.

You can dial any extension number or phone number. Contact Center PhoneSet Manager typically
uses your primary extension tomake calls. You can optionally select a different extension on the
Phone toolbar to make calls.

Making calls
To dial by phone number or extension number using Contact Center PhoneSet Manager

1. In the dial box, type an extension or phone number (preceded by a number you dial to access
an outside line). Otherwise, click the down arrow adjacent to the dial box and type a number or
extension on the dial pad.

2. Click Dial.
3. If you want to view the call details window, click the down arrow adjacent to the box that

displays your current phone state.
See Figure 57.

To dial internally from a real-timemonitor using Contact Center PhoneSet Manager

l From any real-timemonitor, right-click an agent, employee, or extension cell and click Call.

Figure 57: Making a call



MiContact Center Business—MiVoice Business User Guide

193

Making calls to your contacts
Tomake a call to an extension in your contact list

1. Click the arrow adjacent to the dial box and click theContacts tab.
2. Select a contact in the list.
3. Click Dial.

Making calls using speed dial
To dial using speed dial

l Click Speed dial and select a name in the list.

Terminating calls
To terminate a call

l Click Hang up.

FORWARDING ANDANSWERING CALLSUSING CONTACT
CENTERPHONESETMANAGER
You can forward calls manually to pre-configured call forward destinations without having to speak to
the caller first. In addition, you can configure and enable call forwarding so the telephone system
forwards calls to other answer points when you are temporarily unavailable or away from the office.
See "Configuring call forward destinations" on page 189.

If a call is ringing on your extension and you click the Forward button, the call will be forwarded to the
default call forward destination configured in the telephone system. If you click the down arrow
adjacent to the Forward button, you can select an extension or phone number for call forwarding.

Forwarding calls
When a call is ringing on your extension, to forward the call using Contact Center PhoneSet Manager

1. Click Forward.
2. In the dial box, type an extension or phone number (preceded by a number you dial to access

an outside line). Otherwise, click the down arrow adjacent to the Forward button and select a
contact.

3. Click Dial.

Answering calls
When an agent receives a call with Contact Center PhoneSet Manager detailed caller information is
displayed on the desktop. (See Figure 58.) Agents can choose to answer the call or forward it to
another agent. Additionally, the display can provide access to call notes, which are notes an agent
adds to the call before transferring it. See "Adding call notes to a call" on page 195.
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If configured and available the following information is provided in the soft phone display

l Caller name—name of the caller
l ANI—telephone number of the caller
l DNIS—telephone number the caller dials
l DNIS name—the name associated to the DNIS number in YourSite database
l Agent ID—agent who transferred the call
l Extension—extension from which the call was transferred
l Queue—queue from which the call originated
l Collect Caller Entered Digits—digits the caller enters for identification purposes, such as a
customer site key

l Customer Collected Information—information collected from a third party OBDC database
l Call notes—notes added by an agent
NOTE:Call notes are supported for inbound calls only.

You can answer calls by right-clicking the Contact Center PhoneSet Manager system tray icon and
selecting Answer, or by clicking the Answer toolbar button.

Figure 58: Contact Center PhoneSet Manager display

To answer a call using Contact Center PhoneSet Manager

l Click Answer.

HANDLING CALLSUSING CONTACTCENTERPHONESET
MANAGER
You can handle calls by right-clicking the Contact Center PhoneSet Manager system tray icon and
selecting telephony functions, or by selecting telephony buttons on the Functions toolbar. The
telephony buttons available depend on the action you last performed. You can configure the toolbar
buttons so they are always visible, or visible only when required. See "Displaying, hiding, and retiring
toolbar buttons" on page 186.
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When you pre-configure speed dial numbers in Contact Center PhoneSet Manager, these contacts
are available in drop-down lists adjacent to the Speed dial, Trans/Conf, and Request help buttons on
the Functions toolbar. See "Configuring speed dial numbers" on page 190.

Placing calls on hold
To place a call on hold

l Click Hold (red oval button).

Retrieving calls
You can retrieve a held call, or retrieve a call when a call is camped on to your extension.

When an agent is on a call and another caller camps on to their extension, the Retrieve button is
enabled. When the agent presses the Retrieve button, they can talk to the held party. From that point
on, the agent uses the Swap button to switch back and forth between the two callers (current and
held parties).

To retrieve a call

l Click Retrieve.

Adding call notes to a call
When employees are speaking with customers, they can add notes to calls to share with other
employees involved in the call. This ensures all employees have context on calls and know what
information has been provided to customers upon call transfer.

When a call is being transferred to an employee, the soft phone display shows themost recent note
associated with the call. When the employee answers the call, Contact Center Client appears on top
of all other open applications and displays the Call Notes monitor. Themonitor includes all of the call
notes associated with the current call.

Employees can add notes each time a call is transferred, and employees on conference calls can
add notes simultaneously. Each set of notes includes the employee's name and a date/time stamp.
When an employee completes a call and answers a new call or closes the Call Notes monitor, all call
note information is saved and included in the Lifecycle reports. Call notes are not preserved when a
call is parked.

NOTE:

l Call notes are supported for inbound calls only.
l On the Soft phone configuration window, you can clear the Enable call notes check box to
hide the Call Notes monitor and prevent call notes from being displayed. Optionally, you can
enable the Bring to front check box to ensure call notes display on top of all other windows
when calls are received.

l Youmust have Contact Center PhoneSet Manager or Contact Center Softphone open in order
to view or add call notes.

l Time stamps are based on the 3300 ICP telephone system clock.
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To add a call note

1. As a call is ringing on your extension, on the soft phone display click Answer to answer the
call.
Contact Center Client appears on top of all open applications and displays the Call Notes
monitor.

2. AfterEnter a new call note, type a note.
Call notes can include amaximum of 100 characters.

3. Click Add.
The call note is added to the Call notes text box and is included in the soft phone display upon
call transfer.

Transferring calls
You can perform a blind transfer or a supervised transfer.

To perform a blind transfer

1. While on a call, click Trans/Conf.
2. In the dial box, type an extension or phone number (preceded by a number you dial to access

an outside line if required). Otherwise, click the down arrow adjacent to the Trans/Conf button
and select a contact.

3. Click Dial.
4. Click Hang up.

To perform a supervised transfer

1. While on a call, click Trans/Conf.
2. In the dial box, type an extension or phone number (preceded by a number you dial to access

an outside line). Otherwise, click the down arrow adjacent to the Trans/Conf button and select
a contact.

3. Click Dial.
The system places the caller on Hold.

4. Wait for the called party to answer. If you receive a busy signal or a voicemail greeting, click
Cancel to return to the initial party. Otherwise, speak to the agent and identify the caller.

5. Click Transfer to transfer the call.

Conferencing calls
You can include up to eight people in a conference call. The following example illustrates a three-way
conference call.

To set up a conference call

1. In the dial box, type an extension or phone number (preceded by a number you dial to access
an outside line).

2. Click Dial.
3. After you speak with the person who answers, click Trans/Conf to add a person to an in-

progress call.
The system places the person on hold.
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4. In the dial box, type an extension or phone number (preceded by a number you dial to access
an outside line). Otherwise, click the down arrow adjacent to the Trans/Conf button and select
a contact.

5. Click Dial.
6. Speak to the person who answers.
7. Click Conference to initiate a three-way conference call.

To split a conference call

l Click Split.
The last person you added to the conference call is placed on hold, and you can speak
privately with the first person.

Consulting with people while on calls
To consult with a person while on a call

1. Click Trans/Conf to conference in the person.
The system places the initial party on Hold.

2. In the dial box, type an extension or phone number (preceded by a number you dial to access
an outside line). Otherwise, click the down arrow adjacent to the Trans/Conf button and select
a contact.

3. Click Dial.
4. After you consult with the person, either click Conference to conference in the person, click

Cancel to hang up on the person, click Transfer to transfer the call to the person, or click
Swap to talk to the initial party.

Requesting help while on calls
To request help while on a call

1. Click Request help.
2. On the dial pad, type the extension number of the employee you want to call. Otherwise, click

the down arrow adjacent to the Request help button and select a contact.
3. Click Dial.

The system calls the employee. The employee can click Answer and listen in on the call
without the caller knowing and can click Conference to join the interaction at any time.

Using Camp on
The Camp on feature is available when youmake a call to an extension and receive a busy signal
because the employee is already on a call. Camp on notifies the employee you are attempting to call
with a series of audible beeps.

NOTE:

l Callers cannot camp on to your extension if you have call forwarding or voicemail configured
on the extension.

l You cannot camp on to an extension that is in Make Busy or Do Not Disturb.
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To camp on to an extension

1. In the dial box, type an extension number.
2. Click Dial.
3. If you receive a busy signal, click Camp on.

The employee you called will hear a series of beeps and can click Retrieve to place the caller
on hold and speak with you. After speaking with you, the employee can click Swap to return to
the caller.

Leaving and retrievingmessages
The Leave amessage feature is available when youmake a call to an extension that is idle or on a
call. Youmust use the dial pad to type a number when you are retrieving amessage.

To leave amessage

1. In the dial box, type an extension number.
2. Click Dial.
3. If the employee does not answer, click Leave a message.

The telephone system leaves amessage waiting notification on the employee’s extension and
the Contact Center Client icon flashes red and white in the employee’s system tray.

To retrieve amessage

1. Click Dial pad and type the number configured in the telephone system for message retrieval.
2. Press Enter.

The automated attendant will ask you for your password.
3. Type your password on the dial pad.
4. Follow the instructions provided by the automated attendant to retrieve themessage.

NOTE: If agents leave Call me back messages youmust use your physical phone set to retrieve the
messages.

Using Call me back
The Call me back feature is available when youmake a call to an extension that is idle or on a call.
When you select the Call me back button, the telephone systemmonitors the called employee’s
other extension. When the employee’s other extension returns to idle, your phone rings. If you pick
up the call, the employee’s phone will ring. If you do not pick up the call, the callback will expire.

To leave a callback message

1. In the dial box, type an extension number.
2. Click Dial.
3. If the employee does not answer, click Call me back.

The telephone systemmonitors the called employee’s extension. Your phone will rings when
the called employee’s other extension returns to the idle state.

4. When your phone rings, click Answer to pick up the call and speak with the employee.
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Tagging calls with Account Codes
If your system is set up to use Account Codes, you can apply them during a call. Classification
Codes are a type of Account Code, but differ in that you can apply them during or after a call.
Classification Codes can only to be applied to ACD calls. If you are set up to use Account Codes,
you are not necessarily also set up to use Classification Codes.

To tag an in-progress call with an Account Code or a Classification Code

l Click the down arrow adjacent to theAccount Code button and select a traditional Account
Code or a Classification Code.

After hanging up, while inWork Timermode, you can tag calls with Classification Codes.

To tag a call, after hanging up, with a Classification Code

1. Click the down arrow adjacent to theAccount Code button.
2. Select After Call Classification and select the appropriate Classification Code from the

drop-down list.

MAKING ANDTERMINATING CALLSUSING CONTACT
CENTERSOFTPHONE
When youmake calls, on the Functions toolbar you can readily select from contacts you pre-
configure in CCMWeb, or speed dial numbers you configure in Contact Center Softphone. See
"Configuring speed dial numbers" on page 190 and "Displaying, hiding, and retiring toolbar buttons"
on page 186.

You can dial any extension number or phone number. Contact Center Softphone typically uses your
primary extension tomake calls. You can optionally select a different extension on the Phone toolbar
to make calls.

Making calls
To dial by phone number or extension number

1. In the dial box, type an extension or phone number (preceded by a number you dial to access
an outside line). Otherwise, click the down arrow adjacent to the dial box and type a number or
extension on the dial pad.

2. If you want to view the call details window, click the down arrow adjacent to the box that
displays your current phone state.
See Figure 59.

To dial internally from a real-timemonitor

l From any real-timemonitor, right-click an agent, employee, or extension cell and click Call.
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Figure 59: Making a call

Making calls to your contacts
Tomake a call to an extension in your contact list

1. Click the arrow adjacent to the dial box and click theContacts tab.
2. Double-click a contact in the list.

Making calls to contacts who have called you recently
Tomake a call to a contact who has called you recently

1. Click the arrow adjacent to the dial box and click theRecent tab.
2. Double-click a contact in the list.

Making calls using speed dial
To dial using speed dial

l Click Speed dial and select a name in the list.

Redialing numbers
To dial the contact who last called you

l Click Speed dial and select a name in the list.

Terminating calls
To terminate a call

l Click Hang up.
Alternatively, on the Phone toolbar, click Cancel.
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FORWARDING ANDANSWERING CALLSUSING CONTACT
CENTERSOFTPHONE
You can forward calls manually to pre-configured call forward destinations without having to speak to
the caller first. In addition, you can configure and enable call forwarding so the telephone system
forwards calls to other answer points when you are temporarily unavailable or away from the office.
See "Configuring call forward destinations" on page 189.

If a call is ringing on your extension and you click the Forward button, the call will be forwarded to the
default call forward destination configured in the telephone system. If you click the down arrow
adjacent to the Forward button, you can select an extension or phone number for call forwarding.

Forwarding calls
When a call is ringing on your extension, to forward the call

1. Click Forward.
2. In the dial box, type an extension or phone number (preceded by a number you dial to access

an outside line). Otherwise, click the down arrow adjacent to the Forward button and select a
contact.

Answering calls
When an agent receives a call with Contact Center Softphone, detailed caller information is
displayed on the desktop. (See Figure 60.) Agents can choose to answer the call or forward it to
another agent. Additionally, the display can provide access to call notes, which are notes an
employee adds to the call before transferring it. See "Adding call notes to a call" on page 195.

If configured and available the following information is provided in the soft phone display

l Caller name—name of the caller
l ANI—telephone number of the caller
l DNIS—telephone number the caller dials
l DNIS name—the name associated to the DNIS number in YourSite database
l Agent ID—agent who transferred the call
l Extension—extension from which the call was transferred
l Queue—queue from which the call originated
l Collect Caller Entered Digits—digits the caller enters for identification purposes, such as a
customer site key

l Customer Collected Information—information collected from a third party OBDC database
l Call notes—notes added by an agent
Call notes are supported for inbound calls only.

You can answer calls by right-clicking the Contact Center Softphone system tray icon and selecting
Answer, or by clicking the Answer toolbar button.
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Figure 60: Contact Center Softphone display

To answer a call using Contact Center Softphone

l Click Answer.

HANDLING CALLSUSING CONTACTCENTERSOFTPHONE
You can handle calls by right-clicking the Contact Center Softphone system tray icon and selecting
telephony functions, or by selecting telephony buttons on the Functions toolbar. The telephony
buttons available depend on the action you last performed. You can configure the toolbar buttons so
they are always visible, or visible only when required. See "Displaying, hiding, and retiring toolbar
buttons" on page 186.

When you pre-configure speed dial numbers in Contact Center Softphone, these contacts are
available in drop-down lists adjacent to the Speed dial, Trans/Conf, and Request help buttons on the
Functions toolbar. See "Configuring speed dial numbers" on page 190.

Placing calls on hold
To place a call on hold

l Click Hold (red oval button).

Retrieving calls
You can retrieve a held call, or retrieve a call when a call is camped on to your extension.

When an agent is on a call and another caller camps on to their extension, the Retrieve button is
enabled. When the agent presses the Retrieve button, they can talk to the held party. From that point
on, the agent uses the Swap button to switch back and forth between the two callers (current and
held parties).

To retrieve a call

l Click Retrieve.
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UsingMute
To useMute

1. Click Mute.
The system disables your microphone so you can consult privately with another employee.

2. To restore your microphone, click Resume.

Transferring calls
You can perform a blind transfer or a supervised transfer.

To perform a blind transfer

1. While on a call, click Trans/Conf.
2. In the dial box, type an extension or phone number (preceded by a number you dial to access

an outside line). Otherwise, click the down arrow adjacent to the Trans/Conf button and select
a contact.

3. Click Hang up.

To perform a supervised transfer

1. While on a call, click Trans/Conf.
2. In the dial box, type an extension or phone number (preceded by a number you dial to access

an outside line). Otherwise, click the down arrow adjacent to the Trans/Conf button and select
a contact.
The system places the caller on hold.

3. Wait for the called party to answer. If you receive a busy signal or a voicemail greeting, click
Cancel to return to the initial party. Otherwise, speak to the agent and identify the caller.

4. Click Transfer to transfer the call.

Conferencing calls
You can include up to eight people in a conference call. The following example illustrates a three-way
conference call.

To set up a conference call

1. In the dial box, type an extension or phone number (preceded by a number you dial to access
an outside line).

2. After you speak with the person who answers, click Trans/Conf to add a person to an in-
progress call.
The system places the person on hold.

3. In the dial box, type an extension or phone number (preceded by a number you dial to access
an outside line). Otherwise, click the down arrow adjacent to the Trans/Conf button and select
a contact.

4. Speak to the person who answers.
5. Click Conference to initiate a three-way conference call.
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To split a conference call

l Click Split.
The last person you added to the conference call is placed on hold, and you can speak
privately with the first person.

Consulting with people while on calls
To consult with a person while on a call

1. Click Trans/Conf to conference in the person.
The system places the initial party on hold.

2. In the dial box, type an extension or phone number (preceded by a number you dial to access
an outside line). Otherwise, click the down arrow adjacent to the Trans/Conf button and select
a contact.

3. After you consult with the person, either click Conference to conference in the person, click
Cancel to hang up on the person, click Transfer to transfer the call to the person, or click
Swap to talk to the initial party.

Requesting help while on calls
To request help while on a call using Contact Center Softphone

1. Click Request help.
2. On the dial pad, type the extension number of the employee you want to call. Otherwise, click

the down arrow adjacent to the Request Help button and select an employee.
The system calls the employee. The employee can click Answer and listen in on the call
without the caller knowing and can click Conference to join the interaction at any time.

Using Camp on
The Camp on feature is available when youmake a call to an extension and receive a busy signal
because the employee is already on a call. Camp on notifies the employee you are attempting to call
with a series of audible beeps.

NOTE:

l Callers cannot camp on to your extension if you have call forwarding or voicemail configured
on the extension.

l You cannot camp on to an extension that is in Make Busy or Do Not Disturb.

To camp on to an extension

1. In the dial box, type an extension number.
2. If you receive a busy signal, click Camp on.

The employee you called will hear a series of beeps and can click Retrieve to place the caller
on hold and speak with you. After speaking with you, the employee can click Swap to return to
the caller.
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Leaving and retrievingmessages
The Leave amessage feature is available when youmake a call to an extension that is idle or on a
call.

To leave amessage

1. In the dial box, type an extension number.
2. If the employee does not answer, click Leave a message.

The telephone system leaves amessage waiting notification on the employee’s extension and
the Contact Center Client icon flashes red and white in the employee’s system tray

To retrieve amessage

1. In the dial box, type your voicemail access number.
The automated attendant will ask you for your password.

2. In the dial box, type your password.
3. Follow the instructions provided by the automated attendant to retrieve themessage.

NOTE:After you have checked your messages, youmust clear themmanually. They will not
be automatically cleared.

To clear amessage

1. On the Phone toolbar, click Message.
2. AfterCALL ME BACK?, click Yes.
3. Click Erase.

The telephone image displays NO MORE MESSAGES.

Using Call me back
The Call me back feature is available when youmake a call to an extension that is idle or on a call.
When you select the Call me back button, the telephone systemmonitors the called employee’s
other extension. When the employee’s other extension returns to idle, your phone rings. If you pick
up the call, the employee’s phone will ring. If you do not pick up the call, the callback will expire.

To leave a callback message

1. In the dial box, type an extension number.
2. If the employee does not answer, click Call me back.

The telephone systemmonitors the called employee’s extension. Your phone will rings when
the called employee’s other extension returns to the idle state.

3. When your phone rings, click Answer to pick up the call and speak with the employee.

Tagging calls with Account Codes
If your system is set up to use Account Codes, you can apply them during a call. Classification
Codes are a type of Account Code, but differ in that you can apply them during or after a call.
Classification Codes can only to be applied to ACD calls. If you are set up to use Account Codes,
you are not necessarily also set up to use Classification Codes.

To tag an in-progress call with an Account Code or a Classification Code

l Click the down arrow adjacent to theAccount Code button and select a traditional Account
Code or Classification Code
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After hanging up, while inWork Timermode, you can tag calls with Classification Codes

To tag a call, after hanging up, with a Classification Code

1. Click the down arrow adjacent to theAccount Code button.
2. Select After Call Classification and select the appropriate Classification Code from the

drop-down list.

CONTROLLING YOURAVAILABILITY
You can log yourself on or off, cancel Work Timer, cancel Reseize Timer, and place yourself in or
remove yourself fromMake Busy with reason or Do Not Disturb with reason using the soft phone.

To log on to the ACD

l Click Actions=>Log on and select an agent ID.

To log off of the ACD

l Click Actions=>Log off.

To set Make Busy with reason

l Click Actions=>Set Make Busy and select aMake Busy Reason Code.

To removeMake Busy with reason

l Click Actions=>Remove Make Busy.

To set Do Not Disturb with reason

l Click Actions=>Set Do Not Disturb and select a DoNot Disturb Reason Code.

To remove DoNot Disturb

l Click Actions=>Remove Do Not Disturb.

To cancel Work Timer

l Click Actions=>Cancel Work Timer.

To cancel Reseize Timer

l Click Actions=>Cancel Reseize Timer.

MAKING ANDHANDLING CALLSUSING CONTACTCENTER
CLIENT
You can open an agent, employee or extensionmonitor, or the Queue Now monitor and either right-
click an agent and select telephony functions or access telephony functions by selecting an agent
and accessing the options in the Contact Center Client ribbon. For example, when you are on a call
you can consult with an idle employee by right-clicking the employee’s cell and clicking
Transfer/Conference, or by sending the employee an instant message. (See Figure 61.)
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Figure 61: Consulting with a person while on call

Making calls
To call an agent using Contact Center Client

l Right-click the cell of an idle agent and click Call.

Alternatively:

1. Select an idle agent in an openmonitor.
2. Click theSoftphone button under theAgent Control tab in the Contact Center Client Real

Time ribbon.
3. Choose theCallmenu item.

Forwarding calls
If a call is ringing on your extension, to forward the call using Contact Center Client

l Right-click the cell of an idle agent and click Forward.

Answering calls
If a call is ringing on another agent’s extension, to pick up the call using Contact Center Client

l Right-click the cell of the agent and click Pick up.

Adding call notes
When agents are speaking with customers, they can add notes to calls to share with other contact
center employees involved in the call. This ensures agents and supervisors have context on calls
and know what information has been provided to customers upon call transfer. If the call is
transferred, call notes are preserved. Call notes are not preserved when calls are parked. See
"Adding call notes to a call" on page 195.

NOTE:
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l Before adding call notes, ensure the 'Display call notes' option is enabled in the Softphone
configuration window. This option is disabled by default.

l Call notes are supported for inbound calls only.

To add a call note

1. As a call is ringing on your extension, on the soft phone display click Answer to answer the
call.
Contact Center Client appears on top of all open applications and displays the Call Notes
monitor.

2. AfterEnter a new call note, type a note.
Call notes can include amaximum of 100 characters.

3. Click Add.
The call note is added to the Call notes text box and is included in the soft phone display upon
call transfer.

Recording calls
There are occasions when a user wants to temporarily stop recording a call for confidentiality
reasons, or, if the call is not currently being recorded, the user may want to start recording if the
interaction becomes hostile or sensitive in nature and a call recordmay be required. On the Agent
State by Time, Agent State by Position, Agent State by Queue by Time, and Extension Now
monitors, the Call recording option enables you to start, stop, and restart call recording at any time
during a call, usingMiVoice Call Recording functionality. Requirements for this on-demand call
recording feature are Contact Center PhoneSet Manager or Contact Center Softphone, and the
MiVoice Call Recording Connector.

To record a call

l Right-click the associated cell of an agent or extension and select Call Recording=>Start
Recording.

To stop recording a call

l To stop recording, right-click the cell and select Call Recording=>Stop Recording.

Alternatively:

1. Select the cell of an agent or extension in amonitor whose call you want to record.
2. In the Contact Center Client Real Time ribbon, under theAgent Control tab, select Start

Recording from the drop-down list in theCall Recording column.
3. To stop recording, select Stop Recording from the drop-down list in theCall Recording

column.
See Figure 62.
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Figure 62: Call recording 

Silent monitoring calls
Silent monitoring is the process of listening to the voice interactions of internal or external calls
between agents or extensions and callers. Silent monitoring enables you to track call handling
techniques and determine where improvements can bemade in individual performance. If required,
supervisors can conference into the call they are silently monitoring to talk to the customer. For more
information, see "Conferencing calls" on page 196 for Contact Center Softphone or see
"Conferencing calls" on page 203 for Contact Center PhoneSet Manager.

Silent monitoring is aMiVoice Business feature leveraged by MiContact Center Business. With
MiVoice Business 7.0+, supervisors can select an agent or extension for silent monitoring at any
time, but themonitoring does not begin until the agent or extension answers or makes a call. The
monitoring is maintained so long as the agent or extension remains on the call. The supervisor hears
everything the agent hears during the course of the call, including conferences and voicemail. If the
agent moves to a call on another line, silent monitoring will follow the agent over to that line. Up to six
supervisors can silently monitor an agent or extension. MiVoice Business 7.0+ also enables
supervisors to coach agents on call. For more information, see "Coaching agents and extensions on
a call with customers" on page 210.

Silent Monitor can be accessed through Contact Center Client or, if programmed on your 3300media
server, through entering a Feature Access Code (FAC) on your phone or in MiCollab Client. For more
information about silent monitor and its features and enhancements, consult your Mitel MiVoice
Business documentation.

NOTE:

l Themonitoring extension and the extension beingmonitoredmust coexist on the same
telephone system.

l Themonitoring extensionmust be permitted by security role to interactively control other
agents.

l Themonitoring extension’s soft phone toolbar must be open.

The following procedures explain how to

l Silently monitor a call using Contact Center Client
l Silently monitor a call using Contact Center Client and a Feature Access Code

The following procedures take place in an open real-time agent or extensionmonitor
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To silently monitor a call using Contact Center Client

l Right-click the cell of an agent or extension and select Silent Monitor.

Alternatively:

1. Select the cell of an agent or extension in amonitor whose call you want to silent monitor.
2. In the Contact Center Client Real Time ribbon, under theAgent Control orExtension

Control tab, click theSoftphone button and click Silent Monitor.
NOTE: If the telephone system settings are incorrect or themonitoring extension and the
extension beingmonitored are on separate telephone systems, you will be unable to Silent
monitor and will instead see 'Not Allowed' when you right-click the cell. If the extension you
want to monitor is not currently on a call, you will see 'Waiting' when you right-click the cell.

To silently monitor a call using Contact Center Client and a Feature Access Code

1. In the dial box, type the Feature Access Code followed by the agent or extension number.
2. Click Dial.

Coaching agents and extensions on a call with customers
Supervisors can communicate with agents or extensions they are silently monitoring while they are
on a call with a customer throughWhisper Coach. Whisper Coach is a feature of silent monitor,
enabling supervisors monitoring agents to talk to the agent and coach them through their call, without
letting the customer hear what the supervisor is saying. Supervisors can also coach agents who are
not actively handling a call. If required, supervisors can conference into an active call while coaching
to talk to the customer. For more information, see "Conferencing calls" on page 196 for Contact
Center Softphone or see "Conferencing calls" on page 203 for Contact Center PhoneSet Manager.

Once a supervisor starts silent monitoring an agent, they have the option of toggling coaching on and
off through their IP hardset or the Contact Center Softphone toolbar. Whisper Coach is not
automatically disabled when the agent completes the call or switches to a different call. If the
supervisor does not stop coaching, theWhisper Coach feature automatically activates the next time
the agent makes or answers a call. Only one supervisor can whisper coach an agent at a time. A
supervisor can also whisper coach another supervisor, including supervisors actively whisper
coaching an agent. If a supervisor whisper coaches another supervisor who is coaching an agent,
the supervisor will hear the coached supervisor and the agent, but only the coached supervisor will
hear you.

For more information onWhisper Coach, consult your Mitel documentation.

The following procedures explain how to

l Whisper to an agent or extension that you are silent monitoring with Contact Center PhoneSet
Manager

l Stop whispering to an agent or extension that you are silent monitoring with Contact Center
PhoneSet Manager

l Whisper to an agent or extension that you are silent monitoring with Contact Center Softphone
l Stop whispering to an agent or extension that you are silent monitoring with Contact Center
Softphone



MiContact Center Business—MiVoice Business User Guide

211

Towhisper to an agent or extension that you are silent monitoring with Contact Center PhoneSet
Manager

l On your hardset, press Coach On.

To stop whispering to an agent or extension that you are silent monitoring with Contact Center
PhoneSet Manager

l On your hardset, press Coach Off.

To whisper to an agent or extension that you are silent monitoring with Contact Center Softphone

l In theSoftphone toolbar, click Coach On.
See Figure 63.

Figure 63: Softphone coach on

To stop whispering to an agent or extension that you are silent monitoring with Contact Center
Softphone

l In theSoftphone toolbar, click Coach Off.

Transferring calls
To perform a blind transfer using Contact Center Client

l While on a call, right-click the cell of an idle agent and click Transfer call.

Alternatively:

1. Select the cell of an idle agent in amonitor.
2. In the Contact Center Client Real Time ribbon, under theAgent Control tab, click the

Softphone button and click Transfer call.

Consulting with employees while on calls
To consult with an employee while on a call using Contact Center Client

1. Right-click the cell of an idle agent and click Transfer/Conference.
The system places the initial party on hold.

2. In the dial box, type an extension or phone number. Otherwise, click the down arrow adjacent
to the Transfer/Conference button and select a contact.

3. Click Dial.
4. After you consult with the employee, either click Conference to conference in that person,

click Transfer to transfer the call to the employee, click Swap to talk to the other party, or
click Cancel to end the consultation call.



Using Contact Center PhoneSet Manager and Contact Center Softphone

212

Requesting help while on calls
To request help while on a call using Contact Center Client

l Right-click the cell of an idle agent and click Request help.
The system calls the employee. The employee can click Answer in the soft phone and listen
in on the call without the caller knowing. The employee can click Conference in the soft phone
to join the interaction at any time.
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MiCOLLAB AND IGNITE INTEGRATION
(DESKTOP)

MiCOLLAB AND IGNITE INTEGRATION (DESKTOP)
NOTE: TheMiCollab and Ignite integration described in this section only applies to Ignite
(DESKTOP). Ignite (WEB) integrates with MiCollab for inbound and outbound call handling and
supports supervised transfers and conferences fromMiCollab Client. Users requiring the full range
of MiCollab and Ignite integration features are recommended to use Desktop Ignite.

Ignite is a flexible, intuitive, and efficient tool for handling email, chat, and SMS interactions and for
performing basic call handling. Ignite enables agents to handlemultiple interactions simultaneously,
see the agent groups of which they aremembers, receive screen pop notifications of incoming
interactions, set Account Codes and Classification Codes, view personal performance statistics
and those of the queues and queue groups for which they answer, affect personal state indicators,
and be advised of the presence of other agents in their agent group(s).

In this integration, Ignite can be used for basic call handling. (See "Handling calls in Ignite" on page
253.) More sophisticated scenarios, such as supervised transfers and conferencing, require
MiCollab Client. For instructions related to the voice handling abilities of theMiCollab Client
application, refer to theMiCollab Client documentation available onMitel Online or via theWebhelp
within theMiCollab Client.

TheMiCollab Client and Ignite integration offers Enterprise presence (Non ACD) and extended ACD
presence indicators, informing co-workers of your real-time availability.

Contact Center Client is used as a supervisory tool in this integration, enabling real-timemonitoring
and alarming, forecasting, datamining, agent and ACD queue control, abandoned caller callbacks,
and efficient call handling by moving items from busy to less active queues.

NOTE: MiCollab cannot initiateWhisper Coach. For this feature supervisors require either PhoneSet
Manager, Contact Center Softphone, or a hard set.

This chapter describes voice handling using Ignite andMiCollab Client. For information regarding
handling email, chat, SMS, and openmedia interactions using Ignite, see theMultimedia Contact
Center Installation and Deployment Guide.

For installation and configuration details, see theMiContact Center Business Installation and
Administration Guide.

TheMiCollab and Ignite integration described in this section only applies to Ignite (WEB). Ignite
(WEB) integrates with MiCollab for inbound and outbound call handling and supports supervised
transfers and conferences fromMiCollab Client.

Ignite is a flexible, intuitive, and efficient tool for handling email, chat, and SMS interactions and for
performing basic call handling. Ignite enables agents to handlemultiple interactions simultaneously,
see the agent groups of which they aremembers, receive screen pop notifications of incoming
interactions, set Account Codes and Classification Codes, view personal performance statistics
and those of the queues and queue groups for which they answer, affect personal state indicators,
and be advised of the presence of other agents in their agent group(s).
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In this integration, Ignite can be used for basic call handling. (See "Handling calls in Ignite" on page
253.) More sophisticated scenarios, such as supervised transfers and conferencing, require
MiCollab Client. For instructions related to the voice handling abilities of theMiCollab Client
application, refer to theMiCollab Client documentation available onMitel Online or via theWebhelp
within theMiCollab Client.

MiCollab cannot initiateWhisper Coach. For this feature supervisors require either PhoneSet
Manager, Contact Center Softphone, or a hard set.

This chapter describes voice handling using Ignite andMiCollab Client. For information regarding
handling email, chat, SMS, and openmediainteractions using Ignite, see theMultimedia Contact
Center Installation and Deployment Guide.

For installation and configuration details, see theMiContact Center Business Installation and
Administration Guide.

MiCOLLAB BASIC AND IGNITE INTEGRATION
(DESKTOP)

There are some features described in this chapter that do not apply for customers running the
MiCollab Basic application. Refer to the following list of exceptions:

l Agents must use their deskphone for hot desking and cannot hot desk log in from
MiCollab Client.

l Instant messaging is not supported.
l Extended ACD presence is not supported.

MiCOLLAB CLIENT AND IGNITE USER INTERFACE
(DESKTOP)

Ignite, when started, automatically docks to theMiCollab Client application, creating one client
interface for voice andmultimedia. See (Figure 64.)

Figure 64: MiCollab Client and Ignite integration

TheMiCollab Client and Ignite integration offers you the flexibility to access as much or as little of
the interface as needed in order to optimize desktop real estate.
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For example, you can choose to collapse themain Ignite window and only access the Ignite Sidebar
andMiCollab Client (recommended for voice-only agents) or expand the Ignite panes if you will also
handle non-voicemedia. If you are transferring a call, it is beneficial to check recipient agent
availability before transferring. (See Figure 65.)

Given enough space on the screen, MiCollab Client automatically docks to the right of the Ignite
window. If there is not enough space to the right, MiCollab Client docks to the left of the Ignite
window. If the agent repositions theMiCollab Client on the desktop, Ignite will automatically re-dock
toMiCollab Client in its new position.

You canminimize and restore theMiCollab Client and Ignite applications independently or together.
When both windows are full size, you canminimize the individual application. When the Ignite
window is collapsed, minimizing theMiCollab Client window alsominimizes Ignite.

Figure 65: Accessing agent availability in the Ignite Transfer window when transferring a call

HANDLING VOICE INTERACTIONSWITH THEMiCOLLAB
CLIENT AND IGNITE INTEGRATION

The following table lists agent actions and the application in which they are performed.

AGENT ACTION MiCOLLAB CLIENT IGNITE (DESKTOP) IGNITE (WEB)

Voice ACD log on and
log off ✓ ✓ ✓

Set or removeMake
Busy with Reason

Code
✓ ✓

Table 20: Agent actions by application



Handling voice Interactions with the MiCollab Client and Ignite integration

217

AGENT ACTION MiCOLLAB CLIENT IGNITE (DESKTOP) IGNITE (WEB)

Set or remove DoNot
Disturb with Reason

Code
✓ ✓

Cancel Work Timer ✓ ✓

Chat (IM) ✓

Join/Leave Agent
Group ✓ ✓

Answer ✓ ✓ ✓

Auto Answer * ✓ ✓

HangUp ✓ ✓ ✓

Conference ✓ ✓

Merge

Cancel ✓ ✓

Account Code ✓ ✓

Classification Code ✓ ✓

Call me back ✓

Call forwarding ✓

Camp on ✓

Forward ✓

Leave amessage ✓

Mute ✓

Retrieve ✓ ✓

Split ✓

Silent Monitor ✓

Transfer (blind) ✓ ✓ ✓

Transfer (supervised) ✓ ✓

Transfer/Conf ✓ ✓

Table 20: Agent actions by application (continued)
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AGENT ACTION MiCOLLAB CLIENT IGNITE (DESKTOP) IGNITE (WEB)

Volume ✓

Dial Pad ✓ ✓

Dial Contacts ✓ ✓

ACD Hot desk login

x

(with MiVoice
Business 6.0 SP3+)

and with SIP

✓

Table 20: Agent actions by application (continued)

*For the auto answer feature to work for an agent using a deskphone, the deskphonemust have an
auto answer key appearance set and auto answermust be enabled in the agent’s Class of Service.
For an agent using aMiCollab softphone, auto answermust be enabled using theMiTAI browser.

The following features continue to be available in Contact Center Client (Contact Center Softphone
or Contact Center PhoneSet Manager) but are not currently supported in theMiCollab Client and
Ignite integration:

l Whisper Coach
l Custom ring tones
l Speed Dial
l Call notes
l External Hot Desking Agents

If these features are necessary to your business, you can continue to use Contact Center Softphone
or Contact Center PhoneSet Manager but these applications do not support an integration with
Ignite.
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AGENTSTATE INDICATORS
MiCollab Client displays Enterprise presence (Non ACD) and extended ACD presence.

Extended ACD presence displays in MiCollab Client for all agents who aremembers of the same
agent group(s) as the logged in employee. These states are:

l Logged out
l Not available for ACD (not present in any agent groups)
l Available for ACD (logged in and idle)
l Busy <reason> (logged in and busy)

l Busy –Outbound (making an outbound call)
l Busy – ACD (receiving an ACD call)
l Busy <Make Busy reason code name> (in MKB, including systemMKB)
l Busy – Non-ACD (receiving a Non ACD call, such as a consultation call (pre-transfer)
or a direct call to their agent DN)

l DoNot Disturb - <DND reason code name> (logged in and in DND)
l Unknown – this indicator may display following anMiContact Center Enterprise Service
restart

Agent state indicators enable you to determine agent availability and display in bothMiCollab Client
and Ignite. When transferring calls, you can check the agent state indicator to see if the receiving
agent is available before completing the transfer.

NOTE: Ignite may remove voice agent presence if communication between theMiCollab Client and
theMiCollab Client Server is lost. If this occurs, agents must manually reset presence once
communication is restored.

Ignite displays the agent’s overriding state and the time spent in that state. If the length of time
exceeds 24 hours, Ignite displays by days:hours:minutes:seconds. See "Getting started with Ignite
(DESKTOP)" on page 222 for an example of the Ignite Sidebar interface.

Agent overriding states, and their associated colors, include:

l Ringing (Red)
l ACD (Red)
l ACD Hold (Red)
l Non-ACD/Outbound (Blue)
l Work Timer (Yellow)
l DND (Red)
l Make Busy (Yellow)
l Not present in any agent group (Yellow)
l Idle (Green)
l Unknown (Gray)
l Logged out (Gray)
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MiCOLLABCLIENT
Voice handling instructions for MiCollab Client are described in theMiCollab Client documentation
available onMitel Online or via theWeb help within theMiCollab Client.

Logging intoMiCollab Client
If you start Ignite before logging into MiCollab Client, you will be prompted to register and log in your
voice agents in MiCollab Client before signing into Ignite. We recommend you start and log into
MiCollab Client before starting and logging into Ignite.

To log into MiCollab Client as a Hot Desking Agent

1. Right click on theAgent in theActive Callswindow.
2. Select Hot-Desk In.

A new dialog window opens.
3. In theBase DN text box, enter your base extension.
4. If your business uses PINs, enter your PIN.
5. Click Hot-Desk In. Your hot desk agent is now logged in and your base extension is out of

service.
NOTE:By default, Ignite is configured to detect voice agent logout. If you are running Ignite
and you exit MiCollab Client, your employee and all associated agents are signed out of
Ignite.

IGNITE
Ignite is used by agents to handle all types of media, including voice, email, chat, SMS, and open
media.

Note: The Desktop Ignite application is not supported onMiCC Business for Open SIP. Agents
must useWeb Ignite for all agent functionality.

Ignite is available as either a desktop orWeb version. They sharemuch of the same functionality but
also offer unique agent and supervisor experiences enabling you to choose the application that suits
your individual needs. In our documentation, we refer to desktop Ignite and its features as Ignite
(DESKTOP) andWeb Ignite and its features as Ignite (WEB) or, where appropriate, as DESKTOP or
WEB only.

If you want access to the following features, we recommend using Ignite (DESKTOP):

l Fully supported integration with MiCollab Client, including:
l State indicator collaboration (state changes in either Ignite or MiCollab are reflected in
each application)

l Ability to dock Ignite to MiCollab Client andminimize/maximize both applications
simultaneously

l Auto-logout fromMiCollab Client when agent logs out of Ignite
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l Recording and implementing pre-announce and agent greetings
l Requesting help from other agents or supervisors while on a call
l Viewing agents' Inbox contents
l Being notified by email of Enterprise Server alarms
l Using the ‘Next Longest button’ to access longest-waiting Chat and SMS interactions with a
single click

l Grouping, sorting, and organizing interactions using the card and grid views

If you want access to the following features, we recommend using Ignite (WEB):

l Accessing Ignite from any supported, Web-enabled device
l Full support for tablets (Apple, Android, andMicrosoft)
l Partial support for mobile phones (Apple, Android, andMicrosoft), including the ability to
log in and out, view dashboards, change ACD state, set and removeMake Busy and
DoNot Disturb, removeWork Timer, and interact with agent states via dashboards

l Viewingmultiple windows simultaneously to enable greater, immediate access to different
types of information

l Switching between desktop, tablet, andmobile device, while maintaining consistent access
to all relevant information

l Logging into Ignite, without necessarily being available in queues, enabling employees to
access Ignite without being presented with ACD calls

l Accessing supervisor-light version of Contact Center Client’s Interactive Contact Center
capabilities, including interacting with agent states and agent group presence, andmoving
interactions from queues to agents, based on agent availability and queue activity levels

NOTE:UsingMiCollab Client in conjunction with Ignite, to handle voice interactions, but without
integration functionality, such as collaborative state updates, docking, minimizing/maximizing
together, click to IM other agents and supervisors, andMiCollab Client auto-logout when logging out
of Ignite

In this chapter we discuss Ignite as a voice handling system in conjunction with MiCollab Client and,
as such, suggest you refer to theMultimedia Contact Center Installation and Deployment Guide if
you want to access detailed Ignite instructions related tomedia other than voice.
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Getting started with Ignite (DESKTOP)
The Ignite user interface contains a Folders pane, a List pane, and a Preview pane that displays
information about an active call. The Status bar displays agent status, and the Action bar and
Sidebar contain controls for various call handling operations. See Figure 66.

Figure 66: Ignite user interface

You can choose to collapse themain Ignite window and only access the Ignite Sidebar or expand the
Ignite panes if you also handle non-voicemedia. Additional options for personalizing the Ignite
interface are available to agents. See "Configuring agent profiles in Ignite (DESKTOP)" on page 226.

The following sections describe how agents can use Ignite to:

l View agent state and statistics
l Access agent handling statistics
l Log in and out
l Configure agent profiles, including recording andmanaging agent greetings
l View and adjust Agent Group Presence
l Set and removeMake Busy and DoNot Disturb status
l Handle calls and perform in-call actions, such as transferring calls, tagging calls with Account
Codes and Classification Codes, and requesting help

l RemoveWork Timer (if enabled for the queue)
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See "MiCollab Client and Ignite user interface (DESKTOP)" on page 215 for a view of the overall
Ignite user interface for voice agents. See Figure 67 for a detailed view of the Ignite Sidebar, where
themajority of voice agent actions take place.

Figure 67: Ignite Sidebar
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Viewing agent state and statistics in the Status bar (DESKTOP)
The Status bar displays the employee’s overriding state, including:

l Time in Ringing – Displays when an employee has interactions ringing in the Inbox
l Time in ACD – Displays when an employee has placed ACD interactions in reply mode
l Time in ACD Hold – Displays when an employee has placed ACD interactions on hold
l Time in Non ACD – Displays when an employee is handling Non ACD interactions
l Time in Non ACD Hold – Displays when an employee has placed Non ACD interactions on
hold

l Time in Outbound – Displays when an employee has placed an outgoing call
l Time in Work Timer – Displays after the employee has handled an interaction, provided
none of the employee’s agents are in an ACD, Non ACD, Outbound, Make Busy, or Do Not
Disturb state

l Time in Do Not Disturb – Displays when the employee is in a DoNot Disturb state
l Time in Make Busy – Displays when an employee is in aMake Busy state
l Time Logged in Not Present – Displays when an employee is not present in any of their
agent groups

l Time in Reseize Timer – Displays when an call fails to route to an employee
l Time in Idle – Displays when an employee does not have contacts in the Inbox

An overriding state is a state that supersedes other states. States higher in the list override the
states appearing lower in the list. Note that all of the employee’s agents are considered when the
system calculates overriding state.

The oldest length for a state supersedes other times for the same state if an agent is handling
multiple interactions. For example, if an employee had two emails in ACD, the displayed value in the
status bar would be the time of the oldest email. When the oldest email is completed, the displayed
value in the status bar would switch to the other email’s Time in ACD.

You can display agent handling statistics by clicking the ^ button on the right-hand side of the Status
bar. Ignite’s Status bar also contains statistics on agent performance as it relates to handling
multimedia interactions. See theMultimedia Contact Center Installation and Deployment Guide for
more information.

NOTE: The Status bar is only visible to employees with associated voice, email, chat, SMS, or open
media agents.

Accessing agent handling statistics by media type (DESKTOP)
Agents can view statistics related to their performance via the Sidebar. If you are enabled for media
types other than voice, you can toggle betweenmedia-specific statistics using the icon directly
above the statistic display. Select the headphone icon for voice, the envelope icon for email, the
interaction icon for chat, or the phone icon for SMS statistics.
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By default, the Sidebar displays Shift Time, DND Time, andMKB Time. However, you can select
any three agent shift statistics from the Sidebar Stats tab under the Settings menu. See "Sidebar
Stats settings (DESKTOP)" on page 227 for more information.

If the statistic name is too long to display in full, you can hover over the statistic and read the tooltip
or left-click the statistic to view the full name in the fly-out menu.

Logging into and out of Ignite (DESKTOP)
You can open Ignite from theWindows Start menu, Programs menu, Taskbar, or from aDesktop
shortcut.

We recommend that agents using Ignite in conjunction with MiCollab Client log into their voice agent
in MiCollab Client before logging into Ignite. If you choose to log into Ignite prior to logging into
MiCollab Client, you will be prompted during the Ignite login process to register your voice agent in
MiCollab Client.

Depending on administrative settings, agents may find that, after logging into their phone and into
Ignite, they are placed inMake Busy across all agent capabilities. After logging into Ignite the agent
can removeMake Busy and become available to receive ACD calls.

When you log in to Ignite, you become available to answer interactions for your associated queues
and will receive items based on routing rules and your agent workload.

To log into Ignite

1. Start Ignite.
2. Enter yourUsername andPassword.

NOTE: If your system uses Windows Authentication, you will be logged in automatically.
3. If you want the system to remember your login credentials, click Remember Me.
4. Click Login.

To log out of Ignite and restart the program to the login screen

l In theSidebar, click theSign Out or Exit button and select Sign Out.
The agent is logged out of Ignite, and Ignite restarts to the login screen.

To log out of Ignite and close the application

l In theSidebar, click theSign Out or Exit button and select Exit Application.
NOTE:You can also close Ignite from the Sign In screen by clicking theExit Application
button.
The agent is logged out of Ignite, and the application closes.
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Configuring agent profiles in Ignite (DESKTOP)
When youmakemanual adjustments to Ignite, the system stores the changes in your profile. When
you close Ignite, your profile is automatically saved. When you reopen Ignite with your user name,
Ignite loads your most recent profile settings. If Ignite shuts down suddenly, for example, due to a
power outage and subsequent computer restart, Ignite uses your last saved profile when restarted.

To reset your profile to the default settings

l Press and holdCtrl+R as you click the Login button in Ignite. Continue to holdCtrl+R until
you are logged in to Ignite.

In addition to auto-settings, Ignite offers the following configuration options via the Settings button in
the Sidebar.

General settings (DESKTOP)
By clicking the Settings button in the Sidebar and then clicking the General settings tab, you can
customize Ignite display and behavior.

l Launch MiCollab Client if installed but not running when signing into Ignite: This
setting is selected by default and automatically opens MiCollab Client, if not currently running,
when an agent signs into Ignite.
NOTE:Youwill be prompted to register and log in your voice agents in MiCollab Client before
signing into Ignite.

l Always show Sidebar: This setting is checked by default. If unchecked, you will not have
access to the options listed below and you will need to use the arrow icon to show or hide the
Sidebar.

l Expand Ignite when a multimedia item is accepted: This setting is checked by default.
When selected, if themain Ignite window is collapsed and an email, chat, SMS, or open
media is accepted via the toaster, themain Ignite window automatically expands. If not
selected, Ignite will not automatically expand when an email, chat, SMS, or openmedia is
accepted and the agent must expand it manually by clicking the arrow at the bottom of the
Sidebar.

l Expand Ignite when a voice item is accepted: This setting is not checked by default and if
themain Ignite window is collapsed and a call is accepted via the toaster, Ignite does not
automatically expand. We recommend deselecting this setting as themain Ignite window is
not essential for handling voice interactions. If selected, if themain Ignite window is collapsed
and a call is accepted via the toaster, Ignite automatically expands.

l Collapse Ignite on startup: This setting is not checked by default. When you start Ignite, the
main window will not collapse. If this check box is selected, only the Ignite Sidebar displays at
startup. You can use the arrow icon at the bottom of the Sidebar to expand themain Ignite
window. If this setting is not selected, when you start Ignite themain window and the Sidebar
will display.

l Collapse Ignite when inbox is emptied: This setting is not checked by default. When
selected, and your inbox empties, themain Ignite window collapses. If not selected, themain
Ignite window does not collapse when your inbox has been emptied.
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Sidebar Stats settings (DESKTOP)
By clicking the Settings button in the Sidebar and then clicking the Sidebar Stats settings tab, you
can select which three agent handling statistics you want to display in the Ignite Sidebar.

You can select which queues are visible by clicking the Settings button in the Sidebar and clicking
Queue Selection. You are still offered interactions for the queues to which you are assigned, even
though they may not be visible.

Ignite can display amaximum of 64 queues. If your profile is new, from an upgrade, or has been
restored from a reset, Ignite automatically loads themaximum number of queues, starting with
Unified Queues and then Individual Queues. Queues under Reporting Queues are never loaded by
default.

Agent greeting settings
The Agent Greeting feature enables agents to recordmessages (as .wav files) that play
automatically to callers when the agent answers an inbound ACD call. The greeting can provide a
consistent experience for each caller and free the agent from having to repeat the same introductory
phrase for every call.

Agents can recordmultiple greetingmessages in Ignite and assign them to different queues or use
the same recorded greeting on all queues. The agent greeting is a two-way playback, where both the
caller and the agent hear the recording.

Agents record andmanage their greetings on the Agent Greeting tab on the Settings page.

NOTE:

l When the agent greeting is playing, the caller is able to hear the agent speaking. To prevent
the caller from hearing the agent or other contact center background noise during the agent
greeting, mute the agent's headset for the duration of the greeting.

l Administrative settings determine whether you have access to Agent greeting functionality. If
your contact center is not enabled for agent greetings, the Agent Greeting tab will not display
in Ignite.

On the Agent Greeting tab, you can:

l Record greetings
l Assign greetings to specific queues
l Designate a recording as the default greeting
l Play or re-name an existing greeting
l Re-record or delete an existing greeting

Recording agent greetings (DESKTOP)
When you click the Record button to create a recording, the system's Record Agent Greeting
workflow is triggered. The Record Agent Greeting workflow instructs the system to call your DN and
prompts you to record and save a greeting.

NOTE:When recordingmessages, your voice agent is in a Non ACD state, and is not offered calls
from any incoming queues.
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To record your first agent greeting

1. Click theSettings button in theSidebar, then click theAgent Greeting tab.
2. Hover over theAdd New Recording label to make theRecord button visible on the right-

hand side.
3. Click theRecord button.
4. Enter a name for the recording and click OK.

The Record Agent Greeting workflow is triggered and instructs the system to call your DN.
5. Answer the incoming call and follow the system prompts to record and save your greeting.

The new greeting displays under the Default Recording heading.

By default, the system selects the first recording as your default recording. The default recording is
played on all incoming calls, regardless of the originating queue, unless there is a specific recording
assigned to the queue. For more information, see "Assigning a recorded greeting to a queue
(DESKTOP)" on page 228.

You can record additional greetings and designate any one of your saved recordings as the default
recording, or you can choose not to use a default recording.

To record additional greetings

1. Click theSettings button in theSidebar, then click theAgent Greeting tab.
2. Click on the down arrow beside theAdvanced Options heading to expand the section.
3. Hover over theAdd New Recording label to make theRecord button visible on the right-

hand side.
4. Click theRecord button.
5. Enter a name for the recording and click OK.

The Record Agent Greeting workflow is triggered and instructs the system to call your DN.
6. Answer the incoming call and follow the system prompts to record and save your greeting.

The new recordedmessage displays under the Recordings heading.
7. Repeat steps 3 to 6 to record additional greetings.

Assigning a recorded greeting to a queue (DESKTOP)
By default, the recording listed under the Default Recording heading on the Agent Greeting tab is
played on all incoming calls, regardless of the originating queue. However, you can assign different
recordings to different queues if you want to customize your greeting for certain inbound calls.

NOTE: If you do not have a designated default recording, youmust assign a recording to each queue
explicitly. If there is no default recording, and a queue does not have a recording assigned to it, no
greeting is played to customers on incoming calls from that queue.

TheQueues section of the Agent Greeting (under AdvancedOptions) lists all of the queues to which
you are assigned. The recorded greeting that plays on incoming calls from a queue is shown to the
right of the queue name.
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To assign a recording to a queue

1. Click theSettings button in theSidebar, then click theAgent Greeting tab.
2. Click on the down arrow beside theAdvanced Options heading to expand theAdvanced

Options section.
3. Under theQueues heading, select the queue to which you want to assign a recording by

selecting the check box beside it.
l You can search for a specific queue by typing the name in theSearch box.
l You can filter the list of queues to show only the queues that do not have the default
recording assigned to them by clicking theOnly Show Non-Default option.

4. Click theApply Recording button.
The Apply Recording window opens. The selected queue is displayed at the top, and a list of
available recordings displays below.

5. Hover over the recording you want to assign to the queue tomake the check mark visible on
the right-hand side.

6. Click on the check mark to apply the selection.
The check mark turns green and the new recording displays beside the selected queue in the
Queues list on themain Agent Greeting tab.

7. To remove the custom greeting from the queue and revert back to using the default recording,
click theX button beside the recording you just assigned to the queue.
The Default Recording label displays beside the queue.

Managing recorded greetings (DESKTOP)
You can review, modify, and delete existing recordings in Ignite. You can:

l Play a greeting
l Re-record a greeting
l Rename a greeting
l Designate a greeting as the default greeting
l Delete a greeting

To play a greeting

1. Click theSettings button in theSidebar, then click theAgent Greeting tab.
2. To select a non-default greeting, click the down arrow beside theAdvanced Options heading

to expand the section.
3. Under theRecordings section, hover over the name of the recording in the list to make the

row of icons visible on the right-hand side.
4. Click thePlay button (second icon from the left).

The system plays the recorded greeting on your PC.



MiContact Center Business—MiVoice Business User Guide

230

To re-record a greeting

1. Click theSettings button in theSidebar, then click theAgent Greeting tab.
2. Click on the down arrow beside theAdvanced Options heading to expand the section.
3. Under theRecordings section, hover over the name of the recording in the list to make the

row of icons visible on the right-hand side.
4. Click theRecord button.

The Record Agent Greeting workflow is triggered and instructs the system to call your DN.
5. Answer the incoming call and follow the system prompts to record and save your greeting.

The changes are saved to your existing recording.

NOTE:You can also re-record the default greeting. Hover over the greeting listed under theDefault
Greeting header and click theRecord button (as noted above) to re-record the greeting.

To rename a greeting

1. Click theSettings button in theSidebar, then click theAgent Greeting tab.
2. Click on the name of the recording you want to rename (either in theDefault Greeting section

or theRecordings section).
The name field becomes editable.

3. Type the new name of the recording in the name field, then click Rename.
The recording displays in the list with the new name.

To designate a greeting as the default greeting

1. Click theSettings button in theSidebar, then click theAgent Greeting tab.
2. Hover over the name of the recording in the list to make the row of icons visible on the right-

hand side.
3. Click thePin button tomake the greeting the default greeting.

The newly-designated greeting displays in the Default Recording section.
4. To clear the default recording designation, hover over the name of the default recording to

make the row of icons visible, and click thePin button.
The greeting is removed from the Default Recording section.

To delete a greeting

1. Click theSettings button in theSidebar, then click theAgent Greeting tab.
2. Hover over the name of the recording in the list to make the row of icons visible on the right-

hand side.
3. Click the Trash button to delete the greeting.

The system displays a confirmation dialog.
4. Click Yes to confirm that you want to delete the greeting.

The greeting is removed from the system.

Agent greeting settings (WEB)
The Agent Greeting feature enables agents to recordmessages (as .wav files) that play
automatically to callers when the agent answers an inbound ACD call. The greeting serves to
provide a consistent experience for each caller and free the agent from having to repeat the same
introductory phrase for every call.
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Web Ignite allows the agents to record a single default agent greeting that can be assigned to all
queues. The agent greeting is two-way playback, that is both the caller and the agent hear the
recording.

Agents record andmanage their default greeting on theOptions > Agent Greeting page.

NOTE:

l When the agent greeting is playing, the caller can hear the agent speaking. To prevent the
caller from hearing the agent or other contact center background noise while the agent greeting
plays, mute the agent's headset for the duration of the greeting.

l Administrative settings determine whether you have access to Agent Greeting functionality. If
your contact center is not enabled for agent greetings, the Agent Greeting options will not
display in Ignite.

Recording agent greetings (WEB)
When you click theRecord button to create a recording, the system's Record Agent Greeting
workflow is triggered. The Record Agent Greeting workflow instructs the system to call the dialed
number and prompts you to record and save a greeting.

NOTE: When recordingmessages, your voice agent is in a non-ACD state, and is not offered calls
from any incoming queues.

To record a greeting :

1. In theActive Greeting section, go toOptions > Agent Greeting and click Record.
2. Enter a greeting name in theRecord Greeting dialog box that appears.

Note: Only digits, letters, dash, underscore, space, period, and apostrophe characters are
allowed.

3. Click Ok. The Record Agent Greeting workflow is triggered and instructs the system to call to
the dialed number.

4. Answer the incoming call and follow the system prompts to record and save your greeting.
While recording, the Agent Greeting page is disabled and aRECORDING IN PROGRESS
message and a spinner icon are displayed.

5. After successful recording and saving of the greeting, DOWNLOAD GREETING messages
appears.

6. After the greeting is downloaded, the Agent Greeting page enables, the downloaded greeting
becomes theActive Greeting and is loaded in the audio player.

To record additional greetings :

1. If there is no Active Greeting, follow procedure described in the preceding section.

2. If there is an Active Greeting, click Record. A dialog will appear asking you whether to record a
new greeting or re-record the Active Greeting.

3. If you click New, a new greeting is recorded. Follow the procedure described in the section "To
record a greeting".

4. If you click Existing, the Recording Agent Greeting workflow will be triggered automatically and
will use the same greeting name that you have entered for the existing greeting. The rest of the
procedure is the same as described in the section "To record a greeting".
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Managing recorded greetings (WEB)
After selecting a greeting, perform the following actions inWeb Ignite:

• Play a greeting
• Download a greeting
• Re-record a greeting
• Rename a greeting
• Designate a greeting as the default greeting
• Remove default greeting
• Delete a greeting

To select a greeting

To perform any actions on a greeting, youmust select that meeting so that it becomes the Active
Greeting.

1. In theActive Greeting section, click Search. Search Greeting dialog box opens.
2. The recent last 10 used greetings are listed under theAgent Greeting History section. You

can delete any greetings from the history by clicking theDelete From History icon
3. You can also search for a specific greeting by typing the name in theSearch box.

By default, only the first 15 greetings are displayed.To view additional greeting, click SEE
MORE.

4. Select the greeting that you want to be an Active Greeting. The selected greeting is now the
Active Greeting.

To play a greeting

1. Execute To Select a greeting.
The Active Greeting is automatically loaded in the audio player.

2. Click Play in the audio player.

To download a greeting

1. Execute To Select a greeting.
The Active Greeting is automatically loaded in the audio player.

2. Click Download in the audio player.

To re-record a greeting

1. See the section To record additional greetings.

To rename a greeting

1. Execute To Select a greeting.
2. Click Rename.

The RenameGreeting dialog box opens.
3. Enter a name for the greeting and click Save.

To delete a greeting

1. Execute To Select a greeting.
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2. Click Delete .
A confirmation alert is displayed.

3. Click OK.

To designate a greeting as the default greeting

1. Execute To Select a greeting.
2. Click Set as default greeting

A confirmation alert is displayed.
3. Click OK.

To remove default greeting

1. InDefault Greeting section, click Clear Default Greeting
A confirmation alert is displayed.

2. Click OK to confirm removal of the greeting.

Assigning a recorded greeting to a queue (WEB)
By default, the greeting listed under theDefault Greeting section is played for all the incoming calls.
However, you can customize the greetings for inbound calls by assigning different greetings to
different queues.

NOTE: If you do not have a designated default greeting, youmust assign a greeting to each queue
explicitly. If there is no default greeting and a greeting is not assigned to the queue, then no greeting
is played to customers for incoming calls for that queue.

TheConfigure Queue Greeting section lists all the queues to which greetings are assigned. The
greeting that plays on incoming calls from a queue is shown to the right of the queue name.

NOTE: If there is no greeting assigned to a queue and there is a default greeting, the default greeting
will be used and tagged as“(Default Greeting)”.

To assign a recording to a queue

1. Select the checkbox beside the queue to assign the greeting.
By default, only the first 15 queues are displayed. You can view additional queues by clicking
theSEE MORE link.
You can also search for a specific queue by typing the name in the Search box.

2. Click Assign. TheSearch Greeting dialog opens.
3. By default, the last ten used greetings are listed under theAgent Greeting History section.

Click Delete From History to delete the greetings from the history.
4. You can also search for a specific greeting by typing the name in the Search box. By default,

only the first 15 greetings are display. You can see additional greeting by clicking theSEE
MORE link.

Removing a recorded greeting from a queue (WEB)
1. Select a queue or multiple queues from which you want to remove the assigned greeting.

NOTE: At least one of the selected queues must have an assigned greeting; otherwise the
Clear Greeting button remains disabled.

2. Click Clear Greeting .
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GETTING STARTEDWITH IGNITE (WEB)
The following sections provide a walkthrough of Ignite’s interface. While this section contains some
procedures for viewing and orienting Ignite, agents can access in-depth information on how to use
Ignite by following the cross-references throughout.

The following sections describe how agents can use Ignite to:

l View agent state and state statistics
l Access agent handling statistics
l Launch Ignite
l Sign in and sign out
l Reconnect Ignite
l Post feedback and view forums
l Report performance issues
l Configure Ignite dashboards
l Configure agent profiles
l Manage agent group presence and agent status
l Handle calls and perform in-call actions, such as transferring calls, tagging calls with Account
Codes and Classification Codes, and requesting help

l RemoveWork Timer (if enabled for the queue)

Viewing agent state and state statistics (WEB)
The agent state section of the Avatar displays the employee’s overriding state, including:

l Ringing – Displays when an employee has interactions ringing in the Inbox
l ACD – Displays when an employee is handling ACD interactions
l ACD Hold – Displays when an employee has placed ACD interactions on hold or have
themselves been placed on hold during an ACD call

l Non ACD – Displays when an employee is handling Non ACD interactions
l Non ACD Hold – Displays when an employee has placed Non ACD interactions on hold or
have themselves been placed on hold during a Non ACD call

l Outbound – Displays when an employee has placed an outgoing call
l Outbound Hold – Displays when an employee has placed an outgoing call on hold or have
themselves been placed on hold during anOutbound call

l Work Timer – Displays after an employee has handled an interaction, provided none of an
employee’s agents are in an ACD, Non ACD, Outbound, Make Busy, or Do Not Disturb state

l Do Not Disturb – Displays when the employee is in a DoNot Disturb state
l Busy – Displays when an employee is in aMake Busy state
l Away (Not Present) – Displays when an employee is not present in any of their agent groups
l Offline – Displays when an employee is signed in, but their agents are logged out
l Reseize Timer – Displays when a call fails to route to an employee
l Available – Displays when an employee does not have inbound interactions in the Inbox
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An overriding state is a state that supersedes other states. States higher in the list override the
states appearing lower in the list. Note that all an employee’s agents are considered when the
system calculates the overriding state.

The oldest length for a state supersedes other times for the same state if an agent is handling
multiple interactions. For example, if an employee had two emails in ACD, the displayed value in the
status bar would be the time of the oldest email. When the oldest email is completed, the displayed
value in the status bar would switch to the time of the other email.

Agent states by media are available in the Inbox. For more information, see "Viewing agent handling
statistics (WEB)" on page 235.

Viewing agent handling statistics (WEB)
The Inbox contains agent handling statistics for each of themedia types the agent handles. Figure
68 displays agent handling statistics across media types.

Figure 68: Inbox agent handling statistics (Average Handling Time)

Eachmedia type’s icon indicates the corresponding state of the employee’s agents. Table 21
outlines the different states.

STATE VOICE CHAT EMAIL SMS OPEN
MEDIA DESCRIPTION

Ringing
An ACD interaction
ringing on an agent,
waiting to be handled

ACD An agent handling an
ACD interaction

ACD Hold
An agent who has
placed an ACD
interaction on hold

Idle
An agent logged on and
waiting to receive an
interaction

Non ACD -- -- -- --

An agent involved in an
incoming Non ACD
interaction or agent
originated voice
interaction

Table 21: Agent states
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STATE VOICE CHAT EMAIL SMS OPEN
MEDIA DESCRIPTION

Non ACD Hold -- -- -- --

An agent who has
placed a Non ACD
voice interaction on
hold

Outbound -- -- -- --
An agent on an
outgoing voice
interaction

Outbound Hold -- -- -- --

An agent who has
placed an outgoing
voice interaction on
hold

DoNot Disturb

An agent who has
activated DoNot
Disturb and is not
available to receive any
ACD or Non ACD
voice interactions

Make Busy

An agent who is not
available to receive
ACD interactions but
can receive transferred
interactions and voice
interactions dialed
directly to the agent

Work Timer

An agent who is
completing post-
contact work, such as
paperwork, and is
unavailable to receive
interactions of that
media type

Offline An agent unavailable to
handle interactions

Away (Not
Present)

An agent whose
presence is removed
from an agent group or
media type

Table 21: Agent states (continued)

The Inbox offers five different types of handling statistics:
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l Workload (current + Work Timer / maximum) -- Displays active interactions, and any
Work Timer states, against themaximum number of interactions an agent can be pushed per
media type, as defined by the agent’s Workload. Note that Work Timer states count against
Workload, and will affect whether agents are pushed interactions.

l ACD (Count / Duration) -- Displays the number of ACD interactions the agent has handled
for amedia type, and the time spent handling interactions of that media type

l Non-ACD (Count / Duration) -- Displays the number of Non ACD interactions the agent has
handled for amedia type, and the time spent handling the interaction

l Average Handling Time (hours:mins:secs) – The average time the agent has taken to
handle interactions of eachmedia type

l Unavailable % -- Displays the percentage of time the agent is unavailable during the shift,
including DoNot Disturb, Make Busy, Unknown, andWork Timer states, and when the agent
is logged in but not available to receive ACD interactions

By clicking theMore button, agents can change the statistics being displayed. (See Figure 69.)

Figure 69: Inbox real-time statistics

Launching Ignite (WEB)
Once Ignite is launched you can sign into the application. See "Signing into and out of Ignite (WEB)"
on page 238.

NOTE:

l The intended users of Ignite (WEB) are employees connected either locally on the LAN or to
the network via VPN.

l Ignite (WEB) does not support Compatibility Mode.
l Ignite (WEB) requires JavaScript be enabled on your browser. For more information, consult
your browser documentation.

l When configuring screen pop notifications to be used with Ignite (WEB), you can execute only
web URLs. Direct file execution (for example, .EXE or .BAT files) does not work in Ignite
(Web) as the browser considers it as a security risk.
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Launch Ignite by typing the following URL into a supported web browser:

l http://<EnterpriseServerName >/Ignite
OR

l http://<EnterpriseServerIP>/Ignite
NOTE: If your system uses SSL, type ‘https’ in place of ‘http’ and insert a valid domain or
FQDN in place of an IP address.

For a list of supported web browsers, contact your supervisor or system administrator. Ignite
supports default browser configuration settings.

NOTE: 

l We recommend that you do not use the Ignite (WEB) and Ignite (DESKTOP) applications
simultaneously.

l Editing responses across multiple, open browsers simultaneously is not supported.
l If you are drafting an email response and change browsers, hit 'Refresh' to pull down your
drafted content.

Signing into and out of Ignite (WEB)
NOTE:After signing into Ignite and becoming Available, youmay be placed in Busy across all agent
capabilities. This is an administrative configuration. To remove Busy, see "Setting and removing
Busy/Make Busy in Ignite" on page 249.

Your default sign-in state is Offline. This means you are signed into Ignite but your ACD agents are
logged out. You cannot receive ACD interactions until your state is Available. To change states, see
"Adjusting agent states in Ignite (WEB)" on page 249.

If you are enabled for voice, you can set Ignite to log you into your phone. See ‘To sign into Ignite and
log into the phone’, below. Otherwise, we recommend you log into your phone before signing into
Ignite so that your agents may become Available.

Logging out of the phone or exitingMiCollab will only log out the voice agent (multimedia agents are
not affected). Logging out of Ignite will log out all agents (voice andmultimedia) andmay requeue
items in the Inbox, depending on administrative configurations. To avoid losing work on these items,
agents should finish their replies or transfer inbox items to a queue before logging out.

The following procedures explain how to

l Sign into Ignite
l Sign into Ignite and log into the phone
l Sign out of Ignite
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To sign into Ignite

1. Launch a supported web browser and type: http://EnterpriseServerName>/Ignite.
OR
http://<Enterprise Server IP>/Ignite.
NOTE: If your system uses SSL, type ‘https’ in place of ‘http’ and insert a valid domain or
FQDN in place of an IP address.

2. Enter yourUsername andPassword.
NOTE: If you useWindows Authentication, enter your DOMAIN\Username and your domain
password.

3. Click Sign in.

To sign into Ignite and log into the phone

NOTE: 

l This feature is supported for hot desk and external hot desk agents only
l You can set or change phone settings from Ignite’s Options page.
1. Launch a supported web browser and type: http://EnterpriseServerName>/Ignite.

OR
http://<Enterprise Server IP>/Ignite.
NOTE: If your system uses SSL, type ‘https’ in place of ‘http’.

2. Enter yourUsername andPassword.
NOTE: If you useWindows Authentication, enter your DOMAIN\Username and your domain
password.

3. Click Sign in.
4. On the Log in to a phone dialog window, specify yourExtension andPIN (if applicable).
5. To log into your phone once your sign-in is complete, select theAutomatic login checkbox

and click Login.
NOTE:

l Clicking ‘Save’ dismisses the dialog window and signs you in as Offline. However, the
phone information is saved to your profile and you are logged into your phone once your
state is Available.

l Clicking ‘Cancel’ dismisses the dialog window and signs you in as Offline across all
media types.

To sign out of Ignite

l Click your avatar and select State=>Log out.
NOTE: 
• Voice agents on active calls are not logged out until the call is complete.
• Directly closing the browser does not log you out of Ignite (Web); youmust manually log

out of Ignite (Web).
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Reconnecting Ignite (WEB)
If Ignite experiences connectivity issues, a ‘Reconnecting’ message displays. If Ignite cannot
reconnect within the time allotted, a ‘Connection lost’ dialog pops with the option to Reconnect.

Once the connection is reestablished Ignite refreshes and functionality is restored.

To reconnect Ignite

l UnderConnection lost, click Reconnect.

Posting feedback and viewing our forums (WEB)
Mitel has partnered with UserVoice, a third-party service, to host customer suggestions on
https://micontactcenter.uservoice.com. When you post an idea to our feedback forum, others will be
able to subscribe to it andmake comments.

Our forums enable you to send feedback directly to the people building the product. While we cannot
comment on every suggestion, feedback is analyzed and considered for future releases.

NOTE: Please do not use the forums to submit product defects. To submit product defects, please
contact your administrator or dealer.

To post feedback and view our forums

l Click the Feedback button
OR
Access the following URL: https://micontactcenter.uservoice.com.

Your Ignite profile (WEB)
Ignite provides each user with a profile, associated to the username used to log into Ignite. You can
adjust several of the profile's default settings to customize your Ignite experience.

Ignite remembers your changes to the following elements:

l History
l Favorited queues
l Dashboard
l Default landing page
l Phone settings, including Extension, PIN, and automatic login to your phone
l Automated diagnostics reporting
l Filter selection preference

You cannot delete your profile; however you can reset the above to Ignite’s default settings.

The following procedures explain how to:

l Set an avatar image
l Clear or change your avatar image
l Specify your language preference

https://micontactcenter.uservoice.com/
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l Set Ignite's default landing page
l Configure notification display duration
l Configure phone settings, including Extension, PIN, and automatic log-in to the phone
l Enable automated diagnostics reporting from Ignite
l Reset your profile to Ignite’s default settings

To set an avatar image

1. Click Options=>Profile.
2. Click Change Photo.
3. UnderUpload, click to upload a photo or drag-and-drop a photo to the space provided.
4. Click Save.

To clear or change your avatar image

1. Click Options=>Profile.
2. Click Change Photo and select Clear.
3. To change the image, follow the steps in ‘To set an avatar image,’ above.

To specify your language preference

1. Click Options=>Profile.
2. After Language, select a language from the drop-down.
3. Click Save.

To set Ignite's default landing page

1. Click Options=>Customization.
2. UnderDefault landing page, select a page from the drop-down.
3. Click Save.
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To configure the notification duration (in seconds)

An agent can configure the durations (in seconds) for the following notifications: new interactions,
follow up, and info/error messages displayed on the Ignite screen.

To configure Notification display duration

1. Click Options=>Customization to view the options.
2. UnderNotification Settings, set the Interaction toaster display time (seconds) in the

range 5 - 60 seconds; default value is 5 seconds.
3. UnderNotification Settings, set the Follow up toaster display time (seconds) in the

range 5 - 60 seconds; default value is 10 seconds.
4. UnderNotification Settings, set the Info/ error toaster display time (seconds) in the

range 5 - 60 seconds; default value is 5 seconds.
5. Click Save.

NOTE: Notification durations can also be reset in Reset Application Options.

To configure phone settings

NOTE: These settings enable login to your phone from Ignite. This feature is supported for hot desk
and external hot desk agents only.

1. Click Options=>Phone.
2. Specify yourExtension and, if applicable, PIN.
3. To be logged into your phone after making yourself Available, select theAutomatic login

checkbox.
4. Click Save.

The next time you sign into Ignite and set your state to Available, you will be logged into your
phone.

To enable automated diagnostics reporting from Ignite

NOTE: You can send on-demand reports in addition to automated reporting. See "Reporting
performance issues in Ignite (WEB)" on page 242.

1. Click Options=>Diagnostics.
2. UnderContinuously send diagnostics information, toggle the switch to blue.

To reset your profile to Ignite's default settings

1. Click Options=>Customization.
2. Under Factory reset, click Reset Application Options.
3. When prompted, click Reset.

NOTE:Resetting your profile to Ignite's default settings resets theClear quick reply templates
view after insert option.

Reporting performance issues in Ignite (WEB)
You can report performance issues in Ignite on-demand, to be reviewed by a supervisor or system
administrator. Reports include log lines from your browser and any details you enter.
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On-demand reports are sent in addition to Ignite's automated diagnostics reporting. For information
on enabling automated diagnostics reporting, see "Your Ignite profile (WEB)" on page 240.

Supervisors looking to access diagnostics reports should consult 'Accessing diagnostics reports
sent from Ignite (WEB)' in theMultimedia Contact Center Installation and Deployment Guide

To report a performance issue in Ignite

1. Click Options=>Diagnostics.
2. In the field provided, describe the issue experienced.
3. Click Send.
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Configuring Ignite (WEB) dashboards
Real-timemonitoring of employees, agents, queues, and callback requests is available via the
dashboards in Ignite (WEB). You can createmultiple dashboards, customize the widgets that
display in each, and give themmeaningful names to indicate their purpose.

NOTE: The real-timemonitors in Ignite (WEB) are known as ‘widgets’ in the dashboard user
interface.

Adding and configuring dashboards
Upon first use of Ignite (WEB), a default dashboard is created, containing the Employee State
widget only. You can rename this dashboard and include additional widgets to display.

Adding and configuring dashboard widgets
The following widgets can be added to dashboards:

l Employee State—Displays employee presence and shift information
l Callback Requests—Displays a list of callback requests
l Queue Now—Displays queue and queue group statistics
l Agent State—Displays agents organized by time spent in the following states: ACD, Idle,
Non-ACD, Unavailable, Not Present, andOffline

l Web Browser—Displays the website content that is embedded in the widget

To add widgets to a dashboard

1. In a dashboard, click Add Widget.
2. Select the widget you want to add to the dashboard.
3. Repeat steps 1-2 to select additional widgets if desired.
4. Click Save.
5. If you want to addmore widgets after saving, select the dashboard to which you want to add

widgets and click theEdit Dashboard button.

When a dashboard is in edit mode, you can edit the content within widgets, collapse widgets,
change the widgets’ location on the dashboard, or remove widgets from the dashboard.

NOTE: When you are editing aWeb Ignite Dashboard that includes aWeb Browser widget you will
not see the webpage in the widget while in edit mode.

NOTE:You can collapse or expand the widget at any time (you do not have to be in edit mode).



Handling voice Interactions with the MiCollab Client and Ignite integration

245

The following procedure describes the editable features that are common to all widgets.

Tomodify a widget (common procedures)

1. In the dashboard, click theEdit Dashboard button.
2. In the widget toolbar:

l Click theSettings button to edit the content within the widget (see the relevant
procedures for each widget for specific details).

l Click theCollapse button to collapse the widget or theExpand button to expand the
widget.

l Select theMove button to drag and drop the widget to a different position on the
dashboard.

l Click theDelete button to remove the widget from the dashboard.
3. If you edited the content within the widget, click Apply.
4. Click Save to save the changes to the dashboard orUndo to revert the change to the

dashboard.

Configuring options in the Employee State widget
When you configure options in the Employee State widget, you optionally change the name of the
monitor and add an employee to bemonitored.

To configure options in the Employee State widget

1. In the dashboard, click theEdit Dashboard button.
2. In the Employee State widget, click theSettings button.
3. Optionally, under Title, type a new name for themonitor.
4. UnderEmployees, either select from the displayed list or type the employee ID in the search

field to find the employee you want to monitor.
5. Click Apply.
6. Click Save to save the change to the dashboard orUndo to revert the change to the

dashboard.

Configuring options in the Callback Requests widget
The only option available to be configured in the Callback Requests widget is themonitor name.

When you configure options in the Callback Requests widget, you can change the name of the
monitor and add or remove the device to bemonitored.

To rename the Callback Requests widget

1. In the dashboard, click theEdit Dashboard button.
2. In the Callback Requests widget, click theSettings button.
3. Under Title, type a new name for themonitor.
4. Click Apply.
5. Click Save to save the change to the dashboard orUndo to revert the change to the

dashboard.
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Configuring options in the Queue Now widget
When you configure options in the Queue Now widget, you can change the name of themonitor and
add or remove the device to bemonitored.

To configure options in the Queue Now widget

1. In the dashboard, click theEdit Dashboard button.
2. In the Queue Now widget, click theSettings button.
3. Optionally, under Title, type a new name for themonitor.
4. Click the drop-down besideQueue and select eitherQueue orQueue Group.
5. Optionally, enter text into theSearch field to search for queues or queue groups.
6. Select the check box beside each queue or queue group you want to monitor, or select the

check box beside ID to select all queues or queue groups.
7. Click Apply.
8. Click Save to save the change to the dashboard orUndo to revert the change to the

dashboard.

Configuring options in the Agent State widget
When you configure options in the Agent Statemonitor, you can change the name of themonitor and
add or remove the device to bemonitored.

To configure options in the Agent State widget

1. In the dashboard, click theEdit Dashboard button.
2. In the Agent State widget, click theSettings button.
3. Optionally, under Title, type a new name for themonitor.
4. Optionally, type content into theSearch text box to filter the agents that display in the list.
5. Select the check box beside each agent you want to monitor, or select the check box beside

eachmedia icon to select all agents who are configured to handle that media type.
NOTE: You can optionally select multiple voice agents for each employee, if applicable, by
selecting the check boxes located under the voice (telephone) icon, beside the employee
name.

6. Click Apply.
7. Click Save to save the change to the dashboard orUndo to revert the change to the

dashboard.

Managing agent group presence and agent status
Agent group presence refers to whether an ACD agent is present in or absent from an agent group.

Agents present in an agent group can receive interactions in the Inbox, pick interaction s out of
queue, and be sent interactions from a supervisor. Agents absent from an agent group cannot handle
interaction s for the queue.

Agent states refers to an agent’s availability to receive ACD interactions. Examples of agent states
include Available, Busy/Make Busy and DoNot Disturb. An agent’s state determines Ignite handling
options available to them.
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WEB - An agent in the Offline state is logged into Ignite but their ACD agents are not logged into the
system. In this state interactions cannot be handled for the queue.

NOTE:When you configure Agent Group Presence for agents who use an ACD softphone, youmust
set the default presence toAbsent. If the presence is set toPresent, agents will receive ACD calls
when they log in toMiCollab, without logging in to Ignite.

Viewing Agent Group Presence in Ignite
Agents can view the agent groups of which they aremembers. Viewing Agent Group Presence helps
agents verify that they are able to handle interactions for the appropriate queues.

Agents can view Agent Group Presence on a group-by-group basis across media types. If
administrative configurations permit, agents may alsomake themselves present in and absent from
agent groups and themedia types that the group handles.

To view Agent Group Presence (DESKTOP)

l In theSidebar, click theAgent Group Presence button.
Check marks display beside agent groups to which the agent is present. Media types that an
agent is present in handle display a blue background. Media types that an agent is not present
in handle display a white background.

To view Agent Group Presence (WEB)

l Click your avatar and select Agent Groups.
Media types that an agent is present in handle display in blue. Media types that an agent is not
present in handle display in grey.

Adjusting Agent Group Presence in Ignite
If agents have the required permissions, they canmake themselves present in, or absent from,
agent groups.

Adjusting Agent Group Presence enables agents to make themselves available or unavailable for
interactions of different media types. For example, an agent belongs to the Sales (voice and chat)
and the Training (email) agent groups. This agent makes herself available to answer only email
interactions by becoming absent from the Sales group.

Agents can alsomake themselves available or unavailable to answer interactions of specific media
types. For example, the agent makes herself available to answer only Sales voice interactions by
becoming absent from chat in the Sales agent group.

Agents can alsomake themselves available or unavailable to all agent groups of which they are
members, in one action.

DESKTOP -When agents are not present in any of their agent groups, Ignite’s Status bar displays a
‘Time Logged in Not Present’ status. See "Viewing agent state and statistics in the Status bar
(DESKTOP)" on page 224 for more information.

WEB -When agents are not present in any of their agent groups, their state becomes Away (Not
Present). See "Viewing agent state and state statistics (WEB)" on page 234.
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NOTE: Agents may bemade automatically present in their agent groups upon logging into Ignite,
with multimedia interactions routing as soon as the login is complete. This is an administrative
configuration and is not controlled by the agent. However, without this administrative configuration,
agents must make themselves present in agent groups in order to be offered interactions.

The following procedures explain how to

l Become present to an agent group
l Become absent from an agent group
l Become either present in or absent from all agent groups
l Become available or unavailable to answer interactions of a specific media type
l Apply default Agent Group Presence settings (DESKTOP)

To become present in an agent group (DESKTOP)

1. In theSidebar, click theAgent Group Presence button.
2. Select the group or groups from theAgent Group Presence screen and click Apply.

Multimedia interactions begin routing.

To become present in an agent group (WEB)

1. Click your avatar and select Agent Groups.
2. Hover over the agent group’s avatar and select Join <Agent Group name>.
3. Click Update.

To become absent from an agent group (DESKTOP)

1. In theSidebar, click theAgent Group Presence button.
2. Deselect the group or groups from theAgent Group Presence screen and click Apply.

To become absent from an agent group (WEB)

1. Click your avatar and select Agent Groups.
2. Hover over the agent group’s avatar and select Leave <Agent Group name>.
3. Click Update.

To become either present in or absent from all agent groups (DESKTOP)

1. In theSidebar, click theAgent Group Presence button.
2. To become present to all agent groups, click Select All.
3. Click Apply.

You become present in all agent groups andmedia types within the group.
4. To become absent from all agent groups, click Clear All.
5. Click Apply.

You become absent from all agent groups andmedia types within the group.

To become either present in or absent from all agent groups (WEB)

1. Click your avatar and select All Agent Groups.
2. To become present in all agent groups, click Join All=>Update.
3. To become absent from all agent groups, click Leave All=>Update.
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To become available or unavailable to answer interactions of a specific media type (DESKTOP)

1. In theSidebar, click theAgent Group Presence button.
2. To become available to answer interactions of a specific media type, click themedia icon in

the agent group so the icon displays a blue background.
3. To become unavailable to answer interactions of a specific media type, click themedia icon in

the agent group so the icon displays a white background.
4. Click Apply.

To become available or unavailable to answer interactions of a specific media type (WEB)

1. Click your avatar and select Agent Groups.
2. To become available to answer interactions of a specific media type, click themedia icon in

the agent group so the icon displays in blue.
3. To become unavailable to answer interactions of a specific media type, click themedia icon in

the agent group so the icon displays in grey.
4. Click Update.

To apply default agent group presence settings (DESKTOP)

1. On theAgent Group Presence screen, click Defaults.
2. Click Apply.

Adjusting agent states in Ignite (WEB)
Agents can adjust their states tomake themselves available or unavailable to receive ACD
interactions without logging out of the application.

Agents can set the following states in Ignite:

l Available: Agents are logged into Ignite and their ACD agents are available to receive ACD
interactions.

l Offline: Agents are logged into Ignite and can peruse the interaction repository, but their ACD
agents are offline and cannot receive ACD interactions.
NOTE: Time in Offline does not count towards shift duration.

l Busy: See "Setting and removing Busy/Make Busy in Ignite" on page 249.
l Do Not Disturb:See "Setting and removing DoNot Disturb in Ignite" on page 252.

Setting and removing Busy/Make Busy in Ignite
When agents must become temporarily unavailable for inboundmultimedia interactions, they can put
themselves into Busy/Make Busy and choose a code indicating why they are unavailable.

Setting Busy/Make Busy for one agent capability applies a Busy/Make Busy status status to all of
the employee’s agents. Inboundmultimedia interactions are not routed to the agent; however, agents
in Busy/Make Busy can receive transferred interactions. While in Busy/Make Busy, voice agents
are able to receive Non ACD voice interactions without being removed from Busy/Make Busy and
can pick interactions waiting in queue.

Entering Busy/Make Busy while handling interactions ensures that agents are not offeredmore once
finished. However, existing voice, email, chat, SMS, and openmedia interactions continue until one
of the parties ends the interaction.
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Agents also enter Reseize Timer when they decline an interaction, fail to answer a ringing interaction
within the allotted time, and place an item on hold for longer than is permitted. In each instance, the
agent is automatically put into Busy/Make Busy across all media capabilities, and a SystemMake
Busy is registered for the employee. For information on the time allotted to answer a ringing
interaction and the duration for which interactions can be on hold, contact your supervisor or system
administrator.

The following procedures explain how to

l Set Busy/Make Busy and change Busy/Make Busy codes
l Remove Busy/Make Busy
NOTE:Agents must remove Busy/Make Busy to become available to receive inbound
multimedia interactions and internal voice interactions.

l Change to a DoNot Disturb (DND) state while in Busy/Make Busy

To set Make Busy and changeMake Busy codes (DESKTOP)

1. In theSidebar, click theMake Busy button.
2. Select aMKB code and click Apply.

NOTE:Agents cannot programMKB codes and can only select from the list provided.
3. To change aMake Busy code assigned to you, follow the above steps.

To set Busy and change Busy codes (WEB)

1. Click your avatar.
2. UnderState, click Busy.
3. Choose a Busy code.

To removeMake Busy (DESKTOP)

l In theStatus bar, click theX button.

To remove Busy (WEB)

1. Click your avatar.
2. UnderState, click theX button next to Busy.

To change to a DoNot Disturb state while in Make Busy (DESKTOP)

NOTE:DoNot Disturb and Busy/Make Busy states layer. If an agent in Busy/Make Busy changes
their state to DoNot Disturb, the agent will remain in Busy/Make Busy once DoNot Disturb is
removed. This prevents agents from receiving interactions when switching states between
Busy/Make Busy and DoNot Disturb.

1. In theSidebar, click theDo Not Disturb button.
2. Select a DND code and click Apply.
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NOTE To remove DND and revert to Make Busy, click your avatar, click theX button next toDo
Not Disturb

To change to a DoNot Disturb state while in Make Busy (WEB)

NOTE: Do Not Disturb and Busy/Make Busy states layer. If an agent in Busy/Make Busy changes
their state to DoNot Disturb, the agent will remain in Busy/Make Busy once DoNot Disturb is
removed. This prevents agents from receiving contacts when switching states between Busy/Make
Busy and DoNot Disturb.

1. Click your avatar.
2. UnderState, click Do Not Disturb.
3. Select a DoNot Disturb reason code.
4. To remove DND and revert to Make Busy, click your agent name and click X button next to

Do not Disturb.
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Setting and removing Do Not Disturb in Ignite
When agents must become temporarily unavailable for receiving inboundmultimedia interactions
and internal voice interactions, including transfers, they can put themselves into DoNot Disturb
(DND) and choose a code indicating why they are unavailable.

Agents in DND can receive external voice interactions, and existing chat and inbound/internal voice
interactions continue until one of the parties ends the interaction.

Setting DND for one agent capability applies a DND status to all of the employee’s agents.

The following procedures explain how to

l Set DND and change DND codes
l Remove DND
NOTE:Agents must remove DND to become available to receive inboundmultimedia
interactions or internal voice interactions

l Change to a Busy/Make Busy (MKB) state while in DND

To set DND and change DND codes (DESKTOP)

1. In theSidebar, click theDo Not Disturb button.
2. Select a DND code and click Apply.

NOTE:Agents cannot program DND codes and can only select from the list provided.
3. To change a DND code, follow the above steps.

To set DND and change DND codes (WEB)

1. Click your avatar.
2. UnderState, click Do Not Disturb ….
3. Choose a DND code.

To remove DND (DESKTOP)

l In the Status bar, click theX button.

To remove DND (WEB)

1. Click your avatar.
2. UnderState , click theX button next to Do Not Disturb ….

To change to aMKB state while in DND (DESKTOP)

NOTE: If an agent changes their DND state toMKB, the agent remains in DND until this state is
removed.

1. In theSidebar, click theMake Busy button.
2. Select aMake Busy code and click Apply.
3. In theStatus bar, click the X button to remove yourself from DND and enter MKB.
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To change to a Busy state while in DND (WEB)

NOTE: If an employee applies aMKB state while in DND, the employee remains in DND until the
DND state is removed.

1. Click your avatar.
2. UnderState chooseBusy....
3. Choose a Busy code.
4. Click your avatar.
5. UnderState, click theX button next toDo Not Disturb.

Handling calls in Ignite
Agents can perform basic call handling in Ignite.

The following sections explain how to

l View call information
l Pick calls out of queue
l Answer and end calls
l Make calls
l Perform in-call actions
l RemoveWork Timer
l Handle calls using the Action bar (DESKTOP)
l Handle calls using the Active Call controls (WEB)

MiCollab Client is recommended for performingmore advanced call handling functions such as
conferencing and supervised transfers.

NOTE:

l DESKTOP - Ignite provides call control for Inbound ACD interactions only. Agents must make
outbound calls using Contact Center Softphone, PhoneSet Manager, or a hard set or useWeb
Ignite.

l Ignite’s phone functionality does not support multiple lines.
l Ignite’s phone controls are not supported for External Hot Desking Agents.

Viewing call information
You can view basic call information in Ignite before picking a call out of queue or handling it from the
Inbox. Note that information displayedmay vary based on administrative configuration.

The following explains how to

l View information for calls in queue
l View information for calls in the Inbox

To view information for calls in queue (DESKTOP)

1. In the Folders pane, select a queue.
2. In the List pane, select a call.

Call information displays in the Preview pane.
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To view information for calls in queue (WEB)

1. Click Queues and select the appropriate queue.
2. Select a call from the queue.

To view information for calls in the Inbox (DESKTOP)

1. In the Folders pane, click Inbox.
2. In the List pane, select a call.

Call information displays in the Preview pane.

To view information for calls in the Inbox (WEB)

l Click Inbox and select a call.

Picking calls out of queue
Agents can pick calls out of queue and send them to the Inbox. Once ringing in the Inbox, the call
can be answered.

NOTE: 

l Agents cannot pick or pick and reply to interactions from the queue if they are in Do Not
Disturb.

l Agents may only pick or pick and reply to interactions from the queue if they have the
appropriate permissions.

To pick a call from the queue (DESKTOP)

1. From the Folders pane, select the queue from which a call will be picked.
2. From the List pane, select a call from the queue and, from theAction bar, click thePick

button.
The call is transferred to your Inbox.

3. Pick up your desk phone to answer the call.
4. Answer the call usingMiCollab Client.
5. To answer the call, select Inbox and, in the List pane, select the call and click Reply.

NOTE: Additional handling options display in the Action bar. For more information, see the
appropriate procedures in this section.

To pick a call from the queue (WEB)

1. Click Queues and select the appropriate queue.
2. Select a call from the queue or hover over the item avatar and click Pick.

The call is transferred to your Inbox.
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Answering and ending calls
NOTE:

l You cannot explicitly decline a ringing call.
l Agents can request help from other agents, as well as from supervisors. When you answer an
incoming request for help, the Ignite toaster displays "Request Help" and the name of the
person requesting help. Accepted requests are entered in Silent Monitor mode. Supervisors
must use Contact Center Client or their hardset to escalate to Coachmode.

l When supervisor receives an ACD help request and chooses to answer the call throughWeb
Ignite, the call will be directly connected to the agent and the supervisor can coach the agent.
Supervisor do not need to specifically press theCoach button on the desk phone to coach an
agent.

For more information on the Request Help feature, see the appropriate section in this guide.

You can answer incoming calls from Ignite. Ignite displays a toaster for each incoming call and
allows you to accept the call from the toaster.

When you answer a call, Ignite displays call information.

To answer a call (DESKTOP)

l In the Ignite toaster, click Accept, select the call in the List pane and, in theAction bar, click
Reply.

To answer a call

l In the Ignite toaster, click Accept. Alternatively, select the call or hover over the item avatar
and click Accept.

You can end calls from Ignite.

To end a call (DESKTOP)

l In theAction bar, click Hang Up.
Alternatively, in theConversation window, in the bottom toolbar, click theHang Up button.

To end a call (WEB)

l Click Inbox and select a call or hover over the item avatar and click Hang Up.
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Making calls
DESKTOP -We recommend you useMiCollab Client to make calls, although you canmake calls
using Contact Center Softphone or Contact Center PhoneSet Manager. This recommendation
applies to internal and external destination calls, and calls to dialable queues.

Tomake a call (WEB)

1. Click Contacts.
2. If the destination is not a recent contact, type its name or number in theSearch field.

NOTE: You can also create external contacts or import contacts from the Contacts page. For
more details, see "Contacts (WEB)" in this document.

3. Hover over the destination’s avatar and click Call. If applicable, hover over multiple Call
avatars to select the appropriate dialable number. For calls to agents, a colored dot on the
avatar indicates its availability.
NOTE: If Contacts is open, click Contacts again to close the window and expose the desired
controls.

Optionally, you can alsomake a call using the New Call button (Phone icon). You can choose the
name and number that should be displayed on the external phone whenmaking a call to an external
destination.

To specify name and number whenmaking calls

1. Click New Call, theVoice Contacts page is displayed.
2. Click the From button. The From page is displayed with all the CLIP (Calling Line

Identification Presentation) numbers. The number with a bold font is your reporting number or
the line URI.
NOTE: The outbound CLIP numbers are populated from the DNIS device list in YourSite
Explorer.

3. Select the number from the list. The customer sees the selected name and number on their
display when they are contacted.

Performing in-call actions
While on active calls you can:

l Put calls on hold and retrieve calls from hold
l Tag calls with Account Codes.
l Tag calls with Classification Codes
l Transfer calls (DESKTOP)
l Initialize Conference calls
l Transition to alternate interaction types
l Merge calls (DESKTOP)
l Contact agents before transferring calls and requesting help

Putting calls on hold and retrieving calls from hold
At times, agents may have to put a call on hold. Ignite displays a paused icon over calls on hold so
they can be easily identified.

NOTE: Calls on holdmay not be transferred until hold is removed.
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The following explains how to

l Put a call on hold
l Retrieve a call from hold

To put a call on hold (DESKTOP)

1. In the Folders pane, click Inbox.
2. In the List pane, select the active call.
3. In theAction bar, click theHold button.

To put a call on hold in the Conversation window (DESKTOP)

l In theConversation window, click Hold.

To put a call on hold (WEB)

l Click Inbox and select a call, or hover over the item avatar, and click Hold.

To put a call on hold (MiCollab Client)

l Click Inbox and select a call, or hover over the item avatar, and click Hold

To retrieve a call from hold (DESKTOP)

1. In the Folders pane, click Inbox.
2. In the List pane, select the call on hold.
3. In theAction bar, click Remove Hold.

To retrieve a call from hold in the Conversation window (DESKTOP)

l In theConversation window, click theRemove Hold button.

To retrieve a call from hold (WEB)

l Click Inbox and select a call or hover over the item avatar and click Remove Hold.

Tagging calls with Account Codes
Account Codes identify services, departments, or other elements of the contact center. They are
numerical codes with predefinedmeanings that are used for reporting purposes. You can apply
multiple Account Codes during an interaction. The duration of each Account Code is measured from
when the Account Code is entered until either the end of the call or the time a new Account Code is
entered. Agents tag calls with Account Codes in Ignite to indicate in reports what the interaction
segment was about.

For example, an agent handling calls for three catalog companies enters an Account Code of ‘01’ to
indicate the customer is inquiring about Company A. Later in the interaction, the agent enters an
Account Code of ‘06’ to indicate that the customer is now inquiring about Company A’s mail-out
services.
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Agents can tag calls with multiple Account Codes. Account Codes must be entered during the call
and cannot be entered after the call has ended.

NOTE:

l Account Code categories are supported for Ignite (DESKTOP) only. Ignite (WEB) enables
agents to filter Account Codes rather than sorting them by categories.

l DESKTOP - Account Codes can also be tagged using the ‘History and Account Codes’ button
found in the Preview pane.

To tag a call with an Account Code (DESKTOP)

1. In theSidebar, click theSet Account Code icon to open theSet Account Code rolling
panel.
When a call is offered to an agent, the Account Code icon will display in the Ignite Sidebar.
Youmust apply Account Codes during an active call. They cannot be applied after the call is
completed.

2. Select the applicable Account Code from the list that displays and click Apply.
NOTE: If you are handlingmore than one item in the Inbox, for example, one email and one
call, and you apply an Account Code, it is applied to the item that is currently selected in the
Ignite Inbox.

To tag a call with an Account Code (WEB)

1. Select a call or hover over the item avatar and click Classify.
2. Select an Account Code. You can type the name or number of a Code in theSearch field.

NOTE: If you enter a number in the search field, you can apply the Code by pressing ‘Enter’
when prompted.

Tagging calls with Classification Codes
Classification Codes are a type of Account Code but differ in the following ways:

l You can apply multiple Classification Codes, and this can be done at any point during the (call
or interaction) or its Work Timer. All Classification Codes applied to a call are pegged with the
full call duration, from the time the call arrives until the call ends. This includes transfer time. It
also includes Work Timer duration if 'Include queue work timer as part of handling time' is
enabled on the queue. If the same code is entered twice, it is not double pegged in reporting
statistics.

l Classification Codes can be ‘forced’, meaning the agent must enter a Classification Code
either during the call or when inWork Timer to remain within compliance.

l Account Codes can only be entered during a call, but Classification Codes can be entered
during or after a call (while inWork Timer). There are often scenarios within which you set
single or multiple Account Codes during a call and then set a Classification Code when the
call terminates.

NOTE:Classification Codes are only supported for ACD voice (calls or interactions).

NOTE: During a call, apply Classification Codes as you would Account Codes, using the list of
Account Codes in the ‘Set Account Code’ rolling panel in the Sidebar or in the 'History and Account
Code' section of the Preview pane.
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To tag a call with a Classification Code after a call ends (DESKTOP)

1. In theSidebar, click theClassify button to open theClassify rolling panel.
When the call ends, the Classify button displays (and flashes if forced Classification Codes
are enabled) andWork Timer is activated.

2. Select the applicable Classification Code from the list that displays and click Apply.
NOTE: If you are handlingmore than one item in the Inbox, for example, one email and one
call, and you apply a Classification Code during the call, it will be applied to the call regardless
of which item is currently selected in the Inbox. If you apply a Classification Code after the
call when inWork Timer, the voice interaction stays in your Inbox and youmust use the
‘Classify’ button in the Sidebar to apply a Classification Code to the voice interaction.

3. If Work Timer has not been configured to automatically cancel after entering a Classification
Code, cancel Work Timer by clicking theRemove Work Timer button in theSidebar.
NOTE: Forced Classification Codes prevent cancelingWork Timer until a Code is entered.
Failing to enter a Classification Code beforeWork Timer expires or is removed by entering
Busy/Make Busy or DND can result in a default Classification Code of ‘-1 Non-Compliant’
applied automatically.

To tag a call with a Classification Code after a call ends (WEB)

NOTE:During a call, apply Classification Codes as you would Account Codes, but select
‘Classification’ in the Classify dialog window.

1. Click Enter a Classification Code.
2. Select a Classification Code. You can type the name or number of a Code in theSearch field.

NOTE: If you enter a number in the search field, you can apply the Code by pressing ‘Enter’
when prompted.

Transferring calls (DESKTOP)
You can transfer calls to internal and external destinations. Internal transfer destinations include
destinations programmed in the voicemedia server or in a cluster of voicemedia servers. External
transfer destinations include dialable numbers not programmed in the voicemedia server or in the
cluster of voicemedia servers. For example, agents in the Support queue receiving calls concerning
account renewals can transfer these calls internally to the Sales queue, or agents can transfer calls
externally to a supervisor’s cell phone.

To receive transfers devices must be enabled to handle the interaction's media type.

Agents who are logged out, in DND, Offline (WEB), or whose presence is Unknown cannot receive
transferred calls, but the call can be transferred to their voicemail. Agents who are either in
Busy/Make Busy or at their call Workload limit can receive transferred calls.

Call transfers in Ignite are always blind transfers. In blind transfers, there is no communication with
transfer destinations before sending calls. Calls are transferred immediately, and the system does
not monitor the outcome.

To perform a supervised transfer, youmust useMiCollab Client, Contact Center Softphone, Contact
Center PhoneSet Manager or IgniteWeb. See "Contact Center PhoneSet Manager and Contact
Center Softphone" on page 177 for more information.
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NOTE: 

l You cannot transfer calls on hold. Holdmust be removed before the call can be transferred.
l Youmay only transfer interactions if you have the appropriate permissions.

The following procedures explain how to

l Blind transfer calls to a voice-enabled employee or queue
l Blind transfer calls to a dialable number
NOTE: This option is only available with Click to Call. For more information, see "Contacting
agents before transferring calls " on page 263.

To blind transfer a call to a voice-enabled employee or queue (DESKTOP)

1. When on a call, in theAction bar, click Transfer.
2. Select the Internal Transfer radio button and select a voice-enabled employee or queue.

Expand the device list if necessary. You can search for an internal transfer destination by
typing the name of a voice-enabled employee or queue in the ‘Search’ field.

3. Click Transfer.

To blind transfer a call to a dialable number (DESKTOP)

1. When on a call, in theAction bar, click Transfer.
2. Select theExternal Transfer radio button and, in the Transfer To: field, type a dialable

number. Enter this number as you would on a phone, including any digits required for outbound
dialing.
NOTE: Invalid entries return an error message. Re-type a valid entry and click ‘Transfer’.

3. Click Transfer.

Transferring calls (WEB)
You can perform either a blind or a supervised transfer of a voice call fromWeb Ignite. To perform
either type of transfer, youmake a consultation call to another party (the available queues,
employees, external, or Active Directory contacts) and then decide whether you want to transfer the
call immediately (blind transfer) or wait to talk to the other party before you transfer the call
(supervised transfer). You can alsomodify the call to make it a conference while talking to the
consultative party.

To perform a blind transfer
1. Click Inbox and select a call or hover over the item avatar and click Accept.
2. Select the call or hover over the item avatar and click Transfer.

Transfer window lists all the numbers from available queues, employees, external, or Active
Directory contacts.

3. To select a contact to transfer the call, hover over the contact. This enables the Blind Transfer
and Consultation Call buttons.

4. Hover over the Blind Transfer button to list the dialable numbers associated with the contact.
• If the contact has only one associated dialable number, you can select the dialable number

or click on the transfer button to transfer the call.
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• If the contact has more than one dialable number, select a dialable number to transfer the
call.

The call is now ringing the other party and you are disconnected. The conversation will stay in
your inbox if aWork Timer applies to it.

To perform a supervised transfer
1. Click Inbox and select a call or hover over the item avatar and click Accept.
2. Select the call or hover over the item avatar and click Transfer.

Transfer window lists all the numbers from available queues, employees, external, or Active
Directory contacts.

3. To select a contact to transfer the call, hover over the contact. This enables the Blind Transfer
and Consultation Call buttons.

4. Hover over the Consultation Call button to list the dialable numbers associated with the
contact.
• If the contact has only one associated dialable number, you can select the dialable number

or click on the Consultation Call button to transfer the call.
• If the contact has more than one dialable number, select a dialable number to transfer the

call.
The call now is ringing the other party and the caller is placed on hold.

5. Before the other party accepts the transfer, you can do the following:
• Click Cancel Transfer to cancel the call with the other party whom you consulted and

connect back to the caller.
• Click Complete Transfer to complete the transfer.

6. After the other party accepts the transfer, you can do one of the following:
• Click Cancel Transfer to cancel the call with the other party whom you consulted and

connect back to the caller.
• Click Complete Transfer to complete the transfer.
• Click Conference to connect the three parties together.
• Click Swap to swap the hold. (Applicable toMiVB only).
• Click Hold to put both parties on hold. (Applicable to SIP Only).
• Click RemoveHold to remove hold. (Applicable to SIP Only).
After you leave the call, the conversation will stay in your inbox if aWork Timer applies to it.
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Initialize Conferencing calls
While you are on a call with a customer, you can invite other parties into the call to create a
conference. You cannot transfer a call that is in a conference.You can hang up to leave the
conference or put the call on hold, muting the person who puts it on hold, and keeps them from
hearing the conference. Other parties in the conference can also invite others to the conference.

You can initiate a conference through a supervised transfer. See the “Transfer calls” section for
details.

To conference a call (DESKTOP)

1. When on a call, in theConversation window, click the Invite More People button
2. Type the name or number of the participant you want to invite.
3. Select a participant and click the Invite button.

The system calls the specified participant. When the participant answers, they are added to
the call.

4. To invite additional participants, repeat the above steps.

To create a conference call (WEB)

1. While on a call, click the Invite button. The Invitewindow opens.
2. In the Invitewindow, you can search and filter to find the required contacts from the available

queues, employees, or external or Active Directory contacts.
3. Click the avatar. You can include up to five parties in a conference call.

The first agent who answered the call will be in ACD state during the conference and if the call
was transferred to another agent, the second agent will be in Non ACD state. You can view all
the participants of the conference under theParticipants list in Ignite.

Requesting help
You can request help from other voice-enabled employees by clicking the Request Help Call Control
button in the Sidebar. When you click the button, you can enter either a valid DN in the free form text
box or select an employee from a pre-populated list. The system dials the DN, and the employee is
added to the call when they accept.

Employees who accept requests for help join the call in Silent Monitor mode and are not audible
unless they escalate to Coach or Barge.

Help requests to queues or to external numbers are not supported.

The Request Help button is available as soon as a call is delivered to your Inbox. You can send
multiple requests for help during a call, but you can only send one request at a time. Requests sent
to employees in unavailable states fail.

The Request Help button is not available when a call is on hold.
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To request help on a call (Desktop)

1. ln theSidebar, click theRequest Help button.
Ignite displays a list of voice-enabled employees and enables you to look up contacts in the
Active Directory (AD)

2. In theRequest Helpwindow, do one of the following:
l Select a voice-enabled employee from the list
l In the Search box, enter a voice-enabled employee or AD contact's dialable number
l In the Search box, enter the name of a voice-enabled employee or AD contact

3. Click Call.
NOTE: You cannot cancel requests in progress. The Request Help button is disabled (turns
gray) while the call is being established. Hover over the button with your mouse to view the
connection status in a tool tip.

l If the request is answered within 180 seconds, notification that the request help is
established is displayed, and theRequest Help icon is displayed next to the caller's
icon and on the Inbox item. TheRequest Help Call Control button is no longer
available until the employee that answered the Request Help call hangs up.

l If the request is declined or times out, a notification that the request help was declined
is displayed. TheRequest Help Call Control button is available, and the employee
canmake a new Request Help call.

To request help on a call (WEB)

1. Click theRequest Help icon in the handling icons.
Ignite displays a list of voice-enabled employees and their ACD status.

2. In theRequest Helpwindow, do one of the following:
l Select a voice-enabled employee from the list
l In the text box, enter a voice-enabled employee's dialable number
l In theSearch box, type the name or dialable number of a voice-enabled employee

3. Click Call.
NOTE: You cannot cancel requests in progress.

l If the request is answered within 180 seconds, a notification that the request help is
established is displayed, theRequest Help icon is displayed next to the caller's icon
and on the Inbox item. TheRequest Help icon is no longer available till the employee
that answered the Request Help call hangs up.

l If the request for help is not answered within 180 seconds, the request times out and
you canmake another request for help.

NOTE: The length of time a request help call rings for is defined in the Ignite configuration. By
default, duration is set to 180. See the KB article SO3146 inMitel KnowledgeManagement System
for information on how to change this, and how it interacts with the Agent COS.

Contacting agents before transferring calls
You can choose to instant message (DESKTOP) or call other employees (DESKTOP andWEB) to
alert them of an incoming transfer.

DESKTOP - The Click to Call option is not displayed when agents are in Do Not Disturb or absent
from their agent groups.



MiContact Center Business—MiVoice Business User Guide

264

While on a call, initiating Click to Call begins a consultation call with the agent. The original caller is
put on hold until the end of the consultation call. When consulting with another agent, if the other
agent hangs up first youmust click Hang Up in Ignite to reconnect with the original call. If you are
using a desk phone, you can hang up your extension and the original call will ring your extension to
reconnect.

NOTE:

l If an agent has multiple voice agents, Ignite provides call control for the number associated
with the currently active voice agent

l DESKTOP - Click to IM does not support group IM sessions.

To Click to Call or Click to IM (DESKTOP)

1. In the Transferwindow, select an available agent.
2. Select Click to IM to initiate an IM session or select Click to Call to initiate a voice call

See Figure 70.
NOTE: The recipient's presence displays, advising of their availability to receive your call or
instant message.

Figure 70: Click to IM and Click to Call

ToClick to Call (WEB)

1. Click Contacts.
2. If the destination is not a recent contact, type its name or number in theSearch field.
3. Hover over the destination’s avatar and click Call.

Removing Work Timer
NOTE: When agents are inWork Timer, Interactions remain in the Inbox until Work Timer is
removed

DESKTOP - Interactions inWork Timer aremarked with yellow.

WEB - Interactions inWork Timer aremarked with yellow and a clock icon.

Agents use the time spent inWork Timer to complete post-interaction work, such as consulting with
a supervisor, without having this downtime affect their performance statistics.

WhenWork Timer is the overriding state in Ignite, agents can removeWork Timer and put
themselves back into an overriding state across all media capabilities. Once agents have removed
Work Timer, they cannot put themselves back into this state.
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According to queue configuration settings, agents can be placed in aWork Timer state for a set
period of time after completing a call. TheWork Timer can optionally be configured to cancel
automatically after a Classification Code has been entered. If theWork Timer is not set to cancel
automatically, youmust cancel it manually after entering a Classification Code.

NOTE:Employees inWork Timer can apply Busy/Make Busy or DND, but will remain in aWork
Timer state until theWork Timer expires or is cancelled. If Classification Codes are required for the
queue and theWork Timer expires without a Classification Code being entered, aNon-Compliant
Classification Code will be applied to the call..

If Work Timer is not configured to cancel automatically when a Classification Code has been entered
and you end the call and do not manually cancel it you will be unable to receive calls until theWork
Timer duration, as configured on the queue, has expired.

If you are handling voice and other media interactions simultaneously, one agent being inWork
Timer will not prevent you from being offered an interactionof a different media type. For example, if
you are inWork Timer after handling a voice call, youmay still be offered an email from the email
queue, and you can accept it and handle it normally.

To removeWork Timer (DESKTOP)

l In theSidebar, click theRemove Work Timer button.
NOTE:Alternatively, removeWork Timer via the Action bar.

To removeWork Timer (WEB)

l Click Clear Work Timer.
Alternatively, click your avatar, select State, and choose an alternate state.

Call handling using the Action bar (DESKTOP)
Agents can optionally perform call handling activities, such as transferring a call, placing a call on
hold, and hanging up a call, from the Ignite Action bar instead of using theMiCollab Client call control
window. They can also removeWork Timer from the Action bar instead of the Sidebar, whichmay be
preferable for multimedia agents who do not use voice and, as a result, benefit more from the Ignite
main window than from the Sidebar. Multimedia agents may choose to collapse the Sidebar and
expand Ignite’s main window tomore efficiently handle emails and chats.

Handling calls using the Active Call window (WEB)
When on a call, agents can use the Active Call window for basic call handling options.

For procedures on specific call handling actions supported in the Active Call window, see the
appropriate sections of this guide.

For procedures on using Contacts to reach another person, see the appropriate sections of this
guide.

To handle a call using the Active Call window

1. When on a call, click thePhone button.
2. Choose a call handling option.
3. To close the Active Call window, click thePhone button.
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Managing Calls from MiCollabMobile Softphone in Ignite (WEB)
MiContact Center supports Agent calls onMiCollabMobile softphone throughWeb Ignite.

To use theMiCollab Softphone feature, perform these steps:

1. Install MiCollab in your Mobile Phone.
2. Ensure that MiCollab is up and running in your Mobile.
3. Login toWebIgnite, and toggle ON theSoftphone button.
4. Select theMiCollab SIP Softphone radio option.

Note: If MiCollab is not running in your mobile it will display an error that SIP Softphone is not
active.

5. Click Save.
This will change the Presence Status inWeb Ignite to Available.

6. You can now dial, receive, end, and transfer both inbound and outbound calls fromWeb Ignite
to your mobile and vice versa.
Note: Micollab ACD SIP onMobile does not support resiliency; youmust re-toggle the
MiCollab agent in the case of a failover.



Chapter 11
FLEXIBLE REPORTING

Using Flexible Reporting
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FLEXIBLE REPORTING
Flexible Reporting enables you to create customized reports. Access to Flexible Reporting is
determined by your security role.

With Flexible Reporting you can:

l Use a wizard interface to create customized reports with existing statistics (column headings)
l Create custom calculations using expressions
l Select column headings to build custom reports
l Select only the columns you want to view
l Select like data for two or more device types and combine them in one report
l Arrange the columns in the order in which you want to view them
l Customize the names of statistics (column headings) so they aremeaningful to your
department, business, and industry

l Save the reports in Excel and .pdf formats

NOTE:

l Flexible reporting supports amaximum of 256 columns per report.
l Security role settings are not supported in Flexible Reporting.

USING FLEXIBLE REPORTING
In Flexible Reporting you can

l Create new reports
l Modify standardMiContact Center Business report templates
l Modify existing Flexible Reporting report templates
l Design reports
l Manage your Flexible Reporting reports
l Run reports

STARTING FLEXIBLEREPORTING
NOTE: Launching client-side desktop applications from the task bar causes them to bypass the
MiContact Center Updater Service process. To ensure successful updates from the Enterprise
Server, after an upgrade close all client-side applications for 15minutes or reopen them from the
Start menu/Start screen.
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To start Flexible Reporting

1. Open Flexible Reporting.
2. If prompted, type yourUsername andPassword and verify theEnterprise Server IP

address.
3. If you use Secure Socket Layer, select SSL.
4. Optionally, select Remember my credentials.
5. Click Login.

TheWelcome to Flexible Reporting dialog box opens.
6. Select from: Run a report, Create a new report, Redesign a standard report,Modify an

existing report, orDo not show this dialog box again.
NOTE: The Created Language column for existing reports displays your current language
preference.

7. If you want to initiate a procedure, click OK and see the associated section in this chapter.
Otherwise, close the dialog box.

VIEWING THEFLEXIBLEREPORTING USER INTERFACE
The Flexible Reporting user interface includes the following. (See Figure 71.):

l Report Designer wizard
l Layout designer window
l Flexible Reporting button
l Ribbon
l Toolbox window
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Figure 71: Flexible Reporting user interface

You can customize the position of the windows in the following ways:

l Dock to the left, right, top, or bottom of the user interface
l Float
l Hide
l Auto-hide

Report Designer wizard
Whether you are building a new report or modifying an existing report, the Report Designer wizard
leads you through the following steps to select data for the report:

l Create a new report based on an existing one, or design a new report
l Select a report type
l Select the device types
l Select the statistics (column headings), and the order in which you want them displayed
l Specify the time frame options
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Layout designer window
The layout designer window comprises two tabs: design and preview. The window displays the
report header and data grid. You can perform the following functions in the layout designer window.

On the Design tab you can

l Add images to report headers
l Edit the report header titles
l Adjust the placement of the report header titles and values
l Remove report header titles and values
l Add existing or custom columns
l Move columns
l Delete columns
l Edit column heading names
l Specify columnwidth and row height
l Specify row colors
l Freeze and unfreeze columns
l Save report templates

On the Preview tab you can

l Run and preview reports
l Save reports
l Export reports
l Print reports

The File tab
The File tab is a tab located in the upper left corner of the window. The following options are available
from the Flexible Reporting button: New, Open, Save, Save As, Close, Feedback, About, LogOut,
Exit, and Exit and LogOut.

Ribbon
The ribbon provides the same functionality as traditional toolbars. Use the tools on the ribbon to help
you design your reports. The ribbon comprises the Home, Insert, and View tabs.

On the Home tab of the ribbon, you will find the tools to help you

l Change the font type, size, and style
l Select text justification
l Specify columnwidth, auto-fit columnwidth, and row height
l Change row colors

On the Insert tab of the ribbon, you will find the tools to help you

l Insert and remove images from the report header
l Select the report header titles to open in the report header
l Add existing or custom columns
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l Remove columns
l Freeze and unfreeze columns
l View ormodify expressions

On the View tab of the ribbon, you will find the tools to help you

l Show and hide the Toolbox window
l Manage reports

Toolbox window
The Toolbox window contains the following:

l Report header
Report header is a list of report header titles that are currently not included in the report header.
If the Report Header list is empty, all of the report header titles will be applied to the report.
When report header titles are removed from a report they are shown in the Report headers list.

l Column heading
Column heading displays a list of all of the column headings (for only those devices selected
for the report) that are not currently included in the report grid. When you add a column heading
to the report, it is removed from the list. Similarly, if you remove a column heading from the
report, it displays in the Column headings list.

CREATING NEWREPORTS
Using the Report Designer wizard you can build new reports with existing column headings. Use the
Report Designer wizard to select the data for the report.

NOTE: Reports generate in the language they were created in, regardless of the current employee
language setting.

The Report Designer wizard guides you through the following steps:

l Select how you want to display the report data
l Select the device(s) on which you want to report
l Select the statistics (column headers) that will be shown in the report
l Select the time frames over which you want to run the report

To create a new report

1. Click File=>New to launch the Report Designer wizard.
2. Click Next.
3. Click Create a new report and follow the steps in the wizard.

At the end of the Report Designer wizard, the new report opens automatically on the Design
tab.

4. Design the report.
See "Designing reports" on page 274.

5. Click File=>Save.
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MODIFYING STANDARDMiCONTACTCENTERBUSINESS
REPORTTEMPLATES
Using the Report Designer wizard you canmodify standardMiContact Center Business voice report
templates. In the wizard, you can remove data (column headings) and add new data (additional
devices and column headings).

You canmodify the following standard reports in the Report DesignerWizard:

l Agent by Make Busy Code
l Agent Group by Make Busy Code
l Agent Group Performance by Period
l Agent Performance by Account Code
l Agent Performance by Period
l Agent Shift by Period
l DNIS Group Performance by Period
l DNIS Performance by Period
l EmployeeGroup Performance by Employee
l Employee Performance by Agent ID
l Extension Group Performance by Period
l Extension Performance by Period
l Queue ANI by Area Code
l QueueGroup Performance by Period
l QueueGroup Performance by Queue
l Queue Performance by Account Code
l Queue Performance by Member
l Queue Performance by Period
l Trunk group Performance by Period

The Report Designer wizard guides you through the following steps:

l Select the report you want to modify from a list of standardMiContact Center Business
reports

l Select the time frames over which you want to be able to run the report
Choosing options on this page enables you to select time frames when submitting or
previewing reports. The start and end times enable you to run the report for a specific time
frame for each day in the report. For example, you can run the report for your hours of
operation only, 8 A.M. to 6 P.M.
The days of the week time frame enables you to run the report for specific days. For example,
every Friday over the last twomonths.
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Tomodify a standardMiContact Center Business report template

1. Click File=>New.
2. Click Next.
3. Select theRedesign a standard report option and follow the steps in the wizard.

At the end of the Report Designer wizard, the new report template opens automatically on the
Design tab.
NOTE:On the Select an existing report template page of the wizard, under Filter by device
type, select All devices if you want to see all available reports for all devices.

4. Design the report.
See "Designing reports" on page 274.

5. Click File=>Save.

MODIFYING EXISTING FLEXIBLEREPORTING REPORT
TEMPLATES
Tomodify an existing Flexible Reporting report template

1. Click File=>Open.
The Reports List window opens, giving you access to all personal and shared Flexible
Reporting reports.

2. Select the report you want to modify.
3. Click Open.

NOTE:
l If ‘Do not show this dialog box again’ was selected on theWelcome to Flexible
Reporting dialog box, the report will open to whichever tab, Design or Preview, was
open last.

l Shared reports that have no owner will prompt you to optionally take ownership of the
report when opened.

4. Modify the report.
See "Designing reports" on page 274.

5. Click File=>Save to save the changes to the report template.
Click File=>Save As to save the report as a new template.

6. If you want to run the report, click thePreview tab.

DESIGNING REPORTS
Using the options available on the ribbon, design the report by modifying the report header, columns,
and rows.

NOTE:

l You can open and edit report templates you previously created in Flexible Reporting.
l When right-clicking a column to bring up the column’s context menu, do not right-click the
column header cell. This is an editable field and will not bring up the column context menu.
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Adding images to report headers
To add an image to a report header

1. On the Insert tab of the ribbon, click the Insert button.
2. Select an image file and click Open.

The image displays on the report header.
3. Drag the image to where you want it to be shown on the report header.

Deleting images on report headers
To delete an image

1. Select an image on the report header.
2. On the Insert tab of the ribbon, click theRemove button.

Editing report header titles
Report headers comprise titles and values. Edit the report header titles to customize the look of your
reports.

You can edit the font type, size, and style of report header titles.

You can edit the titles of the following report headers:

l Report
l Site
l Device
l Date range
l Date created
l Created by
NOTE:You cannot edit the report header values as these are driven by the options selected
when the report is submitted.

To edit a report header title

1. Click a report header title.
2. Edit the text in the box.

Moving report header titles and values
You can drag and drop report header titles and values independently.

Tomove a report header title or value

l Drag and drop the report header title or value to where you want it to be shown on the report
header.

Removing report header titles and values
All report header titles and values are shown on a report when it is first created. If you remove a
report header title, the corresponding value will also be removed from the header. For example, if you
remove the Date range title, the date range will not be shown on the report.
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To remove a report header title and value

l On the Insert tab of the ribbon, click theHeader button and deselect the check box of the
report header title you want to remove. You can optionally drag and drop the report header title
from the report to the Report header list.
Report header titles removed from the report are shown in the Report header list in the Toolbox
window.

Adding report header titles and values
To add a report header title and value to a report

l On the Insert tab of the ribbon, click theHeader button and select the check box of the report
header title you want to add. You can optionally drag and drop the report header title from the
Report header list to the report.

Adding existing columns
To add an existing column

1. On the Insert tab of the ribbon, click Add=>Existing.
Optionally, right-click the report and select Insert column=>Existing from the drop-down list.
The Add columns window opens.
NOTE:You can also drag and drop items from the Column heading list in the Toolbox window
to add existing columns to your report.

2. Select the columns you want to add to the report.
3. Click OK.

Adding custom columns
You can add custom columns to create custom calculations using expressions or blank columns.
The ability to create custom calculations using expressions enables you to further customize report
data to suit your specific business needs. Blank columns can be used as spacers tomake reports
easier to read, or as placeholders for importing third-party data after a Flexible Reporting report has
been generated.

NOTE:

l Adding columns containing custom calculations requires a thorough understanding of
Microsoft Excel and regular expressions.

l We recommend you preview reports containing custom calculations in Flexible Reporting
before saving the changes and generating the report in CCMWeb.

To add a column containing custom calculations

1. On the Insert tab of the ribbon, click Add=>Custom.
Optionally, right-click the report and select Insert column=>Custom from the drop-down list.
A blank column displays in the report.

2. Right-click a cell in the blank column and select Expression.
The Edit expression window opens.
NOTE:You cannot create calculations using expressions in a header cell.

3. Select an option in theOptions list to view the associated Item list.
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4. Select an item in the Item list to view the associated item Description and expression
Example.

5. Double-click the item in the Item list to insert its expression into theExpression box.
6. Repeat steps 3 to 5 until the complete calculation is entered in theExpression box and click

OK.
The expression displays in row two of the blank column in the report.

7. If you want to edit the expression you created, right-click the cell and select Expression to
return to the Edit expression window.

After adding a column containing custom calculations you can choose to view ormodify the
expression.

To view ormodify an expression

1. Select the cell in the report, for which you want to view ormodify the expression.
2. On the Insert tab of the ribbon, click Expression.

Optionally, right-click the column and select Expression from the drop-down list.
The Edit expression window opens.

3. Select an option in theOptions list to view the associated Item list.
4. Select an item in the Item list to view the associated item Description andExpression

example.
5. Double-click the item in the Item list to insert its expression into theExpression box.
6. Repeat steps 3 to 5 until the complete calculation is entered in theExpression box and click

OK.
The expression displays in row two of the blank column in the report.

You can restrict the number of decimal places that will display for results. As an example, setting the
number of decimal places that will display for the AverageManned Agent statistic is described
below.

To set the number of decimal places that display for results

1. In theDesign view, right-click theAverage Manned Agent column in the report and select
Expression from the drop-down list.

2. Change the current value of =Fields!AgentGroupEventAvgMannedAgents.Value to
=FormatNumber(Fields!AgentGroupEventAvgMannedAgents.Value,1).

3. Click OK.
4. Click Save.

The column is formatted to display one decimal place. To alter the number of decimal places
displayed, enter the appropriate number in place of 1.

To add a blank column

1. On the Insert tab of the ribbon, click Add=>Custom.
Optionally, right-click the report and select Insert column=>Custom from the drop-down list.
A blank column displays in the report.

2. Optionally, click the header cell of the blank column and type a name for the column.
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Moving columns
Tomove a column

l On the report grid, drag and drop the column to where you want it on the grid.

Deleting columns
NOTE:Some statistics require specific columns to ensure a report is meaningful. These statistics
are associated with the required columns and cannot be deleted on their own. For example, in by
period reports, you cannot delete the interval; in by device reports, the reporting number cannot be
deleted.

To delete a column

1. Click a column on the report grid.
2. On the Insert tab of the ribbon, click theRemove button.

Optionally, right-click the column and select Delete column from the drop-down list.

Editing column heading names
You can edit the names of column headings so they aremeaningful to your department, business,
and industry. You can change the font type, size, and style as well as edit the text.

To edit a column heading name

1. Click a column heading on the report grid.
2. On theHome tab of the ribbon, use the font options to change

l the font type, size, and style
l the justification

3. Optionally, edit the name of the column heading.
If, after renaming a column heading, you want to see the original column heading name, hover
over the column heading. The original column heading name displays after Name.

Specifying columnwidth
To specify the columnwidth

1. Click a column.
2. On theHome tab of the ribbon, afterColumn width, type the width (in pixels).

Optionally, right-click the column and select Columnwidth from the drop-down list.

To auto-fit the columnwidth

1. Click a column.
2. On theHome tab of the ribbon, afterScale to fit, click Auto.

Optionally, right-click the column and select Auto-fit Columnwidth from the drop-down list.
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Specifying row height
You can specify a different row height for the header row than the body rows.

To specify the header row height

1. Click the header row.
2. On theHome tab of the ribbon, afterRow height, type the height (in pixels).

To specify the body row height

1. Click a body row.
2. On theHome tab of the ribbon, afterRow height, type the height (in pixels).

Optionally, right-click the body row and select Row height from the drop-down list.
All of the body rows will be the same height.

Specifying row colors
You can alternate row colors to make report data easier to read.

1. On theHome tab of the ribbon, select the primary and alternate colors.
2. AfterAlt row count, type the number of rows for each color.

Freezing columns
Frozen columns remain stationary when you scroll to view columns to the right.

To freeze a column heading

1. On the report grid, click the column to the right of the ones you want to freeze.
2. On the Insert tab of the ribbon, click the Freeze column button.

Optionally, right-click the column and select Freeze column from the drop-down list.

Unfreezing columns
To unfreeze a column heading

1. On the report grid, click the column to the left of the frozen column.
2. On the Insert tab of the ribbon, click theUnfreeze column button.

Optionally, right-click the column and select Unfreeze column from the drop-down list.

MANAGING YOURFLEXIBLEREPORTING REPORTS
Youmanage your Flexible Reporting reports on theMy Reports window. My Reports gives you
access to all of the reports you have created.

You can access all the reports you have created and all shared reports created by others, by clicking
the File=>Open.

NOTE:Shared reports that have no owner will prompt you to optionally take ownership of the report
when opened.
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In theMy Reports window you can

l Change access properties: Shared or not Shared
l Rename reports
l Delete reports

Changing access properties
To change the access properties of a report

1. On theView tab of the ribbon, click My reports.
2. Select the report(s).
3. If you want to share the report(s), underShared, select the check box. Otherwise, clear the

check box and the report(s) will be available to you only.
4. Click OK.

Renaming reports
To rename a report

1. On theView tab of the ribbon, click My reports.
2. Select a report and click Rename.
3. Edit the name.
4. Click OK.

Deleting reports
You can only delete the reports you create.

To delete a report

1. On theView tab of the ribbon, click My reports.
NOTE: You cannot delete a report that is open in Flexible Reporting.

2. Select the report(s) you want to delete and click Delete.
3. Click Yes to delete the selected report(s).
4. Click OK.

RUNNING FLEXIBLEREPORTS
You can run Flexible Reporting reports in CCMWeb or in Flexible Reporting. However, you can
schedule reports in CCMWeb only.

From CCMWeb, you can run Flexible Reporting reports on demand, or schedule them, the same
way you run standard reports.

In Flexible Reporting you can run, save, and print reports on the Preview tab. After you run a report,
printing options enable you to view the print layout, and configure page setup and printer properties.
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NOTE:

l Flexible Reporting will run reports only when there is data to generate the report.
l If you run a report on the Preview tab and the report data is all zeros, ensure you selected a
device on which to run the report. If you selected a device, ensure the selected time period is
one that would have incurred activity.

l Custom reports created in Flexible Reporting can only be generated in the language that was
used when they were created and saved.

Running reports in CCMWeb
To run an on-demand report in CCMWeb

l Hover overReporter, select Flexible Reporting, and run the report.
You will have access to all Flexible Reporting reports created by you and shared Flexible
Reporting reports created by others.

NOTE: When a report supports more than one device type, click on each tab to select the devices on
which you want to report.

To schedule a report in CCMWeb

1. Hover overReporter and select Scheduled Reports.
2. If you want to create a new schedule, click Next. Otherwise, select an existing schedule and

click Manage schedule properties.
3. Configure the schedule properties and distribution attributes.
4. Click Add a report.
5. Click Flexible Reporting and select a report to add to the schedule.

Running reports in Flexible Reporting
To run reports in Flexible Reporting

1. On thePreview tab, underDevices, select the device(s).
2. Specify the date and time parameters.
3. Click Run report.

Flexible Reporting generates the report and displays it in the preview pane.

Saving templates and reports
In Flexible Reporting you can save

l Templates
The report templates you create in Flexible Reporting are saved on the Enterprise Server so
you can run them from Flexible Reporting and CCMWeb.
NOTE:Report templates are not saved automatically. Youmust save your report template
before you exit Flexible Reporting if you want to use it to run reports or modify the template
later.

l Reports
After you run a report in Flexible Reporting, you can save the output (report) on your computer
or elsewhere on your network. Reports can be saved or, optionally, exported in Excel (.xsl and
.xslx), Word (.doc), or .pdf formats.



MiContact Center Business—MiVoice Business User Guide

282

To save a report template as a new document

1. Click the File=>Save As.
2. After File name, type the name of the new template.

NOTE:Only you can run and view reports you have created and designated as not shared.
Shared reports can be run and viewed by others.

3. If you want to allow others to run the report, select theShared check box.
4. Click Save.

To savemodifications to a report template

l Click File=>Save.

To export a report in Excel (.xsl or .xslx) format

l In the Preview window, above the generated report, click theSave button, select Excel, and
specify the location to save the report in Excel (.xsl) format.
Optionally, in theView tab of the ribbon, click theExport report button, select Excel (.xsl) or
Excel 2007 (.xslx) and specify the location to save the report in an Excel format.

To export a report inWord (.doc) format

l In the Preview window, above the generated report, click theSave button, selectWord, and
specify the location to save the report inWord (.doc) format.

To export a report in .pdf format

l In the Preview window, above the generated report, click theSave button, select PDF, and
specify the location to save the report in .pdf format.
Optionally, click theExport report button on the View tab of the ribbon, and select PDF, and
specify the location to save the report in .pdf format.

Printing reports
To print a report you ran on the Preview tab

l On the Preview window toolbar, click thePrint button.
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POSTING FEEDBACKANDVIEWING OURFORUMS
Mitel has partnered with UserVoice, a third-party service, to host customer suggestions on
https://micontactcenter.uservoice.com. When you post an idea to our feedback forum, others will be
able to subscribe to it andmake comments.

Our forums enable you to send feedback directly to the people building the product. While we cannot
comment on every suggestion, feedback is analyzed and considered for future releases.

NOTE: Please do not use the forums to submit product defects. To submit product defects, please
contact your administrator or dealer.

Feedback can also be submitted directly to Mitel without posting the suggestion on the forums. For
more general feedback, you can also provide a rating of your experience with MiContact Center
Business.

NOTE:Please do not use feedback for requesting customer assistance. For assistance with
MiContact Center Business, please contact your dealer or Mitel Customer Support.

To post feedback and view our forums

1. In YourSite Explorer, click File=>Feedback.
2. Click Got an idea? Tell us.

OR
Access the following URL: https://micontactcenter.uservoice.com.

To submit feedback directly

1. In YourSite Explorer, click File=>Feedback.
2. Click Contact Us.

To rate your Mitel experience

1. In YourSite Explorer, click File=>Feedback.
2. Click Rate us.

https://micontactcenter.uservoice.com/
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WORKFORCE SCHEDULING
Workforce Scheduling is an optional application that enables you to create employee schedules.
Using historical data, Workforce Scheduling forecasts the number of employees required tomeet
your contact center's Service Level objectives.

NOTE: Access toWorkforce Scheduling features is dependent on your administrative-set security
role.

UsingWorkforce Scheduling in conjunction with MiContact Center Business, you can

l Customize schedules
l Forecast scheduling requirements
l Match an employee’s skills to those skills required for jobs in each schedule
l View the distribution of employees across each schedule
l Print schedule reports

There are two optional applications that work in conjunction withWorkforce Scheduling: Schedule
Adherence and Employee Portal. For more information on these applications, see "Schedule
Adherence" on page 322 and "Employee Portal" on page 329.

UNDERSTANDINGWORKFORCE SCHEDULING
Before you start usingWorkforce Scheduling read the following sections on how to

l View theWorkforce Scheduling user interface
l Understand forecasting concepts
l Understand theWorkforce Scheduling process

VIEWING THEWORKFORCESCHEDULING USER INTERFACE
Figure 72 displays scheduling information, such as the employees who are scheduled, employee
shift start and end times, the time interval shift totals, and the shift details for each employee.

NOTE: The Scheduling and Forecasting buttons in the Tools>Administration window are used to
toggle between these two views.

TheWorkforce Scheduling user interface is comprised of the following panes:

l People pane
l Time bar pane
l Totals pane
l Schedule details pane



Understanding Workforce Scheduling

286

Figure 72: Scheduler window

People pane
The people pane is located in the upper-left portion of the scheduler window. The people pane lists
the employees included in the schedules you are viewing. (See Figure 73.)

Figure 73: People pane
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Time bar pane
The time bar pane is located in the upper-right portion of the scheduler window. The time bar pane
displays a time bar for each scheduled employee. Time bars display the shifts, breaks, jobs, time
off, and unavailable periods for employees listed in the people pane. You can view the time bar pane
in the following time intervals: 6 hours, 12 hours, 1 day, 2 days, 1 week, 2 weeks, and 1month. (See
Figure 74.)

You can view previous or upcoming dates using the horizontal scroll bar under the time bar pane. If
you reach the end of themonth and want to view dates for the next month, you can click the arrow on
the scroll bar to load the schedule for the next month (as indicated by the red square in the following
image).

Figure 74: Time bar pane

Totals pane
The totals pane appears when you select event totals to view. The totals pane is located in the
center of the scheduler window. Each value represents the total number of employees scheduled for
an event. (See Figure 75.)

Figure 75: Totals pane
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You can view the following event totals:

Forecasted

The Forecasted total displays after you apply a forecast to the schedule. This total represents the
forecasted number of employees required to handle interaction requests andmeet the Service Level
objectives you specify. You can optionally adjust the Forecasted total in the totals pane. See
"Modifying forecast totals in the event totals pane" on page 318.

NOTE: When the user sets View to greater than 6 hours, each cell value in the Totals View is the
maximum value of the composite 15-minute values. TheOver/Under value displayed is also the
maximum of the composite values. As a result, in this view, the displayed value for the Over/Under
does not align with the value that would be obtained from adding the At Work and forecasted values.

Scheduled

TheScheduled total represents the number of employees scheduled for the time you are viewing.

On break

TheOn break total represents the number of employees scheduled for a break at a specific time.

On ACD Job

TheOnACD Job total represents the number of employees scheduled to perform ACD work.

On Non ACD Job

TheOnNon ACD Job total represents the number of employees scheduled to perform Non ACD
work.

At work

TheAt work total represents the number of employees scheduled to handle interaction requests.

Over/Under

TheOver/Under total represents the difference between the number of employees at work compared
to the number of employees forecasted. A value of 4means 4 additional employees are working
compared to the forecasted requirement. A value of (4) means 4 fewer employees are working
compared to the forecasted requirement. When you book annual leave for employees, you can
preview the result on shift coverage by using the over / under function, before updating changes.

Overtime

TheOvertime total represents the number of employees scheduled to perform overtime work.

Schedule details pane
The schedule details pane is located at the bottom of the scheduler window. It displays details on
scheduled employees. You canmodify the start and end times of scheduled events in the schedule
details pane. For example, you can adjust the length of a scheduled break. See "Modifying event
times and notes in the schedule details pane" on page 318. (See Figure 76.)
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Figure 76: Schedule details pane

You can sort the information in the schedule details pane by organizing the headings. The schedule
details column headings are as follows:

l Employee name—the employee to which the specified time event is scheduled
l Schedule—the schedule to which the specified time event is scheduled
l Event type—the events to which the specified time event is scheduled
l Start date—the start date of each scheduled event. You canmodify this parameter in the
schedule details pane. Changes are immediately reflected in the time bar pane

l Start time—the start time of each scheduled event. You canmodify this parameter in the
schedule details pane. Changes are immediately reflected in the time bar pane

l End time—the end time of each scheduled event. You canmodify this parameter in the
schedule details pane. Changes are immediately reflected in the time bar pane

l Paid hours—the total number of paid hours for the scheduled shift
l Budget—the total cost of the scheduled shift
l Notes—the notes on scheduled events you enter in this field

UNDERSTANDING FORECASTING CONCEPTS
Workforce Scheduling assists you in scheduling employees for work and holiday periods. It offers an
integrated forecasting component that uses historical data to partially automate the scheduling
process. Scheduling is not entirely automated. Youmay have tomodify employee schedules and
enter shift and employee variables manually after creating a schedule based on forecasted data.

You schedule employees so the number of incoming calls at any given time typically exceeds the
number of employees currently available. This ensures callers experience a slight delay before
employees answer their calls. The expected number of incoming calls forecasted for the time of day
and day of the week influence scheduling decisions when trying to find the right balance between call
volume and available staff.

For information on accessing historical data to assist whenmaking schedules, see "Exporting
forecasts toWorkforce Scheduling" on page 143.

For information on forecasting variables and how to improve forecasting accuracy, see "Step #3
Forecast the Call Load" on page 26.

For information on Service Level variables and how to calculate the Service Level Percent, see
"Understanding the Service Level" on page 19.
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UNDERSTANDING THEWORKFORCESCHEDULING
PROCESS
Employees, agent IDs, agent groups, queues, queue groups, overtime types, time off types,
holidays, and skills are configured by the System Administrator in YourSite Explorer. After these
devices are configured, youmust decide if you will use forecasted data to build your schedules.
When you build a schedule inWorkforce Scheduling using forecasted data, we recommend you
associate the schedule with the queue group you will use to perform the forecast. Youmust ensure
that the employees you want to schedule are associated with the queue group you associate to the
schedule. You can optionally associate a schedule to a queue group with different employees, which
can be useful for scheduling a new group of employees based on the forecasted data of other
employees.

As soon as you start Workforce Scheduling, you can begin creating your schedules. After you log in,
you are asked to create or select a schedule. You create a schedule by assigning it a name. If you
are using a forecast to build the schedule, you associate the schedule with a queue group.

After you create the schedule, you configure schedule parameters, such as shifts, breaks, jobs, and
scheduling preferences/options for each employee.

You can automate the schedule building process with the Schedule Builder tool. It helps you quickly
build a schedule, with or without a forecast. If you build schedules using forecasted data, we
recommend you use Schedule Builder. Alternately, you can build a schedulemanually. This involves
inserting or removing events (shifts, breaks, jobs, time off, unavailable periods) andmaking events
recur. You canmanually build a schedule based on forecast totals in the Totals pane. After you build
a schedule using Schedule Builder, youmay need tomake a few adjustments.

WORKFORCE SCHEDULING ANDYOURCONTACT
CENTER

UsingWorkforce Scheduling, you can schedule your employees to best suit your contact center
needs. You can

l Customize schedules for your contact center groups
l Forecast scheduling requirements
l Match employee skills to the skills required for each schedule
l View the distribution of employees across schedules
l Print schedule reports

For information on scheduling considerations, and how to calculate the Shrinkage Factor and
optimize scheduling, see "Step #5 Schedule agents" on page 31.

UsingWorkforce Scheduling, you can create schedules for your contact center using a variety of
options. Depending on your contact center, some options may bemore suitable than others. To help
your company useWorkforce Schedulingmost effectively, we have created configuration scenarios
that describe how to implement Workforce Scheduling, based on the type of scheduling used in your
contact center.
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EachWorkforce Scheduling configuration scenario provides a description of the schedulingmethod
and an example of contact centers that typically use that method. Each scenario also provides some
tips on how to configureWorkforce Scheduling for each style of scheduling. The scenarios include
the following scheduling configurations:

l Assigned shift
l Availability
l Rotational
l Forecast

ASSIGNEDSHIFT-BASEDSCHEDULING CONFIGURATION
SCENARIO
The assigned shift schedulingmethod uses fixed shifts staffed by employees who are permanently
assigned to specific shifts. Contact centers that use assigned shift scheduling have consistent call
volumes. Employees are primarily full-time staff and are guaranteed a specific number of hours of
employment per week. Typically, you plan a schedule three to six months in advance with assigned
shift scheduling.

Contact centers ideal for assigned shift scheduling

Assigned shift scheduling is best suited to contact centers that have a steady and predictable call
volume, such as a contact center that runs a conventional nine to five operations. Examples of
contact centers that use assigned shift scheduling include banks and government offices.

To configureWorkforce Scheduling for an assigned shift scheduling environment

l Create fixed shifts
l Use shift names that describe a shift's purpose, such as '9 to 5 shift' or '1st shift'
l Usemass recurrence to repeat scheduled events for multiple weeks
l Configure employee hours using shift assignment by day of week

AVAILABILITY-BASEDSCHEDULING CONFIGURATION
SCENARIO
The availability schedulingmethod uses fixed shifts, but unlike assigned shift scheduling, the
employees that work a given shift are not permanently attached to that shift. Contact centers that
use availability scheduling fill shifts using a pool of employees.

A contact center supervisor sets staff availability based on day of week and time of day. When
staffing a shift, the supervisor can assign any employee who is listed as available for that date and
time to the shift. Typically, you plan a schedule two to four weeks in advance when you use
availability scheduling.

Contact centers ideal for availability scheduling

Availability scheduling is best suited to contact centers driven by shifts, such as hotels or
companies that focus on catalog sales. These contact centers have a specific number of shifts that
can be filled by any qualified employees who are available. This type of schedule is frequently used
with contact centers that operate 24/7.
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To configureWorkforce Scheduling for an availability scheduling environment

l Primarily use fixed shifts, but do not assign employees to specific shifts
l Assign employees all of the possible shifts they can work
l Set employee availability by day of week and time of day
l Use filters to assign the best employee available for a shift, based on skill set, seniority, or
personal priority number

ROTATIONAL-BASEDSCHEDULING CONFIGURATION
SCENARIO
The rotational schedulingmethod consists of two or more unique schedules that recur at defined
intervals. For example, if a contact center rotates four schedules, the week one schedule repeats in
week five, week nine, and so on. The rotational schedulingmethod enables contact center
schedules to be consistent in the long-term, while allowing shifts to vary from week to week.

Contact centers ideal for rotational scheduling

Rotational scheduling is best suited to contact centers that require specific employees to cover
unique periods of time, such as medical clinics that are open on weekends. If each contact center
employee is required to work one weekend amonth, a rotational schedule can ensure an even
distribution of weekend work for each employee.

To configureWorkforce Scheduling for a rotational scheduling environment

l Primarily use assigned shifts with defined employees. The staff changes from one schedule
rotation to the next ensure fair coverage on nights, weekends, and holidays

l Recur the shifts multiple times based on the number of rotations
l Manually track and adjust which employees are assigned to each rotation; Workforce
Scheduling does not create a balanced schedule so you will need tomake changes if you
want to ensure the schedule is fair

l Optionally use rotational scheduling in conjunction with other schedule types. For example,
create a schedule that uses the assigned shift method to cover Monday to Friday shifts and a
second schedule that uses the rotational shift method to cover shifts such as weekends or
holidays
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FORECAST-BASEDSCHEDULING CONFIGURATION
SCENARIO
The forecast schedulingmethod references historical data to create schedules. Contact centers that
use forecast scheduling have call volumes that can change considerably over relatively short
periods of time, resulting in inconsistent scheduling.

Forecast scheduling provides more flexibility than other schedulingmethods since shifts are not
defined. A contact center that uses forecast scheduling does not have a fixed staff or fixed hours, as
both change based on the expected call volume. Typically, you plan a schedule one to two weeks in
advance with forecast scheduling.

Contact centers ideal for forecast scheduling

Forecast scheduling is best suited to contact centers driven by call volume, such as companies that
focus on sales campaigns, promotions, or seasonal sales.

To configureWorkforce Scheduling for a forecast scheduling environment

l Generate historical data specific to the type of event you are scheduling (for example, to
create a schedule for a winter sales campaign, use historical data from a previous winter
campaign)

l Create shifts with flexible start and end times to provide Schedule Builder with the greatest
number of options when populating the shifts with employees

l Remember that shift variables, such as start/end times and breaks, will vary for employees on
a day-to-day basis

l Due to the variety of shift start and end times, create breaks based on the Time to qualify
variable

l Do not configure availability or shift assignment

SELECTING A SCHEDULING METHOD
You can build schedules inWorkforce Scheduling:

l Using a forecast
l Manually

The setup you require depends on the schedulingmethod you choose. If you incorporate forecast
data when you build a schedule, youmust build the schedule using Schedule Builder.

SCHEDULING USING FORECASTDATA
When you use forecast data to build a schedule, you can apply historical data from any queue or
queue group to the schedule. It is recommended to use historical data from the queue group with
which the schedule is associated. Forecast data is simply the number of required agents. It can be
used in schedules which are not associated with a queue or queue group.

Before you build a schedule using a forecast, as a best practice, we recommend you associate your
schedule with a queue group. You should also ensure that the employees to be scheduled are
associated with this queue group.
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Ensure your System Administrator

1. Associates the agent IDs with an agent group.
2. Associates the agent group with a queue.
3. Associates the queue with the queue group (that you will associate with the schedule).

Instructions for configuration and association of agents, agent groups, queues, and queue
groups are located in theMiContact Center Business Installation and Administration Guide.

SCHEDULINGMANUALLY
You have themost flexibility when you build a schedulemanually. However, this can be time
consuming if youmust schedule a large number of employees or if youmust create a schedule
covering a long time period where shift assignments do not recur. You can also usemanual
scheduling to tweak schedules you build with Schedule Builder. See "Creating and adjusting
schedules manually" on page 315.

SCHEDULE SETUP ANDCUSTOMIZATION
In order to build a schedule inWorkforce Scheduling, whether you build your schedule with
forecasting or you build it manually, youmust perform the following tasks to set up and customize
your schedule:

1. Start Workforce Scheduling.
2. Configure schedule options.
3. Configure shifts, breaks, and jobs.
4. Assign shifts to schedules.
5. Assign shifts to employees.
6. Specify scheduling preferences/options for each employee in the schedule.
7. Specify schedule warnings.

STARTINGWORKFORCESCHEDULING ONACLIENT
COMPUTER
NOTE: Launching client-side desktop applications from the task bar causes them to bypass the
MiContact Center Updater Service process. To ensure successful updates from the Enterprise
Server, after an upgrade close all client-side applications for 15minutes or reopen them from the
Start menu/Start screen.
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To log on toWorkforce Scheduling

1. OpenWorkforce Scheduling.
The Login window appears.

2. If prompted, type yourUsername andPassword and verify the Enterprise Server IP address.
3. If you use Secure Socket Layer, select SSL.
4. Optionally, select Remember my credentials.
5. Click Login.

The first time you log on, or if you have not created any schedules, the scheduler window
displays. See "Configuring schedule options" on page 295.
Otherwise, if schedules exist, the Load schedule window displays.
See "Loading schedules" on page 315.

CONFIGURING SCHEDULEOPTIONS
NOTE:

l If you associate a schedule with a queue group, only those employees included in the
selected queue group can be configured in the schedule. (Agents aremembers of agent
groups, which are associated with queues that aremembers of queue groups.)

l If you do not associate a schedule with a queue group, you can schedule any employee
whose profile enables you to schedule them inWorkforce Scheduling.

Before you can build a schedule, either manually or using Schedule Builder, youmust create a new
schedule.

On the New Schedule window, youmust:

l Name the schedule
l Associate the schedule with a queue or queue group (optional)
l Add employees to the schedule
l Configure business hours for the schedule
l Activate/Deactivate the schedule

You can create new schedules and configure all Workforce Scheduling options using the Schedule
wizard. Optionally, use the Schedule tool to add, delete, rename, and activate/deactivate schedules.
Within the Schedule configuration window, you can click Apply at any time to apply changes to the
schedule without closing the Schedule configuration window.

Configuring scheduling options using the Schedule wizard
You can create new schedules and configure all Workforce Scheduling options using the Schedule
wizard.

To configure scheduling options using the Schedule wizard

1. Click theConfiguration tab.
2. In theSchedules group, click Schedule wizard.
3. Follow the steps in the Schedule wizard to configure schedules, business hours, employees,

fixed/variable shifts, fixed/variable breaks and jobs, and fixed/variable shift assignments.
4. Click Finish.
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Creating schedules
To create a schedule

1. On the Applicationmenu or ribbon, click New schedule.
2. AfterSchedule name, type a name for the schedule.
3. UnderEmployee association, select eitherAll employees, Employees associated with

this queue group only, orEmployees associated with this queue only.
l If you select Employees associated with this queue group, select a queue group from
the list.

l If you select Employees associated with this queue, select a queue from the list.
4. If this schedule will be an active schedule, select the This schedule is active check box.

Otherwise, select the This schedule is used for planning purposes only check box.
5. Click OK.
6. Select the check boxes of the employees to add to the schedule.
7. Click OK.

Adding employees to schedules
Schedules that contain fewer than 100 employees are easiest to manage. Each employee should
belong to one active schedule only. However, if employees belong tomore than one schedule, you
can still view the shifts for which they are scheduled.

To add an employee to a schedule

1. Click theConfiguration tab.
2. In theSchedules group, click Select employees.
3. AfterSchedule, select a schedule.
4. If you want to group employees in the list by supervisor, select theGroup by supervisor

check box.
5. Select the check boxes of the employees to add to the schedule.
6. Click OK.

Configuring business hours for schedules
You can specify different business hours for each schedule. By default, you are warned if you try to
schedule shifts outside business hours.

To configure the business hours of a schedule

1. Click theConfiguration tab.
2. In theSchedules group, click Schedule.
3. In the left pane, select Schedules.
4. UnderSchedules, select the schedule tomodify.
5. After First day of the schedule week, specify the day that the schedule will begin.
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6. AfterAnnual calendar start date, specify the date the calendar year begins.
The information in this field is used to calculate annual minimum andmaximum hours for
employees. January 1st is the default date.

7. Specify business hours for the schedule.
l If you want to schedule employees 24 hours a day, seven days a week, under Business
hours, click Open 24/7.

l AfterOpen, select the check boxes of the days of the week to schedule.
l After From, specify the start times for each day of the week to schedule.
l After To, specify the end times for each day of the week to schedule.

8. Click OK.

Renaming schedules
You can rename a schedule without losing any information associated with the schedule.

To rename a schedule

1. Click theConfiguration tab.
2. In theSchedules group, click Schedule.
3. UnderSchedules, select the schedule to rename.
4. Click Rename.
5. AfterName, type a new name for the schedule.
6. Click Rename.
7. Click OK.

Deleting schedules
CAUTION:Deleting a schedule deletes all of the information associated with that schedule. This
cannot be undone.

To delete a schedule

1. Click theConfiguration tab.
2. In theSchedules group, click Schedule.
3. UnderSchedules, select the schedule to delete.
4. Click Delete.
5. Click Yes.
6. Click OK.
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Activating / De-activating schedules
You can activate or deactivate a schedule at any time. Deactivating schedules is useful for
performing 'what-if' scenarios, for seasonal schedules, and for retaining schedules to be used at a
later time.

To activate or deactivate a schedule

1. Click File=>Activate.
The Activate / Deactivate Schedule dialog box opens.

2. Select the schedule that you want to activate / deactivate.
You can loadmultiple active schedules. However, if you load an inactive schedule, all other
schedules close.

3. Click Activate to activate an inactive schedule orDeactivate to deactivate an active
schedule.

4. Click Close.

CONFIGURING SHIFTS
A shift represents work hours on a given day for an employee. You can assign shifts to specific
employees for any day of the week. You can create several shifts for one or more schedules. There
are two types of shifts: fixed shifts and variable shifts. Fixed shifts have a fixed start time and
duration. Variable shifts are based on the following shift variables:

l Typical hours—the number of work hours for the shift
l Minimum hours—theminimum number of hours for the shift
l Maximum hours—themaximum number of hours for the shift
l Minimum start—the time of day after which the shift must start
l Maximum start—the time of day by which the shift must start
l Color—the color in which the shift appears in the time bar pane

You configure the following shift options using the Schedule tool:

l Add fixed shifts
l Add variable shifts
l Rename shifts
l Delete shifts

Adding fixed shifts
To add a fixed shift

1. Click theConfiguration tab.
2. In theSchedules group, click Schedule.
3. In the left pane, click Shifts.
4. In the right pane, click the Fixed Shifts tab.
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5. In the right pane, click Add.
6. AfterName, type a name for the fixed shift.
7. Click Create.
8. UnderStart time, type the start time of the fixed shift.
9. UnderDuration, type the duration of the fixed shift.
10. UnderColor, select a color for the fixed shift.
11. Click OK.

Adding variable shifts
To add a variable shift

1. Click theConfiguration tab.
2. In theSchedules group, click Schedule.
3. In the left pane, click Shifts.
4. In the right pane, click theVariable Shifts tab.
5. In the right pane, click Add.
6. AfterName, type a name for the variable shift.
7. Click Create.
8. UnderMinimum hours, type theminimum number of hours in a day you can schedule the

shift.
9. Under Typical hours, type the typical number of hours in a day you can schedule the shift.
10. UnderMaximum hours, type themaximum number of hours in a day you can schedule the

shift.
11. UnderMinimum start, type the time of day after which the shift must start.
12. UnderMaximum start, type the time of day by which the shift must start.
13. UnderColor, select a color for the variable shift.
14. Click OK.

Renaming shifts
You can rename fixed/variable shifts without losing any information associated with the shifts.

To rename a shift

1. Click theConfiguration tab.
2. In theSchedules group, click Schedule.
3. Click theShifts tab.
4. If you want to rename a fixed shift, click the Fixed shifts tab. Otherwise, to rename a variable

shift, click theVariable shifts tab.
5. UnderName, click the name of the shift to rename.
6. Type a new name for the shift.
7. Click OK.



Schedule setup and customization

300

Deleting shifts
CAUTION: Deleting a shift deletes all of the instances of that shift, including those inserted in
schedules.

To delete a shift

1. Click theConfiguration tab.
2. In theSchedules group, click Schedule.
3. Click theShifts tab.
4. If you want to delete a fixed shift, click the Fixed shifts tab. Otherwise, to delete a variable

shift, click theVariable shifts tab.
5. UnderName, select the shift to delete.
6. Click Delete.
7. Click Yes.

CONFIGURING BREAKS
You configure the following break options using the Schedule tool:

l Add fixed breaks
l Add variable breaks
l Rename breaks
l Delete breaks

Examples of common breaks aremorning break, lunch, afternoon break, and dinner break.

Adding fixed breaks
To add a fixed break

1. Click theConfiguration tab.
2. In theSchedules group, click Schedule.
3. In the left pane, click Breaks.
4. In the right pane, click the Fixed Breaks tab.
5. Click Add.
6. AfterName, type a name for the break.
7. Click Create.
8. If the break is a paid break, enable the check box under Is paid.
9. Under Time into Shift, type the time from the beginning of the shift at which the break must

start.
10. UnderDuration, type the amount of time allotted for the break.
11. UnderColor, select a color for the break.
12. Click Ok.
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Adding variable breaks
To add a variable break

1. Click theConfiguration tab.
2. In theSchedules group, click Schedule.
3. In the left pane, click Breaks.
4. In the right pane, click theVariable Breaks tab.
5. Click Add.
6. AfterName, type a name for the variable break.
7. Click Create.
8. UnderDuration, type the amount of time allotted for the break.
9. If the break is a paid break, select the check box underPaid.
10. Under Time to qualify, type theminimum duration of a shift before you can schedule the

break.
11. UnderMust start time into shift, type the amount of time from the beginning of the shift that

employees must work before they are entitled to the break.
12. UnderMust end time into shift, type the amount of time from the beginning of the shift by

which employees must complete the break.
13. UnderMinimum time before end of shift, type the amount of time before the end of the shift

that the break must end.
14. UnderColor, select a color for the shift.
15. Click OK.

Renaming breaks
You can rename a break without losing any information associated with the break.

To rename a break

1. Click theConfiguration tab.
2. In theSchedules group, click Schedule.
3. In the left pane, click Breaks.
4. If you want to rename a fixed break, in the left pane, click the Fixed Breaks tab. Otherwise, to

rename a variable break, click theVariable Breaks tab.
5. UnderName, click the name of the break to rename.
6. Type a new name for the break.
7. Click OK.
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Deleting breaks
CAUTION: Deleting a break deletes all of the instances of the break, including those inserted in
schedules.

To delete a break

1. Click theConfiguration tab.
2. In theSchedules group, click Schedule.
3. If you want to delete a fixed break, in the left pane, click Fixed shifts. Otherwise, to delete a

variable break, click Variable shifts.
4. Click theBreaks tab.
5. UnderName, select the name of the break to delete.
6. Click Delete.
7. Click Yes.
8. Click OK.

CONFIGURING JOBS
Use jobs in a schedule to differentiate the Non ACD tasks that employees perform. You create jobs
for a specific shift. If the job requires a specific set of skills, you can associate skills to jobs. After
you associate skills to jobs, you can compare the skill (and skill level) of the employees to the skill
required to perform a job. This will ensure the employees you schedule have the appropriate skills for
their assigned jobs.

You configure the following job options using the Schedule tool:

l Add fixed jobs
l Add variable jobs
l Rename jobs
l Delete jobs

Adding fixed jobs
To add a job for a fixed shift

1. Click theConfiguration tab.
2. In theSchedules group, click Schedule.
3. In the left pane, click Jobs.
4. In the right pane, click the Fixed Jobs tab.
5. Click Add.
6. AfterName, type the name of the job.
7. Click Create.
8. If the job involves work on ACD calls, ensure the check box under Is ACD is selected.
9. Under Time into Shift, type the time from the beginning of the shift at which the jobmust

start
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10. UnderDuration, type the duration of the job.
11. UnderColor, select a color for the job.
12. Click OK.

Adding variable jobs
To add a job for a variable shift

1. Click theConfiguration tab.
2. In theSchedules group, click Schedule.
3. In the left pane, click Jobs.
4. In the right pane, click theVariable Jobs tab.
5. Click Add.
6. AfterName, type the name of the job.
7. Click Create.
8. If the job involves work on ACD calls, ensure the check box under Is ACD is selected.
9. UnderColor, select a color for the job.
10. Click OK.

Renaming jobs
You can rename a job without losing any information associated with the job.

To rename a job

1. Click theConfiguration tab.
2. In theSchedules group, click Schedule.
3. In the left pane, click Jobs.
4. If you want to rename a fixed job, click the Fixed Jobs. Otherwise, to rename a variable job,

click theVariable Jobs tab.
5. UnderName, click the name of the job to rename.
6. Type a new name for the job.
7. Click OK.

Deleting jobs
CAUTION: Deleting a job deletes all of the instances of the job, including where it is inserted in
schedules.

To delete a job

1. Click theConfiguration tab.
2. In theSchedules group, click Schedule.
3. In the left pane, click Jobs.
4. If you want to delete a fixed job, click the Fixed Jobs. Otherwise, to delete a variable job,

click theVariable Jobs tab.
5. UnderName, select the name of the job to delete.
6. Click Delete.
7. Click Yes.
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Adding breaks or jobs to shifts
To add a break or a job to a shift

1. Click theConfiguration tab.
2. In theSchedules group, click Schedule.
3. Click Assignments.
4. In the right pane, click theBreaks and Jobs tab.
5. UnderShifts, select the shift for which you will add shifts to.
6. UnderBreaks, select the break to add to a shift.
7. Click > to assign the break to the shift.
8. Under Jobs, select the job to add to a shift.
9. Click > to assign the job to the shift.
10. Click OK.

Removing breaks and jobs from shifts
To remove a break or a job from a shift

1. Click theConfiguration tab.
2. In theSchedules group, click Schedule.
3. Click Assignments.
4. In the right pane, click theBreaks and Jobs tab.
5. UnderShifts, select the shift for which you will remove breaks/jobs from.
6. UnderBreaks, select the break to remove from the shift.
7. Click < to remove the break from the shift.
8. Under Jobs, select the job to remove from the shift.
9. Click < to remove the job from the shift.
10. Repeat steps 5-9 to remove additional breaks and/or jobs from shifts.
11. Click OK.

ASSIGNING SHIFTSTO SCHEDULES
NOTE:Schedule Builder uses the shifts you assign, combined with the employees’ availability and
shift assignment, to schedule shifts (or variations of them).

To assign shifts to schedules

1. Click theConfiguration tab.
2. In theSchedules group, click Schedule.
3. In the left pane, click Assignments.
4. In the right pane, click theShifts tab.
5. UnderSchedules, select the schedule to which you will add shifts.
6. Under Fixed Shifts, select the fixed shift to add to the schedule.
7. Click > to assign the shift to the schedule.
8. UnderVariable Shifts, select the variable shift to add to the schedule.
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9. Click > to assign the shift to the schedule.
10. Repeat steps 6-9 for each shift you want to add to a schedule.
11. Click OK.

ASSIGNING SHIFTSTO EMPLOYEES
To assign a shift to an employee

1. Click theConfiguration tab.
2. In theSchedules group, click Configure employees.
3. In the left pane, underSchedules, select the schedule containing the employee(s) to which

you will assign shifts.
4. UnderEmployees, select the employee to which you will add shifts.
5. UnderShift Assignment, select the check boxes of the shifts that will be available to this

employee.
6. Repeat steps 4-6 for each employee to which you will assign shifts.
7. Click OK.

CONFIGURING EVENTDISPLAYPREFERENCES
Tomake events easy to identify at a glance, you can specify how you want to display the scheduled
events.

You can specify the following event display preferences:

l Time bar content display—provides descriptions, notes, or icons for scheduled events in
the time bar pane

l Smallest scheduling interval—the smallest increment with which you insert events into the
time bar pane

l Default shift color—the color for all of the shifts in the time bar pane. To override the default
shift color, see "Configuring shifts" on page 298.

l Default break color—the color for all of the breaks in the time bar pane. To override the
default break color, see "Renaming breaks" on page 301.

l Default job color—the color for all of the jobs in the time bar pane. To override the default job
color, see "Configuring jobs" on page 302.

l Default time off color—the color for all of the time off types in the time bar pane. Your
System Administrator is responsible for setting and changing the default time-off color.

l Unavailable color—the color for unavailable periods in the time bar pane
l Tool tip display—provides event information in tool tips on the time bar pane. The tool tip
appears as a series of brackets depending on the information criteria you select

l Time display—the time format of the time bar pane. For example, 3 o’clock in the afternoon
appears as 3 P.M. if you select 12 Hours, or 15 if you select 24 Hours
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Configuring the time bar display
You can select from the following three time bar display options:

l Icon—refers to the icons of the scheduled shifts, time off events, and unavailable periods in
the time bar pane

l Type name—refers to the names of the scheduled jobs in the time bar pane
l Type notes—refers to the notes of the scheduled jobs in the time bar pane

To specify how events display in the time bar

1. On the applicationmenu, click Preferences.
2. Click theDisplay tab.
3. Under Time bar content, select the time bar content to display for Shifts, Jobs, Breaks, Time

off, and Unavailable periods.
4. Click OK to save and close the Preferences window.

Configuring the smallest scheduling time interval
By default, events are snapped to the time bar grid in 30minute increments. However, you can
adjust the snap-to-grid interval to 5, 15, 30, or 60minutes. Set the smallest scheduling time interval
to theminimum number of minutes you want to insert events into a schedule. For example, if you
select 15minutes as the smallest scheduling interval, you cannot insert events for an employee in
increments smaller than 15minutes.

The default scheduling interval is 15minutes, which we recommend, as changing this to a smaller
interval will increase the amount of time it takes for Schedule Builder to build schedules.

To configure the smallest scheduling time interval

1. On the applicationmenu, click Preferences.
2. Click theGeneral tab.
3. UnderScheduling preferences, afterSmallest scheduling interval, select the snap-to-grid

time interval.
4. If you want to prevent the user frommanually making any change that would trigger a warning,

select theWarnings are hard limits for the user check box.
5. Click OK to save and close the Preferences window.

Preventing users from manually making changes that trigger warnings
You can configureWorkforce Scheduling to prevent users frommaking changes that trigger
warnings.

To prevent users frommanually making changes that trigger warnings

1. On the applicationmenu, click Preferences.
2. Click theGeneral tab.
3. Select theWarnings are hard limits for the user check box.
4. Click OK to save and close the Preferences window.



MiContact Center Business—MiVoice Business User Guide

307

Configuring the default colors on the time bar
To configure the default colors used for events on the time bar

1. On the applicationmenu, click Preferences.
2. Click theDisplay tab.
3. UnderDefault Timebar Colors, afterDefault Shift Color, select a color.
4. Repeat step 3 forDefault Break Color, Default Job Color, Default Time Off Color, and

Unavailable Color.
5. Click OK to save and close Preferences window.

Configuring the time format
There are two time formats you can select from: the 24 hour international format or the 12 hour format
which uses A.M. and P.M. to indicatemorning and afternoon. For example, 3 o’clock in the afternoon
appears as 15 if you select the 24 hour time format or 3 P.M. if you select the 12 hour time format.

To configure the time format

1. On the applicationmenu, click Preferences.
2. Click theGeneral tab.
3. AfterHour Format, select either 12 Hours or 24 Hours.
4. Click OK.

Configuring tool tip display
You can specify the following information in tool tips for shifts, jobs, breaks, time off events,
unavailable periods, and shadow events:

l Schedule name—provides the name of the schedule in which the event appears.
l Is recurring—displays if the event recurs.
l Type—provides the name of the event.
l Type name—states if the event is a shift, job, break, time off event, unavailable period, or
shadow event.

l Start/End Time—provides the start and end time of the event.
l Event Notes—provides any notes from the detail grid for the event.

To configure the tool tip display

1. On the applicationmenu, click Preferences.
2. Click theDisplay tab.
3. Under Tooltip Display, select the check boxes for the tool tips to display.
4. Click OK.
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CONFIGURINGWARNINGS
Warnings notify you when you try to schedule events outside of your scheduling parameters.

You can set the following warnings:

l Schedule warnings
l Shift warnings
l Break warnings
l Job warnings
l Overtime warnings
l TimeOff warnings
l Employee scheduling warnings
l Schedule Builder warnings
l Employee selection warnings

To configure warnings

1. On the applicationmenu, click Preferences.
2. Click theWarnings tab.
3. Ensure the check boxes of the warnings you want to configure are selected.

See Table 22.
4. Click OK.

WARNING DESCRIPTION

Scheduling work on company
holidays

notifies you when events are scheduled on company
holidays

Scheduling work outside business
hours

notifies you when you try to schedule events outside of your
contact center’s business hours

When scheduling outside
employee's availability

notifies you when you try to schedule employees who are not
available at the specified time

Violates Length of Service
Qualifications

notifies you when an employee has worked fewer or more
months required to qualify for a specific type of time off

Exceeds accrued hours notifies you when an employee is scheduled for more time
off hours than is available to that employee at that time

Exceeds Maximum Scheduling
Limit

notifies you when an employee is scheduled for more time
off hours than specified for that type of time off

Less thanMinimum Scheduling
Limit

notifies you when an employee is scheduled for fewer time
off hours than specified for that type of time off

Table 22: Warnings



MiContact Center Business—MiVoice Business User Guide

309

WARNING DESCRIPTION

Employee does not have required
skills

notifies you when an employee does not have the required
skills for the job for which they are scheduled

Exceeds Daily MaximumWork
Hours

notifies you when an employee is scheduled for more hours
in a day than defined by the parameter for that shift

Below Daily MinimumWork Hours notifies you when an employee is scheduled for fewer hours
in a day than defined by the parameter for that shift

Exceeds Weekly MaximumWork
Hours

notifies you when an employee is scheduled for more hours
in a week than defined by the parameter for that shift

Below Weekly MinimumWork
Hours

notifies you when an employee is scheduled for fewer hours
in a week than defined by the parameter for that shift

Exceeds Yearly MaximumWork
Hours

notifies when an employee is scheduled for more than the
annual maximum hours required

Below Yearly MinimumWork
Hours

notifies you when an employee is scheduled for less than the
annual minimum hours required

Start time outside of specified
range

notifies you when an employee’s shift is scheduled to start
before (minimum) or after (maximum) the parameters defined
for that shift

Within Minimum Time Between
Shifts

notifies you when an employee is scheduled to start another
shift too soon following the one previously completed

Below hours worked to qualify
notifies you when an employee is scheduled for a break
before working enough hours after the last break in that shift
to qualify for another break

Starting before earliest start time notifies you when an employee is scheduled for the first
break in a shift before a break can be taken

Ending after latest end time notifies you when an employee is scheduled for the last
break in a shift after a break can be taken

Removing an employee from a
schedule

notifies you when you attempt to delete an employee from
the schedule

Accepting a generated schedule notifies you when you attempt to save a schedule you have
built

Scheduled shift will cause
overtime notifies you when a shift qualifies an employee for overtime

Table 22: Warnings (continued)
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FORECASTING DATA FORSCHEDULES
After setting up and customizing your schedule, if you are building a schedule from forecasted data,
youmust run the Forecasting tool and export the forecast into your schedule before you can select
this option in the schedule builder or schedule builder wizard.

For information on the Forecasting tool, see "Forecasting tool" on page 135.

To access the Forecasting tool

1. Click Tools in theWorkforce Scheduling ribbon.
2. In theData Mining section, click Forecasting.

SCHEDULE CREATION
You can create and customize schedules inWorkforce Scheduling using specific parameters that
suit the needs of your contact center. You can build schedules manually or with the Schedule Builder
tool. Schedule Builder automates the schedule building process. It uses pre-defined employee and
schedule options to create schedules. See "Schedule setup and customization" on page 294.

Schedule Builder helps you build a schedule with or without forecast data. If you are building a
schedule with forecast data, youmust export the forecast data into your schedule before running the
Schedule Builder if you want to build a schedule with forecast data. See "Forecasting data for
schedules" on page 310.

You can also usemanual scheduling tomodify schedules you build with Schedule Builder. See
"Creating and adjusting schedules manually" on page 315.

NOTE:After you generate a schedule with Schedule Builder, youmust accept or reject schedule
changes before you can generate another schedule.

Schedule Builder uses the following parameters to create a schedule automatically:

l Date/time range
l Shifts
l Breaks
l Forecast data
l Business hours
l Employees
l Employee scheduling preferences
l Scheduling options
l Shift options
l Schedule algorithm options
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BUILDING SCHEDULESWITHSCHEDULEBUILDER
NOTE:After you generate a schedule with Schedule Builder, youmust accept or reject schedule
changes before you can generate another schedule.

To build a schedule with Schedule Builder

1. Click the Tools tab
2. In the Schedule Builder group, click Manual.
3. UnderSchedule name, select a schedule.
4. Specify the scheduling parameters on each tab of the Schedule Builder tool.
5. Click Build.

A dialog box appears reminding you that changes to the schedule will not be committed to the
database until you click Accept Schedule.

6. Click OK.
The Accept Schedule and Reject Schedule buttons appear in the toolbar.

7. Verify the schedule.
8. Make any requiredmodifications manually.
9. Click Accept schedule to save the new schedule.

NOTE:
l After you click Accept Schedule, the schedule is live in the database and the Accept
Schedule button disappears. If you click Reject Schedule, the automatically generated
schedule and any manual modifications are deleted from the schedule. See "Creating
and adjusting schedules manually" on page 315.

l If there are any conflicts, a dialog box appears stating the number of conflicts. You
cannot save a schedule with conflicts. Click Yes to delete the conflicts and accept the
schedule, or click No to adjust the schedule. When you have resolved the conflicts,
click Accept Schedule again to save the schedule.

Configuring the date and time range
To configure the date and time range for a schedule using Schedule Builder

1. InSchedule Builder, click theGeneral tab.
2. UnderDates and times, on theDate / Time tab, select the date range of the schedule.
3. Under Time, select eitherUse business hours, 24/7, orCustom.
4. If you selectedCustom in the previous step, select the time the schedule starts and ends

each day.
5. If you want to exclude dates from the schedule, click theExclusion tab.
6. Hold downCTRL and then click the dates to exclude.

Scheduling shifts
To schedule shifts using Schedule Builder

1. InSchedule Builder, click theGeneral tab.
2. UnderSchedule/Optimize, select theShifts check box.
3. UnderEvent selection, on theShift selection tab, select the check boxes of the shifts to

add to the schedule.
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4. Click theShift, Break, & Job options tab.
5. UnderShift options, specify how shifts will be distributed.

l If you want to count existing shifts when determining the number of employees to be
scheduled, select the The Schedule Builder counts existing shifts when
determining the number of employees which must be scheduled check box.

l If you want to optimize existing unlocked shifts, select theAllow Schedule Builder to
optimize existing unlocked shifts check box.

l If you want to optimize existing locked shifts, select theAllow Schedule Builder to
optimize existing locked shifts check box.

l If you want to schedule unassigned shifts for times when there are not enough
employees available to satisfy the scheduling requirements, select theGenerate
unassigned shifts when not enough employees are available to satisfy the
schedule requirements check box.

l If you want to ignore employee shifts assignments when building the schedule, select
the Ignore employee shift assignments check box.

Scheduling breaks
To schedule breaks using Schedule Builder

1. InSchedule Builder, click theGeneral tab.
2. UnderSchedule/Optimize, select theBreaks check box.
3. UnderEvent selection, on theBreak selection tab, select the check boxes of the break

types to add to the schedule.
4. Click theShift, Break, & Job options tab.
5. UnderSchedule/Optimize breaks, select the check boxes of the shift types to apply breaks.

Scheduling jobs
To schedule jobs using Schedule Builder

1. InSchedule Builder, click theGeneral tab.
2. UnderSchedule/Optimize, select the Fixed Jobs check box.
3. UnderEvent selection, on the Fixed Job selection tab, select the check boxes of the job

types to add to the schedule.
4. Click theShift, Break, & Job options tab.
5. UnderSchedule fixed jobs on, select the check boxes of the job types to apply shifts.
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Generating schedules with forecast data
To build a schedule with forecast data using Schedule Builder

1. InSchedule Builder, click theGeneral tab.
2. UnderSchedule Builder method, afterMethod, select Forecasted data.
3. If you want fewer employees scheduled than are forecasted, move the slider towards

Underschedule.
4. If you want more employees scheduled than are forecasted, move the slider towards

Overschedule.
5. If you want to adjust the number of forecasted employees, next to Increase/decrease the

number of forecasted employees by, enter a number.

Generating schedules without forecast data
To build a schedule without forecast data using Schedule Builder

1. InSchedule Builder, click theGeneral tab.
2. UnderSchedule Builder method, afterMethod, select Explicit requirements.
3. AfterNumber of employees to schedule, enter a number.
4. If you want fewer employees scheduled than are forecasted, move the slider towards

Underschedule.
5. If you want more employees scheduled than are forecasted, move the slider towards

Overschedule.

Generating schedules for your entire workforce
To build a schedule for your entire workforce using Schedule Builder, regardless of employee
availability

1. InSchedule Builder, click theGeneral tab.
2. UnderSchedule Builder method, afterMethod, select Entire workforce.
3. If you want to enable employee filtering, select theEnable employee filtering check box.

Selecting employees
To select the employees you want to schedule using Schedule Builder

1. InSchedule Builder, click theEmployee filtering tab.
2. If you want to filter employees by agent group, underAgent group, select the check boxes of

the agent groups to schedule.
3. If you want to filter employees by their skills, underSkill, select the check boxes of the

required skills. Otherwise, skip to step 6.
4. Under the list of available skills, select an operand.

l If the employees must have a skill level greater or equal to the skill level required, select
>=.

l If the employees must have a skill level lower or equal to the skill level required, select
<=.

l If the employees must have a skill level exactly equal to the skill level required, select
=.
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5. If you want to filter employees by name, underSelect employees with this name, type an
employee’s name.

6. If you want to select specific employees, underSelected employees, select the check boxes
of the employees to schedule.

7. Click theEmployee sorting tab.
NOTE:Youmust configure the employee payroll information in order to select the seniority
and pay rate parameters.

8. If you want to prioritize how shifts are distributed to employees, select theUse employee
sorting check box, and select the criteria with which to sort employees.

9. If you want to assign or edit employee priority numbers, underEmployee priority, select an
employee.

10. UnderPriority, type a personal priority number.
11. Click theOverrides tab.
12. If you want to override employee work hour preferences, underWork hours, select the check

boxes to override daily work hours, weekly work hours, and theminimum time between shifts.
13. If you want to override employee availability, underAvailability, select the check boxes to

override employee availability and unavailable events currently applied to the schedule.
14. If you want to override scheduled time off, under Time off, select theOverride time off

events currently applied to the schedule check box.
15. If you want to override an employee's skills required to do the fixed job, under Fixed Jobs,

select theOverride an employee's skills required to do the fixed job.

Configuring scheduling options
To configure schedule options Schedule Builder uses to create a schedule

1. InSchedule Builder, click theAdvanced options tab.
2. UnderSchedule algorithm performance, specify the settings Schedule Builder will use to

build the schedule.
3. If you want to optimize break distribution, underOptimization types, select theOptimize

break distribution check box.
4. If you want to optimize shift placement, select theOptimize shift placement check box.
5. If you want to optimize shift size, select theOptimize shift size check box.
6. If you want to balance the distribution of employee shifts over the week, select theBalance

over the week check box.
Selecting this option ensures that Schedule Builder does not completely fill the requirements
of the first few days of the schedule and understaff employee requirements by the end of the
week.
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CREATING ANDADJUSTING SCHEDULESMANUALLY
You can create entire schedules manually. However, if youmust schedule a large number of
employees it can be quite complicated and time consuming. Schedule Builder automates the
process and builds schedules for you. You canmanually adjust schedules created with Schedule
Builder. You can create and adjust schedules manually in the following ways:

l Load a schedule
l Populate a schedule with events
l Drop insert an event
l Drag insert an event
l Recur an event
l Mass recur an event
l Mass delete an event
l Mass apply time off
l Modify a forecast total
l Modify event times or notes

Loading schedules
NOTE: Your access rights determine which schedules you can view, modify, or manage.

To load a schedule

1. Click File=>Load schedules.
2. Select the schedule(s) to load.
3. If you want to load all active schedules, select theSelect all active schedules check box.
4. Click Load.

Populating schedules with events
NOTE:

l Your access rights determine which schedules you can view, modify, or manage.
l For ease of use and accuracy when inserting events, select a schedule view of less than 1
week (View=>Schedule View) prior to insertion.

You canmanually insert the following events into a schedule:

l Shifts
l Breaks
l Jobs
l Time off
l Unavailable periods
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You can insert events in a schedule by either dropping or dragging them on an employee’s time line
on the time bar pane. You can optionally drop insert breaks or jobs into already existing fixed shifts.
Drop inserting events is most useful for fixed events, as the duration of the shift is predefined. Drag
inserting events is most useful for variable shifts, as the duration can vary depending on the defined
parameters for a specific event.

NOTE: To accommodate for last minute scheduling changes, you can optionally schedule time off
and unavailable events in themiddle of scheduled shifts or schedule a shift in themiddle of time off
and unavailable events.

Drop inserting events
To drop insert an event

1. Click the Insert tab.
2. Click Drop.
3. UnderEvent, select the event to add to the schedule.
4. UnderSchedule, select the schedule to add events to.
5. UnderEvent name, select the name of the event to add to the schedule.
6. On the time bar pane, click the employee’s time line to insert the event.

The event is added to the schedule.
7. Repeat steps 3-6 for every event to add to the schedule.

Drag inserting events
NOTE: Drag insert is not available in the 1month schedule view.

To drag insert an event

1. Click the Insert tab.
2. Click Drag.
3. UnderEvent, select the event to add to the schedule.
4. UnderSchedule, select the schedule to add events to.
5. UnderEvent name, select the name of the event to add to the schedule.
6. On the time bar pane, click the employee’s time line and drag the cursor from the start time to

the end of the event.
7. Repeat steps 3-6 for every event to add to the schedule.

Recurring events
You can recur shifts, time off, and unavailable events.

Tomake an event recur

1. On the time bar pane, on the employee’s time line, right-click the event to recur.
2. Click Recurring.
3. Click Daily,Weekly, orMonthly recurring.
4. Specify the pattern and range of the recurrence.
5. Click OK.
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Mass recurring events
You can use theMass recurrence wizard to createmultiple recurrences for several events
automatically. The wizard allows you tomass recur shifts, time off, and unavailable periods based
on either a daily or weekly template.

NOTE:Manual or mass deletion is required to remove the generated events.

Tomass recur events

1. Click the Tools tab.
2. In theBulk operations group, click Recurrence.

TheMass Recurrence wizard opens.
3. Click Next.
4. Follow the steps in the wizard to specify the parameters of the events to mass recur.
5. Click Finish.
6. Click Yes.

Mass deleting events
You can delete one or more scheduled events (shifts, time off periods, unavailable periods, breaks,
and jobs) at a time with theMass delete option. Only the selected events are deleted from the
schedules.

Tomass delete scheduled events

1. Click the Tools tab.
2. In theBulk operations group, click Delete.
3. Specify the date range affected, event types to delete, and the schedules to delete events

from.
4. Click OK.

Mass applying time off
You can apply time off to any or all agents in a schedule simultaneously.

Tomass apply time off

1. Click the Tools tab.
2. In theBulk Operations group, click Time Off.

The Timeoff Mass Insert dialog box opens.
3. Select a schedule from theSchedules drop-down list.
4. Hold downCTRL and then click the agents to which you want to apply the time off type. If you

want to select all agents, click Select All.
5. Under Time off, select the time off type from the list.
6. Select the start and end dates, days of the week, and start and end times for the time off type.
7. After selecting the time off time, selectMark remaining periods of the day as unavailable

if you want the hours outside of the start and end times to be unavailable for scheduling.
8. Click OK.
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Modifying forecast totals in the event totals pane
If you build schedules with forecast data, you can adjust the forecast totals on the event totals pane.
On the events totals pane, you can change forecast totals in time intervals as small as 15minutes.
The schedule view you select determines the time interval of the forecast totals. See "Changing the
time interval of the time bar pane" on page 320.

For example, if you select the 8 hour schedule view, you can change the forecast data in 15minute
intervals. However, if you select the 1 day schedule view, you can change the forecast data in 1 hour
time intervals. When you change the forecast data in an interval larger than 15minutes and then
change the view to smaller intervals, you will notice that the change applies to each of the smaller
intervals.

NOTE:Schedule Builder uses the latest forecast data to calculate the number of employees
required.

To change the forecast totals in the events totals pane

1. After Totals, click +.
2. Select the Forecast check box and the check boxes of any other event totals to view.
3. Click -.
4. Click theView tab.
5. UnderSchedule view, select a time interval.

See Table 23.
6. Click the + before Forecasted to expand the forecast tree.

The event totals for the loaded schedules appear.
NOTE:You can use the Tab key to select cells to the right, and the Shift+Tab keys to select
cells to the left.

7. Click a cell in the forecast event total grid and type the new forecast total for this time interval.

Modifying event times and notes in the schedule details pane
The changes youmake to event start times and end times in the schedule details pane are
immediately reflected in the time bar pane.

Tomodify the start and end times of events in the schedule details pane

1. On the scheduleDetails pane, click theStart Time orEnd Time of an event.
2. Type the new time.

The new time is immediately reflected in the time bar pane.
3. Repeat for any other event times tomodify.

Tomodify the start and end times of events in the time bar pane

1. Click the Insert tab.
2. Click Select.
3. On the time bar pane, select the event to modify.
4. Drag and drop the event to adjust its start and end times.

The new time is immediately reflected in the time bar pane.
5. Repeat for any other event times tomodify.



MiContact Center Business—MiVoice Business User Guide

319

To add/edit a note for a scheduled employee

1. On the scheduleDetails pane, click the note field for an employee.
2. Click the ... button.

The Notes editor appears.
3. Type/edit a note.
4. Click OK.

SCHEDULE DISTRIBUTION
You can specify viewing preferences, specify access rights to schedules, and run and print reports.

VIEWING SCHEDULES
You can specify how you view the time bar pane. Use the scroll bar to view other days and times in
the schedule. If you reach the end of themonth and want to view dates for the next month, you can
click the arrow on the scroll bar to load the schedule for the next month. By default, events you insert
into a schedule are snapped to the grid in 30minute increments.

To view a specific date

1. From any tab inWorkforce Scheduling, click Select date.
2. Click the date to view.

The time bar will display the date you selected to view.

Viewing scheduled events
You select how event time bars appear in File=>Preferences. You can isolate shifts, time off, and
unavailability to view them separately in the time bar pane. Youmust view breaks and jobs with
shifts. You cannot isolate breaks and jobs in the time bar pane. See "Configuring event display
preferences" on page 305. You can select what information displays in the Tooltip in Preferences.
For more information, see "Configuring tool tip display" on page 307.

If employees belong tomore than one schedule and you are viewing only one of the schedules to
which the employees belong, any events scheduled in the other schedule will appear as a shadow
event (gray bar) in the time bar view. Shadow events will not display for inactive schedules.

To view shifts

l On theView tab, in theShow/Hide group, select theShift check box.

To view jobs

l On theView tab, in theShow/Hide group, select the Job check box.

To view breaks

l On theView tab, in theShow/Hide group, select theBreak check box.
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To view time off

l On theView tab, in theShow/Hide group, select the Time off check box.

To view unavailable periods

l On theView tab, in theShow/Hide group, select theUnavailable check box.

To view shadow events

l On theView tab, in theShow/Hide group, select theShadow check box.

Changing the time interval of the time bar pane
You can view schedules in the time bar pane over 8 hour, 12 hour, 1 day, 2 day, 1 week, 2 week, or 1
month time intervals. The default view is the 12 hour view.

To change the time interval in the time bar pane to one week

1. Click theView tab.
2. In theView options group, underSchedule view, select the interval to view.
3. Optionally, underGroup view, select Supervisor to group employees in the time bar pane by

schedule.

Viewing event totals
Event totals represent the total number of employees for an event. You can view event totals in 15
minute, 30minute, 1 hour, 4 hour, or 1 day time intervals. Table 23 displays the event total time
intervals that correspond to the schedule views.

SCHEDULE VIEW EVENT TOTALS TIME INTERVAL

8 hour 15minute

12 hour 30minute

1 day 1 hour

2 day 4 hour

1 week 1 day

2 week 1 day

1month 1 day

Table 23: Schedule views and corresponding event total
time intervals
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You can select from the following event totals:

Forecast—appears only after you have applied a forecast to a schedule. This total represents the
number of employees required tomeet your specified Service Level objectives.

Scheduled—represents the number of employees scheduled at that time

Over/Under—represents the excess (over) or inadequate (under) number of employees scheduled
when compared to the number of employees forecasted.

On Break—represents the number of employees scheduled for a break at a certain time

ACD Jobs—represents the number of employees scheduled to perform ACD jobs

Non ACD Jobs—represents the number of employees scheduled to perform Non ACD jobs

At work—represents the number of employees scheduled to handle interaction requests

Overtime—represents the number of employees scheduled for overtime

To view event totals

1. In the Totals pane, click +.
2. Select the check boxes of the event totals to view.
3. Click -.

The totals pane appears with the event totals you selected.

Viewing schedule details
To group information in the schedule details pane

l On the schedule details pane, drag and drop the column header to organize to theDrag a
column header here to group by that column area on the window.

To sort information in the schedule details pane alphabetically

l On the schedule details pane, click the header of the column to sort alphabetically.

To filter information in the schedule details pane

1. On the schedule details pane, click the arrow on a column header.
2. Select the filter criteria.

Synchronizing views
You can synchronize the people pane, time bar pane, and totals pane with the order of the
information in the schedule details pane. Once you have organized the details of your schedules
(sorting, filtering, and grouping) in the schedule details pane, synchronize views to reflect the order
you have selected. For information on how to sort, filter, or group schedule details, see "Viewing
schedule details" on page 321.

To synchronize views

1. Click theView tab.
2. Select theSynchronize time bar view with details view check box.
3. Optionally, select theVertical scrolling check box.
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RUNNINGWORKFORCESCHEDULING REPORTS
TheWorkforce Scheduling reports are produced inMicrosoft Excel format. You run and print the
followingWorkforce Scheduling reports from CCMWeb. For more information, see the Reports
Guide appropriate to your MiContact Center Business licensing level.

You can produce on-demand reports and scheduled reports for the following reports:

l Detailed Schedule by Employee with Totals
l Schedule by Employee by TimeOff by Day of Week
l Employee Configuration
l Summary Schedule by Employee
l Schedule Coverage Totals by Type
l Work Hours Summary Schedule by Employee

Workforce Scheduling reports are found in CCMWeb, underReporter=>Workforce
Scheduling=>Schedules.

SCHEDULE ADHERENCE
Mitel Schedule Adherence is an optional application that works in conjunction with MiContact Center
Business andWorkforce Scheduling. Schedule Adherence resides in the Contact Center Client real-
timemonitors and enables you to view the real-time state of contact center employees scheduled in
Workforce Scheduling. Schedule Adherence compares the current activities of employees to the
configured schedule and alerts you in real time when employees are out of adherence. Employees
are considered out of adherence if they are early or late for their scheduled events or if they are not
performing scheduled events.

Once you have configured a schedule inWorkforce Scheduling, you

l Configure adherence preferences inWorkforce Scheduling
l View adherencemonitors in Contact Center Client
l Set adherence alarms on the Employee State by Position/Timemonitors (optional)
l Run reports on employee adherence to scheduled events

CONFIGURING ADHERENCEPREFERENCE
You can configure adherence thresholds for shifts, breaks, and jobs. You can set parameters for
each event type to suit the needs of your business. You select employee states and assign them to
relevant events and specify event time tolerance levels. You can optionally configure groups of
employee states and then associate them to relevant employee events.

NOTE:

l Schedule Adherence will handle two or more overlapping adherence thresholds in one of the
following ways. If only one of the events is valid for the current employee state, that event will
be used. If more than one event is valid for the current employee state, the first event, using
start time, will be used.

l If no states are specified for an event type, all states will be considered in adherence.
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Configuring adherence parameters
To configure adherence parameters

1. InWorkforce Scheduling, click theConfiguration tab.
2. In theAdherence group, click Adherence Configuration.

The Adherence Parameters window opens.
3. In the left pane, expand the event type list and select the event to which you want to add

relevant adherence states.
4. UnderEvent start tolerance (hh:mm), specify the times before and after which an employee

state will be reported on as out of adherence.
5. UnderEvent end tolerance (hh:mm), specify the times before and after which an employee

state will be reported on as out of adherence.
6. UnderAvailable states, select the states which are relevant for the specified event type and

click > to move the state to theAssigned states list.
7. Repeat the above steps for each event type for which you want to configure adherence

parameters.
8. Click OK.

Configuring state groups
To configure a state group

1. InWorkforce Scheduling, click theConfiguration tab.
2. In theAdherence group, click State groups.

The State groups window opens.
3. Click Add.
4. Type a name for the state group and click Create.
5. UnderAvailable states, select the states that are relevant for the state group and click > to

move the state to theAssigned states list.
6. Repeat steps 2-5 for each state group you want to configure.
7. Click OK.

VIEWING ADHERENCEMONITORS INCONTACTCENTER
CLIENT
Schedule Adherence includes two Contact Center Client monitors that enable you tomonitor
employee adherence to schedules in real time. The Schedule Adherencemonitors alarm on
employees who are not adhering to schedules based on the thresholds you specify inWorkforce
Scheduling and the alarms you configure in Contact Center Client. You can optionally set adherence
alarms on the Employee State by Position/Timemonitors.
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Adherence Detail Grid monitor
The Adherence Detail Grid monitor displays employee scheduled events, expected states, and
event totals. It enables you to easily compare expected employee states and actual employee
states in real time.

There are three levels to the Adherence Detail Grid monitor. The first level provides a high level
overview of employee adherence. The second level has two grids. The first lists all of the embedded
events (breaks and jobs) for the shift and the associated adherence information. The second grid
lists the out of adherence record for the shift. The final level has only one grid, which represents the
out of adherence record for the embedded events.

Table 24 provides column heading definitions for the Adherence Detail Grid monitor.
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HEADING DEFINITION

Employee the name of the employee beingmonitored

Is in Adherence the check box is enabled when the employee is adhering to the
schedule

Scheduled the type of event (shift, break, or job) the employee is performing,
whether in or out of adherence

Expected States the employee states that are relevant for the type of scheduled
event the employee is scheduled to perform

Actual State the current employee state. If this is one of the expected states, the
employee is adhering to the schedule

Scheduled Start the time at which the employee is scheduled to start the scheduled
event

Actual Start
the time at which the employee started the scheduled event. This
columnmay be blank if the employee has not come into adherence
for the scheduled event

Scheduled End the time at which the scheduled event is to end

Current Out Of Adherence
the amount of time the employee has been out of adherence since
the last scheduled event, minus any tolerances configured. This
columnwill be blank if the employee is adhering to the schedule

Total Out Of Adherence the total amount of time the employee has been out of adherence for
all scheduled events for the current shift

Shift Time the duration of time the employee has been working the current shift

% Out Of Adherence the percent of time the employee has been out of adherence for the
elapsed portion of the scheduled shift

Shift the name of the shift for which the employee is scheduled

Embedded the name of the embedded event type (break or job)

Start the time at which the employee went out of adherence

End the time at which the employee came back into adherence

Table 24: Adherence Detail Grid monitor headings

You can set alarms on the AdherenceGrid monitor to alarm on employee adherence. For example, in
an adherence grid monitor, you could set an alarm on the Scheduled variable and set the value to
Unscheduled and have it display as red text, enabling you to clearly see when an employee is not
adhering to the shift as expected.
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You can alarm on the following performance variables in the adherence detail grid monitor:

l Out of adherence
l Scheduled
NOTE: To alarm for when the employee is in Time off or Unavailable states, set the value to
Unscheduled.

l Expected states
l Actual state
l Actual start
l Current Out of Adherence
l Total Out of adherence
l Shift time
l %Out of adherence

To open the Adherence Detail Grid monitor

1. Click theReal Time tab in the Contact Center Client ribbon.
2. From the drop-down arrow in theAdherence column, select Detail Grid.

The Add/Remove device IDs window opens.
3. Select theEmployees orSchedules for which you want to review Adherence.
4. Click OK.

The Adherence Details monitor opens.
See Figure 77.

Figure 77: Adherence Detail Grid monitor

To alarm on schedule adherence in an Adherence Detail Grid monitor

1. Right-click anywhere in themonitor and click Set alarms.
2. UnderPerformance variables, select the variable you want to monitor.
3. UnderAlarm thresholds, click Add and select a value for that variable you selected as well

as the alarm notification options that will indicate when the variable exceeds those
boundaries.
For more information on configuringmonitor alarms, see "Setting alarms" on page 111.

4. If you want to add further alarms for the variable, repeat step 3.
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5. If you want to add an alarm for another variable, repeat steps 2-5.
6. Click OK to save the alarms.

Adherence Timebarsmonitor
The Adherence Timebars monitor provides a schedule time bar, based on the employee time bar and
event colors configured inWorkforce Scheduling, for each employee's scheduled events. The
current time is identified by a green line on the employee time bar and past events are shaded purple.

You can set alarms on the AdherenceGrid monitor to alarm on employee adherence. The following
performance variables can be alarmed on in the adherence timebars monitor:

l Shift out of adherence
l Break out of adherence
l Job out of adherence

To open the Adherence Timebar monitor

1. Click theReal Time tab in the Contact Center Client ribbon.
2. From the drop-down arrow in theAdherence column, select Timebars.

The Add/Remove device IDs window opens.
3. UnderSchedules, select a schedule to include in themonitor or underEmployees, select the

employees tomonitor.
4. Click OK.

The Adherence Timebars monitor opens.
See Figure 78.

Figure 78: Adherence Timebars monitor

To alarm on schedule adherence in an Adherence Timebar monitor

1. Right-click anywhere in themonitor and click Set alarms.
2. UnderPerformance variables, select the variable you want to monitor.
3. UnderAlarm thresholds, click Add and select a value for that variable you selected as well

as the alarm notification options that will indicate when the variable exceeds those
boundaries.
For more information on configuringmonitor alarms, see "Setting alarms" on page 111.

4. If you want to add further alarms for the variable, repeat step 3.
5. If you want to add an alarm for another variable, repeat steps 2-5.
6. Click OK to save the alarms.
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Employee State by Position/Timemonitors
You can alarm on employees who are not adhering to schedules on the Employee State by
Position/Timemonitors using the Out of adherence performance variable. This variable measures
the duration of time an employee is out of adherence, enablingmore targeted alarming on the time
and degrees for which an employee is out of adherence.

To set an adherence alarm on the Employee State by Position/Timemonitors

1. Right-click an Employee State by Position/Timemonitor and click Set Alarms.
NOTE:You can select the Apply the alarm thresholds to all devices displayed on themonitor
option to apply the threshold settings for performance variables across all employees.
Alternatively, you can select Apply the alarm thresholds to a specific list of devices to apply
the threshold settings for performance variables to a list of employees.

2. If you selectedApply the alarm thresholds to a specific list of devices, underDevices,
select the employee(s) to which you want to apply the alarm thresholds.

3. UnderPerformance variables, select Out of adherence.
4. UnderAlarm threshold, click Add and specify the boundary for alarming and set the options

for the background color, font color, sound, pop-up, bring to front, and email.
5. To add an additional threshold for alarming, repeat step 4.
6. Click OK.

Alarming on schedule adherence
Supervisors can set alarms on adherencemonitors in Contact Center Client to alarm on employee
adherence by configuring an alarm in Contact Center Client using the Scheduled Performance
Variable set to a specific value (such as unscheduled).

For example, in an adherence grid monitor, you could set an alarm on the Scheduled variable and set
the value to Unscheduled and have it display as red, enabling you to clearly see when an employee
is not adhering to the shift as expected.

You can alarm on the following performance variables in the adherence detail grid monitor:

l Out of adherence
l Scheduled
l Expected states
l Actual state
l Actual start
l Current Out of Adherence
l Total out of adherence
l Shift time
l % out of adherence

You can alarm on the following performance variables in the adherence timebars monitor:

l Shift Out of adherence
l Break Out of adherence
l JobOut of adherence
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To alarm on schedule adherence

1. Right-click anywhere in themonitor and click Set alarms.
2. UnderPerformance variables, select the variable you want to monitor.]
3. UnderAlarm thresholds, click Add and select a value for that variable you selected as well

as the alarm type(s) that will indicate when the variable exceeds those boundaries.
4. Formore information on configuringmonitor alarms, see "Setting alarms" on page 111.
5. If you want to add further alarms for the variable, repeat step 3.
6. If you want to add an alarm for another variable, repeat steps 2-5.
7. Click OK to save the alarms.

RUNNING SCHEDULEADHERENCEREPORTS
The Schedule Adherence reports are produced inMicrosoft Excel format. You run and print the
following Schedule Adherence reports from CCMWeb. For more information, see the Reports Guide
appropriate to your MiContact Center Business licensing level.

You can produce on-demand reports and scheduled reports for the following reports:

l Employee and EmployeeGroup Adherence Trace
l EmployeeGroup TimeOut of Adherence by Employee by Day of Week
l EmployeeGroup TimeOut of Adherence by Day of Month
l EmployeeGroup Adherence by Period

Schedule Adherence reports are found in CCMWeb, underReporter=>Workforce
Scheduling=>Schedule Adherence.

EMPLOYEE PORTAL
Mitel Employee Portal enables employees to view and trade shifts online and request changes to
schedules for time off, shifts, and availability. Employee Portal enables schedulers to view
employee requests, perform what-if scenarios, quickly approve or deny requests, and automatically
update schedules.

Access to Employee Portal features is dependent on your administrative-set security roles.

EMPLOYEEPORTAL ANDEMPLOYEES
Using Employee Portal, employees can

l View their currently scheduled shifts and the shifts of other employees who share their
schedule

l View messages from supervisors and employees and receive updates about the status of
their requests on the home page

l Offer shifts to the bulletin board for other employees to take or trade
l Remove shifts from the bulletin board
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l Propose to take shifts from the bulletin board
l Propose to trade shifts from the bulletin board
l Accept or reject employee proposals to take or trade your shift
l Request time off
l Request changes to your availability

The Employee Portal home page provides links to the bulletin board, view and offer your scheduled
shifts for take or trade, view your pending offers, request time off, and request availability changes.
Any Employee Portal alerts that require your attention also display on the home page. These include

l You have approved shift requests
l You have denied shift requests
l You have shift requests pending supervisor approval
l You have shift proposals pending your acceptance
l You have shift proposals pending acceptance or that have been rejected
l You have time off requests pending supervisor approval
l You have notes regarding your availability

If a home page alert is red, it requires your attention. Click View to view the alert and any employee
or supervisor notes in detail.

Starting Employee Portal
To start Employee Portal

1. OpenEmployee Portal.
2. Type yourUsername andPassword.
3. Click Login.

Creating a desktop shortcut to Employee Portal
To create a desktop shortcut to Employee Portal

1. OpenEmployee Portal.
2. Type yourUsername andPassword.
3. Click Login.
4. Drag and drop the Employee Portal web address from the address bar to your computer

desktop.

Viewing currently scheduled shifts
To view your currently scheduled shifts

1. In Employee Portal, click My shifts.
2. If you want to view shifts starting on a specific calendar day, select the start date from the

calendar.
3. Optionally, to view the break and job details for a specific shift, underDetails, click Select.
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Viewing the shifts of other employees in your schedule
You can view the shifts for other employees in your schedule to help you determine potential shift
swaps.

To view the shifts of other employees in your schedule

1. Click My Schedules.
2. To view shifts starting on a specific day, select the start date from the calendar.
3. Click Select next to the employee for which you want to view the shift.

The break and job details for the shift display below.

Offering shifts for other employees to take or trade
You can offer shifts to the bulletin board for other employees to take or trade. You can remove shifts
from the bulletin board at any time as long as no employees have proposed to take or trade the shift.
Shifts that have already begun cannot be posted to the bulletin board for other employees to take or
trade.

To offer a shift for other employees to take or trade

1. Click Offer my shifts.
2. Next to the shift you want to offer for other employees to take or trade, click Select.

The shift details display.
3. Click Continue.
4. Optionally, type a note to accompany your offer.
5. Click Submit.

Removing shifts from the bulletin board
You can remove shifts from the bulletin board at any time as long as no employees have proposed to
take or trade the shift. If a proposal has beenmade, you will need to reject it first before you can
remove the shift from the bulletin board.

To remove a shift from the bulletin board

1. Click My pending offers.
2. Next to the shift you want to remove from the bulletin board, click Select.

The shift details display.
3. Click Continue.

The shift offer is removed from the bulletin board.

Proposing to take shifts
To propose to take a shift

1. Click Bulletin board.
2. Next to the shift you want to take, click Select.

The shift details display.
3. Click Continue.
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4. Click Next.
5. Optionally, add a note to accompany your proposal.
6. Click Next.
7. Click Submit.

Proposing to trade shifts
To propose to trade a shift

1. Click Bulletin board.
2. Next to the shift you want to take, click Select.

The shift details display.
3. Next to the shift you want to propose for trade, click Select.
4. Optionally, add a note to accompany your proposal.
5. Click Next.
6. Click Submit.

Accept or reject an employee proposal to take or trade your shift
To accept or reject an employee proposal to take or trade your shift

1. On the Employee Portal home page, next toYou have <#> shift proposals pending your
acceptance, click View.
The Proposals window displays.

2. Next to the proposal you want to view, click Select.
The proposal details display with any relevant employee notes.

3. Click Accept to accept the proposed shift change. Otherwise, click Reject to reject the
proposed shift change.

Requesting time off
To request time off

1. Click Request time off.
The Request time off window displays, including a list of any time off you have already
scheduled.

2. Click Request time off.
3. Select a time off type from the list.
4. Click Next.
5. Specify the time off start and end times.
6. Click Next.
7. Optionally, add a note to accompany the time off request.
8. Click Next.

The time off request summary displays.
9. Click Submit.
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Requesting availability changes
NOTE: You can click Clear request at any time to reset the Request availability change window to
your currently configured availability.

To request an availability change

1. Click Request availability change.
The Request availability change window displays with your current availability.

2. If you need to change existing availability, underUpdate current availability, select a day of
the week and click Remove. Otherwise, continue to step 3.

3. UnderChange availability, specify the dates and times you are available to work.
l AfterDay of week, specify the day of week you are available.
l If you are only available during certain hours, select Part of the day, and specify the
times at which you are available.

l If you are available to work at any time during the day, select Full day.
4. Click Add to add the new availability to the request.
5. You can optionally select a currently configured availability day or time in theUpdate current

availability list and click Remove to remove it from the list.
NOTE: The Add button is for adding new availability to the Update current availability list only
and not for replacing specific dates and times from the currently configured availability list.

6. Optionally, underEmployee note, add a note to accompany your request.
7. Click Accept.

The Confirm availability change window displays.
8. Specify the date that your requested availability will take effect.
9. Click Submit.

EMPLOYEEPORTAL ANDSUPERVISORS
Using Employee Portal, supervisors can

l View employee scheduling requests
l Preview the effect of approving or denying employee shift change requests
l Approve or deny employee proposals to take or trade shifts
l Approve or deny employee requests for time off
l Approve or deny employee requests for availability changes

Handling employee scheduling requests
NOTE: If you attempt to approve an employee's request for time off for a period where a schedule
has yet to be built, time off will not be decremented properly and the time off will be entered as an
unavailable event in the schedule.

To view, approve, or deny employee scheduling requests

1. OpenWorkforce Scheduling.
2. Log on toWorkforce Scheduling.
3. Load an active schedule.
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4. Click theEmployee Portal tab.
5. Click the Request mode icon.
6. In the details pane, click theShift changes, Time off, andAvailability tabs to view any

employee scheduling requests pending your approval.
7. Next toApprove, click the + to view the scheduling request details.
8. If you are viewing the Shift change tab, click View timebar to view the scheduled shift.
9. In the Employee requests group, click Preview to view the effect of approving the request.
10. In the Employee requests group,

l Click Approve to approve the request.
l Click Deny to deny the request.

The schedule is automatically updated and employees are notified of the schedule request
status.

RUNNING EMPLOYEEPORTALREPORTS
The Employee Portal reports are produced inMicrosoft Excel format. You run and print the following
Employee Portal reports from CCMWeb. For more information, see the Reports Guide appropriate to
your MiContact Center Business licensing level.

The following reports are available with Employee Portal:

l Employee Portal Availability Requests
l Employee Portal TimeOff Requests
l Employee Portal Shift Requests
l Employee Portal Shift Change Status

Employee Portal reports are found in the CCMWeb, under Reporter=>Workforce
Scheduling=>Employee Portal.
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POSTING FEEDBACKANDVIEWING OURFORUMS
Mitel has partnered with UserVoice, a third-party service, to host customer suggestions on
https://micontactcenter.uservoice.com. When you post an idea to our feedback forum, others will be
able to subscribe to it andmake comments.

Our forums enable you to send feedback directly to the people building the product. While we cannot
comment on every suggestion, feedback is analyzed and considered for future releases.

NOTE: Please do not use the forums to submit product defects. To submit product defects, please
contact your administrator or dealer.

Feedback can also be submitted directly to Mitel without posting the suggestion on the forums. For
more general feedback, you can also provide a rating of your experience with MiContact Center
Business.

NOTE:Please do not use feedback for requesting customer assistance. For assistance with
MiContact Center Business, please contact your dealer or Mitel Customer Support.

To post feedback and view our forums

1. In YourSite Explorer, click File=>Feedback.
2. Click Got an idea? Tell us.

OR
Access the following URL: https://micontactcenter.uservoice.com.

To submit feedback directly

1. In YourSite Explorer, click File=>Feedback.
2. Click Contact Us.

To rate your Mitel experience

1. In YourSite Explorer, click File=>Feedback.
2. Click Rate us.

https://micontactcenter.uservoice.com/
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TERMS AND DEFINITIONS
This section includes terms that may not be applicable to your software licensing level.

Abandoned call

An abandoned call is a call that the caller ends before the call is answered.

Account Code

Account Codes are classifiers that can be applied to call records and used to identify unique
attributes about the caller or call for individual departments, projects, or services to generate reports
on them. As well, they can be used by agents as classification codes for incoming calls. Account
codes can be verified, non-verified, fixed length, or forced.

See Classification Codes, Fixed Length Account Codes, Forced Account Codes, Non-Verified
Account Codes, Verified Account Codes.

ACD (Automatic Call Distribution)

ACD (Automatic Call Distribution) is a call distributionmechanism that distributes calls to a pool of
available queuemembers.

ACD (state)

ACD is a state applied to a queuemember while they are handling an ACD call.

ACD calls handled

SeeCalls Handled.

ACD calls interflowed

See Interflowed.

ACD calls offered

SeeCalls offered.

ACD calls requeued

SeeCalls requeued.

ACD handling time

ACD handling time is a parameter for MiContact Center Business that provides the sum of all events
from answer to hang up of an ACD call.

ACD path

An ACD path is a predefined route that a call follows before reaching an agent. ACD paths direct
callers to the agents or agent groups best suited to handle the calls. For example, a contact center
can have an ACD path for sales, which routes callers to the agents taking sales orders.
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Active Directory

Active Directory is a directory service created by Microsoft that is used for managing a domain. In
MiContact Center Business, Active Directory is synchronized with YourSite Explorer to align Active
Directory security groups and users with MiContact Center Business employees and employee
groups within selected organizational units.

Agent

An agent is a contact center employee, assigned an Agent ID, who receives calls routed to
ACD paths.

Agents available

Agents available is a real-time statistic indicating the current number of agents who are logged in and
not in Make Busy or Do Not Disturb. If an agent is configured as a part of an agent group and is
logged in, the agent is counted as available, even if they are not present in that agent group. This
statistic can be used as a queue condition in IVR Routing.

ANI (Automatic Number Identification)

ANI (Automatic Number Identification) is a service that provides receivers of telephone calls with the
caller information. ANI can be used to create screen pops for agents or to route calls by caller phone
numbers.

Answered by

Answered by is the real-time name for the number of calls answered by the first, second, third, and
fourth answer points

Answering points

An answering point is a single point of communication available to callers where they can contact a
contact center, such as a queue, voicemail, or extension.

ASA

See Average Speed of Answer

Average Speed of Answer

Average speed of answer (ASA) is an ACD statistic that measures how long the average caller waits
on hold before the call is picked up by a queuemember (including time in queue and ringing time).

Average abandon time

The average abandon time is the average number of seconds callers wait in queue before they
abandon a call.

Blocked call

A blocked call is a call that is unable to get into the contact center's telephone system because there
are no trunks available. The caller receives a busy signal.

Busy hour

Busy hour is a statistic that highlights the busiest hour of operation of a business day.
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Call abandoned parameter

The Call abandoned parameter is a queue configuration that defines short abandoned calls,
determining what abandoned calls are included as abandoned in call statistics. The default the short
abandon is configured at 6 seconds.

Call routing

Call routing is the set of instructions configured inMiContact Center Business to automate the
movement of calls to their intended answering points.

Call type

Call type categorizes calls queuemembers receive, enabling them to be looked up in SMDR
Inspector. Call types include ACD or Non ACD, abandoned, interflowed, requeued, unavailable, or
outbound.

Callback

Callback is an optional feature of telephone systems that enables callers who are unable to reach an
agent in a contact center to be called back by the contact center. MiContact Center Business and
IVR Routing offer several methods of providing callbacks, including Call me back, voice callbacks,
web callbacks, and abandon callbacks.

Calls abandoned

Calls abandoned is a report field detailing the total number of calls that abandoned in queue or while
the phone was still ringing at an extension. Calls abandoned ignores calls that were abandoned
before the short abandoned parameter had been passed.

See Abandoned calls.

Calls abandoned (long)

Calls abandoned (long) are abandoned calls where the caller hung up after the short abandon
parameter had been passed. By default, the short abandon is configured to be 6 seconds.

Calls abandoned (short)

Calls abandoned (short) are abandoned calls where the caller hung up before the short abandon
parameter had been passed and are not included in the call statistics.

Calls answered

SeeCalls handled.

Calls handled

A handled call is a call that has been picked up answered by a queuemember. A call that listens to
in-queue RAD messages is not considered handled until it is answered by a queuemember.

Calls interflowed

See Interflowed.
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Calls offered

1) Calls offered are all calls received, regardless of how they are handled or routed, including calls
handled and both short and long abandoned calls.

2) Calls offered is a forecasting parameter used to determine the queuemember requirement for a
contact center’s Service Level percent and Service Level time targets through applying the Erlang C
equation to the estimated Call Load and average ACD Handling Time.

Calls requeued

Requeued calls are all calls replaced back into the same queue and offered to another agent when an
agent receives an ACD call and fails to answer it after a pre-configured duration or number of rings.

Calls waiting

Calls waiting is the number of callers in a queue waiting for a queuemember to become available,
including those listening toMusic on hold or queue announcements.

Camp on

Camp on is a notification tool that enables callers to notify an employee, who is currently on a call,
that they are waiting to be answered. The employee is notified by a series of audible beeps.

Classification codes

Classification codes are classifiers appended to calls to categorize them, enabling reporting to
examine specific categories of calls, such as those relating to specific products or services.

Clustered environment

A clustered environment is a network environment wheremultiple telephone systems are linked
together to function as a single system.

Computer Telephony Integration

Computer Telephony Integration (CTI) are technologies that merge computer functions and
telephone systems, enabling PC-based telephone systems to deliver functions such as
synchronized voice and data delivery, voice and data conferencing, automatic information retrieval
for calls, caller-basedmessaging and routing, and desktop productivity tools.

CTI

SeeComputer Telephony Integration

Customer Relationship Management

Customer Relationship Management (CRM) is amodel for customermanagement that relies on
technology to streamline andmanage interactions with customers.

Date stamp

SeeDate/Time stamp.

Date/Time stamp

A date/time stamp is an indicator attached to a record or statistic detailing when it was created.
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Delayed call

A delayed call is a call placed in the ACD queue because it cannot be immediately answered by a
queuemember. The ACD queue allows the client to wait for an available member rather than
blocking the client from entering the system.

Dialable number

The dialable number is a digit or series of digits dialed by a caller to reach an answering point, such
as a queuemember, an extension, a queue, or voicemail.

Dialed Number Identification Service (DNIS)

Dialed Number Identification Service (DNIS) is a telecommunication service that identifies the
phone numbers dialed by inbound callers. DNIS can be used to route calls, enabling contact centers
managingmultiple product lines or businesses to direct calls to the appropriate endpoint.

Division

A division is a grouping of several employee or extension groups that enable a single report to be run
for several groups simultaneously.

DND

SeeDoNot Disturb (state).

DNIS

SeeDialed Number Identification Service.

Do Not Disturb (state)

DoNot Disturb (DND) is a state that prevents queuemembers from receiving inbound interactions
and transfers. For agents, Do Not Disturb is an employee-level configuration. When an employee is
in Do Not Disturb, they enter Do Not Disturb across all agent capabilities.

Employee

An employee is a person who is employed by an organization and configured as an employee in
MiContact Center Business so that they have access toMiContact Center Business applications
andmay have their associated devices reported on.

Enterprise

An enterprise is both the single site where the Enterprise Server is installed and all the connected
branch offices that comprise a company.

Enterprise Server

The Enterprise Server is the central server upon whichMiContact Center Business is installed and
from whichMiContact Center Business runs.

Erlang

An Erlang is a unit of measure for telephone traffic equal to one hour or 3,600 seconds of telephone
interaction, such as a single call lasting one hour or six calls lasting 10minutes.



MiContact Center Business—MiVoice Business User Guide

341

Erlang B

Erlang B is an equation used to estimate the number of trunks required by a contact center.

Erlang C

Erlang C is a forecasting equation that uses historical Call Load data, Service Level Percentage,
Service Level Time, andWrap up TimeUsed to predict the resources required to keep wait times
within a contact center ‘s Service Level objective for the time interval and data range selected in a
forecast.

External Hot Desking Agent

SeeHot Desking Agent.

Extension

An extension is an endpoint for answering calls. Extensions can be assigned to RingGroups, or can
be logged into by agents.

Fixed Length Account Codes

Fixed Length Account Codes are verified and non-verified Account Codes that are automatically
submitted to the system when the correct number of digits has been entered.

Forced Account Codes

Forced Account Codes are verified and non-verified account codes that must be entered at a specific
time in a call. Forced verified account codes must be entered as soon as the phone is off the hook.
Forced non-verified Account Codes must be entered after the phone number is dialed. Systems may
be configured to avoid the requirement of entering a forced non-verified Account Code whenmaking
a call that must not be charged (for example, dialing a leading digit such as 8 tomake a call without
entering an Account Code and dialing a leading digit such as 9 tomake a call that requires an
Account Code).

Grade of service

The grade of service (GOS) is ameasure of the likelihood of an attempted call receiving a busy
signal. GOS compares the number of trunks to the level of traffic and expresses the result as a
decimal fraction. A GOS of P.02, for example, indicates that a caller would have a two percent
chance of receiving a busy signal.

Handled by

Handled by is the real-time statistic for the number of calls answered by the first, second, third, and
fourth answer points.

Handled %

Handled% is the real-time statistic comparing the calls handled to the calls offered.

Handling time

Handling time is themeasure of how long a call took to be handled by a queuemember, from when
the call is answered when the call is finished. Handling time includes talk time, hold time, as well as
transfers and conferences on the call.
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Hot Desking Agent

Hot Desking Agents are employees configured with a Hot Desking Agent ID that enables them to sit
at any extension in a network and log on to that extension with all their regular work settings
available. External Hot Desking Agents can hot desk remotely using any phone or headset.

Hunt group

A hunt group is a series of telephone lines grouped by the telephone system that rotates incoming
calls through the lines until an available line is found and the caller is connected.

Inbound

Inbound is a descriptive term applied to forms of interaction or communication, such as a phone call,
to indicate that it is being sent to a contact center from an external source.

Inbound calls

See Inbound.

Interflowed

Interflow is amechanism that redirects interactions from queues to alternate answering points (for
example, to another queue or to voicemail). Interflow statistics include interactions manually
transferred from one queue to another. Interactions routed from queues to other answering points
before the Short Abandon time are not included in Interflow statistics.

Interactive Voice Response

Interactive Voice Response (IVR) is a technology that enables callers to interact with a contact
center’s phone system by pressing keys or speech recognition while following IVR dialog.

Internal calls

Internal calls are calls made from within a system to other answering points within the same system.

LAN

A Local Area Network (LAN) connects multiple computers together over short distances. LANs
typically operate within a building. The computers share information, applications, and peripherals,
such as printers.

Logged on

Logged on is an agent state applied to agents who have signed into the ACD system.

Logged off

Logged off is an agent state applied to agents who have signed out of the ACD system.

Longest waiting

Longest waiting is the duration, in minutes and seconds, of the call that has been waiting the longest
in queue.
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Make Busy (state)

Make Busy is an agent presence state applied to prevent an agent who is busy from receiving ACD
calls. Agents in Make Busy are able to receive Non ACD calls. Make Busy is an employee-level
configuration. When an employee is in Make Busy, they enter Make Busy across all agent
capabilities.

Media servers

A media server is a server or system, such as a telephone system, used to organize and distribute
communications throughout a contact center.

MiTAI

MiTAI is aMitel implementation of TAPI that is used to connect the telephone system/PCs running
windows to external applications, such as ACD controllers.

Mitel OPS Manager

Mitel OPS Manager is aMitel software application that provides network-wide administration and
maintenance for MiVoice Business and 3300 Network Elements or Nodes.

Non ACD (state)

Non ACD is a state applied to queuemembers involved in an incoming personal contact, a member-
originated call, or a call dialed directly to their extension.

Non-verified Account Codes

Non-verified Account Codes are numbers entered onto the SMDR record for billing and call
management. During a call, non-verified Account Codes can be entered as often as required.

Outbound calls

Outbound calls are calls made from within a contact center to external answering points.

Overflow

Overflow is a call distributionmechanism that queues calls against two or more agent groups to limit
the delay faced by callers. If a call in an ACD queue is not answered after the configured Overflow
time, then it is placed into the queue of a second agent group in addition to the first queue.

PBX

See Telephone system.

Pooling principle

The pooling principle refers to the increased contact center efficiency gained by consolidating
contact center resources.

Port

A port is a communications endpoint in MiContact Center Business used to link services.

Probability of delay

The probability of delay is a statistic that measures the likelihood of a call being delayed in the ACD
queue, comparing the number of queuemembers to the level of traffic carried by the trunks.
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PSTN

See Public Switched Telephone Network.

Public Switched Telephone Network (PSTN)

The Public Switched Telephone Network is a global collection of Central Offices (CO)
interconnected by long distance telephone switching systems.

Quality of service

Quality of service is a reflection of an agent's ability to provide excellent assistance to each
customer. Quality of service can be evaluated andmanaged through silent monitoring systems, IT
support systems, CTI, ANI, and DNIS.

Queue number

A queue number is the address of a queue or other answering point used in the telephone system.
The programming associated with the queue number defines the routing and timing options available
to the call.

Queue member

A queuemember is an individual answering for the queue. For ACD paths, ‘members’ refers to
agents in the queue’s answering agent groups. For Ring Groups, ‘members’ refers to the extensions
assigned to the queue’s Ring Groups.

Queue unavailable

1) Queue unavailable is a routing option that reroutes calls to an unavailable answer point/overflow
point. Queues are unavailable when the call enters the system outside business hours, when all
queuemembers have removed their presence, when all queuemembers are in DND, or when the
queue has been placed in DND. Calls interflowed before the Short Abandon time are included in
Queue Unavailable statistics.

2) Queue unavailable is a real-time statistic that counts how many calls were re-rerouted to other
queues due to the queue being unavailable.

RAD

SeeRecorded Announcement Device.

Readerboard

SeeWall sign.

Real-time adherence

Adherence refers to whether or not agents are performing the activities for which they are scheduled.
Workforcemanagement tools enable supervisors to be notified of discrepancies between agents'
work schedules and the actual activities they perform.

Reason Code

Reason codes are descriptive classifiers applied toMake Busy and DoNot Disturb states to provide
more detailed information as to why the queuemember applied the code.
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Recorded Announcement Device

Recorded Announcement Device is an IVR Routing feature that provides prerecordedmessages to
callers waiting in the ACD queue.

Reporting number

A reporting number is the unique number assigned by the system to contact center resources for
reporting purposes.

Ring Group

A RingGroup is a collection of extensions, or a single dialing point for a collection of extensions, in a
business. Ring Groups are typically used to reach back office extensions. For example, a business
with agents taking sales orders may also have several phone extensions in the warehouse. These
warehouse phone extensions are compiled into a RingGroup, which can be reached via a single
dialing point.

Service Level percent

The Service Level percent is the number of calls that are handled, abandoned, and interflowed before
the Service Level time, compared to the total number of calls handled, abandoned, and interflowed.

Service Level time

The Service Level time is the specified time used in calculating the queue service objective in
conjunction with the Service level percent, such as 80% (Service Level percent) of interactions
answered within 120 seconds (Service Level time).

Silent monitoring

Silent monitoring is aMiContact Center Business feature that facilitates the tracking of agent call
handling techniques by enabling supervisors to listen to the voice interactions of internal or external
calls between agents and callers.

Site

A site is a physical location of a contact center with one or moremedia servers. It may be the same
location where the Enterprise Server is installed or a branch office.

Spectrum

Spectrum is a reporting feature configured for queues that provides a frequency distribution of calls
abandoned, answered, or interflowed based on a defined time scale.

SQL

SQL is a standard query language used to enter, query, and change data in a database, as well as
create and administer databases. Administration of YourSite Explorer is done usingMicrosoft's SQL
Server.

Subroutines

Subroutines are portions of workflows that can be reused inmultiple workflows.

Talk time

Talk time is themeasure of the time an agent spends talking to callers, excluding time spent on hold.
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TCP/IP

TCP/IP is the basic communication protocol of the Internet and is used as a communication protocol
in private networks (intranets).

Telephone system

A telephone system is a private branch exchange (PBX) or business telephone switch used to
process incoming and outgoing calls to a contact center.

Time to answer

Time to answer is themeasure, in seconds, of how long an incoming call remained in queue before it
was answered. It is primarily used as an SMDR datamining criteria.

Time stamp

SeeDate/Time stamp.

True talk time

See Talk Time.

Trunk

A trunk is a communication line between two telephone systems.

Trunk load

Trunk load is the duration of time from when a trunk receives a call to when the queuemember
finishes handling the call and disconnects. Trunk load does not includeWrap Up Time.

Unavailable

Unavailable is an agent and employee state real-time column in Contact Center Client that includes
agents unavailable to take calls due to being in DoNot Disturb, Make Busy, Work Timer, Reseize
Timer, or Unknown.

Updated Position in Queue (UPiQ)

Updated Position in Queue (UPiQ) is a notification feature that provides messages to callers
informing them of their position in queue and keeps them informed of their position if it changes, at
preset intervals.

UPiQ

SeeUpdated Position in Queue.

Verified Account Codes

Verified Account Codes are numbers entered beforemaking a call to change the Class of Service or
Class of Restriction at the station. When the call ends, the station returns to normal. Verified
Account Codes can be tracked with SMDR for long-distance billing purposes andmay be reported in
Internal SMDR logs.

Wall board

SeeWall sign.
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Wall sign

A wall sign is an electronic sign used to display real-time ACD statistics to employees in a contact
center.

WAN

Wide Area Network (WAN) connects multiple computers over a wide geographic area. WANs
operate over telephone carrier lines through bridges or routers. Router options enable communication
between high speed LAN links and slower speedWAN links, which tie LAN segments together.

Whisper Coach

Whisper Coach is a silent monitor feature that enables supervisors to converse with and coach
agents handling calls without callers hearing the supervisor.

Workflow

Workflows are programed pathways in IVR Routing andMultimedia Contact Center, which control
how interactions are routed to queuemembers.

Workforce management

Workforcemanagement is the scheduling of contact center agents to meet forecasted resource
requirements and themanaging of agents to ensure they adhere to their scheduled activities.

Wrap Up Time

WrapUp Time is a real-time and reporting statistic detailing the total time an agent spends in the
Work Timer state.
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